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LAR—MER &L T. Adobe PDF] & HTML] DWW &EIR L £7
R—27 W7 =L X (PDF) TOD L R — DFi AIA & 121E « Adobe Reader 7 DL & 234 %
T9,

AT IAT VAT T L— AR E LET . VA MPAST 741 bDT > 7L — bR T 2
s R AR 27V LTHERIE A DT> 7L — %5 8 § 2%, Compliance
Manager B WCAARARLT > 7 L— b AE I T B2 ENTE £

$€ 7 (Finished)] #27Vv/L &7,
Fortify Weblnspect#3L £i— &4 il L TR7 W HEK IR LIz B, V—u3—D L R— rOR
17 (Save Report)] 74 2> %7 Vy/LTZDL K— beARAF T& &7

CHHH TS LFan
"V T SAT VAT 7 L— hOER"

a7 S5A T VAT 7 L— FOVE R

AT IAT VAT YT L— MEVERR § 3121

1.

2.

Fortify Weblnspect] x=2—/3—T7. P/—)(Tools)]> Compliance Manager] # 7
IV & o
Compliance Manager] 7 1> N5 & L7 > 7L — FOMBE 2358 78 St &9

] Compliance Manager
File  Help
[ Mew [ Open | Sawe hd e Up Fonwve Dowen

=l Compliance Description
Mew Compliance Template

< lick here to add a new category. .. =

[ Lwwar7' 4 7> 27 >7'L— NNew Compliance Template) | &0 57L—X% 7 Uy
7L &7,
Compliance Manager® 7 1> RUD | 73 WG 4E T VT RN S E7,
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V=)V HA N
% 3: Compliance Manager (Fortify Weblnspect® )

3. wETYZT. TH Lwar7 547 A 77 1— NNew Compliance Template) ] &9
ZL—RX % A T 27> 7 L — bOR ] (ZOF TETHIPAAL)ICE &R 2 £7.
& Compliance Manager > B

File  Help
13 Mew [ Open |l Save Miawve Up e Down

[=] Compliance Description

<Click here to add a new category... =

Compliance Description

Description:  [H1paa)|

Mewr Cornpliance Template

4. T<H LLA7 T VBN 22id 2% 27 Vv 2...>(<Click here to add a new
category...>) ] LW ITL—XE 7Yy L &£T
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V=LA AR
% 3: Compliance Manager (Fortify Weblnspect® )

5. ME T V7T H LLATTIDLAT W] NI LET. COF T ZRTIET A RT—
MR % (Password Protection) ] T+ it BT S 27— FON ) HEE D L& F 297«
w4 r 9 2(Maintain security during entry and transmission of passwords) ] T4 .

& Compliance Manager = g
File  Help
] Mewr [ Open s Save arve Up IMave Down

=] Compliance Description
HIP&A

Password Protection

<iZlick here to add a new category... =

Compliance Category

Mame: Password Protection

Maintain security during entry and transmission of passwaords.,

Description:

MNew Cornpliance Ternplate

6. 7 Z7AiL Tk 7Yy LT\ [ A 27— MR # (Password Protection) | &0 270V Dff L7z
S REREB LET.

7. T<¥r LOE R 2B N9 212d 2% 27 Vv 2. >(<Click here to add a new question...>) |
EWITL—X% 7Yy LET,

8. I#H L& [H(New Question)] £ 57L—X% 27Uy 7L £,

GEE TVTIZ AT HRE R SN BDT, 2N 6D X7 EMH LTl A 27— MRS | 7T 0
FAIE 5 28 B 21E § 22T & &,
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VIV AA R
% 3: Compliance Manager (Fortify Weblnspect®d 4)

9. ER(Question)] TV7iz. A7 I VCHE T2EM AN I L&T. COBITETAT
SN2 RAT— RO L F AL T ARYAR 7 EL TR R ST 3H7?(Is each character of
entered password displayed as an asterisk?) ] W YEH ] 2N JJ LT &9,

- 0

&y Compliance Manager

File  Help
[ Mew [ Open sl Save hove Up i owve Doen

=] Compliance Description
HIP&&
=l Password Protection

15 each character of entered password displayed as an asterisk?
<Zlick here ko add a new question,.. >
<iClick here to add a new category. ., =

Edit Question [ Threat Classes I Yulnerabilities [ Custamn Checks & Agents ]

Cateqgory: Password Protection w

Question: |15 each character of entered password displayed as an asterisk?

Carnrment:

[] Include Broken Links

MNew Cornpliance Template

10. COHE [ %, # )il 7 7 A, OpenTexttiE & LIcHE 551 . E72& BLATICAE B L7z AR R L
Fryser—y xy M T 2208 TEEd. COBTlE. ETFE
(Vulnerabilities)] 7% 7 Vv 2L T 5. [DEN(AIdBYID)] %#2Vy2L £,

VMM 2723 B B 25 AFIRR L Thremz 2y rd 228 &-T 20N 55 M
1B B 272 % COH [ O IR L1-HE 55 i (Selected Vulnerabilities)] & 7z(4
BN L& B 75 A(Selected Threat Classes)| Dt /> sl & » 3l T& &

EE

11. D& 3Fxzy70iE iN(Add Check By ID)] 71> b7 ¢, 47241 N1 LT DK %27
Voo L &d. 4724151 ~ A /3t fz/S 27— K7 4—)1 N(Password Field Masked) ] &9

Fzy/DIDTHE 5 TTo
H:EHOIDZEMTEET(MTRKIDTDEMLET).
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V=V A K
% 3: Compliance Manager (Fortify Weblnspect®d 4)

12.

13.

14.

foE LizF zvoh BBIR LI §5 14 (Selected Vulnerabilities)] =V 7ic £ /s S £
ERS

al Compliance Manager

File  Help
[ Mew [ Open |l Save Ploece Up Pl e Divivr

=] Compliance Description
HIPAL
=l Password Protection

Is each character of entered password displayed as an asterisk?

<Click here to add & new question. .. =
<iZlick here to add & new category... =

Compliance Question

Edit GQuestion [ Threat Classe, Yulnerabilities [ Custom Checks & Agents l

AllVulnerabilities

----- [1°  MPCScftweb Information Disclosure (4603) A
----- | Webalizer webalizer conf Configuration Disclosure
----- [ webalizer Usage Page Discovery (4629)
----- | ‘WeblWiz Guestbook Database Information Disclos
----- [C]"  webwiz Mailing Information Disclosure (46353 =
----- O BadBlue Webserver ext.ini Information Disclosure
----- | FT&atePro Information Disclosure {4665)

----- []%# Hassan shopping Cart shop,pl Remate File Yiewin

----- ] iPlanet Administration Arbitrary File Source Disclos
----- [ Divine Content Server Cross-Site Scripting (4715)
----- g Password Field Masked {4724) o
. et o el .

CheckIlD Mame Pass If Detected  Exclude

4724 |Password Fisld Masked | ®m | = |

<

Dekail

MNew Corpliance Template

B LM 55 1 (Selected Vulnerabilities)] = U7 121& . IRD2DODF zy /R w7 A0 D

NE9,

o [H an135E & & ¥ (Pass If Detected)] -7 =745, 77 Ur—y s>t % 207 4
CH ST E M AR TAEEHM ELIZEDTH B EE. COATY av 4R R
LE&d. kézlE av 7547 A7 0l 5 50— Td 37 71 v(Privacy Policy.html
BEYDFAE B F 29l T DHARRLF ey 2 R T 26 & 2047y v &1 H
T&&f7.

« B4 (Exclude)]-F =y /D L —7EBII LT 2 L& 2D IO E DF =9/ %
BRAN 4 285 S d. COATY av 5IBIR LET .

COBITIE. EBEDF zy R v/ ALEIR L&A

AT AT VAL R—NEEN VY ID VR MR T3S Bl 2803

(Include Broken Links)] 7 =/ H v X% 412 L £9

CDF 2ol R I AEFNILTWBRIG S AT AT VAL E— 1 EHEIT 728 B ono

NI IRLA— MO B BERRNINET EN LV I T 7 L— NN D

HRIWCEHEST e Tw a6 ZOE M IR L Ty—r3n E7.

B A WEFME . FE ARARLF 2o DB N 5547 LTy a7 54 7> ADY [
WKOWTTINVr—y a5+ DB T 23120DFXTOF zy/7&2B ML ET,
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VIV AA R
% 3: Compliance Manager (Fortify Weblnspect®d 4)

15. IBIMOEM &A7TVE LR OFIETIER LT av 754 TV AT > 7' L— h5E Il &4
7.
16. fEfE(Save)] #2VvrL &7 .

i FH @ £%€

o NTINEIIZIEH 2 R"F 2 2WE THH 2B R LT [EABE] &2 FABH] %
VAN VA& B

e ATTVEFIEB 2N TGS #7IVFREEM %54 2y LTy ¥ 3= My b A
2= AN ZERLETHH A IBIRLALIEH O LN S £7.

o DM DE N, G £FE B B ICHTMLY> 22BN T&E T,

ompliance Category [ |

Mame: |F'assw::|r|:| Prokection |

Maintain security during entry and transmission of passwords,

v pebools . comyguides)password)]

Description:

— B T XA MER 7L —

F 27 1L 7 hVFI| Z5 (Directory Enumeration) T> ¥ i o TfE sSh 32D x—y = 7
W=7 A MHEZITXNTOH BLIORIMDAREENET ] 7 OF =y 2id . A
(Accounting &4 5% |if DT 4L 27 MIDKE R T & 2) %> AZ (Zips & % BT DT 4L 7 MDD
MR TEDR)ETDTN TRy NEIZZ V=7 &h 4. ZOZ )L—712i4 . Microsoft
FrontPage-Microsoft Internet Information Server® o7 7 71 )L, (W3SVCnn)(Z B & -} ( 5
NTWBT AL MEEDE DM DRATDT 4L 7 MIDF zvs b N TH&ET,

fif AT BE 2 §RTCDT—v x> FOFEAN DWW Tl Policy Manager #12 % & 2—CB 4
L. M % 7+ A M& ‘% (General Text Searching)] /— M2/ LT . E R DT—Y =
N 7w LT 2 &0,

B oo
Web Application Security Consortiumid . Web# 1 bD ¥ & 2U7 2%} 3 2% B W i1k

LTI 327200, EREEOHGEEERLTOET. 2 slk BB 77 A(Threat
Classes)] X7 Z YA RSN T &7,
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V=V A K
% 3: Compliance Manager (Fortify Weblnspect®d 4)

ZN 5D BAZK T BHEFIMHE A AF v & DR B Liem E a2 § 2121

1. BB 77A(&12E 2D ayR—2 > MOWT ) 2R L 7.

2. W% /7Vys LT, N EZOE M O BIR S8 B 27 > X(Selected Threat Classes)]
EDET.

OpenText™ Fortify Weblnspect (23.2.0) N—240/360



B4 T2 a—KF 3—X

ZDY—)VIZ &V, Base 64. 161EH . MD5 % EDAF—LZFH LT H 2Ty a—FB &V
Fa— N T & &7, L F 5] #Unicode s 7 71| 12 > a— ¥ % C &%, URLORE 5% T4 ik 3¢
FEMH T2 TEET,

AF U AE R O M, Ty a—RERERE S A Sh e R B b 230 F 5 058 sh
1235 41 L F A & 2 ¢—L T Encoders/Decoders V—)V B Off F. Fa—F
(Decode)] #7 Vv o4 31200 T,

¥ Encoders/Decoders |Z| @| E|
File  Edit Help

= - |@Encnde @Decude |Enn:c:ding: ROT 13 &
Teut Encoding Character éet
1234587830 Select By

(") Character Set Name  (®) Display Name

Westem European (Windows)

Westem European (Windows)
Character Set "Windows-1252"
Code Page 1252

Hex Display

21 3P 3305435 26 37 3R03% 30

(] Prefixed (e

Length: 10

YEH DLy a—F 47

LFEH ATy a— N B2

1. FFRAMNText)] TUTCLFA #N 19 2( 72085 0T )0, A=a—h6 Prfiv
(File)]> BE 4Open)] %i&R L TT7 74 VDN A %t HIA & £4 .

2. [ v h4 (Character Set Name)] 721 &7 4 (Display Name)] D\ 1 7%
FHLTIYa—T 42/ L F ey bR L &7
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V=LA A R
w4 T a—RK|7 13—

3. [Eva—74>7(Encoding)] VA b ol 5 OFESE 2B R L 3. sF 4l DT I
Ty aA=T AT ZA TR DA—V ] #Z H L TS0,

4. LELGE LT, BF—(Key)] 74—V RCF—2AN S LET. AR ¥—5N 1T 5 &

fr > a— NEncode)] £ 2> & F a— F(Decode)] K &> H W& DET .

5. E¥a—REncode)] #7VvrL &7,

F¥ 2 NText)] TY712id 2> a— RSN T I RIS Sh 4. 161 R (Hex
Display)] = V7i2i& T>a— F&N 230 F 51 N D% 35 D163 fiF A3(IE R L 7230 F
Y NC74—vy SN O)KR SN ET,

v 7497 24t &(Prefixed)] I# 91§ 5 &, 163 2 D T T Ox 8B N sh £ 9. C
B & OPELL LIAE L D 55 (C++. C#. Java. JavaScriptZ £) Tld . 163 % D5k BE (C
roxJ &£t ia“(t&z FOX5A3). 46 T8 DO & >TA—HE ¥l T B LaR i L &
T IxIF16EE 2R LT,

L H OF 3
FH) T a— N Bl

1. FFRANText)] U7 FH) 2N J1§ (£ 1230 OFF T 8) s x=2—h 6 Praw
(File)]> BE {Open)] %iER L TT7 7/ VDN A it HIA & £4 .

2. [E>a—74>7(Encoding)] VA h ol S OFHH 218 IR L £

3. WEG LT, FBE—(Key)] 74— Ricx—2# AN L&,

4. F a—N(Decode)] #7VyrL &7,

HTTP Editor ©. WeblnspectD > a—7 4> 7 B SV F a—F 4> FHBE 2 T § 2284 T

EFET. vy OEET A 2T BE AT AT ET AT AT DA TS T

JEXATEET,

> a— RSN 1230 F 4] OFRAE

Ty a—RFSNIE RO FH2iE BIRIA T BE 2 L FE DT ENTH G 08H0ET .
Ny 1/\——;«))1‘/:!*‘?‘4‘/7 AF—LFlEF—EUEET 20T A>T AF—LEH
H 323562 SUASHBCH A LET. BRI ] B8 4 3C F i Windows 7 ) w7 R — Kz 3
E—7T %&L:@T Ho4li izEncoder/Decoders» s at—L 7z 0, ZHCHE OfF /7203 32 &k
T&EHA. 12120, COHIR 2B 5 2720020077 1EHDHVET .

o IVI—RNRENTLFENETANARIE L TBE, ZNET I— N B EL&ITE A=2—05
P 71 v(File)]> B {Open)] #i# 4R L T. Encodery—ivizo— KL &9 . ZD&. LD
TiEYREHR TG ) F—&2EH LT a—r L &7,

o Il BRIz a—T 4>/ R EeF— 2 LT FH #x>a—RNLIE RO
Y4 #Base 64T R A H LTy a— R T 23288 TC&ET. Z2DB . 2O FEH %57
Vo7 h—RZae—L. 7Vy7'R—FON 5 &5 Off (J, Base 64 %#ffi | L T7 a—FL T2
BLILDHEHZHA T2 5 F— 4 LTHUYTa—RFLET,
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=LA R

T4 T a—KI7 3K

I aA—T AV T RAT

Encoder/DecoderCld . IR DR WZECH SN oy a—T 4V 7 XA 7 5B IR TE £ 7,

rya—
7 AT &AL
79

3DES

Baseb4

Blowfish
DES

Hex
MD5
RC2

RC4

ROT13

SHA1

E &

Triple DES. 7—&%3[n {5 5 1k 3 2DESK; 5 1L 7)v 3 VR LD E— ML F
P 531G 51k S, 2O S oG 51k S, 2045 OG5 7 F R M3
H OIS 54k 2T bh £9). F—3128 v M F7213192 6y M163LF &7213
24 F)TRUNIE R VEE Ao

8ty bF 27 v D3O 5. AL F DI/ N—7EL Ty a— FB LU T a— L
FT. /% LFEV—ATHB24y hOF D6Ey M EE L i . ASCIE LU
EBCDICO$RTDNANTY MIF EN AL FRIEFH §2280 &0, i1
Dxya—7 4> 7R CH 2 G M 20 & L THET,

DES7 VT VX LD o HEL TfE T &3I4 7V T VX 4

7 — XM AL EE HE , TR 20009k i 2 25 & 27 54 X— hD(HDF % D)
BB F—4 ] T&x 2. 5 YEH S Tw a7 —&1E 240 . EE T
Ea—H DM 7 2E CA &l 2 H T 20 EAHDET,

163 % .

I ChHNANT] LicT —Rxt LT, 128y FOTFRAL ] &/oid T Aot —2 XA
VA M EERLET,

Ronald Rivest & 5t LI=A] 25§ -4 XD 7 0y /g 5 . 7'av 44 X364
By Ty V7 N7 27 TIEDES & V&) 242 7 534% & 3 T3

Ronald Rivest2i& &t L7122 bU— ARG S . Chid. 231 ME A O AE 24T
I A 2SS H A XD b Y— LIS T3 . RSA SecurPC 7% EDOBL i D7 74 L
g S AL s aZaichn 2. SSL7 e bav &{E ] L7224 e Web+- 4
DR D b5 749700 54 D & AC, 24 2B U H &N 4.

BXFETIV IRy NCI3L FR I HIZLFICE SR AT, 7F A MR
2 Ab 2o d H &h 2 Hi 4l e Caesarfig = .

LF 27wy 27T YR Lo NISTIZ & >R % L. iEHEFIPS 180 CE &
SN TWB.— ANy 28 8. SHA-11E 19944 (2 F AT Sh 1220 5T I
T, ANSHZ#X9.30(/A— R2)IC bRl Sh T &9,
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VIV AA R

T4 LY a—K]7 a—XK

>va—
?:4‘/7 &4
7

SHA256
SHA384
SHA512
ToLower
ToUpper
TwoFish

Unicode
URL
XHTML

XOR

E 3

256 Ly MG Sk 2 ] § 28 % 27/ v 27T VX 4,
384y M S 21l 2L+ 27/ vy a7 LT YR A
512y M 54k 2 il 22 F 27/ v a7V T VR A,
R F 2N LFEEELET.
INLFERLFREE L ET.

LT OBlowfishiz 3t 2 i 54k 7L 3 VR A,

T IyNTr— b 70l A BIUFREICHR L KX LTEA O
HiE#fe e LEd.

R O F LS OURLT Y a—F 4> 7 I Tx 2l #E R L. 20
EHR— P BT SUHFRT ST TCRRNTEBRENLET .

AN INT—RETF A MRT T, <text>7T —Z</text>D & HZ A7 ik L
EQC N

XORIGH L I OREEAME #=4T LT . ¥—4IEE T AL ELRHVES, F—
WFEHOE S L ELTORES . 2O FiE. > a— R NF a— RN F4|
W O& S F ekt LCORMLER &h £9,
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ES5HTTP 7 1 &

HTTP Editorid . 23R #1E A /213804 L TH— NS Ly B & 24 OHTMLTE R L1z
D, 7L YRV L TR R LIEDT 22020 H L9 . HTTP Editorid &) O\ v+
IV TH B fEFHICIEHTML. HTTP. 8 SUEE R Y o RO 78 501 3k 250 ¢

o

7R YN TA=RE LURRAE N T A—RER T T 210 BE I LT L (Edit)]>

(Settings)] iR L 7,

{5} Hitp Fftor
Bie [t Yew pep
i) B b | Chsend asts @) Show Mstory

Locabory Prm ) taes, s pnascs ooee: 30|

I
[oebect g recuss Bcion] = dpoly | 34

GET / MTIRS1.1

User-Rgent: Mozillasl4.0 [ocompatibler HSIE 5.01; Windows EHI 5.0)
Comnpecciony Heep=-Alive
Hose ' wnw . spidymesios.com

| rcreoner I e ]
Chumioed | M Compression - 4
HITR/1.1 200 OX =
Date: Fri, 17 Pek 2006 18:58:13 GMT

dervess Apache

Heep-Riive: timeout=13, maw=100

Compecticn: Keep-Alive

Iranafer-Encoding: chunied

Comugnt~-Type:! texc/huml

1000

44 2 1fE html PUBLIC ==//WIC/ /L0 XHTHL 1.0 Stanmiticha - B

“<html =mlns="http:/ /ey, sl ocg/ 1993/ Khtml™> =
[e] | ¥
Ry
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V=L H AR
=5 HTTP =7 41X

75k ¥ 2—7(Request Viewer)

EEoR Ea—7(Request Viewer) | (IZIEHTTPE SR Xyt —Y 3R R S &9 . ZD Ave—Y
EIRDEXTEH LT4DDR £ 2L N TR R TEET.
o A (Raw)-E R Avt— 47 FAMER CMTFFOERRLET.
o BE#H (Details) -~ v&4 L7 4— IV ME A7 —7WIE R TERLET.
o 16 (Hex) - v — 161 H LASCIIDRFL TR L& T,

o XML-Ayt—Y AR OXMLIY 7>V ER R LET (ZDOX7IE ERICXMLIE X OF —
BV ENTL R HICDAE R SN ET).

Jts 2 € 2— 7 (Response Viewer)

[ % £2—7(Response Viewen) ] IZIEHTTPIG & Ayt —YBE R SN &F . CD Ayte—Y
G IRDETE#EH LTA4DDR 4 2L XA TRRT& LT
o E(Raw) -G & Avt—Y 7 FAMER TMUT ¥ OR R LET.
o TIVH LB Avk—YETIVFIL VAV LTRRNLET
o 163 F (Hex) -it: & Avt—y #1614 £ LASCIIDOFE L TR R LE T,

o XML - A=Y AR DXMLIY 7> V&R RLET. (COX7IE G E XMLE R D7 —
B EN TV B CDARIR SN £T).

HTTP Editor®D A= 2—

P 71 v(File)] A=2—
P71 V(File)] A=a2—Zid . IRDAT'> > HBH DET
o ¥ E R (New Request) -LLRT Dt v avm oD X TOME R &1k L. vr—y 3
URLZYE v L &7,
o 3R %p8 {Open Request) -LL{l Dt v s i IR fF S IHTTPE R 285 A2 774
Wen—RNT&Ed,
o SR O (Save Request) - HTTPZE K #{# 7 T & £,
o LT 241 TER %12 7F (Save Request As) - HTTPE R #{# £ T& £7.
« URLF #(URL Synchronization) - S #1%4R 72 &, [P FLRA] VR R w2 RN T L
1230 7 5 HTTP# 3R 47 ORequest-URIIZIE il 811 &9,

e ZD ¥ {5 (Send As Is) -CDA 7'y s #IE IR LG & L IR Lz 20 Ok & (B
27 {\HTTP Editorid E R #8 FH LI A. COATY avHFH 2 & Z X H 25k of2
TR LI A=V REE T EENTEET, COATY Vi T 28 RBAE B8 LU
DXL O EIEH/ENICH VET,
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=LA R
E5 HTTPZ7 4 &

WH: 7 ox 2R M 3L 0B R EFEH THE T 22LE TEETH. L DFE#E
HTTPZ o> 4—/ Nd JFHEHL OHTTPE R 2L ¥ T& &t A

o # 7 (Exit) - HTTP Editor £/ U £,

i 48 (Edit)] x=a2—
fi 4 (Edit)] A= 2—WE IRDAT Y o 0bVET.
o U] VB Y(Cut) -IER LIz7F A bEHIFR Ly Z2Vv7 R—RRGF LET,
o aE—(Copy) iR LT F A MYy R— MR IFE L ET .
o B Ut (Paste) -2 )7 R—Fh a7 F A MEHEAN LET,
o« MEFind)-FR & LT FAMNMR T 20D 70/ R/ AR R LET .
o 3% 5E (Settings) - HTTP Editor DE 3R /3 5 4—&, REE AT A=K, BEU T OEF /85 A—
RERETEET .
R (View)] x=a2—
BR(View)] A= 2l IROATY o 03b DT .
o JB B DF 7R (Show History) -i% /& L#zHTTPE K #— B o Li=RA V&R R L ET,
o 3 VIR L(Word Wrap) -5 XTD7* A b E DR AW UL 7.

V7 (Help)] A= a2—
PVZ(Help)] A= 2—i2id  IRD a~> FRH VLT,

HTTP Editor~\ )L 7(HTTP Editor Help) -~ v 7" 7 7 L6 & H ¥ (Contents)] X737 2
TAZWZ R NET .

A4 >7 v R(Index) -~V7 7 A VhB & W7 v A(ndex)] X707 7T 47 % DET .
M & (Search) -~ V7' 7 7AW HBH & BE (Search)] X717 77 4702k D&Y,
HTTP Editoric Dt»T(About HTTP Editor) - HTTP EditoricB 3 21k 2R m L &£

3k 7 73 32(Request Actions)

B3R b 2—7(Request Viewer)] X1 >® B3R 77 3(Request Action)] VA b5l
ROA7y av & TEET .
PUT 7 74 L ® 7 v7"u— F(PUT File Upload)

PUT #xV v Fi& . 48 7€ L7:Request-URID N WCHE NN DT> 747 %G T2 &2 ZR L
X9
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=LA R
E5 HTTPZ7 4 &

H— N7 IV EE ZIN DI

1. [k ea—7(Request Viewer)] X1 > D Favy7 X7 YR+ 5 PUTZ7A VDT v7°
o— N(PUT File Upload)] #i# R L £ ¥

2. VRAPDAMNICERIR SN BT F A PRI A, T7A VD7V AREN T LET S
- Freld -

v % (Open Folder)] 714 a> %27V L T, 7v7'a— T 277/ )V EIEIR L &
ER

3. BHApply) #27VysLEd. Chicsn, av 7>y EOHEE LT b £,
Content-Length®%% ¥ (Change Content-Length)

WH E—NTE 2= AR DO Ay —V R &4 4 92 & HTTP Editor2s 2> 7 > /&
%F#HH LT, Content-Length~ vX N O Zid V) zofifi 0B & 2 4. Lo, BDEE
%15 (Send As Is)] A7 s> Hl 4 235 & (& HTTP Editorid 2> 7>V R #48 L &¥
Ao BEIR #IEAT 9 BH1C COFFHE 298 6l 10123 4T 3 512E . Content-Length®ZE &
(Change Content-Length)] £ 4R L < & H (Apply)] #27Vv2L &7

5 2—54d ODURL > 2—7 4> 7|7 a—7 4> 7(URL Encode/Decode Param Values)

URLODAL: 1% (RFC 1738, 944124 )id - URLIWZffi ] T & 23 F %, US-ASCII XL F £ v hD
H7 ey MIRE LT &Y. — 5+ HTMLTIZ1SO-8859-1 (ISO-Latin) 3 F & v hD 4 i [
ERF AV M CxET. £7-HTMLA T ] T & 2305 OFE P 2558 S TH 0.
Unicode XL 7 & v Mk $8I & g T E 4. COH| R O #E 5 &L Tid . JEE%E D
FHEIVI—TAVI LT ZNEETR— T BT SUHRT S/ TRRNTEBLENCT BE
WITERDVET,

VFOURLZY a—7 4> 713 %150 5 DB (72D F DISO-Latin 2— RH A > D247 D
161 K 5L 2% Lm0 4. ) 218

o 7TAXYRZEL 5 *]1=1SO-Latint v FD10#E % D42
o 10if ¥ D42 = 163 B D2A
o 7ARYAZDOURL I— F= %2A

URLT>a—7 1> 7 #Mi F| 3 2 &, ISO-Latin & v b & 2 ] L TE R Xvt—Y 2%
TITEETRHREDF—7— P2 § 28N ERAEMRE > A7 A(DS) /N /SATE& &
¥, 221X IDSWEMNogin] (ISO-Latin)id i R T& £9 4. COHFE #URLTY a—7 4> 7 L
2L DT BT %A4C%AF%47%49%4E | IR LEE A

Ay —V R TR I A—REURLI— RICHE & 2 212, PSSA—XEHDURLT > a—7 1
>Z7(URL Encode Param Values)] #i# 4 L. [ (Apply)] #2Vvo/L &7 .

URLZ Y a—7F 427 & 1285 4—K%ISO-Latinic 2 #2 + 3121d . pPNFA—ZfEH OURLT
a—7" 4>7(URL Decode Param Values)] #i# 4R L. EH (Apply)l £ 27Vv/L &£

E R DOUnicode = > a—7 1> 717 a—7 1>/ (Unicode Encode/Decode Request)

Unicode Worldwide Character Standard Cid . A D4 XTOF E 45k S B O F .
B RR L A)at sl BIUERRE S 2.8l — S ey a—FPRF—L 2l H LT
EFRLTOET, 2547 M—AA 77075 —3 3o %0Web+ 1 ~MZUnicode #8H A A ¢ &,
REROL Ty e T 256 L RXTRIECIA NEHJR CE2R[REE DD DE T,
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Unicode #ffi ] 9 2&. 1200 Y 7 by =78 i 272131 D0OWebH A b, > v =7 V7 %
LTHEBOT S5y 74+—4, il BIOCEHCH U TR TCEET, $12 OR L BT
LH CT—REWIB T2 Gk T&LT.

FoR Ayt —U 4k #Unicode 28 2 3 31213 . EER DUnicode = 2—7 4> 7 (Unicode
Encode Request)] %% 4R L. A (Apply)l £2VUv/L &7,

BLR Ayt —Y 44K #Unicode SISO-LatinicZE # 3 2124« B3R DUnicode7 2—7 4>
7 (Unicode Decode Request)] #i# 4R L. & H (Apply)]1 #27Vv/L £7,

)l F/3— pPost DIE % (Create MultiPart Post)

POST xV v FiE . E R K OFEIR N of2 > 7 47 1%, Request-Line DRequest-URI T1&

E SN2V —RADH LWEJE VY —AEL TR AN B LD, BE L/ NWCER T 5720

AEH] S &9 POSTE R Ave—Y & AE LT 7—RD7 v7'a— Neil & 5 ENTE &

ERD

T7AIHET —REFN T 5124

1. Bk e2—7(Request Viewer)] X1 >® 7 a(Action)] Ko v7’ X7 YR +ns [
)W F 83— FPostDAE i (Create MultiPart Post)] 1% L £9,

2. P73y a/(Action)] VA MDA ICH BT HF A MR YI R Z7ANVD IR AENTT L &
ER

- &2l -
P &%G {Open Folder)] 742> % 27Uy LT AN T 3774V EIEIR L £,
3. ®WHApply)l&#27VysL £,
)l F/3— FPost DHI k& (Remove MultiPart Post)
VT A= MR D TH BT 7V EHIBR 2113 . K ©2—7(Request Viewer)] ~
1>® [F7¥ a(Action)] VA 5 v F 23— FPostDHl Bk (Remove MultiPart Post)] %
IR £9,

X A ~ N
BT Iy A
I %& ea—7(Response Viewer)] X > D A7 DT DTY7 2L IXD3DD > ho—
WD DET
* PF+>7(Chunked)] + &>
« BY7¥»va—7 4>7(Content Coding)] Fov7' X7 YA h
o BARRY, AN 2L 5% TR (Find In Response)] X4 702 K v 2435 &,
ZITTHFAMLFHNEABE LULBEN TR C&ET.
F %> 7(Chunked)

HF— N BB O FHR 2R T 2R 2O B DIE (R 20 4 3 255 6 L & &k 2/
S F oo B LTOERICER LET. 2O & %02 12l I Transfer-Encoding:
chunked] £V INVEDE EN T ET . F v 7 A=Y R, —EHDF v 7055 &
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=5 HTTP =7 41X

. ZOWTO1(E 0)DAT 2358 & ZOB AT Y 2D 7yRET AT %8 &7 . & F v

21 IR D2DODEI; THERL S &5,

o 1BHEXL DF v> /7 — KU A X% AT « YAXDIE L 338> BB I D /85 A—RH %
WTWAGAEBDHVETH. TN SEEN TEFTFHR N TEOT N LEETEHNEE
A)o AT DA IGCRLF T,

o T—RZDLD., D% ICCRLF A%t & £ ¢ .

av 7>y a—7 4>/ (Content Coding)

HTTPJG 25 (L4 7 — 208 EN TV ARG EE KD YA M H B4 T 2D N H%fd
H LT —R&L4i R C&£7,

o GZIP-GNU7 oy =7 N WAE il S i B4 2— 7 4 V7 4T ¥

« Deflate - RFC 1950 [31] T 3 & Tw» 2l zlib ] JE A %#. RFC 1951 [29] CELIA &4 Tua
2l deflate | £ 45 A=A L L AH LTI DTT,

IHHH TSI Ean
B SR & 21 S DR R IR DR—D

FLR O# 45 LEAE
BOR 24 L CGEE T30

1. E R ea—7(Request Viewer)] XA > CER Ayt —V &2 FH L7,
TXFAMNLFHN 2Ty a—NEfld 73— T 2. 7TFANERIRLTE Z2VvoL. Ry
7T w7 A= a—h 6 v a—7 4>7(Encoding)] £7/2i& § a—7 4> 7(Decoding)] %
EIRL T,
PR OFF e OIEH 22 8 ¢ 3121 P27y a(Action)] YA b»alEH #1EIR L. &
B (ApplY)] 7V v s L& 4. BEATIC DL Tid . TTHTTP =7 48 A— 45| 5% [ LT <2
Sy,

2. BEfE(Send)] #2Vy/L T HTTPE R Aot —Y ik fE LET.
HTTPIG & Avb—Y 5% (5 T 5 &, b2 Ea—7(Response Viewer)] XA V2 ZD Ay
L—UNERIRN SN ET

3. WWEETIVFILYRYY T LTR IR T B PIU4 (Browser)] X7% 7 Uy 7L &
R

4. P'Zv4(Browser)] £71zL > XY 7 S f:HTML 2> ho—)v £ /zid JavaScript 2> +
oA LT IRICEAS 3 2HTTPE SR 21l T &9, COMERE 2 H 4 212
& fHEE 8 e7 —2 a/(Interactive Navigation)] # 7> 22( §i4E (Edit)]> e
(Settings)] # 7 Vv ) EIEIR § 2L EHLH VLT
a. B Fr(Location)] 7+ FIZURLZA 1 L. {5 (Send)]1 #27VUv/L £7,

T7Nr—y avhal A7 r—L&R LET.

b. % (Response)] X1>T. P74 (Browser)] x7%2Vy7L &d.

OpenText™ Fortify Weblnspect (23.2.0) ~X—>50/360



Y=L HA K
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C. LYRUYITENA—Y T, 2—H 4 ENXRAT7—FEAN 1 L. 15 (Submit)] 27Uy
7LET
YK O % O & HzHTTP Editor 733 3R (Login.aspx URLADPOST xV/ v N4 il 4
B)e7+—~vvhl. L% B3R v2—7(Request Viewer)] XA IR R LET.

- - -

0 b Dhsendasts 8 Show Hanry |
Locason; = prsennn G ey i, S e gty - ﬂs.ﬁl
| mebectaregueds aoven] = Asely | AN

PosT '.';Hn'."p: HEIDALA

ser=Ryenr: Morillsaf4.0 [cossaribler MSTE 5. 54 Wimdaws NT 5.0)
fost: hacmebank.qs.spidynamics.com
ane=rian: Hesp=Rliwe
CoOnCEnT-TYypel Applicacion/x-wwe-Eform-urlenooded
AEERE=-28EgTHh: 11¥
= 3.k & Marl '-'._-l;__""'Ti.= SUMENRT -J._'." ENITAIL=duth ] VR AN T eI Bg e PR L n b LT TN

d.
||
Hacme Bank™! 53 a software security traiming application provided by
Foumdsione, Inc, This spplcaion & desgeed to teach sppication developers,
prograEners, achitects and secusty professonals how to create seome
softviare. Hocme Bank was designed with knawn vulnerabibites winich allow
users 1o e fenl explosts and 1o demonstrate how 1o buld more seome =]
| 5

d. BEE(Send)] 57157 T, 7oy b SRS B (24 &8 RT— FEH ©) &
P— NIEfE LET.

5. TR #R A7 7 212k Pr1v(File)]> E R Offf(Save Requests)] #i# i L &
ER

CHELHTSH S En
"BELOR £ B DM RN

Bk 30 O &
BER FLEIEDTFAMNEMRE T 21201

1. B3R e2—7(Request Viewer)] N1 > &fzlx & & € 2—7(Response Viewer)] XA >
DUFNHTREIYYILET,

2. ER M OM % (Findin Request)] 74> K7 & 213 |54 N O % (Find in
Response)] 71> RO LT, L FH &7 IEHR R 2N ) 723K L 27
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3. MEXFH ELTERRH 2EH 2551, Regex] Fzv/R v/ A#E R L &
7T,
4. BERFind)]52Vy2L %7,

7% 7€ (Settings)

HTTP EditorDs% i€ #2454 3123 L (Edit)]> B E (Settings)] 22V v 7L, IR D>
THNOORTEFERLTEHE 2MZ. DKl 227Uy L &7,

o 7'y 32/(Options)
o 2 AE (Authentication)
o 7' 3(Proxy)

B BRTODHEIWZOVTE RDE sy 2T LFEFT .

br~"> 22(Options)] &7
B3R 7 v—7(Request Group) ] lCIE IR DAT'y av b DET .
e ZD % ¥Xf5(Send As Is) -CDA 7'y s #IER LG A L IR Lz 2 DM D% & (B

12 & HTTP Editorid ZE R #2885 LEF B A. COA7 Y av2F 43 &, & [MH) ICER oF2
FERIC LAy —V 3R E TRIENTEET. COA7Y a2 2. BiE

(Authentication)] 6 S U° P'r¥ 3 (Proxy)] Ok & & ERh 12 V&,

VE: 7ox s T 3L W EREATE CHE T BALLTEETH, IF LALDRE
EHTTPZ o+ o4 — NI E YL OHTTPE R 2 TE EH A

o R O 4E (Manipulate Request) - CO A7 v £ 4R L1235 & - HTTP Editorid {X ©
NIA— IR G T & NCER LT LT
« JR 88 D3FE F (Apply State) - 77 V7 — s>, Loy N OIRRE 24 5 272017y
F—, URLF #F &IA &, &/2ldPOST7 —2DH: i1 #1fi | 9 %35 & - HTTP Editorid %
O RERFE L. TN TS BE 2R E LLIEL £,

o 7'0% > OiF F (Apply Proxy) - O 47> v #1# R L1235 4 - HTTP Editorid 22— 4
B L7 o SR E I >CTERZETH LT,

o 74VvADIE A (Apply Filter) - 2D 47> a4 . Fortify WeblnspectDfifi H /1 iz A% v
BTN TH—AADD BEE(DE D AF v &5 WIAR D AF v DEATH)ICHTTP
Editor ##2 #) L7125 & DA R IR S & F. COA7'Y av IR S T 2854 L HTTP
Editorid . Fortify Weblnspect® PifE D 2 * v>i% 5 (Current Scan Settings)] 12 & 3

D v X(Filters)] i% i€ %3 ] LT HTTPE R 8 FUIGH DM R 6 FUE R DL—v
FEIMLET.

VE: HTTP Editor 2T O 3781 12 BLAE D A+ v &% & (Current Scan Settings)] #
THLTH R EDHVEE A HTTP Editorid . A v> O 4 5 (2 2 Td o1z

A E EfEH L&d
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o N vXDiE A (Apply Header) - CD 47> 14 | Fortify Weblnspectdfii F H (2 2% v
BTN TA—NADD B EE(DE D AF vV EH WIAR D AF v > DFEATH)IZHTTP
Editor£#2 ) L2 & DA R IR SN & T, COA7Y o NE IR S T35 4 L HTTP
Editor(s . Fortify Weblnspect® Bi7E ® 2% +>&% % (Current Scan Settings)] (2 & %

P v¥ —I~ vX(Cookies/Headers)] &% i& #HTTPEL Rk D=zl H L £ 7.

VE: HTTP Editor 2 O 3781 12 BLAE @ A+ v &% & (Current Scan Settings)] #
BHELTH. R IEHVET A HTTP Editorid . A ¥ v> DB 1f W5 I0H %) TH o7z
REEEHLET.

i e7 — a7 )v—7(Navigation group)] ©. E: L(None)]. ki3EZY (Interactive)].
1z2i& 574 £— F(Browser Mode)] ###R L £ 4.

[i: % £ a2—7(Response Viewer)] (T &8 X1 )T P Zv4 (Browser)] &7 % R 3 % &,
Y NGB ETSTFICL VXY LTR IR CEET . i EE B (Interactive) ] # E 234 %
W oTW A & d. 7775 L v XYy 7 S fzHTML 2> ~o—)v & fziX JavaScript 2> b
o=V E R LG IRICIES 3 2HTTPE R 21 flf T& &7,

) HTTP Editor [ = =]

File  Edit ‘iew Help

5 | send 2515 @) Show History
.Location: httpiffzeroavebappsecurity.com: 80/ loginhtml - ﬂ Send ]

|Request Yiewer |

Raw I Details T Hex ]

(Select a request action) * Apply Search Text - 3 @RegEx
GET /login_html HTTPF1l.1 T‘

Uzer-Lgent: Mozillaf4.0 (compatible; MSIE 7.0; Windows NT E.1; EW1; .NET CLR 1.1.43ZE)
Host: mero.webappsecurity. com

Fi-RegquestManager-Memo: StateID="3"; sc="1"; ID="f44£435a-91lce-4ell-aclb-40a?dE2alaca"
H-Degquest-Memo: ID="40Z2c33eb-4335-4a81-8162-0£02b31cilbe"; =sc="1"; ThreadId="1";

J,

Response Yiewer

Ra Browser I He:x ]

Log in to ZeroBank

Login (7]

m

Password ||

Keep me signed in

Request caomplete
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1z £71E | http://zero.webappsecurity.com:80/login.htmlD o7 4 > X— (L O {% D £ D)
#4335 4 1E. Login] 4 i (Tusername ) & Password] (Ipassword]) &\ 77 LT
#5 Bignin] &2 Yv /T & &4, HTTP Editorid « % 3R (signin.html )/ —ZADPOST A v
NE 4 2) 5 7+—<y L. RO R D & 2B R % B R ©2—7(Request Viewer)] (2
RRLET. 20 04> Avb—V e tE T 20 B 5B 8). 20 ££7:77 LS
(Send)] &2 Vv s L TH— TS LET.

t;) HTTP Editar (= = [[=2 |
File  Edit  Wiew Help
N 5 A | Esend 2515 @) Show History

.Location: http:fizerovebappsecurity.com/signinhtml - B Send 1

|Request Wiesaer |

Raw I Dietails I Hex ]

(Select a request action) > Apply Search Text S ! [ RegEx

POST fsignin html HTTPS1.1

Tser-Agent: Mozilla/4.0 {compatible; MSIE 7.0; Windows NT S.1; SV1; .NET CLE 1.1.43ZZ)
Ho=t: =mero.webappsecurity. com

(-LequestManager-Memo: StateID="3"; =sc="1"; ID="fdd&d36a-9]lce-dell-aflb-40a7dE9a8a65" ;
H-Regquest-Memo: ID="40Zc?Peb-4332-4a81-8162-0£02b31lcZlbe"; sc="1"; Threadld="1";
Content-Type: application/x-www-form-urlencoded

Content-Length: &7
izer loginsusernamesuser passvordspasswordisubnit=Signtin

J,

Response Yiewer

Ra Browser I Hex l

Log in to ZeroBank

Login | username (7]

m

Password sessenee

Keep me signed in

Request complete

P94 £— F(Browser Mode)] 47> 2> #1#4R 3 2 &, kF55 (Interactive)] €— &
iz DET A, HTTP Editorid H BICE R #IAE L& 3. SR lcz—H%E C& 2L I E
3R % B3R ea—7(Request Viewer)] (LR /R T2 8E LEF A

Vo747 a>7 Y %E ¥j2 3 3(Enable Active Content)] 7 v /K v/ A% A 12T B &y
TXTO7 FU4 7 1> K CJavaScripts LM DX A F 3y 7a> 7Y ERIT C&D LN %
N4,

I LA EDWebX—1Zid I H T NELF 2y b7 75 IR T 2B AE g T &
T . CO$E R & HTML R 2 2> fOHEAD & 73 3> @DContent-Type)is & \ vX( & 121k
HTTP-EQUIVJE 1% #4+F DMETAXZ) & L TiT b &d. X F v a7 F 7Y ALTW
WA=V (CHTTP Editor i Fl 9§ RXEXLF v MR € T& 7. EE ZHTTPENT
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(Advanced HTTP Parsing)] 7 v —7"¢. & &h 3L F € v ] x> 31— F(Assumed
'charset' Encoding)] #i# 4R L £ 9.

2 &k (Authentication)] &7

FRRE 2 25 A & BB AE (Authentication) ] YA b SR 7 ZIEIR L & T o FE A v F
FIER L7145 1*‘*7“?% ENAT—=RENTLET . GBAE AV v FEIR D EB VT,

 H &) (Automatic)

 HTTP# Z (HTTP Basic)

« NTLM

AL AV v NEIEIN LIztE . B—4%4 (User name)] & PSAT7— N(Password)] (C A\ 77 L &
To N1 3IR%R <fevy PSAT— FOBERR (Confirm Password)] 71— NIZ/SA7— %
HANNT2LERDNET

P o¥ 2 (Proxy)] 47
7'oF o H— %A LCHTTP Editoric 7 7t A4 2113 IR D% E 2 L & 4.

o H¥EEH (7 o+ &%) (Direct Connection (proxy disabled)) -7 & o +—/3 %4 [f]
LW &k COATY s 2& R L LT,
o 7'mFx Uk E OH &) # i (Auto detect proxy settings) - WPAD (Web Proxy

Autodiscovery Protocol) & i 1] L’C7°Dﬂf SHEIRE 77AVER DT, ZREH LT
7' 774 DWeb7' v ¥ iR E #1T W G ld. COAT Y v #IERRN L&,

o YRFLDT X K E %% H + 3(Use System proxy settings) -o—#L v 2670
FoH—MER AL VR— MBI COF T RN L ETS

« Firefox7' ¥ 5% & #1# F 3 3(Use Firefox proxy settings) - Firefox»> 57 o 3 +#—
IER A Vv AR— T 2. COATY 2 5IBR LET.

W 7S50 iR EAE R LT, 7O YW TV Ry NIT I
ATEBREL L HVEE A Firefox 7S5 04 E NI 7 oxs 2 LR ESNT
WBIEA . ZoF i S Et A

o 7'o¥ v EHRKICER E 7 3(Explicitly configure proxy) -7 o & 4 — & i TA > X—
A2y MIT 2R AT 2 COATY av FIER L ZR SR IE R ELL T DL AT L
9,

a. B—/3(Server)] 74— K27 0% v —ADURL £ 12X IP7 FL ZZA F7 L. 50 C
( B— MPort)] 74— Fi2) £ — 1E 2 (80804 £) &N J1 L &7

b. 7o 4 — &K HDTCP 774y /7D Df-p D71 ha) %, SOCKS4,
SOCKSS5. &7-i3 RO »haiBIR L &7,
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V=L H AR
=5 HTTP =7 41X

C. AL E 235 A & EBAE(Authentication)] VA I AR/ 72 L £ 7.
° H Ej(Automatic)
AR HEIRE 2B € 728 AF v OB 2B < 0ET. LIE L TWL 25D
REE A I REFRE T 28 AF v DA Tr—v > AL KW B L&
# A< (Basic)
£4 Y =X MDigest)
o Kerberos
4 I¥ x— MNegotiate)
NTLM
d. 70F s —NTRAL 0 E 2 E . Eg % B—¥4 (User name)] & pPSRAT—
M(Password)] #A Jj L 7.

e. FEEDIPT7 FLA(NE 7 A MA M ENWT 22 AT Bl 7 md v — N &HH
PLE RO EIE. Vo4 RT 244 MBypass Proxy For)] 74— K
7 FLAEIEURLEAN ST LET . = bEX V) 2555 & Av~aEH L&,

« HTTPSH O # 7' u¥ > %48 & ¥ 3(Specify Alternative Proxy for HTTPS)

HTTPSE: 4t 2% U AN 27 0% o4 — D& 1. HTTPSHORE 7oxs e+
%(Specify Alternative Proxy for HTTPS)] 7 =y /4 v/ A% IR L, B3R sn -t &
ANNTLET,

IR B

EBRBHOARZ—G N R L FR— A& EH LTER S 4. IRODF 2. h
SO FD—# &/ L. 2O B 2T HG 2n Lad. R 72O &L T
'Regular Expression Library | 3% D &3

pas

\ WO FHER LT L TC—2LET. G FInjic—s LEd. >—7 >
ANn/iE s AT X F e LT,

A ANJ] AT ORI LET.

NFIFREEVIEH 728 BE X TFEERLET . 12821 contentT (L
2 M YN Dlcontent/en & & Uf/content/ca ZFk <9 X T &k 4h 3 21214 /content/[*
(enfca)] L &1 il L &9 .\S\D\W &2 i LT <2 &0,

$ AN ERBATOREIC—FHLET,

© AT T B F OO0 UL E DR B L& T, lz0M1dTz) £bTzo0) £t —F L
£

o

o

o

o

+ BT TR F ORI L, EORIE &L &7, /zoHIdTzoo o — B L &9 43,
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http://regexlib.com/Default.aspx

Y= A R
5 HTTP =7 4 X

XF #H
[zJi2iE—8 L&A

? BAT T 2L F D0 F2E 10 O I &—F L 9. /a?ve?/idnever] Dl ve]
W—LET,

AT X F 2B EBE DI FIC—H L&,

[xyz] LT b FEINHN OMFEF D17 — B L &7 . /[abc)/idTplain] Dlalic—
FLET.

\b AXN—RG EOBGES Fic— 3 L &9 . /ea*r\b/id . Tneverearly | Dler]ic— 3L
L&d.

\B HEE LA OFF FLic—F L 9. lea*r\B/ix never early ] O Dlear] &— 2 L
Eq A

\d 100%F e 5 L. [0-9]4F LT,

D BT LS OI LTI LgT. [F0-9]¢F LT,

\f WA= FIC—FHLET,

\n - HUAT I EILET,

\r F o)y YR FI B LET,

\s AR—R, BT\ A=Y EOF HIWC—F L FJ . [\An\nt\v] &[F LT

\S FEXFUASOLFC—FLET. [P\An\ntWV] &F LT

W TYR—RATES CIEE OME LT L&, [A-Za-20-9_] EF LT,
W EEF LA O T — B L £, [*A-Za-20-9 | &F LT,

IHL5HTHI LEan
"IE R AR I OFPLIR" R

IFE 5 3R i 0L 58

B H DIE R £ B L wexk 9 2355 A\0penTextD > o =7 L VB FE B U5 s ¢
WET, FHRERAHMER 72553 RO EE T2 H &,
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IE R %7

[HEADERS]
[COOKIES]
[STATUSLINE]
[STATUSCODE]
[STATUSDESCRIPTION]
[ALL]

[BODY]
[SETCOOKIES]
[METHOD]
[REQUESTLINE]
[VERSION]
[POSTDATA]
[URI]

MR B A 7

AND
OR
NOT

[]
()

1

(@) AT —RATICAT—RAI— 2001 3% &M TH O 5 D(b) Ay —Y R IL D E I
MNogged out] & FREF) 038 FN TH AL L 1 H 77212 IRDIER K H 2 H L %
ER

[STATUSCODE]200 AND [BODY]logged\sout

TR SN2 YV —AB— B OURI (URA L & NCHETE § 3 28477 LTH 0. ok
% DEIHIZ AR Login.aspl NDS B A& £ 20 % M H 9 51201 IRDIE R B
L £,

[STATUSCODE]302 AND [ALL]Login.asp

(@) A7—xAa— F»3[200]. 7Dl logged out] %7zl session expired] &> 555 f) 234
LDEIMIZE FNTnd, &12iE (D) AT —XAT3— K302 DG E DETMII/RA
[Login.aspl ~D% M A £ T2 E OLF %R T 2123 . KO HEH %
fERHLET,
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=L HA N
E5 HTTPZ7 4 &

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302 AND [ALL]Login.asp)

MB35 90 & 723 TEA U135 90 ORI 4 1 AR—A(ASCI 32) 65 0 2L E A H VLT, 29
Lawe FEIARR sTIEHR BRI O—F el s 9.

o UXAL 7 hLocation™ y&XD & Zhizllogin.aspx] BN 3 VKA L 7 MG E 218 3 21
G IROIEREFEHR 2 H L&,

[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7—XA{T DReason-Phraseif (2 4F i D F ¥ (T Please Authenticate | & £) 258 £
BIGE R T3 IRDIER KRR 2EH LEd.

[STATUSDESCRIPTION]Please\sAuthenticate

CHhoH TS LFan
"I K B < — 56
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% 6: Log Viewer (Fortify Weblnspect®
# )

Fortify Weblnspect i il 3 23 &S &4 0/ #Mi f 3 2121d - Log Viewerzffi FH L &7 C
DR RE Ik F 12 B ShicA vy 7 > b E § 2720 CFortify A X &~ A — b )L—712
ST s &7

07 774V ERIN T BIZ:

1.

PF—(Tools)]> Log Viewer] #7Vy7L &9,

AF YU EN BRI T H— A AN D B L& ZLog ViewerzB] WG & . 70l S 4
2—HFRZDRAF > DOl KR LEIELTWBLDER L &T . AT v741CiE A &
KR

R ¥ %P8 {Open Scan)] #27Vv/L &,

[A¥ v> %5 {(Open Scan)] 74> N7 T, 07 2K /N 2AF v 2iE IR L. B <
(Open)] 52Uy 7L &3, Bl DF—AR—ADAF vo 4B SR id. F—RR—RDE
¥ (Change Database)] # 7 VvZ7L £ .

b7 247(Log Type)] VA thomy #IEIR L £ 4. 1 F 7] 5 & X1 7' . (Fortify
Weblnspect® [77'V7—3 a2 5E (Application settings)] T) 2D 2 ¥ v>1xf L TIE R
SNfeaZ LN E TR A VLT,
/R OFEAMRE T B Y—LA—D RE(Find)] &2 )7L £5.
- &l -

B4 (Edit)]> B & (Find)] #1248 L £+,
07 7 7AW ERTE T Bk Y= 3—D EZAR— MExport)] £ 27V v L £ .
-l -

P 71 V(File)]> BZDxZA:K— MExport Logs)] ZE 1 L 7.

L FEE DAF oI L ves 2588 3512 Y—v3—D Weblnspectn/

(Weblnspect Logs)] #7 Vv L £7
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B2 R)y—2a—Y ¥

R Y —&id | Fortify Weblnspectz’\Web 77 V7 —3 2> DB & £ 7213 WebfR &R £1T K& &2
2B E O vBIURBE - 2 DAL 7Y 3T, K avR—2 > ME. /8
AFA MRIVT T A>T DR IRF SOT A 44 by V—OfF 5 BERI O — g g5 1k 07
;—*7“7& EVEEEDRAIBHNET . I AHD AV E—F Y ML IR DI V—T 1245 T b &

o M/ T UY

« i ATy 3~

o — ML TTVr—y 3T A b

o — MK & THFAMER

o H— N =7 4DWeb7 7 V)r—3 3

e WebD 7L — LA 7— 43 38

e Web#—

o Web+ 1 D

o« NARLI— x|

o NARLF zv/

A T OV R AN 6T RTOaYyE—F Y M, D THEBE I/ V—TUTITN 3. &
BB T —7121d . WebH A MO §gME 2 F =/ BH | DEY a— (B —Y x> b &
IS B)DH 77 V—T W N THET .

Fortify WeblnspectiZid \ 1 &A ED 22— E A2 H& ARG Sy FHET A vr—ofk &
NERV—DRN T FNTHEST. IRXTORY—CE I RE 2 T RXTOE A >y
VET—V Y MG ENTOLETA, TN ADIVFE—2 Y FDIBH RSN 2571 v M.
RV =Tl R A 0EST. RV—  BE IO BLO &M Y OB —y 2> N &
g =2z MO V=) ) E1IE R T B ETHETEE T RV —%ER T3
W BEFORV—%8E LT LK CRFELET.

Ea2—

Policy ManageriZid . ¥ L2— YR B La— D2 IE DL 2—RHNET. N sld Ba—
(View)] A=a—h5Y—nA—D7 A 3% 209/ LTH) OB 2 2enTE T
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VIV AA R
w7 RV —vr—Y v

P P a—
CDE2—lk. 7 74V hCRTDOFE LA L SN I2F 2y /D YR MR IR S &
T PRy 7R YA M LT B /L —7 T B RE T BLUOF B 7F7RZ &2
FrylERKNTBHIELTEET (45414 . Web Application Security Consortium @43 % (2
W o1z DIZHNET).

Sewen Pernicious Kingdoms j Attack Groups j Severity j Threat Classes j
E||:|Q Standard E||:|O Standard EDO E||:|Q
B[]\ APL Abuse [B]iFy Audit Engines 5[] i Critical B-[H] 1) Authertication
E-[7] () Cade Quality 7[5 General Application Testi &-[E] & High B1-[HIER Adthorization
D@ Encapsulation [B](F General Text Searching |:| TMediunm D@ Client-side Attacks
B-[H]IEg) Enwironment [H](E Third-Party Web Applicat &[] 63 Low -[H](E) Command Execution
D@ Errars [B]IE7 wweb Framewarks/Langu: E-[m] {dy Infa D@ Information Disclosure
M-[H] (7 Input Yalidation and Rep [H](E Web Servers E-[E] ([ Logical Attacks
E-[H]IES) Security Features -[H]IfR Web Site Discovery
@ Time and State
----- 1P Custom Agents
----- [l Custom Checks

VR —F Y MR EEER T 2I2E . avE—F Y M EAT AN TW B3 F 2y oKy
JAEA > FlIE AL ET .

BH ST /— RO ICH B F 2y /Ry R, /— NN DAT7Y =7 FOTIEIR | A7—
RAERNLET

IFR Authorization
|:| i Client-side Attacks
E-[]IER Command Exscution

FuZlE. TRXTCOATY 27 MNEIR SN THWBZEER LET,
FEONMAIL. —HOATY 27 MRIR SN THWARIEE R LET,
BORYIAL ATV 27 MR E ol QRN SN T W eEnr LT,

J—FER T2, 7SR Ser Uyl ET .

E-[+]If8 Autharization
&-[+] ([ CredentialfSession Prediction

&-[+] [ Insufficient Authorization

Eg---@ Insufficient Session Expirakion

&-[+] [ Session Fixation

----- H 1153 General Authentication Bypass (10354)

----- [w]E CORS Unsafe Methods Allowed (11278)

----- [w] €% Overly Permissive CORS Access Policy (11279)

----- [] €% Prolonged Caching of CORS Preflight Respanse (11280)

..... ) CORs Functionality sbuse (11282)

..... () Session Token Discovery (11287)

----- H Insufficient Session ID Length (112830

----- H Insufficient Session ID Entropy 11289)

..... 9 Predictable Session ID (11303)

----- Insecure Domain Access Policy For Session Cookies (11304)
----- 88 HTTP Verb Tampering - Metwork Authentication Bypass (11499)
----- H Cross-Sike Websocket Hijacking (11587)

----- 88 T Mone Algorithrn Atkack (11595)

&-[9] [ Client-side Attacks

- |IFR) Command Execution
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V=L HA RN
BT R —4r—T %

BmEpra—

COE2—Tld FHE VA MBI LB DO TR B —Y o MR R TEET,
e Mas51EID

o fifi 55 1% 44

o« IV VERAT

o B KT HT H R

« CWEID

o Gt

o fBfEE
o FAT
o 218
o ZIRTER

COBERE G BN T 2F x5 DU 2cm b & i sn £9. 7282018 PHP A2 Y
TN E BTV —y R AF T A A ME 74—V RCIPHPL 21 R T& £ 9
MR KA &— B 3 2 = — = (3Policy Managercp DA RSN 26, FDIT—Y x> M
LUt O F 2y R 252 VT L CI—Y 2y MERBHICTEE T, ZDB A LIKY
~/~>:r1%7(?“9“%>(%0)¢ V2 —DZE T ARG T B) e 28 LicR Vo — &4l I E D A
FAOWlEH TBIENTEET,

ﬁ Policy Manager H=] B3

File Edit Wew Tools Help

+ 5 | | <2 standard Yiew |- Search Yiew

Criteria:

Surnmary * | |contains | |PHP Search
| = =) _searh |

¥ulnerabilities {1325)

| Mame | 1D | Type | Severity | Last Lpdated I;
[ Pharum comman. php Arbitrary File Source Disclasure 1360 3556 High 10/19/2017 8:136:53 PM |
- Fassible PHP Source Cod sa¢ Jwooe  JHgh 1o/
Possible PHP Source Code Disclosure 1384 10023 High 10/19/2017 8:04:15 PM
|_ php\Weblog Administrative Access 1425 3856 High 10/19/2017 §:36:52 PM
[ Piranha Configuration Remate Execution 1590 3556 Critical 10/19/2017 8:36:31 PM
- PCCS-MySGL Database Administration Configuration Information Disclosure 1961 3556 High 10/19/2017 8:36:14 PM
[T Basilix Webmail Configuration Information Disclosure 1970 3856 High 10/19/2017 8:36:12 PM
[T Badelue Configuration Information Disclasure/D0OS Aktack 2214 3856 Mediurn 10/19/2017 §:35:53 PM
C cbeoo bk it ik = Pt ik 1nf1niong ST
Attack Group:  General Text SearchingiSource Disclosure
Summary
-
Summary: Possible PHP Source Code Disclosure :I
Vulnerability 1D: 1384
CWE ID: 200

Kingdom: Envirenment

A serious vulnerability in the web application has been detected due fo the presence of publicly available PHP source code. Obfaining PHP

source code on a system allows an attacker to view the logic of the script and extract extremely wseful information such as code bugs or

logins and passwords. Recommendations include removing this script from the web server and moving it to a location not accessible from the -
< o™
Find %ulnerability in Standard Yiew

Ready
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V=L H AR
BT R —v2—Y ¥

CHHH B JZ8n

" Y R—84

"RV —OFER £k HRE" T
"HEE DI—Y 1Y FOMUR" X—UT74
"HARXLTF I DAE R IR DRX—Y

AV —DFE B & 7213 A 5

Fortify WeblnspectiZld . £ {D2—H 1k s T& B & UK ET S e Fi S vr—of &
NERV =D O ENTHET, W ADR Y —EAMNICET §328ITEEY
ho 212U, I BDWTNAET 7 L—eLTH & WA FEHE LTHRRLR VY —%/E
B Uy AARSA X LI CDR Y —%5F LOZH CIRIF T2 8E TEET . HWARLKRYY—
AR E T URMEBSLIRAF TEET,

RV —58n 5 23 E KT 2120

1. v—nu3—7T. Policy Manager] =77l £7.
- &2l -
E/—(Tools)]> Policy Manager] OJIE (2347 L £ ¢ .
Policy Manager#3ff & &3 . 7 74V FCIE R R Yy —po— PSR &7,
2. MOWETNUEFEITLET,
o URTWHER LIRS —(D& 0. AAXKLR V) admtE + 212k, PrAv(File)]>
B4 {Open)] DJIEIER L, AV —#IBR L E 7.

o HEI vr—vMbh &N RV —D1 DI ARV —EE R T 3. i
(File)]1> 7 #i (New)] DJIE 121 R (X /21 Eﬁ%ﬁn‘ )2 —(New Policy)] 74 a> %27y
DA H LORVY—DEF VT 2R Y —FIBR L &5

3. B T BT mo s K v AR SV (EFGRIR) T B k5T, B Y
W B (XA RN L £ F . Z—T T D I— = & IR & A 2
W29 B i@“?)lx*‘7%’:@ﬁ'ﬂL’C?b>6\&é@"%%l/?ﬂ“/ﬁX’ézﬁ%LiT

4, W N—T DLW £ E § B2l
a. W I NW—T%4 7')‘77Li?“0
b. ¥ a— Ayt A=a—h56. BATZE E (Rename)] 2R L X7,
5. W7 V—7#IBINT 212
a. MEODWE I V—T454H 7Vvo L £1,
b. ¥ 7ty A=a—m56. B BE 71— (New Attack Group)] ZiE R L £ 7.
B 3 B % 7 )L —7(New Attack Group)] v TH H 28 Sh TR R Sh £7.
c. ZOF LW L—7%4 2VysL. BETZE (Rename)] %% R L 7.
d /V—"UCHE -V > NIy 7 oy’ LTEMLZT,

6. WARLF vl afE T3 TELT sf Al ODOTE " HARL T =0 7DIVE " IR
DAR— | %S L TS0,
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VIV A AR
w7 Ry —v A —Y

7. B E¥E F(Auto Update)] 7 =v 7+ v 7 AR R S Tu 335 4« Fortify Weblnspect
IZ0penText7 —ZRN—ANSK 7 a— RSN 2T B SN I8 21— =0 bOH LLIY
IV MEMCT E2hERICT 20E. TOREH T—Y =2 O Hras it D
WTIRE LET . 72£21E . MicrosoftDIIS (Internet Information Server) %) % &4 214
B -y bEERICLT BEE S (Auto Update)] iR + 3 &, Fortify
Weblnspectid v A7 AKX 7> a— T IS E O 81—y x> MEH L EE A
Wz, RV —THA N 2T 2T—y o> M E T 28 LOE 21— x> MOFE T
SN I—v x> NIA RSN £7,

E: Av— N 7T — M & o TR yo— REN = LOETEE F 2o 2k . 2—5 D
YER LIz AR R LRV —ICH B TIIB TN & 2 A,

8. P r4(File)]> Bl 241 U TIE 7 (Save As)] DIEH ICIRIR L& 3. P A4 (File
name)] 7 t— NIZAARRXL RV —DZ R 2N J1 L. BRFF(Save)] #27YVy 7L T L
A Y3 —%Fortify WeblnspectOD* pollcyﬁ/fﬁ TIHRAFELET. 7 74 bR U —D BT (W
# (Assault). 75> 7(Blank). 12 % (Standard) % £) & ] L TR V> —%R 17 T3 28
T&EHF A

IH6H ISR a0

"HARLT—Y 2> hOfF " R—74
"B E DT =¥ hORRR" R—U74
"NARLF v DIE " R

HARARLF 297 DIVE K

Fortify Weblnspectid £ 7F 7213 £ ¢ 2 F 207 4L DI 55 M 28 + 37291 CWeb+
A AR %z%ﬁ CHINET S, 77V —y [l O 51 2 3 3 AAKRLF =y
I E R A B NET

Fortlfy Weblnspectfﬁa% T3 20 EEE T IHIARLAF vl eER LIS %44 3
B O F 20 2 B L IR 0, 2O L F 292183505 S & ¥ AL 2ERIE . Fortify
Weblnspectid il i « T (copy)) &> S 7197 ADf WXy 27 97T 4L 7 MR T %
FAL 2NN ZE F 2o 05 FEAT LET AR LIZARRLF 2o EFIFRICH 7490 A
[(Copy) I Dt 13Tz 3 907 977 AL 2 MIRHRE § 2 F 297 C b 2854 1& . % 5114850
[\y27 v77 4L 2 1k Y((copy))(Backup Directory ((copy)))] &> 5% il O F zv 7 &5 12 L
Z W &, Fortify Weblnspectid (207 4L 7 ME T TR LTW D T) D ARRLF 27
FIEE L&A,

ARRLF 290 EE R T BICiE:

1. Policy Manager#fi & 9

2. DLRT R LR Yy — 2§ 2121 Pr1v(File)]> B {Open)] DI &R
L. RU—%iERLET.

3. Hui Nvr—yfb anfeR Ve —E2F Sl LRV —%E il 335 v P
(File)]> Br#i(New)] DJIE (CIZ IR (& 721k Eﬁ%ﬁ A U —(New Pollcy)] 74’ avEIVY)
LB Lok ')/*-O)%T)I/CLT%)/T')/*"S: EIRL &,
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IV AR

=7k

Jo—v4r—Y %

4. fE#E ¢a—(Standard view)] 7E IR SN T T, £ DRA T ODHE FE L F N YA
PENTHBIEEMER L ET

5. WARZXALF zys(Custom Checks)] 4 2Vv/ L. ¥ 3 bAy b A=a—h5 PR HAK
4L F zy2(New Custom Check)] ## 4R L £ 7.

AARARLF 97 74— IR IR SN E7 .

Wizard

Attack Type

e INC e Bie e Bhie e |

Select a type of attack to create. Q

—Description
Simple Attacks are attacks that are sent
File Bxtension Addition once for every server scanned,

Directory Enumeration

File Extension Replacement
Keyword Search

Parameter Injection

Simple Attack

Stte Search

< Bacl I MNext = I Cancel |

6. LLT QLB RATHS1D5ER L ET. & XA 7 OFAB Y] & & Ll MR L&
EE

7 4L 7 kY31 2 (Directory enumeration)

CDF xy/TEVIRE LB HT DT 4L 7 PIDBRR S &7,

o W ¥ A7 7 41 7 |4l 2 (Directory Enumeration)

o M % /directory_name/ (directory_nameld t& & 327 4L 7 bUDA )

o 7 =% x. [STATUSCODE]3\d\d OR [STATUSCODE]2\d\d OR
[STATUSCODE}40[13]

7 74 WL 5R T DB fi (File extension addition)
CDRALTDF xy/TlE IR LI 7 7AWILIR T 2R D7 7 A VAR Sh &7,

Fortify Weblnspectid Web{x & 1 (A7) 50:D44 B &fa] 650DIL R T O 7 71 (12 &4
I&', global.asa) %1 i 2 &, 2R LA CHAHI T M LIiR T L2 — 3R E L
JAR TR T 2 Wi 7 A OVDOHTTPE 3K #1515 L& 9. f2&Z21E . =—H H.backup &u»
27 74 WML R T &8 7€ L T 235 4 . Fortify Weblnspectid global.asa &> 57 71 v
% 9 3 &L i Ly Tglobal.asa.backup £V 97 7/ L ERE R LT,

W —Ndglobal.asa 7 7AWV DE R 2 L& 945, 7'l vy —A Ewny
OT 7T 7AIWEKR LTOT 2O 7 7AW DL G- F 0MF LW T s &
(global.asa.backupZ &), 2D 7 71 ) (ZtLiZidglobal.asa” 7 IV D5E 4= % V) —AD
FEINTHR) S — PR LTCLEITREMERD VLS.

R o€ DIBIN SNIALIR T 2FF D7 7AWER R T 2HRARLTF =07 BE N T 21204
HARLF 297 74— RTCUL R 2N I L&
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V=L HA RN
BT R —v2—Y ¥

o W 2A7" 774 VAL T DIl fin (File Extension Addition)
o W ext(extid MR T 27 A IVD 7 AL T) JHHIC Ky METd EVA R()
7‘,7‘;‘ Y \ g‘ —(“ —a— o
° ¥ 7 =7 [STATUSCODE]200 AND ( [HEADERS]Content-Type:\stext/plain
OR [HEADERS]Content-Type:\sapplication/octet-stream )
o 774 NVHETRF OB ¥ (File extension replacement)
CDBATDF 2/ Cla T L7 7AVIEIR T 25 D7 7L R S &9

Jz £Z14 | Fortify WeblnspectiZid « #1258 1 .old 5 L ie 7 71 L 1 &R 4 2L HE D
FxyIhE EN T &3 . Weblnspectid Web#E Z i (i ! 4 2(F & DL |l 6 £ O
£ DL TR T D7 74 (12 £Z1E - startup.asp) iz D\ Ty 21 E4 B 5F CCHE 58
T oldoMt LW TWw 3771 (12 £Z21E . startup.old) DHTTPE 3R #1615 L £7,

KrE DR T D77 MIVER R T AAARLAF 2o 0 BE L T 3121k HARL
F 74— FTCL R 2N LET.

o W KA7% 77 LR T D E % (File Extension Replacement)

o W ext(Text]iIBRTB27ANDT7AANIETR T) L TEHIC Ry bEE EUA R
BESERES T

° ¥ 7 =7 % [STATUSCODE]200 AND ( [HEADERS]Content-Type:\stext/plain
OR [HEADERS]Content-Type:\sapplication/octet-stream )

« ¥—7— & & (Keyword search)
CDRATDF v/ Tld 48 & OHGE L7214 585 A1) (1IE#L R B TE 3% Sh 2)SHTTP:
BN AL T 2hEIMEHE LT,
RO HTTPIL & T 2R EFR ST X OM O F #M R L& (d =L &

OFLF).
o W ¥ X(7"% £—7— MK (Keyword Search)
o I EE: N/A

o ¥ 7 =7 [BODY\d\d\d-\d\d-\d\d\d\d
o« NFA—&A>Y 27 3(Parameter injection)

CORAT OB TlE 5l HUE BBUESCFHCE &Rz on 7.

i

http://www.samplesite.com/webapp.asp?ValidParameter=ValidArgument

DIRD &N SN &7

http://www.samplesite.com/webapp.asp?ValidParameter=AttackArgument

INFGA=BA Y 272 3/UE IR D & D B OO D NET .

o I+ FE{T(Command Execution)
AV FEATDF =2/ TlE R R LT 00 6% X F-HN D5 ARV —T AV TV AT 4
LD avy REH A G DbE SN ET. ZNIE(Web 77 V75— s WA 1 & F xv

LT IE TE 2 WA W) Web 77 Vr—y /8 O F A 2l LCavy
NEFAT S EIET BRATT
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Uk Of| Tl . support_page.cgi & 7' as SAEE A N J1 RS 3k
TATA=RA Y 20y A LET. ER R &8 3 37 —KHBHTTPR:
BHENTOBGE . 7705 —y 3 3= FEAT O LTSS &z sk
NEd.

o W' RAT NF5A—KA Y 22y 3(Parameter Injection)

o I ¥t /support_page.cgi?file_name=|id|

« 37 =% v [BODY]uid= AND [BODY]gid=

o SQLA Y =y av

SQLA >y =y av b, 77 05—y 2ASQLI— F&JE 1 1E T4 . h 50
By 7 5113 SQLIE SC O B THE I S T8 0. Web 77 )75 — v ASQLA T —
b A NEAE S BER AT IR DX F EFR L LA W T IO T 2 ¥ 5
& ZDSQLIE L OW i 537 —&RX—RAH4—/NTHAT S £7.

o WH RAT" RS A—K4 > 273 3(Parameter Injection)

« WE(ADDTEA a7

« 7 =% x [STATUSCODE]5\d\d

o yaAH¥A NA2Y7' T 427 (Cross-Site Scripting)

COMREIE . KA+ Iv 2 i S f=WebX—2 12, IE LU REE Sh e L J) a3

RSN TWBRAGECHELET. COGE . B HTER SN 2ZOXR—D I E
= Db dJavaScriptZHl vl & BEOH2ZOXR—V 5B LIAEE D2—F D
YUV TARIVT MEFEAT T EIENTEET . 2—F BT F A MAve—Y 28 Hi T&
2HA MEL COFORTLB I LTHESS A RETE b D&,

K O Tk« Fusion News 77 U7 —3 2> TD Za A4 A NAZVT T 427 %K 25 L
¥9.

o WH AT RS A=K1Y 27 3(Parameter Injection)
o %% /fullnews.php?id=<script>alert(document.cookie)</script>

o > 7 =7 ¥ [ALL]Powered\sby\sFusion\sNews And [ALL]<script>alert\
(document\.cookie\)</script>

° T AL MY FIA—H)L

F AL 7 MY R IA—HIL T A IE 2URLX 4 %1% 15 LT, WebH— D3> 7
YYDAE NPT 7 AL E . BB E & M XT NAR—= Y o &F LT,
H—NEDIEFZERTANIT 7 ALEIELET . 1221 B E 32ODEY
F RERT e 2033 F(.J) & X—4 v NFURLICE N Ly FIA—RF 37 1L 2 FYD
B ASEFS LM S 2282 & 5T, www.server.com/../../../..[password % €D
VAT LNAT—RTZ AV ER DI TENLCT 7 AT B BetE b D& 4.

X O Tl boot.ini 7 7/ WA R S £
o W B KA N5 A—&A ¥ 223 3 (Parameter Injection)
o W ¥/ /. .0..1.0.1.1.1.1. /boot.ini
e 7 =7 v [ALL]\[boot\sloader\]
o B N J7(Abnormal Input)

BEENITOBEB L FHE. T LN S0 2E 1k sh Thig bWWeb 77 )7 —
Ay ARG AN 0l S LI N a—T 4> 7 SN Tha W 5—) &5 &

OpenText™ Fortify Weblnspect (23.2.0) N—268/360



VIV A AR
w7 Ry —v A —Y

CTA[REME D B2 F T SN 3. £ DA RAFH 4 0374 3 5.
770')’7"/3/@I7*]*‘|3)<77 AL T ERS R EZM R T2 7— Ay —UH
P— N ENR R SINET ., V—RAa—FEH RSN B EHLHNET,

OB Tld s N y77A—N"—70—%5| &L 2322, 18 F IR WICF ) ik
Ean 7,

o WB RAT" NFA—&A ¥ 273 3> (Parameter Injection)
A AAAAAAAAAAAA.. . AAAAAAAA (32 7 TAJD1000[E D%k Vi L)
e 7 =F % [STATUSCODE]5\d\d

o M4l I % (Simple attack)
CDERAT DB BN, —N\EAF¥ v B0 1HIEE S Ed.

?ﬁ(@@ﬂf“li\52”’7‘/|\@URLi7Li|P7|‘l/X LG 3= B =N | I - S P SN
UNIX S AT— 7 74 )L DL £38 A £ 5,

o I 2A7" B4 I B (Simple Attack)

o I % /etc/passwd

o 37 =% v [ALLJroot: AND [ALL]:0:0
« %4 M& E (Site search)

CDRATDHE L, Web— N2 & FR SN B end b7 7 v ekt 3+ 2H 1 TIF
b EFT. 12E21E. IDFS279DF v/ Tl log.htmEB I7 A L EM R L &5 .

R OH Clg. 2—4 v FOURLEIZIP 7 FL A B Z 4 2B 2282 & 0.
xanadu.htmlEW 77 VAR L &7,

o W ¥ XA 44 MK & (Site Search)
i ¥ - xanadu.html
o % =% x [STATUSCODE]2\d\d OR [STATUSCODEJ40[1]

confidential.txt &V IZ BT D 7 7AW EIR R T EAHARLF 2y 5E i § 2121 HAR
A©F 9074 —FCLL R 2N ST LET,

o W ¥ 2A7" 44 M Z (Site Search)
o I ¥ : confidential.txt

° ¥ 7 =7 % [STATUSCODE]2\d\d AND ([HEADERS]Content-Type:\stext/plain
OR [HEADERS]Content-Type:\sapplication/octet-stream)

7. WANext)] #2VUvsL 7.
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V=L HA RN
BT R —4r—T %

8. BE(Attack)] 71—V Fic . WM IfERH § 27— 1 L&Y
Wizard EHE

Signature =
Input the attack data ko send. Q

—Attack - Ex. fcgi-binfissue. pl?param=/etc/passwd

I,l'personnel,l'

— Signature

Search Far: IZEIEI in |Response jl j

Response
Response Body Inserk |
Skatus Line
Headers

Skakus Description
Cookies

< Back I Mexk = I Cancel |

LREDT AL 7 VI ZE OB D F =7 Tld . B—47 v MOURL 72X IP 7 KL AL % 5L
= %] (/personnel/) ZiE Bl 2 2 £ Tpersonnel] £ 57 4L 2 MUER R L &7

9. 2—HUW S/ =FrIEE T ILEHHVET. >/ =F vy B2 BIEH BB (R
K—>E&RLiR ¢ B & 7 F A N FH)) T . Fortify Weblnspectid HTTPJS & 1% R
L. 37 =F+TieiR S ic7 F A MER DI 28 2D vy i 551 757 28k € L
9. BB H(Searchfor)] 74— FEFm Y7 K7y YR bAd ] L CIE ¥ % B 21
T BIENMTELT . VAV FVD NI HBTFA MRy ACER KR 2HZAN N+
5LV TEET .

2% xt % (Search for)] 7+ F&Af ] 3 21214
a. METE7FAMEANSLET.

B Ex} % (Search for)] 74— FIZIE 7F A MDA EN S L& ER KB IGA
T L uTESL,

ZOf (Tpersonnel] &7 4L 7 MIEKRER T 2)D & 7 4L 7 NUBFAE T 2385
B —NABAT—RAT—F200%1R T DT, BEXF % (Search for)] 71— KiZ
[2000 ENFT LT, 2P LEEWE. 200 G £/1213300F & DAF—KAI— K
P AT—RA2— F401 £7/214403%2%2 AN 255 b HBTL £
. REYT R R E VLT MR T AHTTPIS ZE D2 7y av &8 E L &7,

C. (A7ya2NEMLMRAHEMN TG HE.2HHB Doy Ry r 22y T, 7—
JVIE BT (AND. OR. 713 NOT)%iZR L £ .

d #HA(nsert)] #7VysL &7,

e. (A7 DNVEME LMK 21T IG5 H & LB IS CTCAT vahed e ik LEd.
FEDTFAMR I AR N SN BEHR BRI 2HE $EEHR T2 TE&
T,
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10. A(Next)] #7UvrL &7,

Wizard EHE
Report information
Fill auk the repart information and set the vulnerability severity,
Surnmary |Implicatinn Execution I Fisx I Reference Info
Check Type: |vulnerabilicy x| severity: |Low |
< Back I Finish I Cancel |

11. [ &— rO1 3 (Report Information)] /S 2L T% £7% 7Yy L, S L TR R T2
TE¥AMEANTILET.

12. HEZE D&A17(Check Type)] VA bh5IE H #1E4R L £,

13. E KE (Severity)] VA bMpomE K LNVERIN L& .

14. FE T (Finish)] 22VvsL &9,

15. 77+ b4 TNew Custom Check] % F =y 2D H K 23 7 2L Fi (A5 L4,

Sewen Pernicious Kingdoms j

E-[E]{g) Standard

G-[H](E API Abuse
|:|--- Code Quality
[]---IE Encapsulation
E&-[5](Eg Environment
G1-[E](Eg Errors
[
[
[

-[H] I Input Yalidation and Representation
-[H] I Security Features

-[#] IR Time and State

..... |:| (@ Custom Agents

B[ Custom Checks

16. HARLF v B 5T B(F v /— 0T W T B) MR L &1,
Seven Pernicious Kingdoms j

E-[E]{g) Standard

E-[1](ER API Abuse

Code Quality

Encapsulation
[E]IFg Environment

|§| Errors

; |§| Input Yalidation and Representation

Security Features

Time and Skate

..... |:| (@ Custom Agents

B-[¥]ig Custom Checks

o FLS] Personnel File Check
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17. Foy7 &> VR s BB 7 v—7(Attack Groups)] ZiEIR L. =2 27Uy /LT i
x> ¥ (Audit Engines)] 74V X R L £ 4.

Abkack Groups j
5 QR =

EID@ Audit Engines
-[]IFR Audit Options

dy Keyword Search

..... ciy Known Yulnerabilities
..... ¢y Local File Inclusion
"‘r Persistent Cross-5ite Scripting
..... ¢y Postdata Injection
..... [y Postdata Sequence
..... dily Query Injection

..... [y Query Sequence

..... dy Peclassify

..... dh Pequest Modification
..... dy Site Search

..... [y 50aP Assessment

..... dl S0L Injection

18. WMOX W UL MER LIF vl RA7 Wk LCHEY) 2B E > oG ek T
WB(F zyre— AW TOR)CEEER L ET.

WEODOL(T... R 2BEIOV.L

7 4L 7 | V%1 2% (Directory Enumeration) 7 4L 7 b V¥ 2% (Directory
Enumeration)

7 74 WAL 5% - DI il (File Extension
Addition)

7 74 WAL 5k -1~ (File Extension)

7 74 WL 5k T D& # (File Extension
Replacement)

7 74 WL 5% T~ (File Extension)

*—17— i & (Keyword Search) ¥ —7— M K (Keyword Search)

INFA—=ZRA ¥ =7 3> (Parameter
Injection)

B 4l T4 B2 (Simple Attack)
A M& % (Site Search)

OpenText™ Fortify Weblnspect (23.2.0)

Post7 —&4 > > =73 3>(Post Data
Injection)

5& 7 =v/(Fixed Checks)
A M& % (Site Search)
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19. D7 (File)]> {777 (Save)] DIE ZIE4R L £,
20. H LRV —DLEI N1 LT, RFE(Save)] #7VyrL &,

Fortify Weblnspect?3 ¢ R TDHARLF =07 T XTOA N —IZBEM L &F. #2720, A %)
W LEBTAMDRYVS—THRARLF 2y 2% T BIiE T"H Vo —OE i & 7214 4 2
"AN—UB4 | #S IR LT S0,

ARRLF 2y 7 %8R 2T BITIE:

1. HARLF 2yl 5IER L ET,
2. ZhciEff sz F 2o R v REF I LT
ARRLF 2y 7 %H] & 3 B12id:

HE! RUS—DoHRRLF /5B 28 ZDF 29/ BRI XTORY—EV AT
LA 7 5HI B S £

1. HARRLF =904 27Uy L ET .
2. ¥ MivbA=a—»5 HIE(Delete)] iR L £¢ .
ARRLF =y %R 3 BI12i:

1. RV —%f &&7,
2. WARLF %R L £T,
3. Policy Manager®4 XA > C. #ARALAF z2y/D7 07455 H L &4,
Ei Policy Manager =]

File  Edit Wew Tools Help

- & o [ e

Seven Pernicious Kingdoms j Attack Type: IDirectnry Enumeration j
E‘DQ Standard Check Type: I'u'ulnerability j
BI-[5] (R API Abuse )
£ = hd
@ Code Quality Severity: Low
E-[H](ER Encapsulation Attack: I.l'IDEI’SUI'lI'lEL"

E-[E]IE5 Environment Signature:  [[STATUSCODE]3|did OR[STATLSCODERRd\ OF [5 Edit
-5 Errors a I |—|

B-[H] (5 Input Validation and Represe SUMAFY |Implication I Execution I Fix I Reference Info I
D@ Security Features A Folder narned "Personnel” was found on the webserver,
E-[]IEg Time and State
----- ¢ Custom Agents
B[]l Custom Checks
IS Personnel File Check

l | W

Ready

4. %77 (Save)] 74 av %YL &F.
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w7 Ry —v A —Y

ChoH TS LFan
"IEFF R X—06
"IE K B OYLIR" X—v97

IR DIT—Y 2 NOM R

e Offg 591 7 v /(8 =—> = N &M R 3 212i& . Policy Manager® &%
(Search)] ba—#%{fiH L. 2D . il ¥ D1—y 2> b D 20 T 20518 T &
EQ AN

W 1—o o> MR T 3121:

1. v—)/3—7T. Policy Manager] z7Vv7L £,

- &l -
E/—i(Tools)]> Policy Manager] DJE (Zi# R L £ 3.

2. RUy—HBEBIR LT W&, B U>—#H {Open Policy)l 71> R 6K )y —
#ER L. OKIZ2VvIL &7,

3. R (View)]> BZE (Search)] DIH (CIER L £9,
TNCOLE T—y = bOFL I 1 B BWR . EAT R BER LD L A—+
T4V RIDET N T T MR AT H 728 BIR LizL A— 74—V FTHR
ELETFA MR R I—Y 2 MR TEET.

4. EE¥E(Criteria)] YA M6 MR 2L R— M7=V REEIN L LT

5. FouyZ XU YR doiiEH T #E IR L ET( FF Lu(is)] . B DK &u(is greater
than)]. [ O/ Sus(is greaterthan)]. & ©(contains)]).

6. THFAMR VIR MR TE7TFA NI FEAN I LET.

7. ®ZE(Search)] #7UysL &7,

8. Policy Manager® PFzyZ(Checks)] TV7 2. R &MH &~ 29 XTCOWE =—
Y MIVA NS ET . 77T A7 % T— 2> MO R ORE (2I& . F =y 7=— 20 0
TWET . FryvI R I REAANEIEANCT BIET, T—V 2 VT 0T 47 (&1
ETITANCTBIENTEET

9. BRfE(Save)l 7V /LT AW LRy —%FHFELET.

HAARLT— x> NOAFE A

Fortify Weblnspect D 7 J R # it 1k« #Hak N OV 7 by =75 #3403 5E L. AA KL
T—y x> peLTCSecureBasel A LET. I sld. R —THRNILTAF v DFEAT
AE ] 522 EMNTE ET . Policy MangerCAARL T— x> N RNIC T BI2IE:

1. WOOBT»EFITLET.
o NARLI—Y z¥ b zy/D&EHEOCH LOR VY —2ER T 212k, Praw
(File)]> ¥i#i (New)]> B DR V> —(Blank Policy)] DJIH (2 L T, A7 v72IC
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V=L AHA N
w7 Ry —v A —Y

A ET,

o NARLI—V z¥  Fzvih EHEDRIV—H DM OF 2y &— 4 2H it 25
Hlds AT o7 A £,

No v 7' &7 )R s B, 7’)0)75% BB ZEIRNLES,

A &L T—Y 2> MCustom Agents)] 7 v —7"%#f & &7

DA MPAHARLT—Y 2> MEIEIR L &7,

N

2
3
4
5. P 71)v(File)]> R7F(Save)] DIHEIR L £7.
;# YEEITTREEH LI ARRLI—Y 2 byl O RV —5IRIR L £

o

VE: BH %% AL IR HE AR &5 A B L7285 4 1 Policy Manager £ U T4 &7 F B 1>
TME] SNTAHRR L=V 2> MR T 2L E DD VET

Fik

Web 77 V7r—3 312id . WebH A bEAE R ¢ 32— F2UTld % < WebH A ba— K icn
Bl LT L DD T BB 2 7—F 7 7Fvavhi—2 v beE &N 4. Web7 7Y
=3 DX F VT &5 T B e&d T ICA B S T35 2210 Tk 4 < Web+
A NERR DS 128 21200 T 29 XTCOavE—2 v M5 E Lo 2 0Et A

Fortify WeblnspectidWeb 77" V7 — s> &5 B L CIETE I & £+ 207 1. - DR B 245 &
LA SN TR L2 —FREN 62B H TEZL AL ZH1C. ¥ 2V7 1D 8 2 ik
T2 E LB O R AR LET. WebD & 55254k LE: 284+ Iy o e i
TR O F 207 4V EFH T3 ENM XTI I BT, COM 25 L.
OpenTextDi% &t F— Ak V7 b7 27 AMi i S 27200 BT LEBE &1 D v > 7 F 32k
LR LI AN A DF L P R—ABH B EHH S 24 Ak FF LE LIz, EH DR, V7
R727E T AMNTRDT7 7 Vr— 65t LTEN 6Dy 7Pk ET 32— L&,
FLyYN—2RIL, OpenText® ¥ 2 V7 (DHEFI K 2Tl & SESE LY — K/ 3\—7 40
KFDLF 297 1AL L7 H VA M o)z AUE SN TL &9,

B LD Tk A &0 3 &L OpenTextid SecureBase™)ifii 55 P 7 —4~X—24 2D H O
BT v 7L —RLET. LN Web7 7 Vr— s>Dt ¥ 27 1. O 55 1 25F i 3
% & &ZFortify Weblnspect2Mii 1] 3 23 %2 Fik T3,
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IR T A— A

IS A—ZEANE Tl . URLAS S A—REN SA LTy 22— A 5 & oF) F] T &4 Wi 3R 25

BLET NTA—KIGENE T NTA— R B L E 35 B AT BN, 7238 B L
F.RARC, FARNITTEEEARE T NI A—KEAEL - & . Web)b— +D | D
TZ7ANWVDE IR T —ZR—ZA6DE RO . BIMERE DARL—T 4T AT LLN

WaAvwy ROEAT 2 8 WOMDHE B DIER OfDIfFH T&Fd. COFEIE LT wext L
T A s 7.

o JTUNFEH . . Web77' V75— aid. 7547 beyr— o7 —R&0E ¢ B 27k &
LCo2Z UL FH & 258 082 VT, 22U FAE NA =Y 217 — &
CHLEBEM L. Vo 78N eR—V IR R SN B REWMB T2 55T WREH &7
T FIEBAE LT B LT —ER—AnBE R 4B A 0. Web 77 Vr—y 32D
T—%7 7F vt 4l # N T L1z D. Weby— FE CTavy FEHEAT L0 20 fEt: 235
N &4 . Fortify Weblnspectid B 25 247 FE . B F & 72 U F ¥ e F 252 %5 L TH—A
TODavy ROEAT ORI 2R L. 22U FHEAE kT § 2Web 77 )7 —2 3> D
JE 55 1 2R LET,

e Post7—Z&., 7T UL FH OFAIE X 757 DT FL A= T F X bEN 1T 5 & NCF
HICT &R0, 2 \OWeb 77 V75— 3> Tld GETTlE & & 74— 4 EPOST XV v K%
HAGDOE T T2328E 5T R—YH TOT—XD%Z JE LT > T Ed . @
W\ 7 IV TIEPOSTT —&NE R SN Wi, —H D70l =it 7 —XD4E F &
R B 720 A AT RE 72 & WIA A T &35, KR IL1¥ T3, Fortify Weblnspectid /3 5
A= AE OPOST AV v N&F| FH L2 B oxt ¢ 277 Vr—y 2o O 55 1 #H)5E L £
ER

o ANyK, HTTPE R Y% Tld HTTP Ayt — B 4 315 R D5] & Lie~ vXoMfi ] &
NEd. £ DWeb77 V75— a3 8574y 20% 5115 Rk 2L EE 2120 12T referrer]
luser-agent] % EDN\yXET —AX—AZ 7508k LTW A hhb 69 HTTPAN X%
AN ZV7THBER 2L TR WL FEE 0 &4 . Fortify Weblnspectid B 25 DFE 12~ v
RIEIR &% L CIFS F LN\ A4— KMl 552 FFE T el & 7,

o IvF—, Z ADWeb77 V75— 2 7vF—%[EH LT, 2—FIDR XA L AR T ED
HREIFATY MOV AMRAGF LET BEODHDZ2—Fid . I 5O 2 T L1z 0,
7ok —5l FAX =27 LI 0T B2ET D 2—F D7 A7 MR ST 72 AT 2]
BetENDET. Flos WEEN2—HF DI vF—%5E A, IDESAT— RO ] % EDOF
GEENANALT, 2= DT AV MCEE T 78 A4 3288 H VET . Fortify
Weblnspectid A% v>H (K SNz dRXTD 7 vF—%2 VA L. AR Zn 6D 15
A—RDIEHE #i A T

IS A—BEAE L IR DX 7y 2Tl 2L 3. WOLDHT AT TN e 5.
NIA—RAL VY 27y 3

NIA=RA >y 27y 2B T, 5 BE PR BE LTI ICE &R 2o 7.

] :

[ http://www.site.com/webapp.asp?ValidParameter=ValidArgument] %
[ http://www.site.com/webapp.asp?ValidParameter=AttackString | (CZ5 5 L &3
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URLICEHIH ¢ 25 4—REEAFE L& T B2 A B EIRD L OB ICO%
MWNET,

avy FEAT

A2V FEITWEBOLFIIE . FFR L F EARL—T 4V AT AL )L av > ROH & &
bE TR SN £3. Web 77 Vr—y 22055 Bl WCH 7k S 2R 30 COXX 9 54
AL—=FA¥ Y 2 A7 L 3%y FORUH LCH T 28 COXF A DAL —F 427 2 27
AL avYy RPNFEAT SN 7,

Bl - id; .

Fortify WeblnspectiZ ID 2> M4 EDE DL L I2y FEIEE LT B H CL->Tavr K
DR SN CHEIAT SN 20 etk #HER LE T,

SQLA>Y z7y av

SQLA> Y 20y it R F AEX LTHA WSQLI— RE 77 Vr—y 22 78 /E
T¥. 2 SOBEE L F 51X SQLEE X OWr Fr sl ST 0, Web 77" )r— 3o i

SQLAT— b A MEAE L 9 BB S BT R € O F 2 228 KO F 4] 2 H
T 3&. ZOSQLIE L OW i 7 —AN—AH—NTHAT SN £

#1:'+(SELECT TOP 1 name FROM sysobjects WHERE 1=1)+'

SQLL F ) #M L Ca— WM B DL AT LETTVr—2 D7 /e AME 25 2 287N
BB, THRANIZA() % EDRE T 7D 2T B M 435 2 F7 (F 3 2155 %) 55 2B 5 % 23
L Thhne MENREAE T2IL8H0NET.

JOAYA FRIVT T 4T

COMEE L. KA F Iy E R S i-Web_X—2 2, IF LYGEE SN WA JI KRR SN T
WA AR ELET. COGE . B E G4E R SN 220X —2ICE & D H dJavaScript
FHOAA . BEOHEZZORN—VEMHE LIERD2—H DL v TCAZYT b eEIT T3
CEMTEET o 2= NTFAMvE—V 2R TEBH A ME. D& BB B oxt LT
A REMEADVEST. COMETIME G PLF TLE st £7.

e NTENIMEF—7— N8B R TR Y

o ITTEHE OV TH & VR §T5— Avb—Y

o B C—HICEKRINBNT 74— LA

o 2—HHME D Avt—Y 5 T&B3Web xy—Y R—FK,

WIEH 270G A NI VT T A TR T B & H G WM T s i), 7ok —nifh
E &g aniz, B3 a2—DLD L E 2 61 B0 BeVE A d 25 R HME L Sh iz
D BRDHZI—FP2—F DY AT LATEIT SNTNT 2BZNHHVET .

BENN

BEENNBBOLFH G T LN T BT Stz WWeb 77 )75 —y 2280 T
KALFEBI AN 07 S L TER VI S) 25| &GS IR et 236 230 7 CHRERL Sh &
T, 2 DG A RUFG A I K28, 77 V75— 2 ON EF AA=R L § 20535 1
MEM IR T B3I Ave—Y BRI ENFT, V—Ra— PR SN 2G5 08H VLT,

%1: %00
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INGA—RZF—/\—T710—

RS A—BF— =70 B, Tl NFA—RE2E 7 vF—~NvXDG| $ 121 /X5 A— &%
DO, TWeb 77 V7 —y s KE OF — &L (E S £4. Web 77V r—y 2o F R L
KOWKBEOF—R5HE WM C&23L07 0/ L8N Th WSS E [ETE DAL —
FAVIT VAT ALV a— RREAT SN2 0, —E2A$E FIARBE 5] &t 23N /204 21] fE
b nEd.

N7 7D A —/N—T70—

N7 7DA—N—70— BT AT B DARNL—FT AV T VAT LAV REFEAIT T 272H124f
H &h 2] getE 73 0 &£ 9 . Fortify Weblnspectid /3 v7 7O A —/3—7o0—K B 123t LT
FGEIMEHTE Ly Ny 7704 —"—70—0i 551 2B IE T 270 DFF AN 1E ) 282t L
QR

i
http://www.site.com/webapp.asp?ValidParameter=ValidArgument
IR D &N S FF

http://www.site.com/webapp.asp? XX XXX XXXXXXXXXXXX &8+ 1 o3¢
- ] XXX=ValidArgument

ROENETH SN GG LHNET.

http://www.site.com/webapp.asp?ValidParameter=XXXXXXXXXXXXXXXXX [ 512
T DI 5 TXXX

A S SV

NIA—LZB N Tl HIR S T3, X E R ShTwuzw 77V r—y kg
T 72 ALI0. WER D77 ) r—y 3V 8 & AE L7209 2728010 HTTPE SR 128 LA
Z A—K(admin=trueZ )7 H N\ Sh 7.

T7Vr—y a7 N7 12 X9 BT E— RO N T A—X

T7Vr—2 a7 /N7 [Ny BT = RD R Z A=K fh B RFE Dzl 7' as i & 5T
Binanfe. XER SN THAEWTTNr—y M THEIENLZ WEDTT, 7 /37
TNy R7E—RNIT 72 ASN 28 Web 77 V7 — s DW Hf AH=R L% B
LB b2 E B RPN AT 2R NH 0 ET.

i :

http://www.site.com/webapp.asp?ValidParameter=ValidArgument&debug=true

o Yo

NAEEAVEIE Tk . Web)L— bD F D7 7ANADT 24 A MERAT 5B DA R AL T4
L7 M)—BOERIR, &/2d 77400 Y —ZADK IR D iz iz, HTTPE 5k DRequest-URI ¢ 7
NI B SN Ed. NABIEDOF IR G IRDEI L LDBHDET,
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w7 Ry —v A —Y

RADY] V& T

N2V 0Fe T L, 77ANWVE DL OEEF DT 4L 7 M)ER D ZER TT ., L0,
F AL 7 M) B AL IR SN B & D D ET . Fortify Weblnspectid /3 2DV 0¥ T EE 4T
Ls ZOBR T AL 2 bVD—BE AR IR SN0 B 2 5—0FE L0l WhEEZR L
9,

i

> 2121 http://www.site.com/folder1/folder2/file.aspl 7% &4 235 &« /SR %) D¥E TT
[ http://www.site.com/folder1/folder2/ ] < http://www.site.com/folder1/] Dk & 217 H&.
WebH—/ 357 4L 7 DN 4 & 7 LIz 00 RALFEG 4 3584 LIz L &9

NELYya—F 47

NF Ty a—T AT BT BRI O VY —RxE 3 2F R O OSLF A, 21 LR %5 D
IYVI—RSNLFULEERZoN ET. Web7 7' ) r— avh, Ty a— NS e T &%
BN E T, HERA 520 OH K ¢ 20> a— RS URIEE ] LT 4
LLiR #5547 9 2 & MR A5 OR% E MR 10 o720 VY —Aa— Fosli 2L Lz D9 1]
BE 1 23 0 & ¢, Fortify Weblnspectid T> a— FaN - 8 £ & £ 4 X 74 %1% 15 LT, Web
77—y AR ST 2 IE USRI & 2028 o0 %0l 52 L £9 . Fortify Weblnspect 33
FIYVA—T AT TANEFEIT T2 KR e B2DEUL FOEXKTY.

« Unicode: Unicode Worldwide Character Standard Ti& . tH L O3 XTOFE E L5l iR F
EENO) G AN AN S Y7 Ve ANEC] /1 =W ST L 5 | i v </ el (O s s bl 37408
F— L& LTEF LT 3. Fortify Weblnspectid [7] 2% ®Unicode S 7 ¥ 145 i &
N1 ZiEAE U COEAE 218 LA IE R AE B A& T 3k 201 32 2 &ail & &
ER

o 163 0—7 427 T, CF EF 2% 0161 B0 7 E &H 2 22 LT . Fortify
Weblnspectid 161 T> a—7 1> 7 S 730 751 #1615 L. CO#EAE 238 L TR IE 1238
AEE GG IR AR T el A X T

MS-DOS 8.30D%E W7 71/ V4

MS-DOS 8.30DJH W77/ IWH B TlE. 7714 HMS-DOS 8.3 (1268 F . ZiL
Xt Uy e it OWindows /A=Y 3> TOD 7 74 )L 4 O F il [RIG225 X F )R S £ 7.
Web 77" Vr—y avH, #ERRAT 5 0 OH 1) T, F i1 ICFAT32/INTFSTE SN DX 1 %
1T H 312 Z2DMS-DOS 8.3 D7 7 )v44 4 I LT 78 LL#R 25K AT 9 2 &, # IR AT
5 Q% E DR of2 Dy Y= A= R AL LI 2R RetE D D& T,

%1 : Tlongfilename.asp 1 lNongfi~1.asplic % D& ¥
7 AL 7 MY R IA—4 )

FAL Z MR SIA—H LI E ., URNZEG » a2 T3 . Web 77 Ur—y s BNH R 12 b5
W= WL F 5T T ETCCOLF I E#EH L TT7AVOG T 28 € 328 20
RIZE>T. Webb— FDE D774 )LD & #WebH— 1\ hERm LET.

fl: ../..1..1..1../boot.ini
X F DY) %

WFOYI BRI Tk, — N F 2 77U — 2V MR NT 3 20] 1 3 H 2URNER Bk SC
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M . Policy Manager#f#i il L T12LL E DR Vs —&i & T& 47,

CH6H TS s
"HAARLT—Y 2 PO " R—TT74

HNARLF =7

AARLF 297 FEEDF 2o/ T CELWIF EOM M 2 + 22— EFOD
TO—TTCF . HDARLF 2o lE VTN I —RE A L ER c& 7.

CHHH TS FFEn
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VIV AA R
BT R —v2—Y ¥

"HARXLF 2y DIE " X—Y65

1AL R B

EM B O AR KR A F R —r Y A LUER Sh &9, IROF 2. 2h
SO FD—H &/~ Ly 2O B 2B 28 Lad. R T2 DS &L T
'Regular Expression Library | 3% D &3

X
\

[xyz]

\b

\B

\d
\D
\f

it B

WOL F 5 »R L F L T~v—2LF T ECFEInjie—s LEd. >—7 >
AN/l BAT L F I L &Y.

AT ERIEATOHRTEIC—HLET.

T IFREEHVMH T8 B E LT H#EIR LET. /L2 contentT (L
2 MY D/content/en® & U/content/ca #Fk <3N T#FR4M 3 21214 /content/[*
(en[ca)]*L* &1 I L & . \S\D\W 2 i LT 2 &0,

AT &REATORRBIC B L&,

HAT 3L F D0 L EDORIE E—FLET. /zo*idTz1 &bTzool 65— F L
QN

HAT I BLF DAL EDOxIE &L ET. /zoHdTzoo lo— B L F3 4.
[zJiE—8 LI A,

JAT T3 F D0 /-3 1[H OH B &— 3 L 9. /a?ve?/idTnever] Dlve]
B LET.

BAT X F 2R EE DI F I L&

Ly e FHINH OIFEE D1 Fe—F L E7 . /[abc)/i&plain] Dlajic—
HLEY.

AN—RA% EOHEEE FLc— 8 L £9. /ea*r\b/id . Tneverearly] Dler]ic— %
L7,

BEE LA OB L ic— 3 L 9. lea’r\B/ik never early | O Dlear] &— 21 L
ES 2N

1208 71— L&+, [0-9] [ LT,
B LA 010 7 ic—5 L& 3. [*0-9] & LTTs
A= I LET.
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http://regexlib.com/Default.aspx

V=L AHA N
w7 Ry —v A —Y

XF wH
\n AT LTI L &S,
\r F o)y YRV F B LET,
\s  AR—AL KT WA=V A EDFE HIC—F LT [\ &R LT
\S FEAXFLUAOLF I LET. [P WMn\tW] EFE LT,
\w TYR—RAAT7 % & AR OBEGE L FI—H L Ed. [A-Za-2z0-9_]EF CTT.
W EHFE LA O F I L ET. [FA-Za-20-9_| & LT,

IF #5380 58

I DIF 3R B S wext 9 23655 2A0penTextD T2 =710 S B FE B LUERE Sh T
WET EHRER2ER T35 5. RORTEEH T2 &,

IER R %7

« [ALL]

[BODY]

[STATUSLINE]
[HEADERS]
[STATUSCODE]
[STATUSDESCRIPTION]
[COOKIES]

IR B T

« AND
« OR
« NOT
* [l
« ()

1

o QAT —RAMTILAT—RAI— 2001 H53F EN THE D, 5 O(b) Ay —Y KL DEIHIZ
MNogged out] & FREA) 03 FN TH AL L M H 7212 IRDIEHR K H 2 H L &
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VIV A AR
w7 Ry —v A —Y

ER
[STATUSCODE]200 AND [BODY]logged\sout

o TR SN F2 YV —RAH— B I OURI (VKA L 7 NCAETE 3 3 2455 LTH D, hofis
% D EIHIZART Login.aspl NDZ I 258 Fh 25 £ H T 2121k IRDIEHR R B
HERA LT,
[STATUSCODE]302 AND [ALL]Login.asp

o (a) A7 —xAa— FH»I200]. »Dllogged out] & 721 ['session expired] &u» ik B 234
L DEIHIE FN TS, &1zl (D) AT —XRAI— K302 DI & D ETHIZ/AR
[/Login.aspl NDZ B NE 4N TH ARG ZEDWT N4 21k IROIEH EH %
fEHLET.

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302 AND [ALL]Login.asp)

YE: TBH X 4590 £/21 3 TR CIHE 9K ORT 18 1c AX—A(ASCI 32) 25 » 20 B dH D &
To FOLBWVLE FEINDRS>TIEREBHO—E ER 3 £9,

e X1 L 7 hLocation™ vyXD & Zhizllogin.aspx] I B VXA L 7 M & 2% H § 212
EIROIEHFH KRB 2 H L £7,
[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7 —XA{T DReason-Phraseifl (2 & D F % (T Please Authenticate | & £) 238 41
BIGE M T IROERRHR 2 A L &7
[STATUSDESCRIPTION]Please\sAuthenticate
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m8 MR =7 4K

FEHER L. CFHDOLy 4RI RAZ—>TT, EHEFR G, S0 E T 214 H
LTNSEREFHAE DT R E>T H R LA CHE R SN &+, EHREBHRCHEH T2
FEH M A O 2PN COMRE 2 T RXETT,

EHREFEHROFZ N

Regular Expression Editor & ] L T IX D & NCIE R LT 27 X M LORGEE L £7

1. P—(Tools)]> Regular Expression Editor] #7Vvy7L £,
Regular Expression Editor] 7 1> N 7235 & 7

& =
8 Regular Expression Editor |Z]@|g|
Eile Edit Help
pression ] E]

grialely
[[] Beplace ‘with

[] Match case

Dr. Gray has grey hair and a grevhound. = Gray

< | >

[ wiord wirap

Execution Time: <1 ms; 3 matche(s)

2. B (Expression)] TU7IC. R T AT F AR O3B b BIER KT 2N 1 &
Fld B OfF O E
CiE e, 2l e s o s LTy 28 kO YR MER A LET. SR
URLUPT7 FL A2 E R T2 ARXL F LIEMRRIADE & 5. A7V 27 b5 7Yv LT
FALET.

F: EHERIROW R A H LT E DT YTOHTTP Xt —2 IR 28R 7 2
CELTEET.

E Arvy single character

Zeto OF moare

Qe or more +

or |
Word boundary b
IPv4 address {0k
LIRL Lk
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IV AR
B8 IF R 7 4K

6.

7.

A 71 LT3k OH% S #3Regular Expression Editoriz & > THi 25 &h. @ (%) 25 4) &
1213 (M5 235 B )RR S & TS
BMELO7FF 2% BRE 7+ X MSearch Text)] TV 7 1 L& (/5 0ff U &
EBE
1214 LLHTWCHTTP Editor 2 H U TR A7 LIGHTTPEL SR /21 s & Avte—Y 2R D
AL TCae— R NT&£T,
a. P 71(File)]> E3K %258 {(Open Request)] #7Vv7L &7
FR 770k EERICIEHTTPE R 5% Ol Jj 07 —REH &t vy a2 TT.
b. HE¥ED 77/ VIR 74> P LT RTE SN vy 55 L 771 L 5N
LEd,

c. ER(Request)] #7214 5% (Response)] #iE R L 4.
d OKl]#7VUvyrL &9,
KORKLFUNLF e~ T 2HBE QA &R T 212 RIXFIPLFEX
71l 3 3(Match Case)] 7 =v /K v/ A& AL EFF,
IERLR B & 0T S 12308 2 O 74 TH &R 2 2121k DL O fE %
KAITLET,
a. B F % (Replace With)] F =2k v 7 A% L £,
b. Fovw&yyar R Ry AeH LTCFA 2N I Frd#@IRLET.

FAMNTest)] #2707 L ERKRBIC—H T 2L FINER—7 b TFAITHEL
9. —HLA O TR R SN T,

E#(Replace)] 77’y s #IZ R L1355 k. B#R(Replace)] #7Vy 7L T\ MR
SN FHN T RTCEEBR LT LB &S] 2L &7

CHELHY TSI FEn
"IERRE R
"IE H R B 0L R " X—2102

IS 7]

EREBHRHORZ— G R R LT —r A& LTER S &9 . IROF 2. Ih
SO 7 D—HB &x L O 12 ] 25 LEd. #ESE 3 2 DS M5 &L T
'Regular Expression Library | 3% D &3

X7 B

\ WO ERER L FEELT—2LET . ME X FEInJic—FHLEd, v—F >
AN AT P — L &Ed.

NN ERAT OG B I L &S
WP IR 28 BEX T 28R LET. L2 content7 (L
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http://regexlib.com/Default.aspx

W—ILAHA RN
B8 IF R 7 4K

XF

[xyz]

\b

\B

\d
\D
\f
\n
\r
\s
\S
\w

\W

it B

2 MY D/content/en® & U/content/ca #Fk <3N T#FR4h 3 21214« /content/[*
(en[ca)] L. &1 I L £ . \S\D\W 2 [ LT 2 &0,

AT &REATORRBIC B L&,

HAT 3L F D0 ML EDORIE E—FLET. /zo*idTz1 &bTzool 65— F L
QN

AT I BLF DAL EDOxIE &L ET. /zoH/dTzoo lo—F L F9 4.
[zJWiE—8LEE A,

JAT T2 F D0 /-3 1[H OH B &— 3 L 9. /a?ve?/idTnever] Dlve]
B LET.

MAIT L F 2R T EDILF e LET,

LT tyh. FEINH OIFEE DI FiC—F L &9 . /[abc)/ikMplain]Dlajic—
HLEY.

AN—RA% EOHEEE L ic— 8 L £9. lea*r\b/id . Tneverearly] Dler]ic— %
L7,

BEE LA OB L ic— 3 L 9. lea’r\B/ik never early | O Dlear] &— 3 L
ES 2N

100K Fie—FHL£T.[0-91LF LTT.

AU DI Fic—F L&, [0-9] L LTT.

A=Y FIC—FHLET,

AT XL &

F o)y YR—2 LTI LET,

AR—RA, BT P AR—V R EDF I L &9 [\Wn\n\t\W] &F LT,
FTHXFLAINOL Fic—F L &3, [*\A\n\nt\v] &F LT

TYR—RAAT %% CAEE OBGE L T IC— L ET. [A-Za-2z0-9_]&F LT,
BT IO FIc—F L ET. ["A-Za-z0-9 1 EF LT
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IV AR
B8 IF R 7 4K

I 5 3R i O 58

I DIF R B S wext 9 23655 2A0penTextD > =710 S B FE B LFUERE Sh T
WET EHRER2ER T35 85RO EEH T2l &,

IER R %7

« [BODY]

« [STATUSCODE]
« [STATUSDESCRIPTION]
« [STATUSLINE]
« [HEADERS]

« [ALL]

« [COOKIES]

« [SETCOOKIES]
« [METHOD]

« [REQUESTLINE]
« [VERSION]

« [POSTDATA]

« [UR]]

« [TEXT]

MR B A T

« AND
« OR
« NOT
* [l
* ()

17

e QAT —RAMTICAT—XZRI— 200125 N TE D, 2 D(b) AvE—Y KL DEIHhIZ
MNogged out] & FREA] 037 FN TV R E M H 77210 IROIEHR KB 2 A L £
ER

[STATUSCODE]200 AND [BODY]logged\sout

o BR SNV —AN—KEHIZH OURI (VEAL 7 NIAFTE T B2 8%m LTE D O
Z D Ehz/ AT Login.aspl NDZ B 3 E i 205 % #1837 2121 IRDIEHR R B
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V=LA A R
B8 IF R 7 4K

#EHLET.
[STATUSCODE]302 AND [ALL]Login.asp

o (a)A7T—XAa— ’AI200]. »Dllogged out] &7z [session expired] & JiE B A4
L DEIMIZE FN T3, 12l (b) A7 —KA3—R302] 22D B D ETHIZ/SA
[/Login.aspI NDZ M 258 FN TR BILE DL TF N EIH 32121 IXRDIERL R #
fEHLET.

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302 AND [ALL]Login.asp)

VE: TH 145 9K 721 TR C13E IK OHT 12 (IC AX—R(ASCII 32) 45 B 2L E 3D D &
To 2BV E FFINAGR >TIER R O— ¥ LR & Sh £,

o UXAL 7 hLocation™ v&XD & Zhizllogin.aspx] BN 3 VKA L 7 ME & 218 3 21
G IKOIEH R AEH L.
[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7 —XA{T DReason-Phraseif \24F & O F 1| ([ Please Authenticate | % £) 73 % &4
PGB AR T IROER B #EH LT
[STATUSDESCRIPTION]Please\sAuthenticate
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% 9: Server Analyzer (Fortify
Weblnspect® #4)

Server Analyzerid . — /Nl WHE DY EL TH—RDARNL =T A4V T L AT A /N F—,
Zy®—. ZOf OIF W £ sz L&,

P/ DI T

P—NEI T T B

1.

2.

4.

BE—7" v bk A MTarget Host)] 7 +—)v NiZ. &—7 v M—/SDOURL £ 72 IP7 ML 2%
ANTTL&ES,
A MRAE (=L ENAT— BB E 2 6& . £ld 7 e —N N LTX—7 y
MF—NC T 2 AT 2854 . BRAE(EdiY)]> B (Settings)] £ 7V v/ LT, Bk &
NEBERENTLET OO, TRRAER E" K OR—=2 18 LT T o 2%
E"AN—U10612#Z ] L TS0,

£ Bt DE 47 (Run Analysis)] 71 a> %27 Vy /L &7,
# 7 3 % &, Server Analyzerizl 73§71 52 T (Analysis completed) ] D A 7—&X R &, 43 7
HADIHEH DVA MER SN E£T.

IH B 0¥ 4l (Item Details)] X1 vzt ik #K /R 9212 B E (Item)] X1 > TIH
H#ERL£T.

D Server Analyzer - b
File  Edit Help
Target Host: |http:ffzer0.wehappsecurit}r.cum! | [ Run Analysis & Export
Items Itern Details
=i httpf{zero webappsecurity.c
Rl cerver Fingerprint The underlying web server of the target/device has been
My Site Analysis Summary identified as the following:

-4 Site Analysis Information || Apache 2.2.x, or Apache 1.3.x

¥ Application Technology

g Server Banners

All the underlying web server fingerprints that partially
matched this target/device:

3. Apache 2.2.x

3. Apache 1.3x

2: Apache

11540

11550 Vv
1. 156.0

£ >

Status: Bnalysis completed
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V=LA AN
% 9: Server Analyzer (Fortify Weblnspect® 4 )

=L == S

AX B O)g d

Server AnalyzerDi% & #%48 B ¢ 31214

1. & (Edit)]> B (Settings)] #7Vv/L &7

2. ROLFNAI LRI L £T.
o A NEEE(Host Authentication)] . " 251 7% E" F12Z B L TS0,

o PuFy(Proxy)]. "7 o il E" IKON—v 25 LTS,
3. OKlzZVUyIL &,

AnalyzerD#E B D 7 AR —

M EE R AHTML 7 7 VI T 2 AE— 1 2121

1. P r1(File)]> E7AA— MExport)] Z7Vy7L £7
2. PO sAR— NExportFile)] 714> NV T IG5 T &7 7A VA 2RI £r2ig N S L
9,

3. Rfr(Save)]z/VvrL &7,
H6H TSR FEan

N2y 2T 2L 22 n
A0 X & 7:

"TaE CRBUE" IRDA—Y
27) =L = oz
> FIJtE IIIX /—\E

Aol AV R
FRRE 30 L e 1 5 (& L BRI OOFE S AR L T 2 s
« H #(Automatic)

VE: HEIM U 28 T8 RE v DI R <A DET . HEHE LT0 25 OFEE A
VyREIRE T 28 AF x> DAT+—v Y AL KIF W - LETS

£4 Y =X MDigest)
HTTPZ 4 (HTTP Basic)
Kerberos

NTLM (NT LanMan)
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VIV A AR
% 9: Server Analyzer (Fortify Weblnspect® 4 )

Ay 2T VR ek
o Al B A% 15 )
E—44 (User name)] 71—V Fic2—#ID%#AN J1 L. PSA7— N(Password)] 71— I

2= DRAT—FEN T LET. N1 3IR%P <fzoiz. PRAT— FORERR (Confirm
Password)] 74—V FIZ S AT7— RF%&4: DIk LA L&

Server AnalyzerC/S 27— NN /7 2> bo—u AR H & 372000 2h 5D 1% 15 3R %1%
T2 PRRT—FAT 74—V FRH 2 74— Al Th 5OR IR #1415 73
(Submit these credentials to forms with password input fields)] Zi# 4R L £ 3.

7'a¥ ik E

COMBE LT 7 A 21cid . BREE(Edit)]> B E (Settings)] 27V v/l &4 . k2. Pe
*3(Proxy)] ZiER L £7.

H 7 4 (7 o ¥ > # %) ) (Direct Connection (proxy
disabled))

7oXH—NEEH L WG A E. COAT Y v IR L&Y,

7'n¥ LR E O H B H (Auto detect proxy settings)
CDATY av %R 3 % &, Server Analyzerid WPAD (Web Proxy Autodiscovery
Protocol) &8 [l L T7 ¥ v HBIER E 77/ V&R DU, 20 &M [l LT7 574 DWeb~7' o
FURRE AT VW ET S

VAT LD7 uF i E 2 H § 5(Use System Proxy
Settings)

O—Lvy b7 X — MER 24 VAR— MBI COAT Y v HIEIR L ET

Firefox7 0¥ 2 #% & #1# H 3 %(Use Firefox proxy settings)
Firefox/ a7 B s H—ER 24> A— 1§ 22k, COATY o IR L £7,
H: 757907 uFx iR E A LTEH, 7o o — A& H CA v E&—2 v NI T 78 A

TEDIRAEIE B DEE Ao Firefox7 20 O &tk € Nl 7 oFx o LR E ST 3
G a3 S Et A
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VIV A AR
% 9: Server Analyzer (Fortify Weblnspect® 4 )

PAC7 7A V&l L T7 v¥ v 5% € 1 %(Configure proxy
using a PAC file)

COA7y av##EIR §2E. URL] 74—)L TR E L7123 AT 12 & 2PAC (Proxy Automatic
Configuration) 7 7 W67 0% La% E Ho— RS 9,

7'o¥ v &8 7R 128k € § B(Explicitly configure proxy)
7aF Y —NEHTA YRy MIT 72 AT B2 COATY 2 FIEIR L, ER sh iz
BMELTOLNA S LET.
1. f—73(Server)] 7+—v Niz7'ax 24— OURLEEIP7 KL A& AN J1 L. &t T

( B— NPort)] 71— Fi2) & — 1 5 (8080% £) &A1 L&

2. 7oF Y= H CTCP r 774wy 80L 3 27 0 haLvd BA7(Type)] %
SOCKS4. SOCKS5. /s tEHE iR L E 4.

3. WALV E 1A &, FREE (Authentication)] VA b s XA 7 HIEIRN L 4.
« H &) (Automatic)

E:HIMHE 28 E $588 A% v DU AR L NEd . 182 LT 35 O
SE AV REISE T BE AF v DA Tr—v AL KR ICH LT,

# A< (Basic)
£ 1Y =R MDigest)

Kerberos

# ¥ — MNegotiate)

NTLM (NT LanMan)

4, 70F Y —NTRRAE PV E 2 53 WS 42— &N AT—FEAN I LET,

5. FFEDIP7 FL AN 7 A M A MW T 78 AT Blepic7mF o H— & 42

WE RO A . Pods #3432 9 244 MBypass Proxy For)] 71— Fiz 7
L AZGURLEAN JJLET. =Y NEX Y] 2556 & Av~EH L &7,

HTTPSH O & 7o+ > %45 & 3 2(Specify Alternative
Proxy for HTTPS)

HTTPSE: 4t 2% U AN 27 0x 24— 105 k. HTTPSHORE 7oxv 2B E T3
(Specify Alternative Proxy for HTTPS)] 7 =v /K v 7 ZA#I& R L, ER shiziEH 2N\ 7
L£9d.
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£ 10: Server Profiler

Server Profiler #ff i L TWeb+ 1 cOH FI 7 A %47 u», Fortify WeblnspectDFF & D&%
EEETH T 2LENDI0EIDEHM LET. ZF 20 2L b 284 . Profilerid
REDVAMIRLET. INADIREEF . ZUTANBZIELIE R T332 TEET,
fz£Z1E . Server Profilerid . A M 2120 HERST 5BV ECTCHBELDD, A ) &t 2—
P ENAT—RIRPIEE SN T W EFHE T30 8N E A TDEEAF v 25i1T
LT3 L <Y DK Wik B 218 20Tk % & Server Profilerd 7" o> 7" MIfE 5T &54T 3 2Hi
B RERERTE T HIENTEET

[A] £k (2 5% % Tl - Fortify Weblnspect 23 7 74 )W R D6 W1 O H AT L&D
IR E SN TWRIEEHNET COT OV AL FIE LGB I —RE 7T T MpsBiR &
N THA7—KA404 Not Found | iR &% \’WebH A NCIX (3L B &4 (IR D NI AT —K R
[200 OK1%%R S 235 G 03 V&S 23 JE B W& 7 7AWV DH 64 0 b I Ay — T 28
B EN &£9). Profilerid s 2O & HaFiE N E—7 v A MIFESE S To 3 EH I Lt

& ORI IG T & 3 & SicFortify Weblnspecti® & 225 8 § 3 4R L £
Server Profilerid . 4 M} &ZAF v iZIER 32288, 7Y —3 2>(Application)] #%
ECHMIITEIELTEET,

Server Profiler®fi H

K D2ODTT DN m%EfE H LT, Server Profiler£#2 &) L £ 7,
v— v &L CDServer Profiler Dt &)
R D A7 7 124¢ >C Server Profiler 4t & L ¥4

1. Fortify Weblnspect® P—i(Tools)] x=2—%21vy2L. ServerProfiler] & L &
£

2. URL] AR vZ7ZAT.URLE#ZEIP7 KL AZANJ] &38R L E T,

3. (A7¥ 2N E S LT B vy A X (Sample Size)] #28 HH L £ 3. K 4
Web# 1 FCIE B 2+ 5 0§ 2720 77400 b vy 8 5 2 28 v 3
Y E B G NHNET

4. Prir(Analyze)] #2770y oL &9,

Profilerid . $£ Z O— B (/2 E B E AR E TH 2L IAT— AV NER LT,

5. IRE#EH T2 . HET2F 29K/ ADF 29085 LET

22— E LR R OO TE TR SN EREN T LTS,

7. (A7Y )R LI E &7 7/ WIERAF T 211
a. B DR (Save Settings)] =27 VvrL &7,

b. HEHE D77 VIR 71> P el ] LT, 5% E £Settings7 1L 7 bUD 7 71 )L IR
FLET,

o
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V—ILHA RN
# 10: Server Profiler

A ¥ ¥ OB 15 K .2Server Profiler ##2 8) ¢ %
A ¥ v DB 4G R (CProfiler #4C §) 3 212lE IRD AT v WHE VW & T,

1.

o &

KONTN D TAF v 2IELLT.,

« Fortify Weblnspect® Bf & X—(Start Page)] . B4 A ¥ v DBH i (Start a
Basic Scan)] z7Vy7L &7,

« P r1(File)]> ¥i¥i(New)]> E: 4 X+ v>/(Basic Scan)] #7 Vv L £7,

o (V= —0D) I (New)] 71 2> TRy 7 X7V REN#27)v LT BER RF v
(Basic Scan)] #iE R L £ 3.

« Fortify Weblnspect® B &f X—(Start Page)] ©. RT Y 2— W SN TAF v D
& # (Manage Scheduled Scans)] #7VUvZ7L. [BIN(Add)] 22Uyl Th o B
7 X% v>/(Basic Scan)] Zi% R L £ .

AF ¥y T4 — RDAT v7 A A% v B )Ty PeZsu(Profie)] 227 Vv oL &

3 ( Profiler %8 8 i1 125 4T ¥ 3(Run Profiler Automatically)] 75% R sh Cw 235 &

R

Profilerid . 2 Z D— B (/3B H AR E THBENIAT— AV NER LFT.

REFEE T2 HIET23F 9/ R v ADF 2y L E TS

2PN BB E LR F I OOTE BER SN EFR 2N I LTI S0,

K A(Next)] #2VvoL &7
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% 11: SmartUpdate

A > &=y M & LT 34 > 2 bV ERE Tld . SmartUpdatef fiE #:0penText7 — X+t
YR—GEAE LT Bl $1@ B S 7R T 47—y x> b RS E Fxv o BLURY
o —IE W £ 2 L £ . SmartUpdate TiJ . Fortify Weblnspect Dy it /3 — s> i F] L
TV BNE I IER S Loun— B8y o— Ml 2 & BRI S 7.

77 Vr— av &L E) § 3/-0M1cSmartUpdate #3 1T § % & SiZFortify Weblnspect 23 2
TEE7( WEEdY)] A=2—m5 F7Ur— 25k € (Application Settings)] 1% 1 L.
R~— 7 v77— NSmart Update)] &R L £ 9).

Fortify Weblnspect 2 —# 1 > X7 x— 2 sSmartUpdate # 4> 7 ~> NTHEAIT T2 LLTE
9. CDz»IZiX . Fortify Weblnspect® B 4fi X—(Start Page)] 7> 5 SmartUpdate %
B 48 (Start SmartUpdate)] #i£ iR § 3%,  [P—i(Tools)] x=2—%*5 SmartUpdate] %

IR 4 2h, 23 Y—L3—0 SmartUpdate] KX %20y 7L 7.

AV EZ—F vy MG LT WA A MVIREE D & 13 T"SmartUpdate D5 47 (4754

N A= M21#Z R L TS0,

EE! 228754 XA A D4 . Fortify Weblnspect#3ifi ] 4 245 2 @ 7 74
vhSmartUpdate il & > TR - B s 28, oo —ERMFEIE L, 25T

[ A T4 VI AT —RANR IR SN B2 EMH V&9 . Fortify Weblnspect 77V 75— 2> %
RLE) L. — R RE T 2L ERDHNET. DD,

1. & (Edit)]> 7'V — 243 € (Application Settings)] 47/ L £ .
2. Rk 4 ELTHESIT(RunasaSensor)] iR L7
3. [kr4A7—KA(Sensor Status)] =V7D BAH(Start)] R x> &2V s L &7,

SmartUpdate D547 (1 > Z— % v MZH &t L T
254
Weblnspect#3{ > &—3 v MZH% 4t L Tu 335 & (SmartUpdate #5217 § 31214

1. MOLTNHhEFEITLET,
o V—L/A\—T BmartUpdate] #7Vv7L £7.
o« P—(Tools)] x==2—»"5 BmartUpdate] Zi%£ R L £7,

« Fortify Weblnspect® Bf & X—(Start Page)] 75 SmartUpdate DBf 4
(Start SmartUpdate)] #i% R L £ 7.
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7 w77 — K ] BE 2454 1k BmartUpdater] 74> R &, =Y
(Summary)] &7 HE R S 9. Br~USummary)] X7 IRDTAT LEXT
o— N9 2729 Dt DizfzA 0] e 2 HE DA >3 K3DR R Sh &7,

o Wil F /B IUEH ShicF =y

» Fortify WeblnspectY 7 +7 =7

e SmartUpdateY 7 t7 =7
2. 12U EOXvya— R A7y a0 IG §2F 2y /R v AEF AL ET .
3. (A7 Y 2NHH SN BF v/ OFF Al 23K 78 T 25121

a. PFxy/70s%4H(Check Detail)] 57 % 7Vy/L £9,

T DA NG EH SN BF 2y 7DID T BEPN—Y 3> /R T VR MHFE
NI EY. VA ME {BIN(Added)]. FE ¥ (Updated)]. & &8 Bil Bz (Delete)] T
IV—7% Sh 1.

b. B SN2 EDF vl aF RV —2MER T3, VA NTCEFDF v/ %1% R
LEd.

AT FBRY—D YA MY BiE £ Vi —(Related Policies)] XA > E x &
£,
4 (A7 D)EE £Z F 2RV —OF 4£ R~ T 2100
a. [V —0zE#l (Policy Detail)] 7% 707 L £,
FERMORA N EHOWEEZ TR —PEFIH T EER RSN LT,
H: COVAR MG FH SN 2F zv/ D& 22 3 2R ) —RUIRK R ST &
T, U —0F4H (Policy Detail)] 27121\ 7 v7 7 — M & Tw 31 fig
Y2 D 2ZDM DF Yo —ZE T (R Y —OF L\ F zy OB AT /213 A Y
—HOEE L E)ERIN SN FH A

b. ¥fE DAV —THF SN 2F 2v/ 8RR T 2Ud . VA M oR Uy —#IER L &
EE

B 1# 7 v 7(Related Checks)] X1 . B H s 37 =y /DID. & i« 8LV
A=Y 2 o5 3 UA MYE R SN ET. UA MNE {811 (Added)] . FF 37
(Updated)] . 8 &0 Hil Bk (Delete)] T7v—71% s &4

5. 7977 — b eA YA VT 212id. Bv>o—RDownload)] #7Vvy/L &9,

Fortify Weblnspect =8 i ¢ 912 F v/ 2K 7>
g— K9 3

AF PN EDF /5 EAT TR oY v DOEFH AU E T B N—Y 2D
Fortify Weblnspect 21l Fl L Ty WG & . A% v 71 iZSecureBase D F =y 7 D— #f %5

ITTCELVAREMERADH VE T IR TR OF 2ol LTCT77Vr—y %7 A MBI
& B N—2 2 DFortify Weblnspect 2 ] L T 305 FE203H DT,
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SmartUpdate DE AT (4 771 )

#7541 > DFortify WeblnspectiZx} L TSmartUpdate #3217 4~ 2121d « IR OF B WHE W £
ERD

ATF—Y i B

1. PR T —REEH LET. HAZSHR— MEYE 1o, F751
FTP#—OURL EZ o > & ¥ 15 W 2R (it S &4 (% Z 235 8).
SEAIC DL T TFortify 72 &= R— r DB W& b (M7 "
N—=v19])&#Z | L T &0,

2. AV R—FZ Y NIT VR ATERBRY YT A7 VFTPH—/NC 7 72 AL
9,

3. Fortify Weblnspect® Z %7 +v27SmartUpdate ZIP 7 71 )L # X > o—
FLET

4. Fortify Weblnspect23{ > A b=V S T 22 Y T ZIP 7 7/ v 367
NTD77AIERIE L&

5. Fortify Weblnspect #ff] U &9 .

6. fi IR L 7-SecureBase.db 7 71 )L & & U'version.txt 7 71 L %

SecureBase7—&nH 27 4L 72 MW aE—L £9 . 7 74 DI T

C:\ProgramData\HP\HP WebInspect\SecureBase

B> b Windows Tld. 7 74V FCIE N 6D 7L R IE K7~ S £
Hho 7ANVEFTL avH#BH LTRE L7740V R~ LTI S0,
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SQLA >y =7y av dld A E 2T et 030 230 7 2 M (CHIBR LW T o254 7 M
D7 —X%SQL 7T ffi H +8Web 77 V7r—y x> %8 H 4 32F % T 9. SQL Injectorid .
MS-SQL. Oracle. Postgres. MySQL. ¥ $UDB2D7 —&X—A KA 7 %4 F— L. H A
EAESCHEROSEDOY AT AL AT,

ER! COV—id. SQLY— N2 & >TULHE &h 3R] fEE O H ZHTTPEE K #/E Ak L
TEFET22LEN. SQLA >y 27y DI §5tE 27 A ML & 9. Web 77 V75— 3~
Ca—HIRMADF—ZEF ] L CF—ZRN—AL a— FEHEH $ -3 VE R Cx 28584 .
SQL Injectoriz & >THAUM L 3= F2MERL SN B D& T CD & Sl fe %
Bl B4 2720 EH 7T —RZR—AZK LTE TA AT OEOWT IS0 AL b e, 77—
AR—ZAD A—%5 i H T 20 BH F—RZ T Ve ATEL T AN A7 M 2
Dy T —ER—ADT —REFH LIz O8I BR LIz 09 20] GEME 23 b 3 X— 2B A 7 %
HR LTS, SN SDORE HIE LRI ENTEL VI H G EH] 7 —&R—2D 3y
7 7 #HAIAE R LI 92Ty 9 A MR b7 49 0BNE EAEETE & o1 B & &
WT A MEAT oTLIZ S0,

SQLA vy =27y Xkt §BE59 1 27 A Mg B2l

1. 70% s — %l LTOBE & . 720 87 v M A NCRGE 2 B 235 4 1
iR 58 (Settings)] 7% 7Yy L CllY) 215 2N 1 L&d . sEAH DL T, T'sQL
Injector D i " X—2 1171 &5 B L TS0,

2. b 71v(File)]> Fr#H (New)] z£R L 7.
- &2l -
[T 37 22 5k (New Request)] 71/ 2> 0 5 2V y oL &5

3. [|r—y =/(Location)] 71— N2, SQLA > 2oy zxt LTSS 2 b
URLZAN 719 2005 0fF 1 £ 97 IR OfF 45 1] L T2 80,

e GET XY v FDIG & (7T VN7 4 —KIFURLIZH A g £7):
http://172.16.61.10/Myweb/MSSQL/Welcome.asp?login=aaa&password=bbb

o POST AV yRDEG & (7T IVRIA—RIE Ay —V R L ICE F1 £9):
http://172.16.61.10:80/Myweb/MSSQL/Welcome.asp

SQL Injector®7 74V MEGET XY v KTH 2728, HE(Raw)] 27 (s BEa—

(View)]> EZ3R D% 7~ (Show Request)] Zi# IR 3 2 £E /x 81 £97) TPOSTE >k %
WETIZUNELDNET ME LIEREIIROL N L DET

POST /Myweb/MSSQL/POST/2.asp HTTP/1.1

User-Agent: Mozilla/4.0 (compatible; MSIE 5.01; Windows NT 5.0)
Host: 172.16.61.10

Content-Length: 22

Content-Type: application/x-www-form-urlencoded
login=qqqg&password=aaa
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vE: Fortify Weblnspect23SQL A > ¥ =73 s> Ofifi 5 1% 24k i L7235 & & . Fortify
Weblnspect®+ &7 —y 2> XA VTS Lt vy av 4G 2 Vv o(Elid Y~ XA >
@ [ §5 ¥ (Vulnerabilities)] #7 Cfifi §5 2 URL %4 2 Vv 2)L T ¥ 3= by b A
—a—»5 P—y(Tools)]> BQL Injector] iR T & £ 7,

4. BEfE(Send)] £2YUvsL .

SQLA Y 24y R § 56 RF—AKA(Status)] X7 BALA > 273 R
% #(SQL Injection Confirmed)] £E7r S, &£ F XA D A b Y—(Site Tree)] X
TWT AP E Y V—DR AR N SN ET.

2

File  Edit  ‘iew  Enterprise Server  Help

SAL Injector: SQLInjection_1.sdf = B

Y Mews Qpen Save il SOL Injector Settings ,_‘““Hide Request | Clear Request
p 1] 95 ||= q ]

Location: httpi/fsqli.qa.spidynamics.comiB0fmssql/GET/GET_inurl phpTid=1

] Get Tables Get Colurnns Get Data 4" Pump Data -

Raw | Detals | Hex | = |

- Stop Send

(Select a request action) - Anply

Search Text - 34 [0 RegEx
GET fmssgl/GET/GET_imurl. php?id=1 HTTF/1.1
Tzer—-Agent: Mozillas4.0 (compatible; MSIE 5.01; Windows NT 5.0)
Host: sgli.dqa.spidynamics. com
Site Tree |Data Extraction Set: 4 B Status Details Data Log

Database Detection

EL-‘ sqli.ga.spidynamics. comfmssql/ GE g Status SQL Injection Confirmed.
“{o]| | SQLServer(employee) _

ety F‘arameters(

Posk Parameters(

Data Extraction

Extracting Tables!,

Extracting Columnsi,

D 1oft
) oof0
O onofo
3 nofo
) Dofo

Extracting Rowsl:

£ >

Ready..

W,

5. ¥RTOT—7 6T XRTOF—REH H
VA LEEEER A A DA &

COMH [ D Z7DFEA (2D T, T"SQL InjectorD 27" X—2 1161 5 L T2 &

T 3121k F—24 H (Pump Data)] 71 =

FE IROFEEF LT, 77— ] 2RI A T 22886 TE T,

a. F—7)WOE 1 (Get Tables)] #i% R

LEd.

SQL Injector’s, Z—7"y b7 —ZN—AN D FTXTDT7T—7 VDL A #IR L£T .
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'Eite Tree [Data Extraction Set-

Ella zqli.qa. spidynarics, comn)mssaqlf GE
E .l___l SOLSery |-'rI|-r|||:|||| HEE::l
----- .Ej sysdiagrams
----- .Ej emploves
< >
b. 7—7 W EAT FAN TWBF 2y /R v/ RAEA > F1E A7 LT 7—7 I ZIE R

LEd.
c. B OELfF(GetColumns)] #27Vy/L &7,
SQL Injectorfﬁ BIR LT WH DIXRTDH DL R 2R L ET .

'SItE Tree Data Extraction SEt.

= IO sqll qa. spldynamlcs u:u:um,l'mssql,l'GE
BN R0 cerver(mployes

EI ¥ sysdlagrams

b L E] version

-[¢|[=] principal_id

- [¢I[=] name

-[¢|[=] diagram_id
-[¢|[Z] definition

EI .Ej employee
-[¢I[=] name

E id

< >

d. #HEAF TN THWBF vl Ry AEF Y A7 LT A 28R L £,
e. F—XOE 18 (GetData)] #7Vv/L £,
6. JIl #EIR L. F—X(Data)] x7%27Uy/ L DB 2R LET
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'Site Tree [Data Extraction Set. ' Status [ Details

-1 sol.qa.spidynamics. com/mssglGE Data for Table...[employee_employee]
EI[_] SGLServeriemployes)
ij sysdiagrams hame /
W =] wersion Alan Anyone
principal_id
name Clare Voyant
diagran_id David Donalot
; definition
BE employes Francis Fondue
-~ MIE] name George Theguru
LS ge Theg
Harry Hedunnit
John Doe
< > Kevin Kirk Mudgeon |

¥: SQL Injectorns7 — &4 H TE L WA &L BT %7 —&R—20D4 | 25
395288 5T, SQLA > Y 27y > Dfffi §5 Y DFF 1 ZHERR T& 20 REE A H Y
£9. COMRE 28 3hic 3 B2l I"SQL Injector D% & " Ik DX— | DT 30 /HF
fi] N—20DH 1 &S M L TS0,

CHHHTSI FEEn
"SQL Injector® £7™
"SQL Injector D% & " IX DX—Y

SQL Injector® &7

SQLA > v z7y av I § % &, SQL Injectorid X DA > 27 %K m LET .

R XA v
FRARA NG IR DETHRDH VLT,
o £ (Raw)-HTTPE R D7+ A MeF R L ET.

o 4l (Details) -Z R #. xV vy, BERURI, 8EU7'0 harDLs A M T TRR L
F4. BROANVE 74—V FEZOBEBE LB R LET,

o Hex(16# %) - HTTPE K 2161 L X TR R L & T

PR ARA Y ORIR &) 08 2 212id. B3R ORIR (Show Request)]/ B3R DIER R~
(Hide Request)] 7V v/ L &7,

TR #HI B LT7 741 hOhttp://localhost:80/1C B & 2 312id. EXR D27 V7 (Clear
Request)] #7Vy7L £9 .
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—_

T —ANX—ANA
ETORA NI IRDEATHDVET,

o ¥4 bV Y—(Site Tree) - URL. 7—ZX—R, 7—7 . 8LV 2K IR LET,

o 7—4i Hi 3% 5 (Data Extraction Settings) -7 — &0l i ¥ (iR S 27 —7u, 5. 8
ST OR KB LR LET. NSO RN E »ofl Hl S &3228, 2Ih FRE] XA
7R/ CTEHETEET,

4o >
H DXL NG IRDEATHDNET .

o RT7—ZXA(Status) -1& Hi 1% e S H A% BE DIEATIR I N—2 KR L& T,

o 5340 (Details) -7 —R&X— 2D R LF N 1] G & I A—ZDFFEAN 2R R~ LET .
o 7—&(Data) - Liz7—7 I SO ot il Shf-7 — 25 R R LET

o nZ/(Log) 1% ¢ 2 % OME T &34 LR 2 AR S &7

SQL Injector®Di% &
SQL InjectorDa% & #28 H 4 5121 IRD L L &7

1. R (Edit)]> B2 (Settings)] #7224,

2. MOWTNHD KT ZIER L. L FOL 7y s> T 424 5% E 218 € LT
o F7'v 3/(Options)(" 7> =/(Options)] 47" | 4% 1K)
o FAGE (Authentication)(" 27 (Authentication)] 27" X—2119%2% ])
o 7'mF ¥ (Proxy)(" ['u¥ v (Proxy)] 47" X—119%4% I])

3. OK]z7UvoL £7,

br~7"> 2>/(Options)] &7
&4 477 M#P)(Timeout in Seconds)
SQL Injector# & vy 3 48 T § R GZ 45 O [ R B e e L.
IR 88 3E F (Apply State)

T7Vr—y avhit vy av N OIR R 24ERF 3 27012 7yF— URLE & &IA & Fizid
POST7 —2OH 7 218 Fl L T 335 4 . SQL Injectorid 2D )7 X 45 € L. Z1IHE T
B EEE LEHELET .
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7'un¥ v O A (Apply Proxy)

ATy %8R ¥ % &, SQL Injectorls 2—4HEE Lic7 oF ViR B > CTE R %
TELET,

n/5C & (Logging)

D7 CELER T RAANY MEIER L &7

o FIR

o L&

e T o—

o TNNYT Ay—Y

a7 77 wikxmllE 3 T<drives>:\Users\<user
name>\Documents\HP\Tools\SQLInjector\logs!ZfR 17 St &7

B 774 DY EE X YYYY_MM_DD<current-process-id> &0 I ek V&4, ZHf O
B DD id. D& e Riwca s,

o sqli_debug.log: 2D+t v DT /N v7 Avb—YRNE FN FT.
e _errors.log: ZDt vy s> THRAE LIcz5— Rl A 35 & &9

» _RequestsResponses.log: SQL InjectoriZ & >Ti%k %5 SN 2E R UG TXTHY £
nEd,

7 — 44 H (Data Extraction)

SQLA > Y =7y /Zxt LTHESS AURLTT —R&dH § 3 L& IR SN 37— . 4. 8
U DI KB IR LET . N ADfEIE. T —ER—2AX A > D F—44 H 3% & (Data
Extraction Settings)] A7 \C t R /x S &d. N A6DEIE. COXT & 1E FRE
(Settings)] K4 7l #{FH L TEE T& 7,

ey 7 AE 3 3B AL v RO KB 482 L &7,
e 5R /BF ] X— 2D H (Inferential/Time-Based Extraction)

SQL Injectorid . SQLA > ¥ =7 3> OHffg §5 1% A58 ) S 7z 612 2DD5 % 27715 T
F—xEME CEET. TRTOR A HTTPIGZ ON B 2 N2 mF L 2 H LT
EAT SN EFT. COHENERBR LG E 2 B X—203 H EIFiEn 2208 O 1% %
VIR WA ] S BIENTEET. COFHFE TR 7—7 V7 —x5HE 42 b
N\ T —BAR—RY DF L F1Zxt UTERAT R ] 2 W45 OF —ZX—RA 7 T VEIE[E ¢
BET, T —BER—ADLHI #8153 T2 &l & 9. Thid b OFRF[H 23030 2L HE 12 7
BIEMH DI 22— IESQLA > =73 Vi 591 OFF(E i RR 3 2720100 B 4 3T
HefiEecEid,

~27odf# F (Use a Macro)

~/uEEH T35 5. COF IRy R AL BB AR 27 )y LT~ on%
IR LES,
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7 —&XR—R 7 71 )73 X(Database File Path)

COFE AB VE ] 7% A bR v7 A& SQL Injector Y — L 83U F— R ERAFE L, B8 &
NicT —BRX—2AD— R 2 W F 2720IMEK LIcT —EAR—AND NAABEK IR S E T,

2 A (Authentication)] &7
R EE *Y v N(Authentication Method)

HA NCRAL AN E 24 1d. B L(None)] ZiRIR L &4, 2h LoD & & BIE
(Authentication)] VA b2 558 FE AV v REEI L £ 7,

« H & (Automatic)

E: HEMH 2182 728 A% v o OULHE 2 <5 0Ed . 1R LT 27 O EE #
VORERTE T 58 AF v DA Tr—v A KIEWCH ELET.

« HTTP# Z (HTTP Basic)
e NTLM (NT LanMan)
R A & ¥ & 3R (Authentication Credentials)

E—44 (User name)] 71—V Fiz2—#ID%#A /1 L. PSA7—RF(Password)] 71— I
2= DNRRAT—REN S LET N1 3IR%P {Teowic. PRAY— FORERR (Confirm
Password)] 7 +—)L FIZ/SAT7— RE&E DR LA I L&T,

pa¥ 2 (Proxy)] %7
7'aF o4 — %/ LTSQL Injectoril 7 7 A9 3121k IR D% € 2 L &7,
H B4 (7 o+ &%) (Direct Connection (proxy disabled))
TaX = AEEH LawGEE. CO4TY v EFRR L ET.
7'n% Uik € O H 88 H (Auto detect proxy settings)

COA7y av %R 3 % & SQL Injectorid WPAD (Web Proxy Autodiscovery Protocol)
HHLT7ax s AHBRE 771V ER DT, 2N &M L7574 OWeb7 0¥ 23 & %
ITWET.

VAT LD ux vk e & H 3 3(Use System proxy settings)
O—AN ey yhe7 ax s — MER 2 v AR— M B, COATY o HIRIR LT
Firefox7" o L &% & #f# B 4 3(Use Firefox proxy settings)
Firefox/ 67 0% o — \ER 2 >R — T B2 COATY s ZRINL LS.
H: 79790705 R e LTH. 7af s 4—A"EH TV E&—2 v N T 72 A

TEDIRAEIE D DEE Ao Firefox7 20 D4tk € Nl 7 oF o L LI E ST 3
e, 7 aE A S EE A

OpenText™ Fortify Weblnspect (23.2.0) X—>119/360



IV AR
# 12: SQL Injector (Weblnspect® & )

PACZ 7 v fE F LT u¥ v 5% 5& ¥ %(Configure a proxy using a PAC file)
CDA7y %R 424 URL] 74—)v BIHE € LIz 7 71 )V D5 T (2 & BPAC (Proxy
Automatic Configuration) 7 7{ v 67 0F L3 € Bo— K3 9,

7'ax > 8 7R B 28k 2 3 3(Explicitly configure proxy)

7aF Y —NEH TV R—A vy MIT 72 AT B2 COATY 2 FIER L, R sh iz
HRMEUTOENN LT

1. f—73(Server)] 74— P 7' aF 49— DOURLEZIXIP7 FL A& J1 L. i C

( B— MPort)] 71— FiZ) R — pE 5 (80804 &) 2N JI L& T,

2. 7aF oy —EEH TTCP F o274y 3 270 havdD BA7(Type)] %
SOCKS4. SOCKS5. /-l fEHEsIEIR L &7,

3. WAL E 2354 &, BBEE(Authentication)] YA b s XA 7 HIEI L £,
« H 8 (Automatic)

FE: HEME 2B E 728 AF v O 268 e 0F 3. 53R LT 357 O
SE AV yREE T B AF v DA Tr—v R K CH ELET,

# 7K (Basic)
£4 Y A MDigest)

Kerberos

%Iy x— MNegotiate)

NTLM (NT LanMan)

4, 7oF Y —NTRAE PV E LG G E W 22— 8 LSAT—FEN I LET.

5. ¥ EDIP7 FLA(NEE 7 A MA M ENWCT 7R AT 217 md o4 —A"&F ] § 2

BE RO L. PudyEnNLART 391 NBypass Proxy For)] 7 +—v Nz 7
FLRETZEURLEAN I LET . 22 MR Y] 256 & v ~&H LT,

HTTPSH DR # 7'u+ > £#5 & ¥ 3(Specify Alternative Proxy for HTTPS)
HTTPSE: 4 22 UA N 27 0% 24+ —n0DH &1k, HTTPSHOREB 7uxs #BE T3

(Specify Alternative Proxy for HTTPS)] 7 = /K v/ A Z# R L, FR s iziEk 2N J)
LEd,
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SWFScanY— %18 | 4 2 &, Adobe Flash7' 5 b 74— A5 LT 3 s 1277 V7 —
DX 2T AR T IO BET . COEF K 4 Y—vid. Flash7 7 Vr—y 3>
R E AR EFTE ONEIE T 25 E L. 20 o8I B £7203 B B 4 277 7% 28] B (3038 ©
2L ET. WIS OFEA OO TIE T gy MEM " R 123 LT a0,

- 4l &

SWFScanid . ActionScript 2% & '3 (Flash/A\—2 2298 S TUM10) 2 © TR TDON—Y 2> D
Adobe Flash $ & U*ActionScript Z[i H O J5 ¥4 THHR— L &7,

AV &=y &zl > bZ2 v b L OFlashZ 7/ V&R A > N 20, B—Lav Ea—&h5

Flash7 71 )V #o— ¥ % &, SWFScanid . SWF /Y4 ha— %1% 2> /31 )L L. ActionScript

Y—AA—=RELEB L. ART 4w i #FAT LET. ZORIKRONEDL A— AT

&Ed.

o Mgt £5] &L CLIY—R 3— FO

. %%@Hﬂﬁ‘fifﬁ%n%“n%ﬂﬂi?%’&

o MFE KN DIRANSIFARIHARFA

iz Flash77'Vr—y av 2 F 8 T & 4 25 5 (AL DE E 2B INER (4 v h7—F >
7”?0&'. (BN %ﬁll F‘%%‘/Eﬂ?&&‘)éﬁ%ﬁt SN &9,

"Flash 774)1/0363\1% "R DNR—

e 55 1 A5

SWFScanid. X D X4 7DFlasht ¥ 27 i 91 27 X ML £ 7, %ODﬁEO)Hf‘fﬁ PEDF v
21 B % s 201 fF . (SmartUpdate 21 1 L C) SecureBase(ZiE Il 8L £ § .

SWFScaniz & > i S 2ActionScript 3DffE 55 14

Flash QUL | THESE s 1277 07— 3> Cld IR D X4 7 Offs §5 1 55SWFScaniZ & >THE
Han v,

o WATHENWTIOY ST DEE
o BAETHRWTZUr—y 2D
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e Adobe R N5 F A RIE R
o 1B RN

KR OF 2y 2D AN C OB TIE . i (Edit)]> & (Settings)] 1% L. Fzv”r
(Checks)] &7 #i#£ R L £ 7,

SWFScan(z & > T i &h 2ActionScript 18 & U2 Dff 55
Flash 8LL N THESE S 1o 77 U —3 3> Tldk « IR D 24 7 ONfs 55 1 #°.SWFScaniZ & > T
Han zd.

o WHEMEDH BIuRYA NRAIVTTF AV

o 2—FARME LT —REZ NN BS54 B AL
o« HETHWT Y FTDERK

o« BETHOLWTTYr—y 20D

o HEB R

KE OF 2y DrEA D0 TiE . BEE(Edit)]> B E (Settings)] ZiE R L. Fxys
(Checks)] 27 %R L £ 7.

Flash 7 71 )V D43 ¥t

Flash7 7{ v &5 ¥1 9 2121& - SWFScan# A &> F7a>y—v &L T, Z7zikFortify
Weblnspect®&i & 2> F—% v heLTEH T& £7,

ALy R7ary—) &L TDOSWFScanDff
A& K7 a>y—)v &L TCSWFScan#1# | L TFlash 7 71 )V &5 #T 9 %1214

1. SWFScan#ii2§j 4 2i2ld. R&— N> BPXTO7'vs/ 541> Fortify Security
Toolkit]> BwfScan] #7Vv7L £9 .

2. 7t 9 BFlash7 71 u(swh #FR € L E T IRDLT N »EEAT L& T,
o PSR Z/EURL(Path or URL)] 2> KK v 7 AT\ Flash7 7/ WA\D 7V A 2% N T &

123847 L. SWFScany—b i —7. B8t £ oo 54,

« P r1(File)]> B {Open)] #2Uvs L. a—#L A RL—Y 7 /31 2 AFlash 7 74
WEIER LT, B {Open)] 27 Vy/L £7,

SWFScanid. IR L7771/ 50— LT, W a> (v L £9,
3. SWFScanv—iA—7., @nalvze » o 5 54
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Fortify Weblnspectl TDSWFScan D1 H

Fortify Weblnspect D4 & 2> K —% > b &L TSWFScan %{#i i L TFlash 7 71 v &5 #r ¢
BT

1. AF oY OEATH FREFEATR I ROLTNLEET LET.
o Jr—y XA > TFlash7 71 (swh xR DI, 774 #4H 7Vy/L T ¥ 7 b
#y b A=2—5 P—(Tools)]> BWFScan] #i%€ R L £7.

= [Z]dy hittp: /A thack, com
=i i

‘;,} (Event) 1: ,onload
D J00crne_airpark2CB0, swf
[#][] 300cme_avalonZCED . sw
[#][ 300cme_haurlyrate, swf
300mm, svif

D ermnailer.php

Farm.htm

][ gallery.htm

D indez, hkm

& lwan 17 awf

o Jfs§5 ¥ (Vulnerabilities)] %7 CFlash®ff 55 1 # K S, i 5 3URL %47 2 Vv 2
L. ¥ 3 by A=a—hn56 P—(Tools)]> BWFScan] #i## L £ .

Risk. Counk Descripkion ~

et 1 [=l Flash¥ars Cross-Site Scripting J Request Forgersy

et 1 Unencrypred Login Form

W 2 =) Suggested Security Controls For Embedding SWF Files in HTML £
hikkps e, 3000, comy auflogo_1 3, swk v

£} vulnerabilities lﬂ Information l Best Practices 1@ Scan Log lﬁ. Server InFnE S

SWFScany—ivat @ L. W a> /&ty —Aa—Fso—FL T,

2. SWFScanv—iA—c., @analze ooy 5 x4

¥E: Fortify Weblnspect CFlash 7 71 )V &53 iT T& &3 . 2D/ 7 74V N E

( R* v>a% % (Scan Settings)]> b7 > 77 514 (Content Analyzers)] ic & 2) T
ZOBERE 2 T 2L ERH VLS. LhL. SWFScan Tl M. Lk . V—A
I— RN SNLTURLOD Z 2 AR — b, BLU 7740 T &l 7l D L AR— DA 5l 3R]
REWCZ& B7cD & DX DBERE Ll 1l 25 ik S & 7. V=R a— N &72ld Z D5 E D
NERE ST TEET(" Y/ —RAa— PO E" R DR—V 1 55 ]).

IHHH TS REn
"SR OHER" IR DR—Y
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"Y—Z3a—FORER" T

n":l % O)ﬁﬁ [EN

e SN -HE 58 1 D YR MASWFScanDAG T ORA VIcEK R SN 7.

YA MA OIEH & 7Yy LTS3 1E B 3 216 ) &R on L e 99 Mk il sanfzev a—iv
(LM OS> TC)R DT L&T.

§ ———————
= DWFScan Lo s i
Ble Edt  Help
Path or URL: O Dewenboads 3248 pad - & Get | W, Search |5 Settinegs | i Anake

&2 | publlc function handelassPaciet{angD: om. macens.mysd: Fr - Sourte | -] Properter @ Wulns |7 s
43| puble funtion handeEniPadas el :com. macdens. mysg:Pro -
i b Furetior hardeErrorDador e ginim madeva syvigl: Iy T Potential User Account Information Discosure
a» | bl function handlerextacbes()

€5 | puble function handeResponssadoe tlanglom, mackena. ey
o | puble funetion handef el S tFeldacet (ool com. madens.
o b funcoon handefesdtieFeicsfofacke [arpl:com mach
£
€
L}

5| publc function hendeResuitSetasderPaduet s gloom naden
€| publlc funciion handefesuitSeRowPace Harploom madema,
5 | bl fune o handefesutSs tlowaEoPace i pliooos . seck

n | bl Function newPadont])
b Repaiset

& private funcion castbndSe Vel (ar glodbnect, g1 com mads Summﬂr}'

| s Funetion mtflowanalsnt)

€ nternal furanen addCokumn{ar girom macema vl ek A potential information dischonire valnerability was discovered doe to the presence of a keyword that

§ Mt || et e ot sl s bl i e s code Reconmdis e
& PP —— removing this mformation from prodection servers.

5| publlc function ReniSet{arpl:comumadens. mysgt My SaToke

4| publc function et rumColmns() @ int I:'ix

o | puble funetion et tkaen) | cof. madlens. ey MySgToken

| puble function deposel])

2| publkc function firstt]) ; Bookesn

43| puble funciion geiBinary(argl: ™) : fash.utis: Bytedmay Before an application moves into productson, make swe @t is configmed secimely, and that nformation of

| puble furetion geiBlecinardangll:] : Bediean potential valee to an attacker is not being left & your application code. I applcable, remove this information

] b function getiobums() ; Ay ﬁ'mﬂ::pm&rhnnm‘u !

€5 | publc function getDate(argl ™) | Cate

€ | puble funetion petinaiaral: ™) : nt

e P e T
5 | publc function petRows{prgltBoclesn, ang Lint, arplont) : mx Severity = Name Fackage Class g
43| publlc funciion peiString{angd:™) 1 5ing

G
&
i B y
I~ Fyr—- 2 ¢ Dt 1] Fotestial User Accoent 1 commaciemasmysgl HandshakeHandia B
o bl Furetion Lt - Bosiean (Y] Dty Megpaging e fipghstil Lagper
€5 | publc function next() © Bookesn 1] Potestial User Accoont 1 ca 2 flash 1iPiayEvert
€| publle funation previous() : Bookean 1] Dt MEssagng comkongregateasd.dient: AbstracshadowSersie
) i3] pube h:w " 1] Potential User Accoont 1 commaciemamyngl Conpcticn
(5} lulrerabie] Potential User Aot Informaton Dedosre. || W4 PotestalUserAccount ] commaciema.mysgl Hysal
| inbernal statc function Server o tion() L] Fabentsl User Acceent 1 [Glabal] Playeresy
o mterral furction Sertr lnformia bonangl:com. madkema. mysd:: W Potestial User Account ] [Glabal] HySQL
Fl m 3

Y —A I— RO R

FEEDTFANLFEY . &G IBE LIEER KRBT 27 FANLFEI 2R E C& &
T

1. BZEXFF(Search For)] 74—V FiZ. 7F A MCFH - EHRFHR AN S L &
£

2. THFANCFH) Efd IEHL R I ORI F /N7 DX 05— B 2 Bl Fr oA %
BE T 212, KIXCFINICF #X B 3(Match Case)] F v/ v2 2541 L &
¥,

3. XA #EMEB LLCHM T 510l RegEx] 3% IR L&,
4. METHFE O V7 HIERLET .
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ActionScript 27 71 )V D5 5

T XTOY—2R3— (Al Source Code) —i¥f 2> /S f)p & fzy—RAa— R,

¥ € OFf | 2 ) v7(Specific Movie Clip) = VA ;23627 ) v7 %18 L 3.

k5 52 D 71— A(Specific Frame) — 7 V7 7L — A #IE R L &7,

¥ %€ D 7 5 A(Specific Class) — VA 6252 %1E IR L £7 .

5 € D £/ v N(Specific Method) — 7 52 & XV v NEIRAR L £ 7.

ActionScript 37 71 VD5 & -

3 XTODY—2Z3— NAIll Source Code) —i¥i a>/ A )L S fzy—Ra—K,

F5 52 D /8 v —(Specific Package) — YA tm s/ yr —Y #IE R L £ 7,

K5 %€ D 7 5 A(Specific Class) —/ S vy —Y £ 7SRRI L £ 7,

K5 € D £/ v N(Specific Method) —/S w7 —Y . 252, BEU AV vy FEIRIR L £
5. BRZE(Search)] #27VvsL &,

MR 45 R 25 R &5 B (Search Results)] 270 F 7x S, — AR # o Sh £,

SWFScani% 5&

SWFScan# & #1T IZid:

1. SWFScany—iA—. eS8 oL 25

2. SESFIBATCHTEETVEST . HFRXTODHREDFHAMIIOHWTE KD bV 55 IR
LT &0

o "AS20% 4" T

o "AS3DFR I IR DA—

o "7'm¥ 2 (Proxy)" IR DX—v

e "F zy(Checks)" ~—127
3. DKl#2YvrL &7,
L SN R SN 928, SHhDE->THM §2Ld TELEA. REL TR
Flash 7 70 L 243 B + 2icid ., @anavee w5y oy 200 8 135 0 & 4

AS2 D Ak

ActionScript 2/3 v —Y( A —AARXN=R) G T SR I TEE T DIz FFE D
Nor—o BT e 12 R4k (Enabled)] 7 =y /R v/ R EF AL £

B —CEE D BIESIE. COF 2Ry s A% F 7L ET,
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DA MR AN 218 I 3 212id:

1. EBiNAd)] %27V sL &7

2. E4Mv—v@iE N (Add Exclusion Rule)] 74> 7T, W=V DL ] & Ny —Y %
FLR T RIERI R AEAN I LET,

3. OK]z7Vy7L &9,

BN UV — IR 1213 HI BR TE &2, 7 741 bD L —)L(FlashiZ #E 51 7"5 V)3 25
HT&EEtA

AS3 D5 Hk

ActionScript 3/8 v —Y (A —AAR—ABE LUV IS R) N I TE £ . Z2D1®HIC
B DS — &1 2 A E A U s - 18 2D 4k (Enabled)] & zv 2 E v 2 A& A
izl &Ed,

DT AT —V el VR E DB E & COF v IR/ A4 7 LT,
Nor—PB L7 I7REERAIN VA MBI 3 2120

1. fBiN(Add)] #2VvsL £7.

2. Br4MV—LDIE I (Add Exclusion Rule)] 74> K7 T V=V DL & /Svr—v &/
& 772k §BIEMERIREAN I LET

3. OK]z7VvIL &9,

BN U=V 4R F - HIG T ACELTEETA. T 74V MOIL—ILIE B H CE F¢
Ao

7 1% 2 (Proxy)

MOA7y a2 RN L ET.

o HE B (7 o+ &%) (Direct Connection (proxy disabled)) -7’ % o +—/3 24 ]
LG &g, COA7y v #18R L £ T

o 7'0¥ LR E DH B H (Auto detect proxy settings) - D47 3 FIE R 5 &,
SWFScanY—vid WPAD (Web Proxy Autodiscovery)7' o b v 2l LT7 o+~ H#)
BRE 7AWV ER DU, ZR M LTT7 579 OWeb7 0¥ v ik & 217 LW &1,

e YATLDT7 o¥ VX E #fF FH 7 3(Use System proxy settings) -m— L v v 670
FoH—MER AL VRN B COF T RN L ET

 Firefox7' o#* v &% € £ F§ 4 3(Use Firefox proxy settings) - Firefox» 67 0¥ 34—
IER A A= MBI, COATY v #IER LET,

E: 7 o707 xRN E A LTEH. 7oF s H—N"EH T/ Z—2vMNIT 7t

ACEAMREEEIE HNEF AL Firefox 7o DR E NN 70X o L LJCERE SN T
WBEE. 7ux 3 SN E¢ A
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« PACZ7AV#EMF LT7 u* v &8¢ & ¥ 3(Configure a proxy using a PAC file) - PAC
(Proxy Automatic Configuration) 7 7{ )L 67 0% S E 20— R§ BI2lE . CDOATY 3~
FEIRLEd. 2. URL] 74—V RIC 774V OB T 236 € L £7,

o 7'ux v PR KCER E 3 3(Explicitly configure proxy) -7’ o > H— & i TA > &—
Ay MIT AT B COAT7Y av FIER L, BER SR EUL T OL AT L
EQ A

a. B—s3(Server)] 71—v Fiz7'oF o4 —/SOURL &7z IP7 L 2% N Jj L. %\ T
( f— MPort)] 74— Fi2)£— 1 5 (8080 % £) &N 1 L £ 7.

b. 7'm¥ 4 —EH TTCP r 74y 7% § 27 0 bavd BA7(Type)] %.
SOCKS4. SOCKS5. F/oldtEH#E sl IR L £ 7.

C. FRRENLE 26 &, FBAEE(Authentication)] VA M6 7 HIEIR L &7,
o H 8 (Automatic)

AT HEMR I 25 € 928 AF v DL B HE D& S IR LTH B[]0

EE A YRR E T B8, AF x> DA Tx—v  AE KIE A ELES.

# A (Basic)

£4 Y A MDigest)

Kerberos

23— MNegotiate)

NTLM (NT LanMan)

d. 7oF o4 — TFBAL AW B 43545 . 4 B—¥4 (User name)] & PIAT—F

(Password)] # A\ JJ L £
e. FEEDIPT7 FLA(NER 7 A MA M W T 2 AT 27 ad o —"&fi [l 2

WERE WG E L. Paxy e/ (/8273 541 MBypass Proxy For)] 74— Rz 7
FLZETZEURLEAN T LET . 22 MR Y] 256 & Av~&H L&,

« HTTPSH O E 7' u* > %48 & ¥ 3(Specify Alternative Proxy for HTTPS) - HTTPS
B et AN 37 ox o 5— 0551, HTTPSHORE 7oxv 2B E T3
(Specify Alternative Proxy for HTTPS)] 7 =v /R v/ A% A4 1z L, B3R s et i 2N
SiLEs.

o

[¢]

[¢]

[e]

[e]

7 v 7(Checks)

CDRAIE W av A S fza— RN OFEE O 1t 4 F 073 2B 3 RTH— B

LR SN E7,

F 7D/ — |k

7T 74 NClEL Fzy2D YR ML EKE (Severity)]JlH i v— bai . FE K (Critical)] 725
R2Z 7527 1 A(Best Practice)] N &V — h&N &3 . fFzy244 (Check Name)] T 7L

TRy MEWY— b2 F A LE2Vy L& BN LA OY—NEF #1124 3
i A RB LEe > E 2y L ET,
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F v DF NAE R

774V MCE YA M DF =92l $XTHZH TH Y. 2D &id B Z4k (Enabled)] 51 ©
F Iy IR 9 IANA N 5THBIETH MVET . FryrelEshicszcid. B
(Enabled)] %l O F =y /R w7 AEA L ET
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Fortify Weblnspect® + &4 —3 2> XA V2l 5 . WebH 1 b &7-idWeb+—EADE &
I 12U AR RN S, 2RI A THEFI M A sfc vy v RoR s &d. —J7 .
Traffic Viewer T4 . Fortify Weblnspect23i£ {5 L7z N TOHTTPEL K &, — 3065 5
LB HTTPIS & 4R 8 LCHERR $ 24T & 47

Traffic ViewerD A 4—

LR DA A=V AF v>D 574977 7V 5FRK ~ LT BTraffic Viewerz7~ LTy £
T

2 - o %
TV
Site Tree Y| | 10033 Results Traffic Q & &
Eh=] hﬁp://zero.webappsecur\é’ =
==V Request Start ¥ Host Y Port T Path Y Methc ¥ Status Y:I
€60 4/19/2018 5:15:51.7 zerowebappsecurity.com 80 ! GET 200 0K
[ %2e 4/19/2018 5:15:52.2 zerowebappsecuritycom 80 i HEAD 200 0K
E - 4/19/2018 5:15:52.2 zerowebappsecurifycom 80 ’ GET 200 0K
= : a:m 4/19/2018 5:15:52.2 zerowebappsecuritycom 80 ’ GET 200 0K
[ backup g 4/19/2018 5:15:52.4 zerowebappsecurifycom 80 ! DDDDDD 501 Not Impl
[ .bank 7| 4/19/2018 5:15:52.4 zerowebappsecuritycom 80 I OPTIONS 200 0K
L3 bzr f 4/19/2018 5:15:52.4 zerowebappsecuritycom 80 ’ GET 200 0K
O3 gibin 4/19/2018 5:15: zerowebappsecurity.com 80 1d GET 400 Bad Reqr
[ cobalt
= ‘;‘; = zerowebappsecurity.com 80 I BADMET 501 Not Impl-
[ docs : zerowebappsecurity.com 80 GET 404 Not Four
[ errors 4/19/2018 5:15: zerowebappsecurity.com 80 ’ POST 413 Request
E -git 4/19/2018 5:15:52.7 zerowebappsecurifycom 80 ! GET 413 Request
hg
~

a9 Jﬂ 4/19/2018 5:15:53.C zerowebappsecuritycom 80 [SPIfingerprint&04chk GET 404 Not Four .
»

HTTP -]

REQUEST Q, A RESPONSE Q A~
GET / HTTP/1.1 HTTP/1.1 208 OK ﬁ’
Host: zero.webappsecurity.com Date: Thu, 19 Apr 2018 21:15:44 GMT
User-Agent: Mozilla/5.0 (Windows NT 6.1; WOWS4; rv:30.8) Gecko/20186181 Firefox/3Ser Apache-Coyote/

owz =/ Acc

Ca must lidat .

Con -8

Con

Tra

=

4| | M | |
Viewing traffic file c:\users\| \appdata\local\hp\hp webinspect\logs\b30a504c-f81e-4b60-8fb1-e159649c5ec3\trafficmonitor:tsf

F7y aEE TRV ERD B

Traffic Viewer {8 Fi 3 212id . AF v> %517 9 37ij (Z Traffic Monitor =~ (Traffic Monitor
Logging)] A7y av #HG $h e T 2 END NET . AF v &#EA4T 3 %H0 12 Traffic Monitor
1/ (Traffic Monitor Logging)] ZH #hi2 L& L & 2D AF v 12 B L Tid Traffic Viewerid fii
HT& A, st 4l icD0 T M"Traffic MonitorD 47 26" I DR—2 1 2Z R LTS

LY,

ZaFxH—A
Traffic VieweriZld. 7 A2 b7 F TR E LTEIT CERAH O REE M O7oF v H— g8

IFNTHET, INEFH T 26 757 AHTTPE R 41412 L. WebH— 3085 2% 552
JEL 2 E&DT 574D M5 749758 51 © & £4 . Traffic Viewer7 o 213 7 /3 v/ 42 N &F
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i 4T 212D Y—NTH N, 2—HEH A 2T STX L N6, TNTOER EH—NILE %
H 2208 TC&%7,

1z, COBkRE 2ff A L C. Fortify Weblnspect T{i i © & 2Workflow~ 7 o*°Login~ 7 0%
BT 22E8TELT,

Traffic Monitor O %4t

Fortify Weblnspect Tid . 9 XTD R F v 7213 MEl ¥ DA F v i2x} L CTraffic Monitor 45
MCTEET

TRNTDRAF x5t 4 BTraffic MonitorOfF %4k
7 74 N& 5E TTraffic Monitor 26 %) (29 21214

1. ﬁ%(Edlt)P F 74w bD X% v 5% 5 (Default Scan Settings)] DJE i 7V v 7L &

2. Bﬁ& v E (Scan Settings)] X1 > T, B (General)] #/7VvsL &7,
3. Traffic Monitor® /52 §% %4 %2 3 3(Enable Traffic Monitor Logging)] %% R L
7,

¥E: Traffic Viewerld 8274y 27 7 74 VOl S 4k 29— L &€ A. Traffic
Monitor 7 71 )V %15 5 4. (Encrypt Traffic Monitor File)] 7'y a4 v #3 +5
T49 77 7ANH D BRE [ 2RV TDAMEH 526D T,

4. OK]z7Uv7L &9

il 7 O A* w2125t 3 BTraffic MonitorOF %1t

A% w27 — Fefli ] L CAF v 25 Uh 3 2 £ & Traffic Monitor 2 3 (2 2121 IR
DOFN»EFEITLET.
o AF YA — RO TR ICH B §EE (T 74V b)(Settings (Default))] ZEEH L. "<
TDAF vk 3 2Traffic MonitorOF 246" 1D AT v72-412HE > E 9,
o AF x4 — D FEAN & A v 7% € (Detailed Scan Configuration)] 7 4> K7 T,
Traffic Monitor @ %44 (Enable Traffic Monitor)] #i#R L £ 9.

Traffic Viewer D2 &

Traffic Viewer!d . Fortify Weblnspect &Fortify Weblnspect Enterprise THi] Ly Ty 2 A% >
DD R¥ v E R (Scan Info)] S A Vol F) TE & . COHIETY—VERE) T 32L&,
NZ 74907 7ANVDFR I~ St f-Traffic Viewer3f & £ 9. A% x> DI TAKXY K7 o>
V=W ELTY R 74970 70Xy D7 —RER R BTV EH (e TE T,
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BlOLWTWBRAF v s

Fortify Weblnspect &Fortify Weblnspect Enterprise THf 12 Tl 2 2 F > % 5Traffic Viewer
I E) T 2104
o [RF x> (Scan Info)] /% L ¢ Traffic Monitor] %27 Vv 2L .

[

| @ Dashboard | | d: i |
& Traffic Monitor

lattachm %—]
{f False Pos Detailed information about the network traffic associated with the scan |

E: A% v> %47 JAi 12 Traffic Monitor o7 (Traffic Monitor Logging)] 4 (2 L% w»
&. Traffic Viewerld il C& &¥ A

AR N7a>Yy—iL &L T
A&y N7 > DTraffic Viewer £ &) 3 212d . IROWT N HOEAE #5247 L7

« Fortify WeblnspectT P/—iv(Tools)]> Traffic Viewer] D51z 7 Vv 7L 5.

« Fortify Weblnspect Enterprise’® # 2> —)L ¢ P—(Tools)]> Traffic Viewer] DJH
/DA 3 g
N7 49707 0% > DT —ZNE /N SN T WTraffic ViewerSe &) L £ 9.

¥ Windows® R &— ] A= 2—7>&Traffic Viewerz 8 ¢ 326 TC& 7.

A R7—ADF H

D7y 3Tl BEFED77ANVER Tk, 4 MY U—DFEF 7. 7 Uy e a— &4l
Ea—DAARYARTT i 2= A ZT7—A(UNE K DA AL HE ik, BLUHE R
o—LOfFE OB TCER B L ET,

WE A7 D7 71 )L &f <

Traffic Viewer CIX D XA 7 DEEF D 7 74 IV 5B &, vy s &l NBENTEET .
o NI4Ty a7 7 (. tsf)

o LAYTBEFY LYY 2T 7 (. psF)

e Burp Proxy 7 71 v

e HTTP7—#A7(.har)7 71 v
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E: LA T axs vy a7 71 )(.pst) 2B <&, Traffic ViewernZD 7 7 )V & 7
T4 77 AN s LT,

BEAE D7 74 &BH Acid:

1. B QOPEN)] #2VvsL £+,
B {Open)] &1 7ul/ Ky Ak &£7.
2. FayZ X YR Mpbs, i 77V D XA 7 %RIR L £ T,
3. ANV EILTH &7,
Traffic Viewer Tt v s FE /8 St £ § .

YA M )—DfF A

HA MY Y—=IZIEs T 740 FClE AF v P IR ST RXRTOD NS T7492DY Y—E 2—
DL T RENTOHLRWREETCE RSN ET., VI—ZE. FA MR A M DT RTOHT
FALZNID YA MG FN EF. COP2—Tl I L OKR A MIERIR L THTT 4L 2 MY

FREM L. ZFLRUVTHAETIER GLE MR TELT. A MY V—TIHH 2I& R T3
ECEFDIEH D RS T749 003K R SN 1.

YA MY V—=D7 A av
WO TG A MYV—ICR RSN BTV LT0Ed.

742
¥ AW RLTWBRLD

=] H—/Fh A b A bV V= iE O b L)L
OB 7xvx F 4L 7N

O ~x—v 7714V

VY—2AD 5749 7DER I~
YA MV IV—NDIVY—RAD s 57490 8RINTEETIHH D NF74v 08K IR T BI2U4:

o A MYY—TIEH #IR L 7.
ZOIEH R T2TXTD 574900 V5749 2(Traffic)] 7 Vy RICER SN &9

FEAHICONTIE "2 vy 2 DF/E" X—2138 125 I L T &0,

KR NG DA D I~
FAMGEDEDVA NER IR T B
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WBFTXRTD b F7497L a—RERINT B2EVTEET . P37 4—K(Parameters)] #F 4l

—izig [FNF74v2(Traffic)] 7 Uy k& BIE 77+ v27(Related Traffic)] 7 Vv k67 7+
ATC&&ET,

INFA—=ZRIZDNT

INIA=RZIEIRDOBT N IR E T&EET .

o JyF—FT—X&

o HTTPZE 5k OURLO— I &L TRE (S S 3( 120 I O~ wRICE 1 3) 22 UL 5 5
o Post £V v #&Ad A LTi% {5 &h 327 —X(set_<parametername> 7 &)
INFA—LGE R DK IR

Y vy DS A— RO L T B

1. [l\774/7(Traff|c)] )y REfzid B N Z 74 v2(Related Traffic)] 7 Vy KTt vy av
EIRLE7,

2, [/iax—ﬂ(PARAMETERS)]wuwui@:
BN Lick vy s TR SN TOARIA—RNBER IR Sz P8 T A—X(Parameters)] #F 4l
Ea—25 & X7,

H: Al ba—DLAT77 MR B d P85 4—K(Parameters)] 7 Uy FICIEFEE L EH A

[~ 274y 2(Traffic)] 7 Vy RAND /A5 4—5F1 DIE hn

(N2 749 2(Traffic)] 7 Uy MIZH| #IB I LT P87 x—K(Parameters)] & 4l £ a—i2— & 12
SN TVBNRIA—RERIRTEET. [NF771v2(Traffic)] 7 Uy Rz 2 607 — &5 %18 i

OpenText™ Fortify Weblnspect (23.2.0) ~X—>140/360



IV AR
= 14: Traffic Viewer

LTHELE 77— 70—~ 7043 H LTWaEXIZ. Lyy 2> TIREE NS A—R5B L LT »
DEDE IR H CT7Vr—y avhenl 77 &N TH 20 EH [+ 200 5 235 215412
55 T4,

fz&Z1E. JSESSIONID /85 4A— XD #FK 78 LTHK £ v s TOZDME 2 X, £2TC
D S LT 20 %R T& 9. JSSESSIONID /8 5 4A—&DH| %, ZH 24T hE 3 2
%llset JSESSIONID &4 WCiB M L C BB L TR ECRER T IENTEET,
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£7% 5% (Response)] &77% £D X7 TR 3 335 £ « PropertyNameld 71— N7 o /3
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IEFL R B O OFF AT e Dn Tk TMIE R R B O " X—2 1491 25 8 L T &0,

OpenText™ Fortify Weblnspect (23.2.0) N—145/360



=)L H AR
# 14: Traffic Viewer

Bainsxy

PR L F %25 0O FHN T =B OB4 4 7T VERIT CE&ET. Pl 4 7T )eik
MDEIBREDTT,

Method=GET

Scan.CheckId=6

YouTube ¢, 2.
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<PropertyName> RegExp('RegexPattern',' /) - K L 7 &/N T #X 7 L&A WTHR R 2%
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K DY T RegExpi 3L D& DK 250 B L £,
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R & LVE ] ORRE

MERBLIVCEBRTIE, 70X 28 H LTRIE T 3HTTP Xvt—Y N O 7 F 2 MMl O
REBRDIEOON—IVEER TCEET, COBEE G B DY I2L—y 2 5[ F)12AT
I DIEHF TR eV — AR LT, R SN 2HBRERDEBVTT,

o I—HHRRNAT— R EDE T —XD~R Y
o FERADZyF—DIEN
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# 14: Traffic Viewer

o AcCeptE R N X 74—V REZEH LT BB CHFR SN B AT 47 XA 7 %IB N 7213 Hl
bk 9%

o BIRURINDER #/70AH9 A MRV T4V N BIETR T3

M2 B S UE B O (L Traffic ViewerD 7 o X L3 E TIF WET.BE 22Uy L TR E W
772 AL ET .

7 ¥ X MO R LH
BERFLEIGEDTFAMNERR LTCHE &R 2 3120

1. Bin(ADD)] %2 VvsL 9.
F 74 DTy FUNBF BN SN T,
2. zOx> MO BRIGHT(Search On)] %l X7 7V /L &9,

3. FOvwZ R R #7V9 /L C R T2 A=V U7 5B IR LET. A7 a3 IR
DEBNTT,

« RequestFull -E 3R Ayt —Y &k TRE LB 2T VW ET

o RequestHeader -Z 3k N & D 23 TR LB R 21T L T,

« RequestBody -Z 3K A L O 72U TR EE IR AT W &7

o ResponseFull -J5 & Ay —V K TR EBER T VW ET,

« ResponseHeader -Ji; & N\ v DH 21 TR EB IR 21T W E T

» ResponseBody -jt; & A X O U TH R LB R 217 W& T,
WO IGE Ave—YDE Iy R LTHWET,
RESPOMNSE

HTTP/1.1 382 Object moved

Date: Wed, @8 Jul 2815 2@:22:30 GMT
server: Microsoft-IIS/6.9
¥-Powered-By: ASP.NET

Location: banklogin.asp
Content-Length: 134

Content-Type: text/html
Cache-control: private

¢<head»<title>»0bject moved</titler</head>
<body»<hl>»0bject Moved</hl»*This object may be found <& HREF="banklogin.asp">here
IHEH #H

1 YN e

2 IBEAX
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4. BEXFEFor)]F i MR T 27— Xk 7 —2ERTIEHRRI)EAN 1L &

ER

5. B#7—4Replace With)] 5] 12, B Dmofc7 —R%&8 &M 2 27— X&N 1L &T.

E: BEXNZ(For)]sl % E#7—(Replace With)] 51l TIF # K Bl #16 F] 2
Zix. Regex] Fzy/A v/ AFBINL & T "LV— L TOIERRTOMAH" T 1%

ZHE LT s,

6. MEL—ILEFBEIMTIERT22E. A7 v71-5%42 ik L.

7. RHE(SAVE)] #27VysL &7

WL TODIE FL 3R B OfF

ER!
TW&ET,

DXy d . IE R BN SCOME 25 28 D L gl 2—5 DA x4 &L

E#a—riE. BREXR(For)]5 & B #(Replace With)] 51| D] 77 TIF # % Bi 28 H
LT R CERDOL—IVER E TEET. f2eZIE . 1IE#H £ B 218 ] L CResponseBody T
(<return>) ([*<]+) (</return>) 21 R L TH Do ol 7 — R %$1< | [CDATA[$2]]>$3 10 B &
AL —IEH T 2E COMBIL—IIZED, LR IR T2 E AN A0 22827k

NE9.

This Response Value...

Is Replaced With this Value...

HITE/1.1 200 OK

Date: Fri, 31 Jul 2015 14:FZ:40 GMT
Server: Rpache/2_0.63 (Win32) DAV/2 mod suth sspifl.0.&
PHR/S5.2.5 mod =s1/2 0.63 OpenSSL/0.5.7Tm
H-Frame—Options: SEMEORTCGIN
H-Powered-By: PHE/S5.Z.5

H-Token: CH455E5478

Content-Length: 207

Esep—Rlive: timsout=15, max=5H
Connection: Hesp-Rliwve

Content-Type: application/xml

<?7zml wversion="1.0" encoding="UTF-8"7>
<Data xmlns="http://scanms/sexvi(l">
<Body>
<testResponser

<resultrrecurn</result>
<return*2ZZIZ</return
< /testhesponse>
</Body>
</Data>

HITES1.1 200 O

Date: Fri, 31 Jul Z015 14:2Z:40 GMT
Server: RApeche/2Z.0.63 (Win32) DAV/2Z mod suth sspi/l.0.4
PHR/5.2.5 mod_=s1/2.0.63 OpenSSL/0.5. Tm
H-Frame—Options: SAMECRIGIN
H-Powered-Ey: PHE/S5.Z.5

H-Token: CH4S5e5473

Content-Length: 207

Eeep—Alive: timecut=15, max=58
Connection: Hesp-Rlive

Content-Type: application/xml

«<?xml version="1.0" encoding="UTF-B"7>
<Data xmlns="http://scamme/servi0l">
<Body>
<testBesponse>
<resultrreturn</result>
<return><! [CORATA[Z222]] ></ return>
</testResponses>
</ Body>
</Data>

FEA I DL T TR R B Ol " X—2149 1 25 18 L T2 S0,

L—)L DiiE

FRNIGBENLV—IVERR SN TOHBEF CIEREH SN 4. 128218, H2L—n
HTTPS #SSLIZZE L. 2018 124% OL—IVSSLASECURE IS T 4 235 4 14 45 B 1Y

WCHTTPSH/ASECUREICE F S £77,
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IV AR
= 14: Traffic Viewer

V=L DA B

W—IVER BT BT

1. At 2Lr—1D BER(Enabled)] 7 =v /R v/ A% 4 L&Y
2. {R7E(SAVE)] &2VvrL &7,

=L D HE Ak,

NIV [ ] e ) R Y N F o

1. 5T 20— D BR(Enabled)] 7 =v /R v/ A% 471 L £9,
2. RFE(SAVE)] £ 27YvsL £ .

=V DH fk

WV EHI B 9 2120

1. IR 20— 58 IR L ET.
2. BIB(REMOVE)] %#2VysL 7.
3. BFE(SAVE)] 52Uy rL 7.

JL—IL D £E

IV EHR R I B

1. BEIG P (Search On)]%1. BREXNFK(For)]4l. £72id BE#7—X(Replace
With)] 51 D> bUx 2 Y950 £5.

2. TREEHELET,

3. BFE(SAVE)] %2y rL 7.
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= 15: Web#g H

Web Discovery #ffi Fl 3 2 &, T2 &—7 A XEBE N CH O THL 23T NTDKRA MR T
FES

- 4l &

Web Discoveryld (1§ 7€ SN 7zIP7 KL A ER— FDFEIFH N D) F R CDA—T7 VR — M7y
PEIEE L UGB N E OB R EM R LA R 28R L &3 . Web
Discovery(Z i . Web Server £SSL Web Server &£ 55 | € 5§ SN 12200 /37 v bV &
TWET, SR ADM 712 IROHTTPE K 238 g T &9,

GET/HTTP/1.0

Web Discoveryld . HTTPJG & 2 X T A THTTPI #88 K L. 2O F 4 AR, O 3
&L ZDIP7 FL AL £— 5. 8 LU TWebServer] £y 97 ¥ A baE IR L. 612201
Zy F—ANDZH EN—Y BT EHIR T 25 AR A ShIE R R R 045 R 2%
ALET.

M SNz —SDYVA M TF AN AAIWARFE CE LT,
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V—ILHA N
# 15: Web#é H

Web Discovery V—v DA 4—

WDA A—2E ., H4 bOMH D72 DIP 7 ML A8 P AN 1) Sh 72Web Discovery V—L %
ALTHET,

File  Edit  Scan  Enterprise Server  Help

B Start ] Pause Stop @A Settings

Search Addresses

IPY4/IPYE Addresses (or ranges) Ports {or ranges)

|1:-'2.15.10.0-1?2.15.10.29I | 80,443
Example: 192,163.0.1-192,165.0,12;172.16,10.20; 2001:0db3::1425:57ab  Example: 80-100;443

Total IP addresses specified: 30 Total ports specified: 2

Discovered End Points

Selection IPAddress Port Identification

B A O H

Web Discovery #3217 L TH A1 btk th 3 21214

1. [PVA4/IPV6 7 FL A( % 7zis %1 [ ) (IPV4/IPV6 Addresses (or ranges))] £ v7 &2, 12
LLEDIP7 FLA(&72IEIPT KL ZDF FH) 2N 1 L& d .

e WH DT FLAEX Y] 2121k, 3gav s L7,
#51:172.16.10.3;172.16.10.44;188.23.102.5

o HIHH DBHIGIP7 FL A TIPT FL AZX Y] B12ld Ky a&fzlg A7 & L
9,

f1:10.2.1.70-10.2.1.90
HIIPVE T FL AGFE IR CHl O B A H D& 3. B 218
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% 15: Web#s H

o O

o http://[::11D3% & -
Fortify Weblnspectid l'localhost] # 2+ v> L £ 7.

* http:/[fe80::20c:29ff:fe32:bae1]/subfolder/ D% & :
Fortify Weblnspectid . 1§ & S 727 L AD K R hD R F > %[ subfolder] 7 1L
7 b eI L ET .

* http:/[fe80::20c:29ff:fe32:bae1]:8080/subfolder/ D5 4 :

Fortify Weblnspectid . £— N080TH 1T St T 34—/ XD AF v %
I'subfolder] 2> 5B 45 L &9,

R — N & 7zi % 8 )(Ports (or ranges))] K v 7 A2, A¥ x> 2A— &N LET.
s WEBOR— X Y] 212id. £3Iaov A LET.
11 : 80;8080;443

o HIPHODBAMf R— b T A— b2X Y] 212k Ky adicld A7 & LET.
f1: 80-8080.
Web Discovery Dik & #48 ¥ 3 2121 R E (Settings)] #2707l &7 . sf 4 D0
TlE. T3 5E (Settings)" X DXA— | £F B LT &0,
B #E(Start)] # 27Uy L TR 7' o 225 4 L& 7
R0 B stfoz> PR 1 > NDiscovered EndPoints)] T V7R /R SIL & T
[P7 FLA(IP Address)] 5 DT> NU%E 7Yy s LT, 204 A (779 TRR LET.
i 5 (Identification) 15 O > pUE 7 Vv 2L T, e vy a7 037 4(Session
Properties)] 74> NV &5 & A OE R & 2R L &7,

& oA NORE AT

M SNz — D YR MR AE T 3120

1.

2.

P 71 v(File)]> 7 AR — MExport)] % 7Vv /L £7
T —RE.CSVZ7AIVICTZIAR— N B &, ZHL6DIP T NL A7 74 hDFortify
Software Security Center 77 V7 — 3> NE T, L 6D 77V r— av ERf i 7 —
K&\ Excel T4 5 T & £9. 20D1% . Fortify Weblnspect Enterprise TFortify Software
Security CenteriZ 2L 5D 77 V77— av %A R — b C& &7 . 5F 4l (C DL T | Fortify
Weblnspect Enterprise DA > 54 >N L7 %5 Jf L T {280,

BREED T 7 ANWIEIR 74> FYEMH LT 77 0OVICK T 247 O TR L &7

IHL5HTHR Faw

"5% 5 (Settings)" X DX—
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#= 15: Web#s

2
34

iE (Settings)

Web Discovery Y—L D% & 425 B 4 31214

N —

w

B

7.

fR 4 (Edit)]> B (Settings)] #7Vv/L &9,
P'o ba DR (Select Protocols)] 7 )v—7"C. 7’0o haw g OB O F =y /K v/ R %
Iy EE AL EE T2 7y hERIRL & T
B/ 8% (Logging)] 7/ )v—7"C. oZitit ¢ 2E R ZRN L7,
o F—7vR— % n/it#R(Log Open Ports): + X b T Y &0 748 F AT BE 22 4
TOA—7vR— 207508k LET. Web— N\ ER DA 207 771V IRAF L &
ER

o —ERA%#u/EL 8% (Log Services): 1 Hi H (i i S fzF R TCDY—LRE 7 IZED
ELET,

o Web#—/\% /50 8% (Log Web Servers): i jill St 7-WebH— &0/ (Zit #% L &
ER

7 DRC#R 56 (Log To)] & v/ A7 7/ VDG it & N )13 %0 BIKFL 'S ARV & 2
Vo7 LTIRED 7 7AWIEBIR 74> R H LT, o/ 2> MERLE T 27 71V &8 €
L£d.

B4 277 17 4(Connectivity)] 7 )V —7"T. IRD XA L7 7 NIV &k @ LE T
o &t 21 4 77 MConnection Time Out): IP 7 FL 2551 3R AR S 4 Wi & 12,

Web Discovery 7 i — hAF v #1513 2 £ TR 1 215 [ .

o %15 24 477 MSend Time Out): Avt—YikfE #UE— NPT FRA > Mizxt L
TIT HEEW IEENR I/ SRy y M E SN 4., T8 E SN N weIP=>
BARA > bAEAE A7 v MEZERER LA &, Y7y NEP Con, 2Oy FRA
¥ RO Clr—E AR Sh &t A

o 218 21 477 MReceive Time Out): VE— NPT KA > MZ Avbt—Y #1E(E T
BEXIZIEBN RGN S Ay NSO E SN 7. 1558 Sh IR [H 9 1cWeb
Discovery YV —IVNE(E A7 v b &% 5 La W& Vry M Cen., 20> PR
1> MO H TlEH— AR Y Sh FH A

V47 v MSockets)] K v/ A% H LT A—7"> V7 v bOF £ L &5, A—7> Y

Ty NDEI ML VI E. AF v>EIEICE DET . 12720, T— DL EWHE % 2 28

FRE TR R R AE T A R AD VLT,

OK] #2Vy 7L CTHE#H LIz 3R 20# 77 L. Web Discovery] 71> IR DE7,

(R AR—MNEELG D DL T AT ADZL AT TH D Y—EAB A v NT7— 214t T 5
FAY b ¥—ERIG[H] 7—F 7 7F v Tl 10D F v b7— %t 5H 12200 T R A > b3
R L. — B — AR 3 20 fh 7 Ny —e 2% + 2] &% 3. Webs—EAT
d. T PR A > MIURITHE € sh 3)
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IH5H TS JZan
"Web#f i " X—160
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= 16: Web 74— L4 17 14X

X EAEDWeb 77 V7 — 242iE AN JJ 3> bo—(TF A MR v I AL KXY, RayZ Koy
VA Mg OIS FNT 74— LD VET . 2—FEBEH AN 3> ro— V2B H(T7F A M
ANHLEO Foy Ry REER LIz 0§ 25 ) LT 74— L %2158 1 SETHe. ZD 75—
LEMH DIl T—y 2 MIEFE LET. B . COUHMT b 28 22— & 777
Ty DR DR—Y Ffald £ 7o s B H) LET. 12&21 . o/ 4> T75— LN T3
2R TTVr—y DI RN—T I A T,

AF XF DT TNVr—3 av N ThEBIEDTEBRITXRTDN 7EF 7y — b 3720121 7%
Tr— LY T — REIEAE T AR AL B IR DE T,

Web Form Editor it ¥ XTDN FJ 2> br—L D% 5 & WebH 1 ~D R F v 12ik =
TE2LERNDZZNSON ) > ho— VO EE 25 AL 77 AVEER EE BT T& E
T, N A0y MIFURLI &I HE SN 2D T, HlDR—2 2 H B[] D a> ba—Lic[E U4
B oM LT 2354 T 6. Web Form Editorid 2N 65X | T& 4. — T FEED 74— LA
TURM)EN o=V ELTIRE TA2ETEFET [T o— L] L TIRE Sz MY
fE & EOURLIZH 20 BAR % < B CH T @ M 2FF DT XTOAN J7 2> bo—mizxt LT
EfE SN ET,

ER L7740 DTy MEE LRI B IE A —F La WA S 3y ba—v s AF v p 2k H
L& AF v FHid 7 740 ME(12345) 2155 L9
TA—LMED VA MAE R T BT 1EIE IRD2ODB3H D E T,

e FEITYRMAER T 5.
o TV —y 2N EF S — N SHE 5ELEE T B,

Web 7 +— A DL 53

Web Form Editorid . 7' 574 £&—4" v \Web+ A Ml OHTTP v 574y /&0 3 27 0% >
ELTHERE L& . 7740 Tl o— VP 7 L 2127.0.01 Sff AT RE 2 R — b2 L
F¥. 220 A (Edit)] *=2—»5 FE(Settings)] #E RN LT, JI DIP7 FL R &Hh—
NEfRIE T BIENTELT,

Web# A b E DN J) 3> ba—V DL | Ll %% v7'F v 2124d IR DT R L &7

1. Z+—AMMEDO VA MER T 3121k Prfv(File)] x=2—»5 HiFH (New)] i L £
F(Efeld Y= A—0 Bl (New)] 74 a>% 27090 £9).

2. BEAEDYVA M 74— LMl #B N 2i2ik. P rAv(File)] »=2—»5 B {Open)] %
IR L( ik y——0D B (Open)] 714 a>%# 27Uy L), BEHED 7 7/ WIRIR KA T
a7 Ry AEMGRH LT7 7/ IV EER L E T,

3. TI7HDT FL AN—%f ] LTURLEA J1 72138 R L. 7+— L0 E 2 T 3 —
DIHENLET .
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V=L HA RN
%= 16: Web 74— A4 7 41X

4, Tr—LEERSEIEE LESEEHE .
Yost B ETIELE Sh ).

B714Y]. BfE]. BolaLorxr%ss

5. ZOMDR—VUBE L TT7+— L5185 LET. INE, LEBLERDHZTRTD YV

VT 2ETHIT ET,

¥ Untitled® - Web Form Editor

CBEX

File Edit View Help

Smart Credential Username
Smart Credential Password

Mark As Interactive Input

X Delete

A"
MName Type Walue Length | Smart Cred. | Match Type | Allow Hidden Submission | Form
http-//mail .alltel .net:80/servlet/Login
PASSWORD password \Whackadoao Mone Exact False loginForm
USERMAME et dthackery@alltel net MNone Exact False loginFom
jeCapable hidden 1 Maone Exact True loginForm
LOCALE hidden en_lU5_base Maone Exact Trus loginForm
WARIANT hidden consumer MNare Exact True loginFom
http-//search.windstream net -80/_1_2B3G TRCO3FVKEDC__ wind main/search/redir htm
F — Mane Exact Falze idxSearch
g Add Global Farm Input 0 Nore Exact Trus ideSeanch
r Make Global PR4FSREESF40F1230 O None Exact True idxSearch
r_| Modify Maone Exact True idxSearch
r] Nore Exact Trus ideSeanch
Unselect
Select

Browser's Proxy Address: 127.0.0,1:1147

f2eZiE. ERL D VA MDELIE D2OD LY ME IROHTML 757 AY bh&f3 126 DT

ER

<form name="loginForm" action="/servlet/Login" method="POST">

<input type="password" size="16" name='

"PASSWORD" >

<input type="text" size="16" name="USERNAME" value="">

<input type="SUBMIT" value="Submit"></form>

2 H S DL ERAT—REN I LE LT
6. BE G LT T MEA UL, 3 Ay MR 7 T v7) A =2a—%F H L TIEH

RETETCEET.

o TV INVEHE T Bk BE(Modify)] 2R L&,

o IV NIEBINY BIE. P a—rvZr—AN ] O I (Add Global Form Input)]
FIEIRLET. Jo— vy MUK K OURLICBH A S st T AL hYT

R

o TV NUEERANT B, IR (Unselect)] Zi R L&, Cnicdn, 20>
MOIEALEL X R s SRR Ah S & F. 12720 774 Bl BB S &€ Ao

OpenText™ Fortify Weblnspect (23.2.0)
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V=LA A R
% 16:Web 74— L 7 4K

7.

o TV IUEHIK I 21k, BEIEX(Delete)] #iE R L £7 .
o TV IEAT— MEKIEIR ELTIRE T 210k, Rv— MEKER 22— 4 (Smart

Credential Username)] £7:1& R~— M&# 5 #t /S 27— F(Smart Credential
Password)] #3i#4R L £ 3. sE 4N OLTiE . MM Av— SR 15 " ~—21761 4%
HE LT IZS0,

A% v F TOAF v Eo5H] I — K E 1L L. 2= 12Oy NIOE DN J1 23R
274 RUERRT 22 REEHEAN I &L Tv—2(Mark As Interactive Input)]
FIERLET,

AF v} DAT7Y 3> Web7+—LMEH DN 7 #23K 3 (Prompt For Web Form
Values)] 23R s T 3354« A% vFH I EHTTP 74— 4 &/zidJavaScript 74— 4 %
M d 28 AFvre—HEIL LT 2—FR7+—LHN DN F] 3> bo— LD %
NN T 200740 PR RLET. L. AF v+ DAT7Y 3 RIS ENTTD
& % 3R 4 2(Only Prompt Tagged Inputs)] #3A] B (218 I S T 335 & 1 57 E
DA F1av be—uiz 58NS &L T>—2(Mark As Interactive Input)] 35 &
ENTHRWLIR D, 2F v ld 2—HF AN DD Z 1E 247 W EFEA(F2E L, /SR
7RO E G &ET. NAT— RO G AF v F I E R fF IR LT &3k
» 7).

P71 V(File)] A =2—H»56. fRFE(Save)] 7/:1& &8I #4F F TR 7 (Save As)] i

RLET.

Web7+— L DfE & F 8 CIEIN 723K E ¥ 2

Web 7+— DIl 21BN &7 28 B 9 5121

1.

2.
3.

WOHBTNEETLET,
e Web 74— 2 DMl %18 i1 3 2121% « Web Form EditordfE 3 = V7N O & 0I5 fif %

FH IVl v a— Ay MR o7 7 v7) A=a—ms6 Pa—s v 7x—5N 11 DE M
(Add Global Form Input)] Zi#&# L £ ¥,

e Web7+—2DE 27T 4 212i&. T2 MNEL ZVvI L. ¥ 3= My MR v7' 7 v7) £

—a2—H5 BEE (Modify)] #i#R L 7.
E—+5E A\ ) D& jn (Add User-Defined Input)] 7 4> N7 &7218 [\ J) D25

(Modify Input)] 7 1> RUNEK R S F T
B AT (Name)] K v/ AT AN E X OLAT B 2N J1(E/3ZEE)L &
E &(Length)] R vZ7 R IR DWFNENTILET,

o SAXEM TR T 5ME.

o Yr(HAXEIE#EE LEOANTTER DG E).
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V=LA A R
% 16:Web 74— L 7 4K

Tz 28 IROHTML 7 57 A bDTF — 2% (5 § 285 6 . ..
<INPUT TYPE="password" NAME="accessID" MAXLENGTH="6">

... B R (Name)] izaccessID#45 € LTCOL R DT> FEER L. E &(Length)]
WCHART6l 248 E T 2L EBHVET.
4. fE(Value)l A v7 Az N E R CHIEAT 27 — XA AT— e E)EN T Li@“
5. = (Match)] VA &I LT, 2O pUAERE DN F1 3> bo—)L D% 5 12l
LTWEdhEAF v 388 2% MR EABEE LET. A7 3R DEE V)m“o
o B{% (Exact)-\J] 3> buo— VDA FIEYEL. SO bNCE] 0 Ton 24T &
TR LTORLERDNET.

o IR TIf % 3(Starts with) -\ /7 2> rp— L DL BT JEPE . COx> picE 024 T
NIZRT TR £-oCOR BB ERHVET,

« & ©(Contains) -\ Jj 2> ro—VOL HIEPE . SO MIZE] Y Ton f24 i
BT ENTOILERDH VLT,

6. 7l 5=id. 774 7Y b —/ O] TR S 21E R B F EHTTPO X7 — hL A&
WHEE DIk bl TL E D) &R A7 T 572012, type= "hldden"’&f'aﬁﬁ LieANJ1ar
bo—v&HH 22805 0ET . Web Form EditoriddE R m D 2> bu—LOJE M %
UL LTRAR LETH, AF 513 BERRIE(E %7 7 (Allow Hidden Submission)]
PR SN T wé ERRDaY ho—VOE 245 LEE A

7. 1BiN(Add)] #7216 BEXE (Modify)] 22 )vsL £9.
8 MEIWIL LT MEA ZVvI L. ¥ = My NHR V77 v7) A= 2—%E ] L TB I
DM EE| VM CHIENTEET .
o TV NVERRANT Bk, BN (Unselect)] 2R L £4. Tz &0, %1/7
S INF ALY ZOZY PNEALE S R ofR A S & T 1220 T v s
Hil B S &4 A

o IV RNVETITATIZT BT %ﬁi(Select)] FIBEIRLEST., INWCED, Fryrv—
It & ZDTY PUBSLEE X R EL TR E S E .

o TV IUEHIKR T 2CiE. BEIBX(Delete)] #i# 4R L £7 .

o IVNYEAY—MEIER ELTHRE 7211k, Rv— MR B IR 2—4 (Smart
Credential Username)] #7:id R~—FMEIBR S A7— l~“(Smart Credential
Password)] #3i#4R L £ 3. sE 4N OLTiE . MM Av— FE B 15 " ~—21761 4%
HE LT IZa0,

o KEEBIN J1 £LT~v—2(Mark As Interactive Input)] #1Z R 3 &, AF vF 23R
Fyre—HFIE L. 2Oy NIDIE DN SJ #R 274> RURR IR SN ET(A
F ATy 2N RF 2 ICWeb 74— AH O 77 #E 3R 3 3(Prompt For Web
Form Values During Scan)] 8 $ O gZ7f} EN 7 D& #E K 3 3(Only Prompt
Tagged Inputs)] Ok & 237 £ 2555 ).

% WEER N J1 £LTw—2(Mark As Interactive Input)] 2 ] L TS 27— K
CRTEMNTZLBEEHVEE A
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Y= A A K
% 16:Web 74— L 7 4K

774D A R — b

DA D /3= 2 DFortify WeblnspectH (5% 5t 8 S UME I S fe 7 74 v &4 >R — LT
I {E ODWeb Form Editor Tfff FH T& 27 7/ WA T & &7

1. PrAuFile)] A=2—n5 K> &— NImport)] ZiEHR L £,
Web 7 +— 448 D%2 # (Convert Web Form Values)] 7 4> FURFER /R S £ 7,

2. HYR—pT 3771V D (Select File To Import)] D icH 25 R K> e %7
VoL &7,

3. D77 WIEIR 71> MY EfF L T. Web Form Editor® Pl §f D /3—2 2> TfE %,
SNIXMLZ 7AWV ER L &7

4. B—4 v b7 71 )VOEIR (Select Target File)] Dt icd 2 R x> 27 Yw /L &
_g—-

5. BEDT7 7 WER 74> PO H LT BRIZE D77 VD7 713 85 #15 E
3

OK]#27Vv7L &9

o

My M AZ2—

Web Form EditorDfE 2 T U7 %545 2V 0§ 38R I8 SN BR v7 7 w7 A= 2—ms6ld LLR
Davy e T&Ed.

avwy N o B

Za— ) 7r— LA B—+5E F& N\ 7] Di& I (Add User-Defined Input)] 74> F7 %%

ANSTDEMADD  RLET. 2—FE D74 FYTAN S 3> be— V0L R, & &,

Global Form Input) & & Uil £45 5& T & & FFANC DL T T"Web 74— L OfE 2 7
B TIE N &2 2 92" X—U1671 2 | L TS0,

Ja— e 3 BIR Lz YRR E OURLOB AT 2R L& 4. ch 247 D

(Make Global) & AF ¥ FE Oy NIOZRTE M 24 DA J) 3 be— L ER
HLice&iz, 20 ay bo—vo AT iR % B 23515 72 £ 912
ZNES.

25§ (Modify) IV MNOLRT R Sl BIO B (70BN 2 FH T &
ER

I R R Ty M ES s e F 2y R v REF AL ET . 2D MY

(Unselect) G SN &R A. ¥y NI LEZOR—V UK R L

TH. TV MIBYRA MBI SN B3I HNEL A

OpenText™ Fortify Weblnspect (23.2.0) N—>169/360



VIV AAR
= 16: Web 74— 4 L7 41X

aer R i B
12 4R (Select) T MBI e e F v Ry REA LT IRIE SN B Y

AMIZFDIZY PUBE EN B LN 7.

Av— MEHIEIR 22—y NEAv— MEKIE R 22— 4 LTI LTw» 215
2—44 (Smart 4 . Web Form Editorid z—% 2N J LI ZDME 2R F LEEA. A

Credential Foofld. COTY MBS U N T BER 25 ARR—V %
Username) A% v 4 BE. [REL(Authentication)] DA 7'y av T & Sh 1z

2L (2L R E ShTuz LA . T 5
[FormFillText]) #fC AN L &9 .

Av— MEKER 2By PVERAT— MR IE IR A AT7—FEL TR E LT 28

SNA7—NSmart & . Web Form Editorid =z—# 2N /1 LIz 20D #1377 L&t A A

Credential Forld. Oy MICHEfT U N B R &H ALN—Y %

Password) A¥ vrd &, FEE (Authentication)] D47y 3> T € S 28
AT—RNUARAT— R E SN Th WG H I L TF )
[FormFillTextl) #fX A L &7

xpEE M N 77 £LT  Fortify Weblnspect®i5; & D4 : Fortify Weblnspect® A7y 3> R

~—2(Mark As * ¥>H ZWeb 71— LE D /7 #E K ¥ (Prompt For Web

Interactive Input)  Form Values During Scan)] 8 &' BZ4F EAN T DA 2ER T3
(Only Prompt Tagged Inputs)] D J5 733% & 1L T 335 512
2—HFNNHPBE LT MIELTIDIY MERXIFIFLET.
Fortify Weblnspectid CO > MBI A (F s o N FT B HK 25
AER—VERF x> F 58 2= BRIODANJMEAENT] T 24£TA
FrE—RFIE LET. SN BAHEOEE2LE T 27— LT
ERFCAER T3 2O LT L 2 A7 A(F 5 HNEE
LCWaE TZ2OF LTI SN THLET 14 EDRSE IR
T)%, CAPTCHA (J& & 23> ¥ 2—RI2 & o THE B S 22 b C 40
B 2RO FOF vL VDL ALY AT RDF A NG END D&
ER

Hl & (Delete) BN SN PR VR M SRR LET . 2Oy PSR S &
Yho IZEL. COZY AR LEX—V R ERIRT 2L 20T
> MDA MBI S £9,

Web7+—AL 77 A IVEHFH LIz A% v

T 7 FDAF v ik 5 TWeb7+—4 771V &fa € L1356« A¥ v+ idWebH A bDFF
i 2B 45 T2 X CEB R HEIRCZO 77V EIRIR L ET. 12770, ZOIEIRN N A&
TEDAF v K LTHI D7 7AW EIRIR 22T, FEETBZIENTEET.
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V=LA A R
% 16:Web 74— L 7 4K

YERR LIEWeb 74— LfHED VA MfFEH LTHA bEAF ¥ T 2E IROFNE R W ET,

1.

Fortify Weblnspect® &4 (Edit)] *=2—%2Yvy7LT. F 74V MDRF vVak E
(Default Scan Settings)]i£ i L £ 3. F 74/ bk & (Default Settings)] 7 4> K74
b &7

R % 2% 5 (Scan Settings)] © 7+ = P57 (Method)] #i£ 4R L £,

R % %> &) & (Scan Behavior)] 7 v —7"C Web¥R &K OWeb7+—LDHEI A
(Auto-fill Web Forms During Crawl)] #1##1 L £ ¢ .

LRI CRD 8% LIz 7 7V 218 4R 4 221
a. Z AR = EZ7Vy oL Ed,

b. HEHED 77 VR 74> P& LT ¢ 2Web 74— Al 25 A7 714V
R L. B (Open)] #27 Vv L &7,

C. (A7 v )T NIEA 27Uy L TaAvTFAMZa—no647Y 2 2R T2 82
L0 NEERETEET,

Web 74— A DfH %50 8% 3 21214

a. ¥ LuwWeb 71— A D1E B (Create New Web Form Values)] %l % 7V v L &
R

b. Prf(File)] A=2—%2VUvsL. BrFH(New)] #iEIR L 7.

c. P ovyoiE)(Launch Browser)] =27 Vv /L &9,

d. FE40 O TIE., T"Web 74— 48 Ol 1" X—o1651 2 8 L T2 a0,
IR Lz 77140 DWeb 74— Al 280 5 4 31214

BLZE DWeb 7 +— AMH D% £ (Edit Current Web Form Values)] £Ll# 7)o 2L &
ERD

b. FEANCOLTIE. "Web 74— 240 DFC & X—2165] #Z R L T2 S0,

Web 74— A VA NN Y ba—ILD~vyF T

Web 77 V77— 3> #Web#R & L TWeb 7 +— 4 D #1515 3 5 L&, OpenText 2+ v &
Web 74—l D7 7AND Ty M)EST LTl 2368 TREME DA ELET . HEE L
TOBEHE §20Duy v HERE DE LED»SIHIIR DR IR LET .

Web 7+— A D~ wF > 7 D)—)L

f&

BAEXMH it B

R—V[EEF 7+r—4L RBE—H; BT Webik % L1-WebX— T L7k &2
DMl (Name)] 85E 4 —  OWeb— . Web 75— A% . 8 L UMH D

. E &(Length)] £ &H. 2F v M R snf-
M58 4 — webformvalues.xmly D1OD L 2— N &5¢
L TH 3,
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Y= A A K
% 16:Web 74— L 7 4K

(-1 A% it B

W —2 fail Web# % L -WebX— Tt L7-4f &

(Name)] DA —E  ODWebX—> & LUWeb 74— 4% 25, &

L. E (Length)]  #* v 1iE R Sh fzwebformvalues.xml

&7V A= FEST ND1DDLI—FEe—HLTHW3, 20D

AJ Zr—AMECEEAT s TR TV R
Rld. ED &% 74—V EAN TR ANDIEAS
O G $ B(7A)V RA— R T74—)L R —

).
Ja— ) 7r— L0 RE—I KA Webix & L7-WebX—> T ! L 72Web
fil (Name)] e 4 — 74— L% BLUMHE DR SH. AF v M1
M. [ S(Length)] IR sh 7zwebformvalues.xml © 7 o—
e 4 — B 7OWWeb 74— LB £ 7 32 H B1D0D L

a—RFE—FLTWL 3,

WA —B1 Bl WebiE &R LiWebX— T i L7-Web

(Name)] & 54— 74— %0, A¥ v ICER sz

#. [E S(Length)] webformvalues.xmly ® 7 o—/ U & 7

7V RA— &G B 75— L4 B LT

Af 2. 2D 75— LME BT F N TH 3
4= MR ED &% 74— RN T E
NOEAF ORI T (7 AV RA— R 74—
W NR— ).

Wy —;2 71— 771V H OWeb 74— L4 A5, F D o7

N2 DEED BRI 74— M S e— 8L Tw3, 20

(Name)] Ofid TH Web 74— LB I g TH 3T XTDX

n. E &(Length)] 7 #AWebX—y 74— )L N4 DI TEA ) &

54— — 3 L. WebiE & L1-WebX— TR L
74— FE A, A% v IR IR sz
webformvalues.xmly @7 o—/\)LWeb
Tr—LME LIy W HBL A RE—F L
TWh 5,

B4 —H3 71— Tr{ILN OWeb 74— L4l 23, /Db ofz
N DI TRER 43 8 74—V RE S HJe—F LT 3., 20
I AT (Name)] D Web 74— AME I8 N TH 2T RTDYL

Thn. ES T, WebX— 74— N4 DA TE S 47
(Length) ]l 7AW b &=L TW3, ZOL a—FD 74—V FE
H— NEFFA] X AT E D 74—V MR ADEAF () i 3

B(74) FH— 74— MR — ).
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VIV AAR
= 16: Web 74— 4 L7 41X

& A %4 i B
4 —84 B 774 IV OWeb 71— L 53, 5, D53 o7
(Name)] O 5 Z4—I B S BB LTV B, 20

T4V RZIZE £ Web 74— AEHICE N THBTXRTOYL

. E &(Length)] F 435, Web<\—v 74— k4 O— i &—

X 5E 4 — 5 L. WebiE & LI-WebX—> T H L7z
T4 MR AF v IER SNz
webformvalues.xmly @7 o— )L Web
Tr—MME LIy 2 HBLa—FE—F L

T2,
WH—BS5 Bl 774 IV DWeb 74— Al 25, 5, D5 of-
(Name)] Df 3 A= RE R BB LTwd, 2O
74—V R ATE Web 74— LB 125 FNTH BT XTDY

n. E &(Length)] 4% WebX—y 74— % O— i &—

7V RH— & BLTHW3, ZOL a— RO 74—V FE &,

) £ D 74— R ADEAE (0I5 T 3(7
AW RA— 74— PR — ).

—Hal T4V NG IEE A Web 74— Al ED— B #3 4 v, 1R E S
(ZHFA I EWeb 727 700 ME( F 74w MDefault)]) 3%
LA EEL 5 Sh B,
A

F 74 ME L Web 74— 2LE D77 Web7+—AHD— & 7 <. Web 7 +— 4
AT 740 MED H D7 74WICT 740 ME 2 5 0o TR D
TRE SN THaw N &+ A(not found) ] 7% 5 S 5.

2L 2z, L
A E K
TSI Z—5 y N\WebH A bER DI 0T 237775 & LN O E 2 LTIR € 3220

TXET. CNBORE LT /e AT B BEE(EdiY)]> BRE (Settings)]> B
(General)] ##E R L £ 7.

W E it B

7'a¥ v VAF Web Form Editorit « 77+ ££—%" v M\Web+ 1 hd] ODHTTP =

(Proxy Listener) T4y BB § 27 ax ELTHERELET . 7 740 NTIE, B—7
WIP7 KL Z127.0.0 1 & AT RE A — r2f H L9, 72720,
2= Oa—MUP T FLRER— MR E T 2R TEET.
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V=LA A R
% 16:Web 74— L 7 4K

W RE bt B

T s T aR— bada E 3 20] BEME 20l 8 3 2120 .
R— rD B Bh &l v24 T(Automatically Assign Port)] i R L &
ES

P aHTTPRIT 13 EA EOWebR—21i2id, i ¢ 330 F £ v b7 504125 64 2

(Advanced HTTP ¥ »& N T & 3. ZOFE R I&. HTML F¥ 2 x> hOHEAD & 7

Parsing) > 3> DContent-Type)is & N\ & ( &1z HTTP-EQUIVE 1% #%F D
METARZ) &M L TiT b &9 LF 2y beT7F U AL TG
WA—Y ] 1cZWeb Form Editor ¢ | ¥ X& X F v, BE S
h 3l L= ¢ v b] => a— F(Assumed 'charset' Encoding)] VA +
THRET&EET.

—%‘)‘L . ° ~
EX Bl 7 aF Y
7'onF o H—3 %4 L TWeb Form Editoric 7 72 23 212i&. LR DR E 2 LEd. C

NAORFEWT 72 A3 2121k A (Edit)]> BRE (Settings)]> P'u¥3(Proxy)] %
RLET.

B R B

HEES(Toxy Toxey—sffiHLa0G G, COF7y a2 E R L &7
% 1) (Direct

Connection (proxy

disabled))

7'oX Uik E OHH)  WPAD (Web Proxy Autodiscovery Protocol) 7 o kv 2 F L T
5 H (Auto detect 7a¥ HBEIRE 77V ER DT 757 OWeb7 0¥ L3 E %
proxy settings) 1Tk COAT' Y v RN L ET,

Firefox7' o v i% € Firefox» o7 oF o 4— MR 24 >R — b 212k COATY 2~
#f# F 3 3(Use FIERLET.

Firefox proxy

settings)

AT LADTOFY oAy rme7ax—A\ER 2 R— N B, COF
W E M H T3 7y avEEIR L ET,

(Use System proxy

settings)

PAC77{iw%ffiH  PAC (Proxy Automatic Configuration) 7 7{ )V 267 0% 2 5% € %
LT7oFs &R E o= FF32d. COATY v &8I L LS. Wi URL]I KR v2 R

OpenText™ Fortify Weblnspect (23.2.0) X—32174/360



V=LA A R
% 16:Web 74— L 7 4K

W RE i B

9 %(Configure a T77AVDE T8 E LET.
proxy using a PAC
file)

TaF EHRMIE TeF =B H TA Y R— Ay MIT 72 AT BTG COAT
WX E 9 B(Explicitly > s> #IER L, BER SOIAFEREU T OLNAN T LETS
configure proxy)
1. B—3(Server)] £ 7Rz 7 o v 4 —XOURL £ 721£IP 7
LAEN ST L. BT R— MPort) & v/ R ich— &5 (o &
Z1& 8080)FAN J1 L &7,
2. 7 aF A —nEEH OTCP F 774y /DI E Dfz» D7'm f v
%. SOCKS4. SOCKS5. F/:dEHE D naiR L L7,
3. WAL E 2354 . EREE (Authentication)] VA b5 KA
TEIERLET.

B Bl (Automatic)

YE: B 28 E 728, A% v OB A2 < D
F9. IR LTO R0 ORFE AV vy RETRE 58 A
F o DR 74— R KB cH ELET,

# A (Basic)
£4 Y =X MDigest)

Kerberos

4T v x— MNegotiate)

NT LAN Manager (NTLM)

4. 7'aF Y —/NTRAE AW B 215G & Bk 2 —v 8 e
AT—FENTILET,

5 FFEDIP7 FLA(WH 7 A MA M OV T 72 AT B1-0127
DX Y —NEEH T 20 ERALOESIE. Pa¥kresg
NAF %44 MBypass Proxy For)] K v 7227 FL X /214
URLZA I LET. = M Av~TX Y DT,

HTTPSH O E 7" HTTPSHE 4t 2% AN 37 n¥ >4 — 105 &. HTTPSH O
n¥ ERE TS KRB 7' ¥ %3 & T 3(Specify Alternative Proxy for

(Specify Alternative  HTTPS)] Z1Z R L. E R st -5 2N 1 L&,

Proxy for HTTPS)
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VIV AA R
=16: Web 74— 4 7 4 X

v i 1 3R

Web 74— LMl #5083k LT B E&IE . 22— X ATV— DN 1 53R 20/ F > 75— L4

MEIRSINBIENELDNET B Da—HZ ERXAT— L T&E 0. 20
F2OlE s Z7AIVERIE T BRI, 2—F % RN AT7—FD Ty b AT ZA~— MERK TR 1 &L
TIRETAVLELIHNET ., EREDNART—Ne2—H L IR1F SN £¢ A,

AF v FiE, COTY MBS AN ST 32 ha— L ES ARR—V 5 RAF v T 3¢,
Bl @ B AE (Authentication)] A7y av TR E SN TW BN AT7—FEAAN L ET. COAT
VIl EF VT ARV E EL AV D 2—H 4 ERXAT—RBEE SN Ed ., 22—
& E1E A AT RBRE SN THR LIS . AF v Hd X FE A TFormFillText] #1515 L £
T
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£ 17: Web Fuzzer

Web Fuzzery— V& § 2 &, IRICE T 2& 5% — & 20 275 ADWeb 77 )5 — 3+
F 2T AT It LTy WOMDHEE 7 A MEITTEET,

e SQLA vy z7v av

o LFHDT7+—~vh

o JORYA NRIVT T AVT

o /NRA NI/ —H )L

- HWELT

o Ny 77D —/N\—T710—

o 7oL DFE B B v B[ E

777 el

(7702713 HEI Y 7 727 T A MW CL 7705 —> 2D 8ES £ VT FV AL %
Frldy—r vy o 7T —REE R LTEE Ly v F 297 4D 5518 28 ez L& Hel £
To 12E2E N7 7DA—N—To0— 4R T E . TAMIYF L IESE LA ADT —X
EER L. 2N 27705 —y av Ty MIEAY MO1DIIEE LT 77 Ur—y O E )5
EEHEHTEET.

Web Fuzzer~® 7 7+t A

Web Fuzzer—ViZ7 72 A4 3IE. IROWTNhEEITLET.

 Fortify Weblnspect”—iv/Y\—T. P/—i(Tools)]> Web Fuzzer] #7Vv/L £7 .

e ¥ 2UTaY—VE v EHH LT, B (Start)]> Fortify]> Web Fuzzer] #2Vv7L
¥9,

Fuzzer X=a2—12DOWC

D RNEYITIE. Web Fuzzer A= 2a—N"—D S &4 47 DWW BH L £7,

P 71 V(File)] A=z2—

WOFIE. Pr1V(File)] A=a—A7> 2D 8] T,
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V=L H AR
= 17: Web Fuzzer

A7y av 2% BH

A H—b PLAT AR AF LIzt v s> % fe vy a>/(Sessions)] = U721 > A— L
(Import) £9.

ITJRAKR— | fe v> a>(Sessions)] V7D vy 2 EF 7 7AW T I AR — ML E T,
(Export)

vy avDrY  kyrarba—YRALEIVTLET.

7(Clear

Sessions)

#& 7 (Exit) T7Vr—y v EH L&Y,

I 4 (Edit)] A= 2—
WOFEE. FEED)] A=2—A7> 2 OH I TF.
F7y 3> % BH
Y—3(Server) X—7 v M —/3%fEE L. WAERRE #IEIR TEE T

7% 5E (Settings) — MRk E . ToF K E . Vv NRE . BLUT O FVER E £15 E
T&E7,

[z v 2>(Session)] A=z2—
R DF L. v 2/(Session)] A=2—A47"> av OB T3,

ATy av i B

A¥H—b PLRT DR AF LTzt v 23 EN TO XML 7/ L&A Y A— L &
(Import) K

TJRAKR— b oy 2 EXMLZ 7AW T 7 AR — L E T

(Export)

fER(Create)  Session Editor# [ &, R #E ik 3 27-0 OffiE b s 77 o—F
AL E T

A OfER(Raw Raw Editor#ff &, fE#EZR 245 & 7
Create)

# £8 (Edit) vy OB (A ] T & £4. Session Editor 25 & 7.
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V=L H AR
% 17: Web Fuzzer

F7Y 3> % B

£ omERaw b vy 2 DIRRIZ EH T& £9 . Raw Editor 25 & £ ¢,
Edit)

P v X(Filters)] A=a2—
KOERIE. PovAFilters)] A=2—47"> > Dl B T3

A7y av % BH
%%(Edit) P1v X(Filters)] X4 707 %5 &, fa € LI & D& 2R 3 31E
BRI EER TEET,
B3k vy TV REE LT,
(Enable)
Web Fuzzer®Dfg H
R DF L. Web Fuzzer®fifi b5 #2585 LT 25,
RART—Y
1. P ER AR T LET BEACOLTR " — D E" R DR— | %
ZH LT 0,
2. HE T WET . AN OLTIE [M"Fuzzeri® 2" ~—21891 2% R LT <
1780,
3. KOO TNHEFEITLET,

o Ly EEMLET,
o UHTWCIRAE LIz vy av AV R— L (R E LG E)mMELET.

FEAN Iz DV TS T"Session Editordf# 1" Ik @ X—2 | -4 "Raw Editor
Off F" N—2185] #Z | L T2 &0,

4 B #6 (Start)] 2 Vv oL £ 4.

fz v 2/(Sessions)] TV VNIl & oTHE AL ST 1285 £ v 3(FE K
LBV BRI ET,

5. 4R ETER 4320, Ry 3/(Sessions)] YA MDY NE 7Yy L
ER
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V=L H AR
= 17: Web Fuzzer

AF—Y

AR LIzt vy s OHTTPE R 28 BER (Request)] T V7 ICK IR S &7
=N E L. P97y e2—(Browser View)] 27 B O % (Raw
Response)] £7 O] J7 (2R 7/~ St 5.

6. FESE LR 24 4E 2121k e vy 3/(Sessions)] VA hCr vy 3%
EIR L. Ryy a/(Session)] A=2—%7Vy7LT. #E(Edit)] £/-1&

H 4L (Raw Edit) ] DB 60 51K L £,
FEAH DL TIE . T"Session Editordf# 1" T 1 &7z T"Raw Editord{# "
AN—v1851#Z W L T &,
P/ NDEK E

pr—/ D% 52 (Server Configuration)] X1 72/ #{f i L T. &—% v M\Web+ 1 t %3 7
L. IBAERRE #IT LW E T

H—/\BRIE #AT Ol

1. & (Edit)] #27Vy20L. fr—/3(Server)] ZIER L £ .
fr—/ 5% 52 (Server Configuration)] &4 7o/ 76 & £ 4.

v A 12 /IP (Host Name/IP)] £ v 2 212, Web# A rD5E 215 6 B 44 >4 (FQDN) &
FEIP7 RLAEN T LET S

3. f— NPort)] £ vs Rz, — D F— IS AN LET.

4. H—/\7Secure Sockets Layer7' o b &fli ] LT 2 & &, B8SL] FxvoR v/
EACLET S

5. BAE BV E IG5 H & BAT(Type)] VA s XY vy REIEIN L. %Y § 2R v/ AW

22— ERAT—RENTILET .

OKlz27Uy7L &9,

N

o

Session Editor®/# F

Session Editor &1# i} L T, HTTPEE 3K #/E i L7z 0. HTTPE R OfF g D 7y av 48 1
L7zOLET. 7F AR Y2 RIZTF A MDA &2 085 OfF 3 217 >CT. HTTPE & LB &)
ZBIENTEET . FLE VAL —REFHAN LT ER SN T — RS ALER OE R %
e c&£7.
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% 17: Web Fuzzer

v vy 2 DVE Rk
oy av EER T 312

+ [k vy 3x/(Session)]> {E Rk (Create)] ZiE R L £
Session Editor23 b & & 9. "t v 2O E" N ICEA £7,

S A EVAD) T

Yoy a4 I B

1. R v 3/(Sessions)] VA T, € vy av5iER L 7.
2. R v 3/(Session)]> f&E(Edit)] ZiZR L .

Session Editor23 ] & x4, " v 20D " P& £,

t vy a3 DER E
Session Editor ¢t v a5k & § 31214
1. Z7%70y 7L 9.
2. H RTOFHANOWTIE RO 7y 3w &5 M L TS0,
e " [¥V v (Method)] £7" K DX—
o " PiA(Path)] 47" R DR—
o " T Y(Query)] Z7" K DX—Y
e " P3—Y z3/(Version)] £7" N—183
o " INvX(Headers)] &7" ~—183
« " P v¥—(Cookies)] £7" ~—184
" POST#—X(Post Data)] 47" ~—:184
3. KON H»EFEITLET.
o THEFAMIVIAIRIN SN BT —REHE L FT,

o P xAL—R%EEH ¥ 3(Use Generator)] 7 v/ v/ AEIER L. PzrLr—K] %
UL Ty YadL—XEH AN LET. sl 2D TEL T"Fuzzery =4 L — &2 D

T"X—v1861 2 L T30,
4. O YVTELE T 212 MOKXTE Y9I EF .

5. BET2IU74RELILET. DKl 22Uy oL &4,
6. Web Fuzzer] V4> FVIZJR ofz 6. B#G(Start)] 227V oL &9,
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VIV A AR
= 17: Web Fuzzer

[¥ v N(Method)] &7

F 74 FCGET AV yRDMEE SN THET MHERZ DT FAME &R 2 200, A/ yRY =2
L—REfENT&ET,

P Z(Path)] %7
NACHE 4 2R D3ODDEE 5770/ &7,
o 771 IVD% i

o 7ANILIRT
o TALZMILNVEIRE T 330 F (B H & AT vy af)

NEDERXRLZERBRDTFAMEBE &R 220, VAL —REffANTELT,

P —Y(Query)] &7

—HOHTTPE R 121d 2 VXL FH 35 & 3. &% /35 4—&i% . parameter=value &> 9
R T 7o Y NR)TX Y DET. UY—Rik X ) 05t 5 307 (B LR 75 T
DN T7Vr—y 2T O F 2 T& &) E-oT o Un o il St 3. il 2
i

http://www.website.com/category.cfm?model ID=0&category ID=12

ST VST A AR T B

BmAdd)] 270y £9,
name=valueB YA MR RN SN ET. INEVER T 272U FH 2R L FET,
2. BEEi(Name)] 27 %2VyoL £,

Mname] £V IH AT DTG A—REMRE T 2. DNy AL —R&H ] T&ET( P
A L—x%# F 3 3(Use Generator)] 7 =y /H v A& IR LT, PzrL—%K
(Generator)] =7Vl £79).

3. fE(Value)l x7%27Vv/L &9,

B Dlvaluel 8 E T 20 b CY AL —R&ffH C&Ed( P orL—R%&E
H 3 3(Use Generator)] 7 =v 7K v/ 2%EIR LT, P =2 L—X(Generator)] 7 v
sLET).

4. P/SL—ZX(Separator)] x7 %27V L &Y.
2o 0 &0 B4 230 F (B HE EFE S T)EMmME 720, DNy 24 L—R&{f
HT&&d( PAL—K%MH 3 3(Use Generator)] 7 =/ v/ 2R LT, P=x
# L—ZX(Generator)] = 7Vv 7L £9).

5. PA—<vyMFormat)] X7 %/7VUy/L £7,
HAEROERR SN 248 LIz, R OB F AN LI0T 30T E
9.

—
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6. BEHET LE D+ /SL—Z(Name Value Separator)] = V7 C. /35 A— X%y B 4 230 T
(B T\ R ERE T 20 ROy AL —XE2 [ H T&FF( P AL —K%
fE Fl 3 3(Use Generator)] 7 v/ v/ A %1€ R LT P =k L—X(Generator)] %=~
V7L 7).

7. DR A—=REBIN T 512, BIMALD)] 227Uy 7 LT A7 v72-6 %4 ViR L7,

PX— ax/(Version)] &7

W= L BOR DR AE ] ¢ 2HTTPA—Y 3o 24— NR LES. A 3 a3—Y av
£.0.9.1.0. BE1ATT . A= a1E R IETHTTP/version] D K iHE L & 4. 2
Es ATvy 2(1)TXY) s 124 5 S DX 7T . §'ubau(Protocol)]. fe/iL—x%
(Separator)] . B £V p3— 3/(Version)] P3O0t /3 2§ X T 770>/ C& &9 . JE
JP AL L), MR AL FEMALLOLT B ET779 7 TEET.

P\ vX(Headers)] &7
NI =N & 77V — av B R 2ALEE 5 2D14% 5. D 7947 > M2 & oT
FAT SNIEEARBE M AT anTo &9, — K &\ vXid . HostéUser-Agent T3, % v
Kt Tname: value | L 2 LTE R SN £7. COLFT L OREE 5. 77027 D4
DD E| T8 TEET,

Ny R 3 B

Bin(Add)] 2 2VvoL £7
name:valueZN YA MIER /R SN &F . NIEER T 23N vXeR L &7,
Bl (Name)] 27 % 7 Uy L &7,
[name] WG BT DT A—REGRE T2 KDY AL —RE[FH T&E9( P=
A L—2%fF B 3 3(Use Generator)] 7 =y /4 v/ 2 4i& R LT, P zhL—2&
(Generator)] 7y 7L £7).
3. fE(Value)] 27 %7 UvrL &7,
Mvaluel 7 A MEHREE 230 DNV AL —REHH TE& &3 ( P oA L —R%EfE
H 9 3(Use Generator)] 7 =v 7K v/ 2%#EIR L. P =2 L—Z&(Generator)] 7 v
L ET).
4. P/Sv—ZX(Separator)] x7 =7Vl E7 .
E»SZ R 20 BT 2L FEE X 30 EHE T2 Kby =oAL —X&{H T
EF¥( PAL—K%&EH ¥+ 3(Use Generator)] 7 =y /R v/ AFIER LT, Pz
L—&(Generator)] # 7V L £79).
5. Pr—~vyMFormat)] X7 % 7Uy/L £7,
NYRBERNR RN SN BEF 28 LIz, BROM ICLF &2 AN LIZ0T 32ENTE
£9,
6. IZHT LE Dt/3L—%(Name Value Separator)] =V 7 T. N\ vX %% B 3 230 7 %4
20 by sh L —2&ifl C&&9( PoaL—2%MH 7 3(Use

—

N
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Generator)] 7 =v /K v/ 2A#iE IR L T P =k L—&(Generator)] # 7V 7L 7).
7. MONyXEFEBEMN T 2. BIMAD)] 22Vy2L T AT v72-6%48 R L &7

P v+ —(Cookies)] &7

IyF—ld, 2= LIRTE %Eﬂ?‘%ﬁ’&bk77 Nr—y AL ST S /87 4A— X%
RN L NVETT o 79F—ERDEAEKRDEBNTT .

Cookie: name=value;name=value
B RSGA=RE RN T 70 27 TEBLH LH DT T,
Iox—EERN T 212l

1. P v*—(Cookie)] VA +T. {BMN(Add)] 7Yyl &7
P v¥ —(Cookie)] VA hMZCookie: R /N SN &T o CNIEIER T2 79vF—2K L ET
U v¥%—0D3E 4l (Cookie Detail)] VA t¢. BM(Add)]1 227 Vy/L £9,
name=value?® P v¥—®D&¥ 4 (Cookie Detail)] YA MIK R S &7

3. P y¥—DF 4l (Cookie Detail)] VA D45 il icd 3 P y+—4 (Cookie Name)] x7'%
VAP VAVE &2

CHTERAE T 2 MDY kL —REM l T ¥ ( P L—&&fEH ¥ 3(Use
Generator)] 7 =y /R v/ AFIER LT, P =xL—XK(Generator)] 47 Vy/L £7).

4. & (Value)l x7'%27VvrL &7,
Mvaluel 7 A MEHREE 230 DNV AL —REHH TE& &3 ( P oA L —R%EfE
H 9 3(Use Generator)] 7 =v 7K v/ 2%#EIR L. P =2 L—ZX(Generator)] 7 v
L&),

5. R/Sv—ZX(Separator)] X7 %7V L £9
E»2 0 #0732 FEE EE ST T)EME T2 by o4 L —K%E(f
tc&zd( P L—2%MH +3(Use Generator)] 7 v/ Hh v/ AR RN LT, P
A L—A&(Generator)] #7 V7L £79).

6. Pr—~vyMFormat)] X7 %7Uy/L %7,
NYRBERNDR RN SN BEF 28 LIz BROM L F &2 AN LIZ0T 32ENTE
9.

7. I&HT LE D€ /3L—%(Name Value Separator)] = V7 T. N\ vX %5 B 9 230 7 %4
20 by sh L —2&ifl C&&9( PoaL—2%MH 7 3(Use
Generator)] 7 v 7 v/ 2A#iE IR L T P = L—ZX(Generator)] 27V v/ L 7).

8. HDIyF—%BIMT G AT v/ 1T R LET .

N

POST7—X(Post Data)] &7

21 )iz Request-URNZIE I T & 2Dwxf L. POSTF —&id E 3k O 18 Wi & £7,
R IGURIZZ DL TE 0. 1F A EDI & POST AV v NCfE ] &0 ¥ 3. POSTF —%%
23546 B3R ik POST7 — XD+ 1 X %7~ 3 Content-Length~\ X 723& £ Tu»
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2E DD NET . POSTF —X#21J T/ < Content-Lengthfd £ 77> > 7 LT, r—3N &7zld
T7Vr—y aPNED & UAHIE LI 207 A M CE&ET,

HTTPE R Ao —V (770273 286 77 05—y aVIREE D200 4 J& (—7'1 b
DVDELE EWeb 77 Vr—y W E LY.

POST7 —&&1E i 3 31214

BinAdd)] 2270y £5.
name=valueM YA MR RN SN £, CNIEVERKR + 2POSTF—4%42FK L £4,
BB (Name)] 275 2 Vv oL 5.

[name] EW LRI D AT A—REHE T 2. Kby AL — k&G H TEE9( P=x
AL—2&%fF B ¥ 3(Use Generator)] 7 =y v/ ZA%i& R LT, P xhL—&
(Generator)] 7yl &7).

3. fE(Value)] &7 2 )vsL £,

Mvaluel 7F A MEHREE T B30 IO NCY AL —REHH TEE3( P oh L —R%EfE
H 7 3(Use Generator)] 7 =v 7K v/ 2%#EIR L. P =2 L—Z&(Generator)] 7 v
s 7).

4. p/SvL—ZX(Separator)] x7 =7Vl £7 .

ENSZE Z0BE T 2L (B & a0 )E8mE T2 by 232 L —x&{f ¢
&Fd( P=parv—x%M#H 4 3(Use Generator)] 7 =v /R vy 7 AZIEIRN LT, P =&
L—AX(Generator)] = 7Yy /7L £7).

5. Pr—<vyMFormat)] x7'%7Vy7L £7 .

NYRBERDBRIN SN BIET 4 E L) RO L F 2N LIE0T e TE
9.

6. PET LE D+t /SL—%(Name Value Separator)] =7 T. N\ v& %5 B ¢ 230 F %4
ET 20 by AL —%FH &3 ( P=rr—2&fH ¥ 3(Use
Generator)] 7 =78 v/ A#IEIR LT P =2 L —X(Generator)] 27V 7L £7).

7. B OPOSTF —&E &K #B N 4 212k BM(AAD)] 22 Vy7 LT AT v72-6&4% ViR
L£d.

—

N

Raw Editor 1§

Raw Editor 18 | L ¢, HTTPEL kK Ave—Y 2/E L £

ZROOT N O 2L E T 210 Y—LD7 * A Ml e £ 1 4 20, ¥ 21
L—RERALET .

VAL —REFHN T B
1. KOLFRAEET LET.
o BRHNDIERZDGATCA—YIVERF LELT.
o BIRDIERE O 2R N L ET
2. H7Uy/LT, v by A=a—ms P il —X(Generator)] € R L £ 3.
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P =4 L —&(Generators)] X4 707 6] & £ 7,

3. P zkL—&Generators)| X170/ T, ¥ xx L—&%i%E L. & E(Configure)] #
VD VAVE & I
W~7'> 22(Options)] X4 7 a7 36 & £ 7,
4. R7v 3/(Options)] XA 70/ C. & EHRENTI L. OK]Z22VvrL &7,
5. PxzxL—Z&(Generators)] 1 7r7T. DKl %Z27VysL &7,
6. TER Licy s L—&i& . #—Y WAL B (E720d A7 971 T TR LIAE = OEf /7 12

BERAOMAN SN ET,

R OBIAE £7203 ¥ 23 L— RO A\ (7213 2O J7 ) 54T o1 T OK] £ 2Vv 2L,
Web Fuzzer] 74> PR V& d . k1. BME(Stat)] 2 27Vv oL &4

Fuzzery =4 L —&XIZDOWT

AL —REMFH T RE TV I T A vy s OIE AR L B ET . IRDFE I
Web FuzzerCffi FH T& 23 24 L—RIZOWLWTER LTWL 9,

YR L—& B

ASCI HR a2, 155 L8 P OASCISC 7 2108 A L &9,
PRGN F e T LT BEU— B O F 2L —7 ¢ 3R B 2 E L
7,

pas PEE LT E R L S ER 2O F M EN L&Y,
BNSC TR ER KT BEUBE Y R E LE TS

/N T8 LI#T P ) /N 2% R N L &7

B /M (Minimum)] & &KX (Maximum)] O%(. B4 (Increment)] .
BLIUO—H O AN —7F 2RI R E L&Y,

GUID £ 55k 12 & 4 % Globally Unique Identifier (128 & v D% il ) %4
ANL&ET,

TROH #rE LET.
HTTP XYyl %V yNGET. POST. PUT% &) # B R iHfi AN L &9,

7’8 b D A=Y 22409, 1.0, 1.1, LB IR 2R E L LT
HE R LB A OB 2% BRI L &S,

B /M (Minimum)] & &KX (Maximum)] O%(. B4 (Increment)] .
BLIUO—H O 2V —7F 2RI R E L&Y
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YR L—X& B

SQLA>Y s HELETEFANIAAHELTFH) 24N LET. BEROF I, 771
¥ av W DB TEB I E>TIR E0FF . BEIK N Dcharacters 3 XTHHE A
INE7,

7 74V bD 7 74 )V (sqlinjections. txt)iZld IRD2DD T NIBF &
nEd,

"or 1=1
"or like '%

7% A b 5 L7 % A M1DOER A LT,

WordList)—% $8E LIrT7FANTZ AN EH AN LET. BER O I, 774
IWHN DB TERICE>TIR E0NET. BIE N DT X TOXLF N Sh

9.
XSSA>Y s JHELETFANZANDLSLFH TN L&T. R OH L. 774
vav VN DBUE B & oTIR E0ET . Vg N DT X TOILF A3 A Sh
9.
7 74 bD 7 71 )V(xssinjections. txt) i IRD T PUBE Fh &
ER

<script>alert('test')</script>

7 4V ZADEEAE

TOVRE LHI . BEUL— TR SN FT. T— g, Y — B D E Dt
IV TRERTBTHFAMNER TBEMRMEH T, 2l uE AL lerror] &5

HEE NS ENTHT, OB E D AT—KA 32— FELT500-599 15 E S T 254 120
ERIRNTBEIROL—IVEFH LT,

[STATUSCODE ]5\d\d AND [BODY]\serror\s
RORFLIEEEH LG IGEDE 7y av 2B E L LT,
[HEADERS ]

[STATUSLINE]

[ STATUSCODE ]

[STATUSDESCRIPTION]

[ALL]

[ SETCOOKIES]

[BODY]
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POV A(Filters)] X4 7 a7 D7 7€ A

P oV X(Filters)] K4 707127 72 A9 51214

« PovA(Filters)]> §i4E(Edit)] 212 L 4.
P 1L &(Filters)] K4 7027 7\ & £4.

7 )V ZOVE 1%
TV REVE R 5121

1. PavA(Filters)] X4 7u7 <. BI(Add)] %227V vy7L £9,

v—uiZ & 5Tl Default Rule] &4 5% B DL—)L HME [ S £ 37
2. B Er(Name)]. §%8H (Description)]. 8 &8 p—(Rule)] 2 H L £ 4.
3. A Apply)l £27Vy/LT. 74V &&RIELET.

7 4V XD % L2
TV REHRE T BT

1. PavAFilters)] 4 7ur/ . PavA(Filters)] YA a7 0L &R L &4 .
2. B Ei(Name)]. #i8H (Description)]. £7zi& Jv—iv(Rule)] 255 L £ 7,
3. WHApplY)1 #7Vys LT ZBHEERFLET.

7 4L ZDfF H
vy T T7OVRENH § 2121d:

1. PavA(Filters)] X4 7u2/ T, PavA(Filters)] UA b6 7 0L REIER L L9,
2. EBE#ik(Enable)] 7 =y /R v/ AFIER L L7,

BE! BEOL—IVEERICTRIEDEMNI. — K Lv—L O H t G T 3
DEMDNEST., 2Dk PavA(Filter)]> B 24k (Enable)] Z1E R L £9,

7 4L ZDH [
74V REH| B 121

1. P1avAFilters)] X1 7u2/ T, PavA(Filters)] VA bMpos7 oL Z&1E IR L 7.
2. HiBk(Delete)] #2VvoL 4.
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Fuzzer:k &

% 7€ (Settings)] &1 7 u2 TWeb Fuzzers% € 1T ICENTEE T .
Web Fuzzeri% & #17 JiZid:
1. fE(Edit)] #27VvoL. B E(Settings)] ZiE R L £ 7,
% 7€ (Settings) 1 &1 707 35 & &9,
2. WOWTNhEFEITLET.
o T NT— K E #AT NZid L K OXA>T M (General)] ZIEIR L 5. f#

AT BE %k €

OFFICOB T T B E" T 1EZ R LTI S0,

o 70X VEEE BT OIE L DRA VT FaF v (Proxy)] RN L4, 18 H A AE
BRGE ORFAN DWW, T o i e D=2 1 2B IR L TS0,

3. #& T Lizs,

— MR E

OKlz7Uv7L &9,

WOFE, — R ECOOTHIA LT ET.

B R

7V ROE Fik
(Enable Filters)

HE8j A 70— Ea—

(Auto Scroll View)

Y=y MERR
(Show ToolTips)

B K V7 v M (Max
Sockets)

A LT T NP
(Timeout/Seconds)

OpenText™ Fortify Weblnspect (23.2.0)
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TAOVEDY R— BN LET. COATY 2 EF T 3
& PovAFilters)] K4 70l T7OVREB N, #ik . BLO
IR C&Ed . sf 4l icouTE "7 0L ZOFE A" N—2187 1 %
Z B LT a0,

W A=a—1—0D pPavA(Filters)]> B %4k (Enable)] %
BEINLT 7OV REF RN T 5L TEET,

kz v 3>(Sessions)] VA e 2—DHE) A 70— &H %L
¥T. COATY o EFFNCT BE Ca—d HER W H O
twy avEFCAZo— L ET,

2—H A > X7 2—A(UI)DF € DB R ICY VAR Y RESG b
e VIV EY MR IS SN F T,
HT 27y DR K &IBE LET.

VT NEBRA LTV b B THRE L&
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W RE i B

Content-Length®58  Web Fuzzeris . % % (25 UTE =k DContent-Length D1 % H
#l (Enforce Content- EHJ Wil L& ¥ . COATY avH %2 ¥ % & Content-

Length) Length\v&X% 770> 7 TC&FH Ao
Host\ »X' D3 F Web Fuzzerid . 3 XTODE K (CHost\ vX & 8 &3 . ZORE
(Enforce Host e 2 %N T 28 HostN &k E 770 v 7 C&ER A
Header)
7'a¥ ik E
WOFIE. 70X BB OOTHI LTHET,
iR B B
HEEGO e 7ofey—#HifLawGaE. o477y av &R LET.
. %))
(Direct
Connection
(proxy
disabled))
ZoX R ED  WPAD (Web Proxy Autodiscovery) 7o b v il LT7 ¥ v H &)
H By RE T AVER Ly 757 OWeb7 o ¥ ViR E #1T VW ET .
(Auto detect

proxy settings)

YATADZ R vy sy ad s — MR VR L ET,
* VR E &ff

Fi ¥ 3(Use

System Proxy

Settings)

Firefox7’ 0¥ Firefoxh 67 nd v H— ME#H 21 > R— LT
REEEH T

%(Use Firefox

proxy settings)

PACZ 71/ v % URL] & vZ7 A T#5 % L7125 fr 12 & 2PAC (Proxy Automatic
R LT7’'v+ Configuration) 7 7{ W67 0% ik € #o— L &7,
VERET D

(Configure a

proxy using a
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X SE B
PAC file)

77Xy ERR  ERINIBHREANN T EILEoC ToFvERE LET. [T
MR TE FoOmE" FIES LTRSS,

(Explicitly

configure

proxy)

HTTPSH Off HTTPSE: & % UAN 27 0 v H— RO & . CO47'y 2 %1%
Brokveft RL ERSNBWRAENN L7 oF v & ELET. "I 0s 0
& T 3(Specify " F1EB LTS,

Alternative
Proxy for
HTTPS)
7% > DK E

70FVERE T B

1. Br—/3(Servern)] £ v7 A7 mF v —/3XDURL&/2IXIP7 FL AZANJ) L. &> T
( BB—MPort)] A v7 AiZ) R — M 5 (80804 £) AN JJ LT .

2. BAZ(Type)] VA b6, 7ok o 4r— & H OTCP M5 74y 2403 3 270 bajv
(SOCKS4. SOCKS5. &7zl 1 # ) I8 40 L £ 4.

3. WAL E 2354 &, FBEE(Authentication)] YA b s XA 7 HIEI L £,
« H 5 (Automatic)

FE: HEME 2B E 728 AF v  OUE 268 2 0F 3. 89R LT 357 O
SE AV yREE T B AF v DA Tr—v R K WCH ELET,

# 7 (Basic)

A4 A MDigest)

Kerberos

% Iv x— MNegotiate)

NT LAN Manager (NTLM)

4, 7ox Y —NTRAE PV E LG G E W 22— 8 ESAT—FEN I LET.
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Fortify Weblnspect # & U'Fortify Weblnspect Enterprise (2l € v 2> X—ADWeb Macro
Recordery—nW 235 gncwEd. 123 0/ >~27a0fl. ¢ 28 v—2r70—~ 2ol ©
To CORNF2AY FCL N BD2ODY LIk K Du/ A VHE 8Ly — 70— i
DarvrryEE & — Kl £ vy 2 X—2DWeb Macro Recorder] & i 4,

v vy 2 R—Z2DWeb Macro Recorderid . W <{OhD 1k CHE) TEx &3, B4 icONT
X "t vy a2 X—2DWeb Macro Recorder~® 7 7 A" IR DRX— | 5B L T &0,

r /Aol NE

n/Av~rnild . WebH A M7 72 ALTal A>T 2E&CH L T 24XV MDRLER TT o
TO% . CORLEREHH LTAF v 24 3 2 & 2. Fortify A% v F IR /R T& & T, 7—
ry7a—~rnld, al AV A7 y7 (W B G L) &4 b L OFF € OURLOFL % T .

T 2% vr ] &0 O EE & LIE LIET Fortify Weblnspect 8 & UFortify Weblnspect
Enterprise ] DX b Dz H & & 315 3k 25M) 77 O i 1234 Tl £ 25 A ).

IE7 7 /v

7 74 b T £ vy 2 X—ZDWeb Macro Recorderid . Internet Explorer7 27+ 7 7./
P(ET2/uy PR L) e H L Cerngrtix 8 LUH A L LT

/A >v~orn

o/ A4 >~rold. Weby A FE/2idWeb 77V r—y X7 72 AL TRy A > 2l B
BT ITACTADRLER TT o WH L 22— ERNAT—RFEAN T L. [a7 A ]%0[0l 4 %
EDRR &IV ILET AX vV &€ 256 lE E. LT sk Licn/ /v~ 7o
FIRE T 20, $REAF > CEH T2 A T LurZfr~rn%itiE LT,
T7Vr—y avipsnl 7 LI B AR v R TR T T8N e, vl v
szl vl 77 S Lic CEEIITE R T as 7o MR D 4 81 DFR E T B
BIHVET AF oI AF v E SESELBH TR/ 7N 2G5 08H0FT. IR
B #~ LET S

o X=X yhHA MIEoTH S SN B H Ol 77k
o BALT TN EDR—47 A D TF—IRFE
o WEN e NFTA—REED~V/OE kD TS—
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/A y~raD— el Tal/ 77 M EIBE T2 AF v T Lawal 77 b5
FELGEC. 2T ELFH Co/ AV LHIMENE L NET AF vF k. &
A NEAF v T BE I, Z—7 v b A FNOZIGE 20T LTIREZ2H M LET. AF v
. gl 77 LA LG &l nwDOTe. n/fr~rueEfTLTu/(>LE L. a2/ 7
7N L S sy A FOWebIR R /3B E2H B LET.

n/ A v ruEitit T A B D AT v EL Ty £ vy 3 R—ADLogin Macro Recorder(d
EELT A LCTTHBIR o 77 MG 2 L. 2hvzn/ (>~ omidg e L
SO A ET. FEAEDE . FEITul/ 7o MM 2 E T2 EEHNEEA. 1217
L. ol 7o b 2B ElcdmETEEFT.

J—r70—~</7n0

v—s7n—<sald, ul A VAT v (L BIE L) & A P ECTFE TR EN T 25 E D

URL®DEL $% T 9 . Fortify Weblnspect & 7zi& Fortify Weblnspect Enterpriseld . 7—27 70—

v /OZRLER SNLTURLD A B L B A ik il St e A "= Ur 225 L E ¥ A

SO D~snlt. 7705 —y O E O 7 7y AE B 24 Ta-00h & & 4

SN ET. vIOREE T O RO H Tld. 0l A >~ 2o DR AN A2 IZIRDEB T

E

o T—y7O—~x/llld. LB IR E) LI € ODURLDA NS g &d. 77—
7o—v ol BAEKCZEN sOURLICDA 7 72 AL 7.

o U—yTa—~xraTEnl 7 NMEM DI A TIE L WD T, £ vy 3 X—ZADWorkflow
Macro Recorder® 22— 4 > X7 =— ATl V—/r7u—~/u%itit ¢ 3 e/ 77 b
M BERE DBR AN S £

YE: Weby A NCREEEPVE LGS E. al AV ATy 7 57— 70—~ /70llit i L
WTLLESH A b, flonZ A r~ro%it st L TWeby A Mool A > LTS,

vy 3 X—ADWeb Macro Recorder~D 7 7+
A

DL N O TlE. £ vy 3 X—Z2ADWeb Macro Recorder it &) ¢ 2 3 £ X £ 4 )5 1 12D
T LET.

o/ A>~rn

Fortify Weblnspect & 7-(& Fortify Weblnspect Enterprise Tid+ £ vy 2> X—Z2DH Lo/
Av~rasilit 528t LMK AL vy R—ADWAF Dl (v~ /uEi# R (B
SUATY > CHRE)T BIELTELT . IRD & ANAT L ET

* Internet Explorerz L > X V> T2 ELTHA M EAF w2 2K E T 25 65 1d. &—
TybrA hcalfv~ranhEThbIlER E L. fER(Create)] #27 V2L TH L
WOZ A~ AR T B BEEO RS A v~ ERIR (B LUAT Y 2 CHAE) L £
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EE

« Internet Explorer# L > X))/ x> L Tf B L C. Fortify Weblnspect D& A& 2+ +

>~ ¥ 1z13 Fortify Weblnspect Enterprise DWeb+ A F A% x> ik € § 235 & A7 v727T
fr4 B EE (Site Authentication)] ZIZ R L T Lo/ A >~ 7o %it #t ¢ %5 BEAF D
DA v s ERR (B L UAT Y 2 CHAE) LT,

» Fortify Weblnspect—/3—T. P/—iv(Tools)]> [ogin Macro Recorder]> v 3
> RX—ZA(Session-based)] # 7 V27 L T. Login Macro Recorderz A &> N7 a>E—NT
EITL Lol fr~razilst 320 A0/ (v~ ra%f &&9(B8 L0047
v arCTHELET),

« Fortify Weblnspect Enterprise D& # 2> —)L O V—3\—T, P—i(Tools)]>

Login Macro Recorder]> R v a>X—X(Session-based)] = 7YV »7L C. Login
Macro Recorders A &> N7 0> E—RTH & #r Lo/ v~roait it ¢ 25, BEAFOD
/A~ ruE K ET(BLUAT Y 2 THELES).

o ¥ T aY—FyiEM A LT, B (Start)]> Fortify]> [ogin Macro Recorder
(€ v =>)(Login Macro Recorder (Session))] % 2~ v~ L T. Login Macro Recorder %
AR K7y E—RTEAT L. Lol fr~rn%&itif 50, BfF O/ (>~ ro%
B3 T(BLU0ATY 2 THE L 2T,

o Windows T 727’ 0—57T. t v 3> X—AMDLogin Macro Recorder #{# Ji] L Tit #% St
PEEfFDOasAy~railB8) L. K770y LTH &3 . £ vy 3 X—Z0DLogin
Macro Recorderm» 2 &> K7 o> E— R TH & &7

J—/770—~</7n0

Fortify Weblnspect & 714 Fortify Weblnspect Enterprise Tld « #f L 7—27 70—~/ n%id
BT ALLELENF AL OV—r7a—< /iR IR (B LAY s CHRE)T B2
EVTEETRDENAT W E T,

o InternetExplorerzL > XV /7 1o ELTHA M EAF v 28R E 7258513, R
¥ x> &4{7(Scan Type)] # P—277o—(Workflows)] icifE L. 20% . P—2770—
(Workflows)]> 1. 7—277u0—Z7 v OE M Hr LLy—r7n—~/700it k. Zfzid
M D7—r7n0—~ 7004 R— ML ATy av THi B 21T W T,

* Internet Explorer# L > &)/ x> &L Tff ] L CFortify Weblnspect D3t A& 2% >
ERE T BG A AT v71T P—2 70— E &l 2+ v>/(Workflow-Driven Scan)] %
EIR L. L8 (Record)] 721 ¥ (Manage)] #27Vy/L T Lwy—2r7n—< /0%
ALER T 2 BEF DU —r7o—~ /0B IR(BLIAT7Y 2 THRE)L LT,

» Fortify Weblnspect—v/3—T. P/—iv(Tools)]> Workflow Macro Recorder]> fz v
¥ avRX—X(Session-based)] # 7 V7L T. Workflow Macro Recorderz A %> N7 >
E-FCEAT L. FT L y—r7n—~vrusilik 3 50 MFEDOV—/7o—~v o4l & &
T(BLOATY 2 TCHRELET).

« Fortify Weblnspect Enterprise D& # 2> —)L D V—3\—T, P—i(Tools)]>

Workflow Macro Recorder]> [z v 2> X—X(Session-based)] # 7 Vv 7L C.
Workflow Macro Recorder# 2 &> 7> E— NCH &, #f LLWy— 2 70—~ /040 i
T2, BFO7—r70—~rusf EET(BLU0AT7Y 2 THELET).

o ¥ YT ay—F v & LT, B (Start)]> Fortify]> Workflow Macro

Recorder(+t v =>/)(Workflow Macro Recorder (Session))] % 2V~ L T. Workflow
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Macro Recorder# A &> R7 0 E— RCEAIT L. Fi LLwy—2 70—~ 70450 8¢ 3 30

B Ov—r7n—~ /0% & & (B LU0A7Y 2> THELET).

vy 2 RXN—2ADWeb~v 7oL 2—XD A > Z—
T—AICDNT

D MEYITIE. vy 2 RXR—ADWeb~v 270l 3—XD2—H A > A7 x—AZDWTCan B L £

- o X
@
€ elx >
@ Record 3 Delete Highlighted a (CAPTCHA)
Method

R DE TlE. vy o X—ADWeb Macro Recorder® 22—+ 4{ > X7 =—AD 3> Hh—% > b

WOWTI B LET.
JHH #i#
1 VA= BEA I OWTIE L T — A" DR — | A58 LT 7 &0,
AT v HIE Sl AKX A& AL 4 28 B O 7R N —,

K=y M4 RA

A W0DN

T XA o EANICOWTIE . T T XA " R DA—2 1 &S I LT 280,

EY MG RAVDE Sk &7 v A MAVERBECHBETEET.
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V)b

YNNG IRDR THH T 247 08 F g TH T,

A7y av 4 BH

%7 # (New) HlovroefElLsd.

B {Open) R CRER S e~ rnE OT(E A R— L) A ki
BELET RDTZHANRATER e TELETS
e Web~ 7 o(*.webmacro)
» Burp Proxy (*.*)
e HTTP7—#17(HAR)Z 71 )L(*.har)

RA/ BAMOTWav/7os 7 LT,

LT EF T

RAF

(Save/Save
As)

/7y Mk (el Ay~ ouDR) s T M 27 k5B £ &1L BEAHICOLT
(Logout G Mol 77 M 7 2 X—22001 25 IR L TS0,
Conditions)

7SV ER B ' oo+ 5% %€ (Browser Settings)] X1 7 a7 #] & £ 7. fFATIcDO0LT
& "7 279 E" N —v202) #Z [ L TS0,

55 57 <A >
B XA G R R N—=DH ), ZWIR DR T T B3R R EF 2R v ANRER IR S
9,

REANF 2o

RyZA i B

MARRER VL CRAE R L B 0ERIT)EHAE LEST. BT

# (Play (Run)] 91 OB f F 5412 F 928 v 2 ABSEAR ShCu 282 4 L 38

Highlighted) RN SNLEREZHAELET. EBITRUN)] IO OF zvrR o0
2GR L&A

+RCEA B2 AT (Run)] 91 CIEIR SN T B(A4 10 % 5T B)E R O& 2F 4 L
(Play All) ES P
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AR F 297
R yo A i B

WilRE T 28 TRXNTORT IR~ /i g SN F325, v/
FEAE T 27200 BAT(Run)] 5 CIEIR LIz AT w7 120 FEAT &
nEd.

{% 1k (Stop) FRTEAE(Play All)] A& % 2Uys LA ¢ BA ARt &
T IAEOERNE T ¢ 2EHAEEFIELET.

a7 77k (7—270—v/0CIE RSN ELA )T s/ 77 L ET. o

(Logout) 7RI A A S 318 Gt DE R Sk LTHA MED & AL
R T 2hEFIMTEEd.

MARNER  JVysLTHRPFAE R L, B — OFR(UT)EHIBR L& T

% (Delete

Highlighted)

TR THI B B2 1T (Run)] 7l TiER SN T 20 E M E 4 TN TOER %

(Delete All) HIFRL&d.

p/AvO7ay (7—/7o—<70TCId KR SN E¥ A )CAPTCHAE . /1 Vb % %
7"MCAPTCHA A /1 LIEDOBAR ThH-T, av Ea—RXCAER LD TR AW lEs
(avEa—KRE R T REDERET SN FRL VYT Y PL ARV AT ARCT . &—
ANH #X G4 7 v A NCCAPTCHAZEH LT 255 1E. COF 2y /R v o A%
PEAEWHE) Al Ed. voodgl &t &o/ 7Y MREE 2 L &34, Fortify
. ah7z/AB  Weblnspect & 721 Fortify Weblnspect Enterprise D 2—+1¢ . A ¥ v
Fa—Yr77A OBER 8L00l 77 MFE T L0, FH) T/ (>3 205
N)(Promptfor #®0&d. COATY 22BN § 54, —BERKIR SN TLBER DR
login TN SN HTTP b7 4920 2K 8 3246l OXA > HF L &
(CAPTCHA))  +.

RZN—DF OB RANIEIG T A — B R s S IR OFE Tt B 4 2% BFx & &
9,

51 9

% 1T (Run) B TEAE (Play All)] %70y 2 & RS T B(4 0% 5T
BYAT I HEAT SN &S RIF T BE. TRTDRT 7 Hvv 7
fE SN ETH. v /0&BE T 2100 BIR LI AT 7 R RFEAT &

nEd,
& 41 URL]. F 4L 7 bY(Directory)]. £7-i& [R—y(Page)] #i%#7 L
(Excluded) T ZDXAT ORI V=V EIB I L E T BRI L—ILid . COARF v
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# 4l (Details)

IR #& (State)

INTA—R
(Parameters)

%l i B
EEHH T 3AF v oTUUT O 2T NTOE R ICH A &n £
T o BIR OBRANDFLE T 235 6 COF2IE 2D K bt & B DL
HTRRSNEd. PAXL(Custom)]. K#F 7] & R MDisallowed
Host)]. &7:1& [v— bk (Outside Root)] (A F v>Di% & DB 4 K 12

P+ K BB 5 (Restrict to folder) ] 751% R s 7235 5 ) T 9,

Ay R DAY v R(GET £721& POST % &),

AT —RA BRI § B0 DAT—RA(302 £72162007% &)

(Status)

KK (Actual) IEE TR SNEEBEDRAT—KR, AT7—XANT W] LIzl L8 % 215
B AR RSN ET,

URL K OURL.

HFDORA U IRDR T 7287 ME FnTHEd.
&7 B

T DA > TIEIR SN T BERFA RS SN TL2)E R B LT,
BR T =800 L OXA R R s, BIE T 2005 7 —8054hG F O
RA VIR IR SN F T

REERL T, KRB EZR T REMELAHZ2TXTOIHH Oa
Loy av, CNBIE, v 2an7 2eALdh s 35 CH a2t DT
T, NWsZEATCHHCHAS DELLDE, HRREEZL T LD E
LT B DU, 884584701 H #F8CIBIMLIZ0T 22
MWTEFT. Web7 7 Vr—y 30Tt € DS 4A—RT AF— b7
Wl eWwIv—25f U 0nE s 0WGERHNET,

(7—270—=/0 TR SN EEA )BT~ TT+— LN T
T4 R 2—H 4 E120E R AT— RN T ELTHRE CT& 2L &
T, CIOLCVIET 2 /uv sl ¢ 3~ /0TCa—H44 L AT—FD /5
A—REMH LT AF v B ICiB B C&BL L &7

~ 7 nDEC %

¥ vy 2 XR—ADOWeb Macro Recorderid . IE7 7 /oy #{#i ]l LT~ /u%idsd LET. 2O
FEwI Tl £ vy 3 XR—ADWeb Macro Recorder#ffi fH L Tr/ (v ~/n&y—o 70—
< 70ENEE SR T ARAZICDOWL T Bl L £ 4.
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H: U TFOFIETE., v /o0 B 92— R AFIHECOHWTHPFLET. &R
D4k R #13 21218 3 B DI R N—OR N I >Tv ot §f LT L S0,

v vy 2 R—Z2DOWeb Macro Recorderic 7 7€ A4 25 1E DWW TE "2 vy 2o R—20
Web Macro Recorder~® 7 7t A" X—193 | #F I L T 7 &by,

0/ A >~ 2ol i

t v 3 X—2ZDLogin Macro Recorder T, {X D¥:1E 217 W &7,

-

tCiR(Record)] 22 Vv2L £7,

7 RLAZ74—)L RIZ&—47 v MBURLEAN /1 LT ? 2 2UvoL &7,

77 Vr—y a4 L ET.

FIET 27 /Y Tld. 0l A 4 302D 2— R0 28 £y hOE B «2h & 4 200 H
N ZWebH A MEHR— bR THEH A,
TI7Vr—y 2T 72 ALTal A > § bE BR T —RDT—7 1V H35 Bt XA B N
N Fd.
o/ A>vLiz6. EIE(Stop)] 22Uy L&,

BE! /77 20T,

~7abiRfE SN ¥7.

BAPlay)] #27VysL &,

vrung Pl el A SN, TV —y T 7 AL e A L ET,

~7amniE LA SNl o EiEE LEdT. D0, ul/ A r~rani—>7 vy hA b

WIEF CaZ A LichEmM T,

o TVT—y s ZIEWIIT /AL T A LI A G B (Yes)] #2Yy oL &
R
/oL a—XEEEIR ol 7y M e LEDELET . 0l T M AR H
SNdE vl T LET. ol 7V MR s wig A k. FEI T 7
PUVERDHVEST, A ODNWTE "ol 77 M 27 4 I DR— | 5] L
T2 &0y,

o TIVr—y CIER T e ALTRI Ay Lah ot k. PLR(No)] &2y

7L &%, fER(Create)] 27Uy /LCHi Lo rnaitdh ¢ 20, "~ 7007 8y 7"
N—=v2031#Z B LTS,

RAF1B o~ &2 ¥ L1354 & . Login Macro Recorder #Ff U 2 &2, i 4T 3 200 (25
B ERAF 2L AR D B AVE—ORE IR SN ET
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7—27 70—~ 27050 &%

¥ vy 3> X—2DWorkflow Macro Recorder C. X O E 247 W £ 47,

1. 7RLAZ4—L Pie7—270—0B URLAN J1 LT, 2 220y oL &7,
2. #C#k(Record)] #2Vv/L &7,
3. vI/RZECEE LEEL T BAR—YIZHEI L 7,
T7Vr—y avN AR EI T 28, TR 7T —ROTF—7WHG AT XA B I SN 1.
4. 7—70—DFRTCDAT v/ %5L 8% L1 T B1k(Stop)] 227VvrL &7
~7udMiEfE S £,
5. BA(Play)lz2VysL &7,
~ 7] 6HE S, V70— IR EE SN TW BT 7V —y av D& LT
72 ALET .
6. v7anIE LEAE Sl mEaisE LT,
o T— 70—l EE SN TV AT 7 Vr—y 2 D& WCIEW T 7 AL & 1d.
ku(Yes)| #2)v L &d. v /anE T LET.
o T— 70— EE SN TV AT 7 Vr— 2 D& WCIE T X7 722 ALK hoizty
Hix. POZ(No)]z2VvrL &4 . fER(Create)] #2V v/ LT Livv ozt
B 20 ["v 7007 /807" N—U2031 B IR LTS,

RAE1B \C~ 7 u s T L2154 (& Workflow Macro Recorder 28 U3 & &12. 454T ¢ 2H]
WA ZRAE T ALK O B AV —UNE R IN T,

oy 7w Mg T 4R

0l 7y Nk LT ARG LT Ay~ oa0al 7 MR EERR £ 3R T&
T LBELHOR %207 77 MNAT IR E T2 ERTHE Ty T 6D% A DL
il 72 S 1235 A - Fortify Weblnspect & 7214 Fortify Weblnspect Enterpriseld 27 1 >~/
A LTH s AL, hl LG asAf v sl LET. $XTOrY 77 MEA:
DEEE Ly ME . Z—7 v b A MO AF x> nl 77 h&N 25— AT XU DOHBTAN—T
BPLERHVET .

t v 3 R—ADLogin Macro Recorder”3E & [ ic a7 77 MEMF 28 ¢ 2 2 &cliah ¢

28 0777 MEMFEIROOWT OB Sh 7,

s HEIUKAL b =7 v b A M3302 VXA L 7 hCIGE T 22 ED L vy 22 R—AD
Login Macro RecorderiZ & >TH ) S 7285 & 12, COFESE D us 77 MEAE AME R Sh
9. EH R (regex)DIE R 2 Ed.

e HEJ. &—7 v A (3302 VKA L 7 bLLAR (f]: 200) TIG & 3 2 2 &3t vy av R—AD
Login Macro RecorderiZ & >TH !} S 7235 & 10 SO D ns 77 Met AME R &n
EQ A
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0’ 7w M @L_jJD
FlLowaZ 7o M EEBINd 312

1.
2.

4.

Y= \—0 |Z 77 bk (Logout Conditions)] K &> % 27Uy L £,
27 77 b A% (Logout Conditions)] XA > T 227Uy L &7

Lol 7y MBI Sh T,

o875 1(Properties)] 1A > T, 2O/ 7w bk Doy 77 bNeil i & B1E R K B

(regex) Z1E R L £ 9.

IEBRBL e LFI DLy ER S A 2= TS BRI, SESL08H T #

LTl sa el A5 zbﬁél&cwt ST -HADENMERE SN &v. EFHEH

B 4 25050 AR D220, COBERE R 92 & AL TS0,

Regexid . a)fr i 3i 7o X— /&77&7\3“67“;&)0)[174/1—*#@;&]2/\0){5% &\ b)

[ CR i SN —D W T 72 AT 21201, 0l 4> LT a—»h60F CER I

XTT%FEKO)LLVQ&HHU’%JA;c/J% N3 . Regex #3322 FIH LK O

EBOTY,

a. Web7'o¥x 2 Y—uaift#h LT. Web b 7741y 27 %508k L £ 9 . [ OpenText™ Fortify
Weblnspect ’— 77+ K] DWeb Proxy D~ L7 & 121k TWeb Proxy | D& #Z 8 L €
ey,

b. IEX{WZ&—7 vy A MZal AL, (R SNLTcX—YODURLEZIE—L &7

c. n/ 77 LT, ab—LAURLEEH LT, ol (>8I RiE ShfeX—2it7 7k
AL &Y,

d. BE AL L. o/ A 8T IR #E SN R—D K 7 72 AL O 2 O F 45
PREELET.

e. EHRRE =7 12— %6 &£7 . [ OpenText™ Fortify Weblnspect’— 7%+ ]
DIEM R 742DV 7 &G TIERIR B 27 12 O 25 R L T2 S0,

f. oA T URE SN =W T 7 AL O 2 O 2 A 2R L7z
Regex#iE L 7.

g. ul 77 Mk 7 44D Regex] 74—V NCIEM R 2 a6—L &7,

OKl&20vsLTrl 7Y MM #RAE L. 0l 7o MR F 27 422 L &5

a7 7w Mk O R
oy 77 NMEA EHIBR T 2

1.

27 7% 1% 1 (Logout Conditions)] X4 > C. HII& 3307 77 M&AE #18IR L £,

2. Re7Vy7L&Ed,
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7S5

Fortify Weblnspect & 7z1& Fortify Weblnspect Enterprise’& # 2>V —)L T, £ v¥ a2 X—2X
DWeb Macro Recorder# A &> F7a>E— T H 3235 & &, V= 3\—0D PIU4ER
7€ (Browser Settings)] £ %> %271V y 7L T, P'o*x k€ (Proxy Settings)] £7°& By b
77— 7#& 7k (Network Authentication)] 47 %/~ L £9 .

YE: 7o EE v /R SN EE A

o+ 2 5% %€ (Proxy Settings)] 27
RORTHIH SN TWEATY DT eI LET,

*7Y 3~

BEEG v &)
(Direct Connection (proxy
disabled))

7o ViR € O H R H
(Auto detect proxy settings)

VAT LADTaF R E E
F 3 3(Use System proxy
settings)

Firefox7" o ¥ 3% 5& %1% FH
3 %(Use Firefox proxy
settings)

PACZ7M Wi H LT o+
VR %€ %17 AConfigure
proxy settings using a PAC
file)

7'u* ViR € #HRMIAT S
(Explicitly configure proxy
settings)

at B

TaE H—NEEH L WIGE &, CO4T Y %k
RLET.

WPAD (Web Proxy Autodiscovery)7'a kv &fifi Fi L T
7o HERE 7OV ER DU, 7575 ODWeb7 ¥
VR AT A COATY o EIRIR L &Y.

o—Leyrhe7aF o —NEIR A R — MBI
. COF7y 25BN LET,

Firefoxm» a7 of s —/MER 24 >R — g 22, 2D
F7y o EER LT,

URL] K v 2 THa € L7235 Bt 12 & 2PAC (Proxy
Automatic Configuration) 7 71 )L/ 67 0% 238 & #0—
921 COA7y av#IBIRL &7

IRDEN, HER SFHREN I LT 0F v 2K E T

BE COATY 2 RIRIR LT,

o ¥—s3(Server): 7'oF > H—/ ODURL &/2ZIP 7 FL A
ENTTLET.

o R—NPort): H— ME T ENT LET (12218 8080
Qg‘)o
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A4

at B

£47(Type): 7 ax 24— & H DOTCP ~ 77497 %
W 5 270 ha)L(FE #E . SOCKS4. £7214 SOCKSS)
FIEIR LT,

58 3 (Authentication): 525l 77 7% IR L £ 3. 785
JEDFFM I OWTE . - DNV T &l 22— A A
FES I LT S0,

2—4#'4 (User Name): =—# 4% 245 € L £ .
RA7— F(Password): /A 27— R E LT,
7'ux v &#/34/529 341 MBypass proxy for): &
DIP7 FLA(NHB 7 A MA M )T 72 AT 27201
TaF =2 2L EN LGS COFT
v FER LT, Rv2 AT FL A£G URLEAN /
LEd. 2> XY 256 Av~vE2 i HLET.

F v b7— 28% i (Network Authentication)] &7

Ao b7 — IR GE B B b

1. B vy bt7— 7885k (Network Authentication)] # 27V v 7L 7,
2. FiE(Method)] VA th 5L R0 L ZER L LT, LR DEENTT.

« ADFS CBT

H & (Automatic)
#: 7 (Basic)

= MDigest)

ALY
Kerberos

%I ¥ x— NNegotiate)
NT LAN Manager (NTLM)

3. Z /1‘7 71:1qu0):7—_"}-% &/\XV—"P%’:’T %Lij—o
4. P34 7> ML & (Client Certificate)] 7 =v/H v/ A5 AV &1cld A7 L &S . A

L7235 & 1

~7aD7 /NvJ

VEEBE AT 74—V RN ST LT RE I E ZE IR L &7,

ZO hEyITIE. £ 12 AT (locations)] A > T~ roakt & (T /N v/ § BIEAR ) 4 A

Ty OWTERBH L ET,
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15 It (Locations)] X4 >~ T DI it D41 LIk BE OF 7R
AL &% SN 1235 P OFE AN LIR BB 23R R 3 2124
1. B FT(locations)] XA >D7—7 )W T, v~ 70 CTo5—0FE LG 28R L.

Run | Method| Expected| Actual URL

] GET
[+] GET
[+] GET
[+] PosT
[+ PoOsT
[+ GET
[+] GET
[+] PosT
[+ GET
[/ GET
[+] GET

200

200

200

200

200

302

200

200

302

200

200

http
200 hitp

http:/f
403

http:/,
302 http:/

http:/f

302 http://
302 http:/f

302 http://

403 [T

http://

:/fzero.webappsecurity.com:80/bank/account-activity.html?acc
:_f'_f@jo.1-.'r:bappse:urity. com:80/resources/js/jguery-ui.min.js
zero.webappsecurity.com:80/bank/account-activity-show-tri
zero.webappsecurity.com: 80,/bank/account-activity-show-tr:
fzero.webappsecurity.com:80/bank/account-activity-show-tri
/zero.webappsecurity.com: 80/bank/redirect.html?url=transfe
zero.webappsecurity.com:80/bank/transfer-funds. htm
zero.webappsecurity.com: 80/bank/transfer-funds-verify.htm
zero.webappsecurity.com:80/bank/redirect.html?url=pay-bil
zero.webappsecurity.com:80/bank/pay-bills.htm

i/ fzero.webappsecurity.com:80/bank/pay-bills-saved-payee.ht

&

-

2. 774V el BEA (Details)] X7 ER 7 — RS E T —AnE R SN & R

*—4(Scheme)] .

iR R MHost)]. 8 &1 R— MPort)] AIE L Ce2fER L&

3. RRE(State)] x7%7Vys LT, v /7uf A REEAE bR M EH 7 L &

o

4. LE S CTORBEHESF 2 LOTEZEMTEET. FIHRGERDEB T

a. BAZ(Type)] Fav7 Ko YA ML 7 HIEBIRLET RATOATY 2 EIRD &
BOTT,
o Regex
o 7xY(Query)
o KA MPost)
o 7vy¥%—(Cookie)
o AAXKXL(Custom)
b. B EI(Name)] 7 r—v R LTk 04 i # N 1 L &7
BmAdd)] 2070 7.
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Security Questions

To protect your account security, please answer the following
questions.

What is your quest? ‘ ‘

What is the name of your favorite pet? ‘ ‘

What is the capital of Mongolia? ‘ ‘
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@ Security Questions Editor — [m| *
+ @ * Question: "What is your quest?”
. * Answer: "happiness”
"What is your quest?”
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/A vvraEitit Lo 2B R RBIE I V—7" A7 v7 &~ 7B N L C. Fortify
Weblnspect & 7z1& Fortify ScanCentral DASTD 2 ¥ v T2 K &k ]l C& £ .

B

VE: 2% % 5L 1 . Fortify Weblnspect Enterprise Cld A — FSh T Et A

BE| 2EEAN2#AF v M H T30 Ca— AV TT AN 284 1. 328 &2
Af 2> ha—Lt v &— Fortify2FAE N A V77 )5 — 3 7% € T AL BERNHVE T,
PEAICDOWTIE TN 2 DFE " R—299 | 25 B LT 7 &y,

i

115 N1 DR 7 OB AL 225 1 N DEFE R AV T FL A G 8B L&A TA D
FIEE 72t 7 A NI T A0 7 L A0S #5550 E4 G5 LET.
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Y= A R
% 19: /XY MX—ADWeb~v /oL 0—X

W 0 OOl fR 24 I

IR OBE 0 Ol PR TE & 2 KB ar i pe il ] s £

o IMAPH & UPOP3H— 334K — & T &3, 7272 L. [E 4 DID— & (UIDL) &4 £ — k
¥ 2POP3H9— D& NHE— SN 7.

o WIE. HR— SN TV 2DIFAndroidiE s B iE DA TF .

o 14555 5E Tl Fortify Weblnspect?if > Z h—L &L T 37 U474 v b F (CWi-Fifk
s L E TF

Gmail 7 A7y Mo 3 2% E FH I8
Gmail 7 77> MBI 4 2R DS I TEE P E0,

o Gmail 7 717> O E I B H E— N T MAH N &9 . Gmail 7 77> hEAf#
FALTOTH LOZE AV CRIERKEAE LGS . T P&l ¥ 32T 2O/
DRI T AR BEE D DE T I T REE AT BI12id. POP37 AV MR ETT
H7y b ER DR TR E LET .
recent:<email_address@gmail.com>

o t¥ U7 4DF i H 5. Googleld T Google T2 A > | #{# Al L TGmail #=—4 DGoogle
ThH7Y MCEEAT T &3, 2—MERKR LR AT—NEZ AT 8 A . Gmail 7 77>
N 4 2355 . Google 77 VD R AT—REERR LT 320 B8 H 0L . af 4l
ZDWTIE S 77 WA Z7— FOAE Rk &ff T (2B + 2Google 7 77> MD~v=27 V5B B L
TLIZ30,

HA N4>

QE R AR E TGS L IROHNA RFA NV F T,

e 2B R/ N—T AT v 7 e D2BRBIE TNV —T AT 7N IR E TBILETEZ
A,

o« QEEFMIEF /L —T AT TN I2DOD2QFARFEHE A7 v 7 45 L ClE TEE A

o O/ A 7 UL AERE [ T35 2FAREB AT o7 DB I AT AT VT ET VI AT T
BN T 2L ENHNET .
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V=IVAA R
19 {1 XY M—2DWeb~v 7oL 1—X

e 2B Rl A v~ rusiRE 2356 RO IR T LN, ol A VAT v 7 %52
BERBHEIN—TAT 57N EANBLERD VLT,

3 i £ Click on Login link

4 i = Email Twofactor authentication demo@fortify.ninja

2 &+ Login

3 i @ Wait for 2FA TwoFactorResponse
4 i = Type TwoFactorResponse in 2FA Token textbox

5 i @ Click on Validate button

QHEL I EL 7 ) —T AT w7 DB N

2%?&@:}]57)1/"7 AT v7U& 2%%;&‘ nE v hp—ivt > X—| ;g;‘k ’E’lﬁf* LT, 35 At nE 7
r—%B I LEd.

BE! 2BEERRBIE VT ATy BB T 20 E 0D 22FAERRB AT o703 &
NTWET, 2OEN LB WG S  2ERBIE I/ V—T A7 v R L &7,

2ERBAE I NV—T AT o7 #BIN T 2E IKRDFNE#EATLET .

1. [TruClient] 1 FA—T. [RF y7 DI 74 2/ @ Ster ) 5297 L £,
[A7 7R v A X &7

2. [7u—HB %7V LET

3. 2ERBIE I/ N—T AT v7 % 2V LT, i8R SN AT v 71 K597 Ly 22— 4 &8
AT—RENTILIAR W ey’ LET.
7 74 NTCIE SMSD2E K FRAE A7 v B Il s 5

4. IRDOFIWHE > THATLET
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VIV AA R
2= 19: A XY MR—ZDWeb~v /oL I—X

2% 5 5 B BIEFIHE
SMS )& % Bl ¥ 2B L. RO E #IT VT,
¢ [BFEBRES|L v/ AC.SMSILE 225 T 2Ha &S
ANSTLET.

k> b JavaScript# A\ 17 T & & ¢ 43, JavaScript®

EITHEREBEFHES CHIMELHVET, N5

ARG T B TEET . AT DN T
M288 2 BB AE H D /8 5 4—RDE " X—266] %

S LT,

o [ERBHRIRvIAT. SMSIEZ 76 b—2> Dk 4l
H2FEHERHBELET.

EY M HY7IVDIERBIRICOWTIE. Ny 78wy
K %2792 LT &0,

BT A& a. ATy EREHLET,
b. /¥ a]YALC. [MAPEF x> NW2E&RZE
(IMAP Email Two-factor authentication)] & 7zi&
POP3%&E F 4—N2%E K387 (POP3 Email Two-
factor authentication)] Z1%# L £ 7.
c. BIEIZEEH L. IROZE 21T VW ET.
o [BF A MK vIATE T A VL E 225 T 5%
T A—=IWT FLAEN T LET,

k> b JavaScript# A\ /] T & £ 3 %5, JavaScript
DEATEERIEE T A—IVT FLATH 20 H A
HNET NTA— KL EFH T 28 TEETS
ARAH DL TIE, T2E R GEH O3 T A=%D
ER" R—22661 %% B L T <280,

o [H—N|R yI A BT AIWH—ARDIPT FL R &
J2ZiGURLEA I L&,

o [H—AR—HNKvZ R, BT A Ay —Dff
M ¥ er—teANTILET.

o [TLS]H v/ AT & A—)H—SHTLS7 1 ba)v
e 2o EIERIR L &S

E: 7 74V MNRE dtrue T 9.
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VIV H AR
2= 19: A XY MR—ZDWeb~v /oL I—X

R EIHH BIEFH
o [/NAT—RR IR T A—IWT AT MDA
T—REANTILET.
o [ERRBRBIA VAT, BT A IWIBEm6 —0
D&zl ¢ 2IER R 2R L £7.

EY b UV DEH KR ICOVLTIE. FrvK
TUREN #7)w7 LT IES0,

2FAZLF 1 A7 w7 DK B
2ERBIEE I NV—T AT v R E T 2L END 22FAE G A7 7S FnTuw &

T, 2FAEGME 27 o713 2B EEE 2 ba—ib b > X—h A2 2 EE I & 2N IE &
205 HET .

BHE! QFARXFE AT 713 2B EBRBIE I NV—T AT v 7N TODAEITTCEET., XK
YRTOY ATy ELTRAIT T BEE TEET A
QFARFEHE 27 7 4R T2 IROFE#EIT L &7,

1. 745V hCUEN RATYTREAALAT N C~I/uDF R E 180 E R s 4. 777
=3 = ASDIGENIE WSS 4 AR 2SI E T232E. A7y
BALT I N EOMEER &LET,

2. Bl ¥ R L. (BRI ACERL 2N LET.
W DA A—2Tld . Bl £L TTwoFactorResponse #fii Ff L T &9,

O Wait for 2FA TwoFactorResponse

Step

Arguments

* Variable: TwoFactorResponse @

Transactions
Web~ 7oL a—Xif, a> ba—iv >y X—hbDGE & COE B IARIF LE T,
NJJ AT v7' eV A7 w7 DB

2ERBIE I N—T AT v NI 200N AT 2/ N T Iy av AT w7 HB N T 200 B 5
HNEd. 12E. I bo— Ly Z—msDh B 22BE KB I E T A MRy I RS
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19 {1 XY M—2DWeb~v 7oL 1—X

TRANAAT VUL TRE T IV ERDVET . A MIT 7L RAT 720121 & N D%
AVAVIRRANV G EDRR %) I§ B0 Y9I AT v7 ELTRIE T 2L ERDHVET .

AN AT 7Y I AT v7 #BIN 6 LU E T 2121 IRDFIH £#F4T L &7

1.

[TruClient]# { FA—T., [AF v7DEI] 71 2@ Step )5 797 L £,

[AT w7 R v AHE & £

MEEE1 X7 C B AT 22 NP7y DANAT 97 % 2V LCELER SN2 AT V72 RSy

7L, 2FAZRHE A7 v OH B 2B RBIE I/ NV—7 A7 v NI Foy7 LET,

WDENAT V7 &% E LET,

a. (A7 7 bOBR]E 7V L8R I > CREBERBAL I E 7+ A MR v/ A %R
RLEF.

b. A7 v L. [72Y YA SN FEIR L 7.

c. SI¥EEMLES.

d. [Ml]H vZATUS|FER L £7.

Arguments
* Value: B
Clear: Default (true) ~ B
Typing Interval: | Runtime Settings (0) +~ ﬁk
B
Object

Transactions

e. MH]F vI R 2ZFAERGHE AT v CIEM LI B # N1 L&T. I O7 oy —
¥ % Tl il £L CTwoFactorResponse #{# Jil L T 7,
[TruClient]# { FA—T. [AF y7 DB IN] 71 3@ Step) 5 7997 L £ 7.
[AT w71 R w7 AH & &7,
EE1 47 C.[WHATS 22 870y SNAT 97 % 27U/ LTt ik SNIZ AT 971 K5y
FU AN AT v7OEHARIL2ERBIE S V—7 AT 7N kay7LET.
WDENAT 7 H#FHELET
a. [A7Y =7 bDBIN]E 7V L 878 HE STV A VA VR[IR AN ED R R 4%
LT HA M7 22 ALET,
b. XF v 4R L. [727¥ VA e[ 2Vl 438N L £7,
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=19 /XY pR—ZADWeb~v /7oL 2—X

ST LA AT v VI AT w71 E IRDA A=V LFEIFETH L E28HVFT . 2FA%
B A7y 7OEZORE TR LT S0,

20 glv b B
@ Wait for 2FA TwoFactorResponse

Step

Arguments
* Variable: TwoFactorResponse B

Transactions

3 v b By @

= Type sssssssssssssssss in Cnter Response passwordbox

Step
Arguments

* Value: TwoFactorResponse &~
Clear: Default (true) ~ B
Typing Interval: | Runtime Settings (0) ~ B~
Object

Transactions

4|§§ 2 Click on Signin button

TOTPEE & OfE H

2%%‘21314 nE®§71 ’)0)77/2 (e E#FEﬁ NR—=ADT >V ZA L/SAT— I\(TOTP)nu FL[ET—?‘O ;.@77
T SMS &L BT A—IVT b0 &% ET23DTIE L L /\ﬁ /*‘7& NV AT L

REZ 2 LT 22— BN NI 32— #4E M LET. TOTPRM % ## 2%F > T 235 &

& %ﬂ%)\jj@“é’&éf%i@“ﬁi\ D7t A ARV l\f\—‘ZODWebvﬁwj—‘ﬂ‘TE@J
c&&d. ZD1HI1l. TOTPRFESE i € BLPEH L. IR VT R HX—20D7 > %4

L/SAT— &N 71§ %(Type Time-based One-time Password)] &0 58 LW AT 7" TZD
laEE HEH L ES.

TOTPl:pr ):]J‘_E%A O)—:}—L
AL EE R T AR Y] OB T BE L QRI—FEAF v LET ARV MR—ZD

Web~ 7oL a—X14. QR I— Fh 4l ?ﬁ%m&m&\TOTPnuniE%%/——M@I?é@“%t
O A CEEd. fIOHFIEELT.MERBICT 7L ATER 5l ZN%H 5 CTH
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Y= A R
=19 /XY pR—ZADWeb~v /7oL 2—X

% FRALE# (Authenticator)] X4 707N /) LT, TOTPRRAEE #>— MU § 32 L4 T
&¥9d.

TOTPR AL # & & T 5121

1. TruClient7'Z7% . ffi | + 2Web 77" V75— s8I LCa/ A L7,
2. 77 ')’7—"‘/ H/ng%m; nJ_.E }&ﬁ)‘b Cp[./dji'a—
&N, 2= AV Z 71— ATQRI— N2 I3 A i S B S £ 9

3. ﬂ'ruCIient]*ﬂ’ MA—T., BREL#H D# 4 (Edit authenticators)] 71 2>(@) & 7 Vv /L
¥4,

2 Al # (Authenticator)] 4 707 %35 & £ 7.
4. §EBFL#F OB N (+ Add authenticator)] # 7 Vv 7L &9,

B LOREEE 7 77r)l/ b DAuthenticator 1TIEB N SN EF. B LORRAEH Hi~v 7
uLjJD SN BTN T 74V M DR B OF S 01O OB 2 5.

5. MBI LT, WAl & OB HI 2K DN LTEHE L&,
a. B LORBIE#HE (220 T, FREEH 4 D% 4 (Edit authenticator name)] 71 2:/(¢)
‘87')/7(“&?’

b. i f@f@fg AT N7 L. A Apply)]l 2270y £5,
u-@WJ \EREEE 4 d T AuthTest] T9,

@ Authenticator Dialog - O x
-+ Add authenticator Shared Secret ey
Y
AuthTest|
) VAYA -+ 4
6. XDR A >THAT LET S

B —7r vt BEF »—271L vy MShared Secret)] K v/ Aic—27L v b
SNTLdm HH— EZANTILET.
JLy hERI 2T 2

QRz— MRt an T a. BEH v—7L v M(Shared Secret)] & v27 204 il 12 H
w3 3 B7Y 27 bDIE R (select object)] 71 a>(=) %~
IV VF 3 B
TruClient] A FAX—7 4> R2I2 7Y =7 hODIER
(Select Object)] &1 7 s/ K v 7 AHH & £7 .
b. TruClient7" 27+ TQRa—F%2 7Yy &7,
WH>—7L v s, vAF 27 Sn2IREE T
L > —21L v N(Shared Secret)] K v 7 RN J1 &
7,

7. OK]z7Vy7L &9,

OpenText™ Fortify Weblnspect (23.2.0) N—238/360



VIV AA R
2= 19: A XY MR—ZDWeb~v /oL I—X

e MR C~roCfliH §272010 Bl E L SEH v — 7L v OB O T7HER 8
JUOBH RS, 127, B H 4| i%ﬂ%hlﬁf@%ﬁ%ﬁ%@ia‘

TOTP % H L7z~ 7 ndiC #%

TOTP#~/0 T § 21k n/ (> 7 av A&EFE EB LR T 20 ERH VLT 0. —
i3 1k LT LA 7Y =2 b7 23 5/(Generic Object Action)] 27 v #iB il L. Zh iz

R R—2D 7> KA LRAAT— %A J] 3 3(Type Time-based One-time Password)]
7oy kO ERDNET.

TOTPAM FH Lz~ u%itss 3 2120

1.
2.
3.

TruClient 4 b/X\—7T. [ae#%(Record)| 71 2>(0O )& 27 Vv /L &7,

TruCIient7“?f74fT\ D7 A 7F—LBEI L. 77V r—y 2iza/ AL ET,

Ao j"]‘é’)\j] T%)ﬂﬁ'lj FTIEATLS, ]’ruCIlent] A NN—D {«%ﬂ:(Stop)] 74

(B VA OF & a
[TruClient]# 4 F/3—T. [AF y7Dia ] 74 2@ step )z 2002 57,
[AT v 1R v ADBH & &7
8 B8 (Functions)] 27 ¢ L #7Y =2 b7 73 a>(Generic Object Action)] 27 v

B2V L T REEE SN AT w7 EL TN E RT7 L, B fR WCRCEk LI AT w7 DF% 2

CRay7 LET IRDENAT w7 %R E LET S

a. TORTv7 T, B7Y =z MDER (Choose an object)] #7 Vv L £7 .

b. TruClient”' 574 . TOTP 7% A MR vZ A( &2l 74—L R) &R IR L £ 7.

c. WHA7Y =/ 723 3(Generic Object Action)] A7 v ¢. R7 v7(Step)] %
JEB L. P23 3(Action)] VA +55 BHEIR—AD TV RA LSAAT—REAT T
%(Type Time-based One-time Password)] #i# 4R L £ 7,

6 i vy b B @

2 Type Time-based One-time Password [Authenticator Name]

Step

Action Type Time-based One-time Password -
Object Timeout: | Runtime Settings (20 ~
Step Timeout: Runtime Settings (180 ~
Minimum Time: | 0 v
End Event Automatic: Mot Yet Set -
Arguments

Object

d. Bl#(Arguments)] Z/&E 5 L. i F 3 258 5F % % % §R AL (Authenticator)]
Ry AN ITLET
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19 {1 XY M—2DWeb~v 7oL 1—X

Bl oalv b By @

2 Type Time-based One-time Password AuthTest

Step
Arguments

* Authenticator: | AuthTest B~ |
Clear: Default (true) ~ B
Typing Interval: | Runtime Settings (0) ~ B~
Object

COB| TlE BRAEH 4 (& TAuthTest | T
B b fi AT BE ARRAE R 2R oR 7 51d . AL O & (Edit
authenticators)] 741 2:/(9) % 7 Vv 27 LT &AL # (Authenticator)] X1 7/ %
Bl &9

6. YLHA7'Y zs 723 s(Generic Object Action)] 27 v7 #i% R L12IK i8¢ IR
LI A7 v7' D1 25t #% (Record after selected step)] # 7y /LT, a/ (> 7 0t AD

RLER AHIAT LET.

7. TruClient] 4 FA—C, o/ 4 VHEEH OA7Y =2 bR T 24 Wk 27007
AR SN AW E & 0l A VAT 7 DR HGEE A7 v7&B N L. IEE e/
LR ICDARIN SN BATY 27 bR E LET

8. EBAEMPlay)] 712> V)52Vl T. v7aiE LB/ A v aN TW a4 ER L &
R

TOTPD ro7 )Wy a—T 4> 7
TOTPZAE %18 FH 4 2B R E R 4L L2 & k. % 2 oh 25 K] S k7 1 OH 12
CDMEYIHE L DA REVE D N F 4,
QRa—FNZF—D +FT7 WY 2—T 47
WKOFRIC.QRI—FZF—IE LTH 2N B K LR T E2RLET.
o X260 3EH % 2 6N BRI IE

MfHr—27L9b5QR  QRa— N Y] % TOTP% §# URLAIE FfE C. 1E LU
a— el Tt TOTPEURLAS & L aMHH LT3R L LT

Molz] NTHRWA[REE D 2&218. TOTPE g URL D4 U8 &
nNE+d, D EN >TWBIENEE T,

otpauth://totp/IDENTIFICATION?
secret=YOUR_SECRET
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V=L HA RN
19 {1 XY M—2DWeb~v 7oL 1—X

77— % 260 3RH % 2 6N 2R FT IR
TQRaI—FOfEHT 2k WebRN— W H /R &t QRaI—FEHE R E R L] T 2L,

B L FLrg QR I— FE X % Web~ 2oL a—X N C& 254
Web~7oL 2—X ¢ NHNET,
it CxFHATL
17

v/l T5—D NNy a—T 4V
WORW, v /ol ORI LTE AN 3EH YRR T IESR LET,

T5—EER

[ 4 /i Ai<name>D:R if &

DR OMDEFHATLI]

[ named <name> &y 44
B DR EEH OTOTP 24
BT&EHATLE

h—2 & >TED, o
TANKRMLET .

* z sh 3FE K

2 AE# (Authenticator)] X

A7 87 Cilak#& Ak L<
WX E ST WAL BETE 48
HNES.

A v—2L v MIE L <%

WA BEME A D D& TS

AT LR BIE L SR E
SINTWHWEH A

AT LR Z IE L G
SINTHLFH A

OpenText™ Fortify Weblnspect (23.2.0)

% Z 50 BRIRTTIE

2 AL # (Authenticator)] &
470l TRALHE #Hi T
LEd. fFa 0Tk,
[M"TOTPREAE & O E "
N—v2371%Z LTS

W,

HH—sL vy rOBFANS %
FHC(TRE LG E) &2
FQRa—F&fH LTIT W
4. sFA I OLTE .
MTOTPRERE & O & "
N—v2371#Z | LTS

W,

Web~ /7oL a—&MNEAT &
NTHBBEA MY AT LFR
ECYAT LR Z 2R M L £
T B Z &4 L — B IE
LR E SN T B exhf
ALET,

Web~v 7oL a—&MNFEAT &
NTHBEA MY AT LG
ECYAT LR Z] 2R L £
T, R % E&A LY — > HNIE
L GRE SN TV 32 4Tk
ABLET,
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V=L HA RN
19 {1 XY M—2DWeb~v 7oL 1—X

T5—F /R %z o0 3R H % 2 50 BRI TTIE
M= DR LT7L— LG [ il N—2D 7 > A LS A
30> ¢9, 7— &N 713 3(Type

Time-based One-time
Password)] 27 v7' % F i
IT #% CForn—7"27 v7'¢
Zy7 L ET. b4l IO T
& M"Fori—>" X—v283]
B L") —7 L —715 £
- Ofif A" X—285] %%
M LTI a0,

v/ LAV OE

77:!%:;6%%?“%& TruCIienti%XT /7° 163D LNVEE| Y TET, Il 21E, v/
I LXNWIDAT I DAT R T s EBEDE W77 Vr—y DI, TR AE T 37V9 7R
7/7 . LW2CE 0 Tan Ed, vVAA—A—RATy 7 IEIBE . v/l AN E LR
S, LNWIIE Y TN 9.
v /70A7 v 7. TruClient 7’57 D EECH 2V — N NN—D AT v 7' LX)V AFA X T L)L
1.2, 233 EINTRE CRRBLIVHAESNET . b O EELNL3TT,
AIARHLNIVIICERE T 28 LN 2. BEUSTIRTDAT w7 DR~ BLOH A &
NET. BAE I T 22 iJ\'V)lﬁl“*iré%i}iﬁT%M‘Kﬁ‘?}f)%)iﬁ’é”ﬁ‘éf)@ij_ﬁ‘ %ﬂ’u;
L= 0DEAT I 230020 e D VET . T 74 bTlE AZV7 LV 1ICER
EENTHET,
/7oA LOVEAE T 4 120 IR OEAE 24T LW T
o TruClient7 274 T, A7 v7' L X)LD RayZ K7 RE (V)& 27y 7L IROWLT I %
IR LET.
e =L NWIDAT V7 DA ERRNBIOFHELET, 77 07r— 3 &5l § 2121
NIWAD AT w7 Db B Td,
e -l N BLEPLRW2DRAT w7 R RN BLIVFELET, LXNW2DORT v iE . 8%
BRI ES>THBETELROWHIETT 70—y G2 LET.
o al- LNV 2, BEUBDAT w7 e RN BLUHELET . LNWBDAT w7k, 777
r—3 AR LTH et B b NI A

Tu LRWEIBIR LI A —HOAT v IEAER RN ICL DET B LNV EIRIRT S
BIMDOAT 7 HE RN SN £7,
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ARY by RSO H

FAITOECHE T I2DUTELVWAT v70, FVEAIFE T 2AT 97 %50 8% £ 12131 N
TG 6. TG ERIR—Y L OIFVX AL TR R S5 6 TOZEE»FEA L
e ruNRM T BRI REE LD VET .

JeeZIE S ol AR IR OB DR R SN 25 5 08H0E T,

[H—NiE e —IRRE TT . 100 FF o T 6 7l AT L T2 &0, I(“Server is busy. Please
wait for 10 seconds and try again.”)

720k WebH A MR & (OB 8 21T > T o—R V&R U 3 & AL § Avb—Y R IR
TRERDHNET . COL OB E 2N T 2R7 v 0w E . A L a e~ ron
KRS BATREME B VLT ARV MY RIS F DT LG & DR 20 FE
DREELEITF O L&D

AR by RIOLE )
AN P 210d IXKOTFIH#FEAT LET

1. TruClient¥ 1 FA—2 4> 7T, HRY MY RITFAK] 74 A% 2 ) 9 s L &5
ARY MY RITT AZDE & &7

2. i LLARY Y FSDIE BN (Add a new event handler)] 71 2>(+)% 2 Vv 2L T,
FrLOARY MY RSZBINLET,
NYRIEER T 20T ZERPVEMSNZET NV FIZ OB ICTIT—T (3
MRS SN ET,

3. B (General)] 7o/ 7 42K D &N E LET S
a. BAT(Name)] e/ x> b FSOLHETE#N T L. A (Apply)] #27Vv2 L &

_g—

b. BTE D& IR L IZARY MY RS2 2R AT 3 25 DR L T 328012V
tyhEn B)icik. & 2R 4T (Execute only once)] #IE R L £ 7,

C. ZOARY FDEATH M DARY Y FFEFEAT T2, fROARY M & 25
Wt %% 7T 3 3(Allow other handlers to interrupt)] %% 4R L £ 7.

d. Web~ /7oL a—&R~/of 4 2l CTARY b2 YvAY L, ARY MFEE T 310
WARY MY RIEME O 28570 31k RZVZMEE 2B CTIRY MO
hYA %% W 3 3(Event can be triggered during the script)] Zi# W L £ 4.

e. Web~v/oL 2—KZxt LT~ 7ol A th O— I 204Xy MO VA Y 534 0] §
25k RZVZ M 28 CTARY bD MNYH EFF ] 4 3(Event can be
triggered during the script)] D 7 =y 7 %4 L £ 7.

EY b ORI RADF zy o %4 &0 PR (Start)] 840 & T (End)] Ko v
BN MR SN FEFT. CHLAED YR MAFIE AT v 7 888 T A7 w7 418 4R
LT ARV M MNIATEBRAT 7 ORI 248 E L ¥4,
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% 19: /XY MX—ADWeb~v /oL 0—X

f. BA7(Type)] Fav7 X7 URA Mo IROWT N ZIER L LT,

o K7z MNObject)] - 77V =2 MEHE DA XY bFEA T 286 . AL
K=Y F K EDATY 27 MIRIR SN B AR R E DA 7Y 22 v 7' a7 4
A O I LIt & 2 £ T

o K4 7n/(Dialog)] - X4 70l R v AWK 7T v7 RN SN BG A . 1220,
77— M7 ur T MR IR SN B A T,

4. RB7'Yx7 MObject)] D217 ¢ BH7'Y =7 MDE IR (Choose an object)] #2777 L.
TruClient7 274 7 4» RYTA7Y =27 PRI L & 3. DB IS CTHROAT Y av 548
BLET. IN6DAT7Y aViEHEIN AT SN THBIEndHNET .

o X#EI(Roles)] K v/ AT, A7V =7 Mk LTHEAT CE2EME 22 L& 3. 7E 4
COWTEN T A7y =7 MBI 3 2 27 o7 5| 1" X—22681 #Z I L TLE S0,
o Name(ZHf)] R v/ A A7V =7 FNOZLRT 2N 1 LET S
e [DAYyR(ID Method)] Fav7 X 7> YA M6 IRDWBT N EIER L E 7.
° HE)
o XPath
o JavaScript
° FLik ¥
TruClient7 4 2 7 V7" Z2—0DFEAN I DWW Tl
https://admhelp.microfocus.com/tc/en/2022-2022-
r1/Content/TruClient/descriptors.htm %% B L T <72 &y,
o B§3E 47°Y =7 MRelated Objects)] #* v/ AT, A7 Y =2 v 77 V75— s> D
MOA7Y =27 MCBIEST . HAEF OATY 27 bOGI 2B Z 2L &7 . 7F4112D
WTIE T DA 7Y =7 MDD A7y =7 FOR A " X—2298 1 25 MR L T2 &

Wy,

5. A7V 7 MRy MZIE. BAZ(Type)] Fov7’ X7 YR TR DWW n#EIER L &
ER
o H7Y =zl MFETE(Object Exists)] - Ff2E i ATY =7 MMPTE § 3156 AR
A N2/ NP/ NSY (3 e
o RH7Y =zl M7 o/ T 4HFETE (Property exists on Object)] - A 7Y =7 D7 'm /8
FADWE . SN2 1o T & ARV MY RSN MIH SN &7,

WE: XA 707 AXY O & Z471E B4 7 a7 5356 \iz(Dialog Opened)] T3 .
E LIZAT 0l Ry ABB Wi &L, ARY MY RIB NI SN £,

6. WEWISE LT AV FIFEBERDL N E L LT
BE! "B BE AT IINCHIZNERD VLT,

a. BA7ZYLibrary)] Fey7 X7 A h 6. B &5 547 SVERIR L &,
b. B % (Function)] o v X7 YR Mo B 218 IR L £

c. BN LB P E 54— 20 b 2354 1& . Bl F(Arguments)] 71— FiZ 5]
BEENTTLET.
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Y= A R
=19 /XY pR—ZADWeb~v /7oL 2—X

7. OKl 22V TEEHNE R L. 7 4RXEHA L ET,

% 477 VDfE

B SA 7 SV T 28, 8 ViR SN AAT v 7 DFEAT 58 A5 b T1E OFE U Liz
TRIENTEET, oy —HOARY M A S DY GRIEEH &2 7o—EE 547502
BEC AT L CSFS 44 RA VBN + 2286 TE T,

2eZ ISR #5 CSPATUE . MR 7o— 48l A S bE T, A7 971 E—E DL EN J1 12T H
BT ERRE FATINT BENTEET ATV 72T 20 B I HVER A

TruClientB 5t LR % 4 7 S VDREA (2 DL TlL
https://admhelp.microfocus.com/tc/en/2022-2022-r1/Content/TruClient/_tc_c_step_
functions.htm % ff L T 2 &y,

R 0 ODffil] B 54 TH

WL a—A A7 SVETRYE— SN TV aH. A7 NI H G MERR SNt~/
TOAMEH TC&EET, 70—\ WA 7 IVNIHR—FSIN T L WODT, w70 T3A7V%
LH T2 LITEEEAS

B % 547" 5 VODAE 1%
B A7 VEERR § 51204:

1. TruClient { K\—2 4> FUD R H 2 BE 517" Y(Function Libraries)] £7 %
EIRL£7,

2. By —0 B 51475 YU(New Library)] 71 2> (k)2 27Uy 7L &4

Br#i 2477 U(New library)] &4 702 K v 205 & &£,

3. BA75Y4 (Library Name)] X v/ A T4 75 VD&HT #N 1 LT, DKl &2VvoL
E3 2
L4 7Z0h B2 (Function)] Y—W A=l H 2747 FVVA MBI S &3 T "
B H OVE R R 1 DR Bt > T B 2547 5B L £

B 2 D1F 1%

B A 21 B9 B

1. B % (Function)] Y—L =T, 47 FVVA MEIAT7 FZVEIER L ET,
fal Zero Lib %k & LW

Zero_Lib
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VIV H AR
2= 19: A XY MR—ZDWeb~v /oL I—X

2. B BB (New Function)] 74 22(&) % 27Uy LT B LOBI B 21E R L &9
Lo, KB E OB A7 INSE N S &7,
I + Function [Unspecified]

3. R7vr'z744%B JBA C3(Open/Close the Step Editor)]( )71 a>%2Uv/LT
B 2B L. A7 o7 CH D5 F 4K R L&

i [>
+ Function [Unspecified]
Step

Function Name:

End Event: Automatic: Action completed -

Function Arguments

4. B %4 (Function Name)] X v/ AT, BB DL AT 2N 1 L &7

5. 7 AX>MEndEvent)] VA b, 8 T ARV bR L T, sFAl icoL g T
BT AN MIOLT"IRORN— 1 2Z ] L T80,

6. B9 % D5 H(Function Arguments)] &5l L £7.

7. §r Lus3] $ D Bk (Create a new argument)] 71 2>(+) %2V v oL £,

Sl 27 A %hh & &
8. BIM KDL NEH LT,

a. BRET(Name)] £ v2 A5 HDObh 0T LT 2N 1 L. BB 2 ¢ 32L&
ED &Rl EZRE TRNELLBDNBENLET.

b. BAZ(Type)] VA 6. 5l B DR 7 %#IE R L& . RN & PFEFH
(string)] . E¥i(integer)]. P —ff (boolean)] T .

c. fEE (Optional)] VA b6, Gl B AMER TH B EMEfEE LET. BRI
[ a(true)] 721k [y Z(false)] T

d OKl]z7VUvrL &9,
I B AT BN &N £5,

51 Hr O £

BB D5 B 24w & & 214
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VIV AA R
2= 19: A XY MR—ZDWeb~v /oL I—X

1. B ¥ D3] #(Function Arguments)] 7—7 L C. 44 § 35| B 218 R L £ 7

L

+ Function sample_function

Step
Function Arguments +
Name Type Optional
ﬁh StringData % string falzse

ﬁ-a-, BooleanSelector boolean falze

2. Bl ¥ o4 (Editargument)] 71 /()5 2V L £
S| B =7 42000 & £
3. MEIEL DA " X—22451 D AT v7 8D WKt >C . 5l B 2 H L &4

g1 # O
518 ZHI Bk 9 5120

1. B ¥ D5 F (Function Arguments)] 7—7 L C. Bl & 4 25 ¥ 28R L £

2. IBIR L7 ¥ £EI B 3 3(Delete the selected argument)] 71 2> /(T % 7 Vv s L
ER

T ARY MZOWT
Web~ 7ol a—XKld, 4 E— SN TV B T STHFTOHRP DAV MEAEK I T AN

VIR AETERANTEEFRE LEFT. Web~v oL a—KZHEH B CEE R T 25 T ARy
befli H 9 200 AT v7 R D& T AR FEE| DY TEIENTEET,

KDFE TlE. Web~v2olL a—K T EE 4T ARy MCODWTCERBH L £9°,
BT ARV i B

Action completed A7 v7 77y aE T TR T LET. 770 20— &L
(702 BET) T RR U sh b NET.

Automatic: Action A7 v7lE. 77y 2n5E T Lz ETruClientnSig i Lz X128k T
completed (B #i: L7,
7oy S T)

Dialog opened (X A7 w7 a3 XA 707 Ry AWK Wik 288 7 L&,
4707 B Vi)

Document Loaded A7 v7ld. R¥axr bOO—RFLEE 2352 T L& T LT,
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VIV AA R
2= 19: A XY MR—ZDWeb~v /oL I—X

BT ARV e B

(FF a2 X MRa—F FXRTCOAZVT FERRA VY — bDO— 5% [ LTHEAT SN, T
Ih ) RTCDA A=V PR O— RSN TR R SIN T ET,

DOM Content A7 v7'1&« X—DDOM (Document Object Model) D¥E ffi 73 C &

Loaded (DOM >  7z&&WZE T LET. N—=YDarv 7>V, AXA)v, 8 LUFEIE 2
FrVho— & YE 4 21-0DAPIE. 77 V75— 22D 254 7> Ml a— s 5EL

1) R &2 THL UM HHE 5T &,
Step network A7 v7'1& « XMLHttpRequestiz & > TR 4 Sn -E kK 25 &, ¥

completed (R7 v7" TOHTTPE R M5 | LIc&&WZ&& T LET,
DAy MT—IHB5E
T)

Step synchronous A7 v71d $ X TOHTTPE R 7358 T LIz & T LET (AT v
network completed (CB{R D A—7 G B AT U s THBE R G ).
(A7y7OFE 2y HBH . Ih 60O%E K IEXMLHttpRequest #ff fl L T b4 & &
hI—2H5ET) R

o7 7 hEAE O A

Web~ 2oL a—XKiE. &—%7 v M\WebH A hD oy 7w M 2E B M TE 23554 2%
NET 1L D ELZBOR 220l 70 MoFE2I6E T&ET. I 6O M i 1z s
rE. e —ldal/ Ay~ /uEE O LTH aZ 4L, P LT o6 2F v 25
LEd. U77'7I\a<4¢174§?’§:1§}zﬁ LT, a7 77 M 2B IN. e, BLUHI R TE &
T

BE! IO/ 77 MEORK Ly ML Z—7 v A MDAF yoh e/ 77 b
ENBT—RFTRTUEDVWTHN—FT IV ERH VLT,

a7 7 MDA

D777 N EER L VDL VS ET. 0l TN NIATEBIR—YNDE R ZHE T
ZLNERHNET. OF 77 N TF 4XTE IRDRATD Tl 77 NEAE 51E K B & O
HMTx%d,

o« Ly LNR—ZA- URL&E%%%%E PEH LT R D2—F 58 T VKA L 7 MR E
LEd. Fo74v %R LT 0l 77 M e MNIATBERANDIGZE CHE S T 21E R
LR 3 B0 URL’a?)\jJ TEILERHNET,

© ANV IR—R-57 filJavaSeript £ A L Ce” 77 Ak i L. Fortify Weblnspect
t /*T"CLL%D LEd. 7>7L—hDYR l\fa>647“/7)1/®JavaScr|pt:!—‘l\?a”:k?ﬁ L. 77
Vr— A LicnZ 70 MEIF LA 2L a— FERE TEET. 707 L — hOREAN
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Y= A R
% 19: /XY MX—ADWeb~v /oL 0—X

WOWTET"AXR s R—=20 a7 77 b7 o7 L—MIODOW " XN—U252 15 B LTS
W,

PLET D N— 2 DWeb~v 2oL a—Xhaedny 77 M

H & o/ 77 M& i %43 ] L. Macro Engine 5.<version>CWeb~ /7oL :—m:gaﬁ sh
feve/nsfliH LCAF v #FAT LG A I 2L 0nas R 25 Sl CIm Rt nd &
T IRDTVET LT S izaZ 70 MM BB 322 t%@b&;wt

1. ARy MR—Z2DWeb~v /oL 2—XCHEZ D~ 7o x£7.

2. [eZ 77 Mk OHBRE 71 )5 200 £
0y 77 MEME T A8HE X, TR EREERIFEADTRTOOY 77 MEAE R
FRENET.,

3. MAFEOEBI s 7y M EHIR L&D,
4., v~ /orBHELET,
LooZ 7y M E BN ST S &Y,

07 77 M Z T AZND T 7k A

ns 77 Mg T A %% Qi IROFNEE#EAT L ET .

o QI AVHRI L6, (a2 7Y MR OHBRE] T /()5 o)L & T,
07 7 MR T 4800 &L T T FRERIEADTRTOOY 77 MAE AR
NINFT,

Yoy 2 R—2A0 07 777 bk #O) il
vy R R—AD B 77 M FE N T 212

1. £EXA VT, i Lukyy ol 77 bME4E DB N (Add new session logout
condition)] 71 a>(+) %27 Vv/L £9 .

oy o R—2007 77 MBI S 7.

2. BHEi(Name)] R vo Rz, Fr LOFK M ORZRAT AN I L &T
e Al OF D44 H I AT LF] R T S &5

3. T 20777 MDA T H#IEIR L, ZOXALT UL ELEREANTILET IROD
K. ATY O R LET.

*7'y av =5 Bl

Regex D47y &M LT, IEH R Bl (regex) M 28 L £ 3. IEHI R
B, LFH 0y bR 38— Td. EHEHRE. 858%
ZEETEERA LN SN2 A DL E T H D
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IV AR

=19 AR pPR—ADWeb~v /oL 2—X

*7Y av

URL

i B

FONKESR SN F9 . IERER B & 2505, 25 D2 —4 12078,

COMERE AT 92 & C L TS0,

Regexid . a)fri# SN 1z R—DW T 7L RT BlcbDul A > a2—H D

SR ADIG R & b)[A] Ui SN 1e_R—V W7 /8 AT 212010, 1

TAYLTOL 02— 26D U R (x4 200 2 O L 5

T2UERDNET . Regex#ME 7 2— M 2 FNHIFIRD LB Y

Y.

a. Web7oF>v— L& E LT.Web b7 1y 7 %508k LE T,
SEANICOWLTIE . Web7' v ¥ v DL £ 121k OpenText™ Fortify
Weblnspect—iL 77+ FeZ H L T 280,

b. =7 vbhA Mzal 4> L. i S feX—YDURLEZaE—L
ES

c. B/ 77 LT, ab—LIURLEZM A LT, o/ (/8 IR &
NleXN—2oL 77 AL ET,

d. BEZLIR L. o/ A4 2T IfRE SN IeX—212 7 72 AL
DL % O A % i &5 e LET,

e. EHEBH 7 4x%0 & &4 . sF4l OO TE. EHEHR =7+
ZDN)VT & 2id OpenText™ Fortify Weblnspect > —L 771 %
Z MR LT S0,

f. oA S IRE SN R —DW T 7 AL O 2 OfE FH
s AR M L7-Regex SR L £ 7,

g. B/ 77 Mk =7 1 ZD[Regex] 74—V NiZregex s I E—L £
ERS

COAT Y s ZIEIR T 2 & BUER IR ST 2WebXN—Y 437 7 1
IV ME ELTHEIE ] SN &d. 2= v A ia—F &ns
77 BESYRAL 7 MY BEFIURL SR E C& &0 X7 v b
FA NP a/ A N—VIEIEE L&A,

4. [AC3z2)voLTas 7y MR L. vl 77 Mk 27 425 L& 7.

ARy MR—ADrZ 77 M DB I
ARy MR—20O 1Y 77 M FB I 2120

1. ERA>T. BZ 77 MAE D8 N (Add logout condition)] Fe v K> 74 23(v) %

VAR VAN

K R> pX—Z(Event-based)] #1Z R L £ 7.

ARy MR—2AD a7 77 M AE N &0, JavaScript 32— FIZ7 4 &R E R S &9,
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Y=L HA K
=19 A XY MR—ZDWeb~v /7oL 2—X

@& Logout Condition Editor - m} X

Logout Condition Editor Event-based Logout Condition

v
+ B Name: EventBased_1

EventBased_1 Timeout 15

1/ // Start typing your JavaScript logout condition here

« Important! An event-based logout condition uses JavaScript and runs in the browser only during execution.

« Calling Weblnspect JavaScript AP1 ‘Wl.notifyLoggedOut’ is required to end script execution. Refer to the Web Macro Recorder
documentation for more information.

« The code editor supports autocomplete functionality. To view autocomplete suggestions, press 'Cirl + Space”.

2. Name(£Z®l)] A v/AC.H LK G OZRT 2N T LET .
Fe Al DF DA FI & 28T LA R (R S &7,

3. BALT7Y NTimeout)] K vo Az, 0l 70 Mk MEA LT N B [H] 280 AL T
ANTJTLET R %ME1&10-608 T3. 7 74 MEIG 158 T

4. RDFHE >THAT L E T
HH... Z0B A ...

ERRFAT 7L T  a Fr7L—MTemplates)] 2 Vy7L £ .
% B> 7'L— YA NTemplates List)] XA 72/
Ryl AN &3, 707 L— FOFEAT 2D
T "URY MR—207 77 7> 7 L—F
ZOWT"IRORN—Y 155 L TS0,
b. £ OXA>T, 77 L—r&IEIR L ET.
c. B—WNLoad)]%7VUysL £
BAE DAY pR—2D Y 77 ’MeAF A, %
RNLl7>7L—rDa— R CLEE & 332t
FEE 270 T MR SN &Y.
. FEZ(Confirm)] £ 2Vy/LEd.
e. I—FARI—RFI7T 4B SN £,
f. 7705—y DA Ry M—2Du” 77 Mk
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Y= A R
% 19: /XY MX—ADWeb~v /oL 0—X

HH... OB A ...
4 T O B2 CCJavaScript a4 4 L £9.
P H dJavaScript #1E ik % a— RNz 7 4&CJavaScripta— FEAN T L &7,

EY b a—7 4> 7 icA— har 7 U— hOfiE
#2378 9 BI12id . <CTRL> + <Space> %47
L7,

HE! EBFAO7>7L— M H 32565 A Oa—FELIR T 255 b,
Fortify Weblnspectt >4ricas 77 MREE #IE A L TRA L7V b 3 2728
(2« JavaScriptid IR D a— R T L 2L E D NE T,

WI.notifylLoggedOut(isLoggedOut);
5. [ACBl27VyrLTry 7Y Mk 2RAF L. 0l 70 MEM 27 42 %H L &7

07 7‘7 I\/T\ ﬁi D

1. ERACHE T 207 77 MM 2N L ES.
[ZaARF AR T a T 48— B ER SN ET.
2. LE S LT7 a7 15 mELET.
3. LBV LTal 7 MEAE &R AE L. 0l 77 Mk 27 1 2% L &7,

07 7w bk A OHER
0y 77 Mk 2T A XTREAF D ul 7 Mk EHI R 321 OFJEH 4T LET.

1. EXAVTHIBR T 207 77 M 28R L &4,
2. BB 743 @) &7yl &7,
[H Bk Ol 817 0> 7 MR R S &,
3. [EW]&27YvsL &7,
4. [ Cale2VvoLTry Ty MR #RAF L. T 7 MEAF 2T 425 L&,

ARY MR—Z2A0OaZ 77 hT7 > 7L —MZIDWT

CDIEYITE T7Vr—y 2 OEFRICE DY THE TERZ2ARNY MR—ADRI 77 b7 v
TL—NMNIOWTERI L4,
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=19 /XY pR—ZADWeb~v /7oL 2—X

Missing Local Storage Key

CDF>7L—NME. O— VA ML=V F =R O W EKIIRE T 207 77 M 2L
FELEST, COARY MR—2AD /77 bMEME Tl Web X bL— O H #8 31 20
ERDVET sf A OOTUL T GE L A7y 2" XN—23041 45 R L T2 S0,

X DF Tid Missing Local Storage Key 7 > 7L — hCfifi H & Tu» 2JavaScript 72— RiZD
WTEL A L &7,

JavaScript =— K it B

var token = window.localStorage. getItem("<key>"); TSI IARAE S
TWaIEE sz
F—DHE#R L. Z
1 Ztoken & K%
I DS F s 4 L
ES R

var islLoggedOut = document.location.origin == "http document.location
(s)://<path>:<port>" && !token; .originZ’ /87 48
5 € LIzURLIC—
M 2400, b—
IV DM BN
WawalZ 7w Mk
fFamERR L&Ed.

WI.notifyLoggedOut(isLoggedOut); trHnalZ 77 M
fz C & #=Fortify
WeblnspectiZ i %1
L7,

Missing Session Storage Key

DTV 7 L—ME, £y s AP —YF =R O W ERIHE T2l 77 Mq %
ML ET. COARY MR—2007 77 METld. Web A ML —Y DR H 26 3103 %
MERHVET . sf A OOTE T EE M A7y 2" XN—23041 25 IR L T2 S0,

X DF Tld . Missing Session Storage Key 7 >7'L— Cf#i ] &t T 2JavaScripta—
ZOWTE B L&,

JavaScripta— F i BA

var token = window.sessionStorage. getItem("<key>"); X vy AR L TR
SN THLRIEEL
Jo ¥ —O0ME #iR L.

OpenText™ Fortify Weblnspect (23.2.0) N—253/360



V=L HA RN
=19 /XY pR—ZADWeb~v /7oL 2—X

JavaScript 21— F

var islLoggedOut = document.location.origin ==
(s)://<path>:<port>" && !token;

WI.notifylLoggedOut(isLoggedOut);

"http

it B

Z1 Ftoken &y )%
A OZEH T A L
F9,

document.location
.origin7'@/\ 7 A
5 & LIZURLIC—

HT2LOD, b—
V2 Rl Y AR

L& wnlZ 7wk
EEER L ET.

trHnal 77 M
fz C & #=Fortify
WeblnspectiZ i %1
L£d,

Object Exists

COFYTL—NE 07 T T NeR § AT 20 MMEE T 3SR E 207 77 MM %

PR LE9,

X DF Tld . Object Exists 7 > 7'L— ¢/ il & T BJavaScript 2— R DWW T ] L &

ER

JavaScript 72— I B

const element = document. getElementById("<element_ id>"); fHELKIDE

FoEROD
EFELET.

WI.notifyLoggedOut(document.location.origin == "http document. loc

(s)://<path>:<port>" & & (element !== undefined && element ation.origin

I== null));

OpenText™ Fortify Weblnspect (23.2.0)
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& L7zURLIZ
— 3 L. i
SNTEERE D
e 3 31

SN s

nwaZ 77
fz C & Fortify
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V=V HA R
w19 A XY pR—Z2DWeb~v /7oL a—X

77y 2 DfF

TruClient¥ { FA—7 4> RO R EMAT V2 ATEB[T IV RALTTT 7y 2 OE R 6 &
VETHNTEET,

() TruChent fes Weblnapess (TruChent Browser) — (] »

D~ By gl @ an ~ [
Qstp OvPvDE 9 B QER

o 1D Magate 1o THIp N Eene wabappbecuity Comiogn M

+1 = Signin

L 1 ® Type whemams in Logn ladbax
o 2 | @ Type sesesens @ Priswond passwordbon
o 3 | @ Click on Sign in button

3 @ Wt uniil username exisls

Run Logic Actions Function Libraries

=

ye  Actions  Funebion Liware

CDRAT T, ~/70D 8¢ e . BLUOHA 2T 0T,

~7a~\D7 7y aDiB N
a7 oy o EBIN T A IR OEAE 2T VW ET

1. TruClient A KX—7 4> FoOH LI H B[ 77y s DEE] 71 2(E3) & 7Vv oL &
ERR

[7 7y s OB BIZA Tl Ry ANE R SR ET,
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(@) Manage Actions — O X

Actions List

+ W T Jd

Init_Seq g W
Action_Seq
End_Seq

2. [723y avDBEIMTAAT)VELYVILET. T2Y b DR T WL R 545 1 2 &
Uy,

77y DA O U 2
70y avDEF 21 X 2 2121k IROERAE 4T W E T,

1. TruClientt A =742 F7O4 FH 3[7 73 s DEH 74 2> (B3) 527Uy L &
R
[727y o DFBIZA 70l Ry ANK R SN ET.

2. 7Oy AR LT,

3. 74y HEVAIMITLE FEBE T2, [EAN&E[FAI7A 24T V)&s002
LEd.

7 7y 2 DH| &
7oy 2w R T B IROEANE E4T W ET,

1. TruClient¥ { b= 4> FoOf LI ICH B[T7 7Y OB B 74 3(E) 57 Vv L &
KR
[723 OB FRA 70l R v ARNE R SN E7.

2. HIBk¢27 7 av#IBIR L&

3. BIg 74 (% 2VysrL &,
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V=L HA RN
=19 /XY pR—ZADWeb~v /7oL 2—X

Web 2 L —v & —0fi i

IREEFH ICWeb A ML—Y 2+ 377 05—y av Tk, a7 (> 7 ov A (B E 4 3
F—FO— VAN —VUIRE TG ERONET. 77 V75— 23R 58 24 5] L T4+
T&EBENT 2012 Web~v/roL a—X T sDF—%FEH T 20 E1HNET., 2L
WA v /ol AT Ur—y 3 iEWeb A FL—U DR RE 24 H T &9, BEE Sh
TR NAF v R VAL 2 MR T 20 fEERNHNET,

WebA hL—v & —T7 (X% il 9 5& WebA bL—yF—#IB . M4 HIFR L7z0, 1
EHoX—%u—FLIZNT 22EnTEET,

Web A hL—Y F—I 7 4RX D7 7t A

Web A hL—Y F—x7 4 RX%EF] A2id:

o WebZ FL—yDH #— MSupport Web Storage)] &% i€ 4 %o L1248 . WebZA b
L— £ —D4k 4 (Edit Web Storage keys)] 7 1 2>(E) 57 Vv oL &7,
WebZ ML —Y F—x7 4&H6] & &7,
¥ 2O7Aavig. WebZ bL—Y D4 HR— NSupport Web Storage)] 7% 7€ 736 2
WESTOWEAGEILDARE SN ET . FFAIC DL T RE M A7y 22" R—v
3041 %S B LT 230,

HAEHDF—Do—R

Web A bL—y F—I7 4&%0 Gl C~/7uz2f A LTuidg &l i OF 4 Tl H sh
fe¥—%4n0—RFTC&Ed. HAELSF—FD—NT 212!

o H 4 »su—F(Load from playback)] & 2V v/ L £ .
Web A hL—2 F—D YR MZF—HRE IR SN £7

Web Z hL— F—DiE N
Web X fL—YF— 7 4KZWeb A ML —Y F—41B 0§ 21215

1. BmMI7AaH)&229970L &7
7 74 ME ZFF DWeb R L —y F—HiB Il & &4,

2. EF—%(KeyName)l 5| D7 74w bE X7 Vw7 L &7,
T4 FERE TEDE N A DET .

# Key Name + Key Name Type Storage Type

B 1 Key 1| Text Local

3. T4V R FH FE I EREBER AN LET,
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Y= A R
19 ANy fMR—Z2DWeb~v 7oL 2—X

4, F—LDRA7EEHE T3, F—48 DXA(7(Key Name Type)] 5l #8707y s
L. FavZ X7 R M6 XA 7 EIER LET. A7 23R DEB DT,

e 7FANText)-7'L—>7FAPCHM S 25 —% .
o EHKRB(Regex)- EM KRB CHN s 2x—4%4.
B IERRBCERE SUMGE BFEAT S &7

5. AN —YDRAT A TE 4512k R bL—YD X7 (Storage Type)] 5| &£ 7L 7Yy
Iy ROYZ R TUNA MPERAT #RIR L ET. 472 B IRDEENTT,
o D—MV-BENAR 2% L 22— HWebN—PIH 778 A5 2 L& T& 3
localStorage ) D7 — XD & .

o LyYar-T7IUWME Uize&Z7Y7 S %, sessionStoragey D7 — XD 4 .
6. R (Save)] z7VUvrL &,

Web A fL—VF—D 7 VKXYV T
7 —ROE R DF I DL TWebA ML —Y F—%2 7NV RTEET,
DA N DF—% Br—45 (Key Name)] T7 1L &9 212id:

1. BE—%(Key Name)]Fl OR i LEXT L 20w oL &7,
R LA S A w2 AnE R Sh £

Key Name [ilter by key name

2. RyI AR FZME#NTILET
VA MINTTICEDE TV RSN 7.
*—% EHRBEB(RegEX)] 721& F¥ R NText)] T71L &3 Bizid:

1. BF—4% OK(7(Key Name Type)] 5l DL LE#XTIL 72Uy 7L &5,
HH L Py R A MR v 7 ARE IR SN &7,
Key Name Type
2. 7TOVRFAHER L&

YA SN TV RSN T
b—7v(Local)] £721& R v 3>/(Session)] T 7 1L X9 B2l

1. RbL—YODLXAS7(Storage Type)] 5l DR LEXTV 7YoL &T
RH LRy X7V YR MRy AR IR SN ET .

2. 7TOVREAHIER L £
DA MATZ AV ZIN ET
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2= 19: A XY MR—ZDWeb~v /oL I—X

TV D 7T

B —4 (Key Name)] 12 & 27 0L &% 2 U7 4 31214
e R LDZVAR /A TCEE 7y /L £9 .

BF—4% O 21 7(Key Name Type)] £7zi& R hL— D XA 7(Storage Type)] D 7 1)L X%
V74 B

e HH LD FayZ X YA MRy AT, BRTAN] ##ER L &7

Web Z FL— +—0D% &
BEAE OWeb & hL—Y F— 540 5 4 21215

H: v /ol rnsdr—no—rFSndgE& . oD F—EMmETEET. 125l F—
% (Key Name)] #IE I R ICAETE L. F—% ODX(7(Key Name Type)] = [E#HFE
Bl (RegEX)] (222 5 L2 WIR 0 4 4R (IR BB & L DI WL B EE A

1. ZBHE T35 07 28707 )y LET.
2. MOWTNHLEFEITLES,
« BE—4%(KeyName)] DI & LB CTTF A MefifE LT,

o« B—4% D& 17(Key Name Type)] £/zi& R bL—Y D XA 7(Storage Type)] D15
. Py X YR b 6H I OfE #RI L &7

Web Z FL— £ —0 Y|
BEAE OWeb & FL—y — 54 [ 3 21214

o HIfkd2F—#BIN LT, BIBR] 7252000 7.
F—MNYR Mol S 4.

/85 A—ZDAF

v /uELEE T A A E. NS A—REF ] L TIR OFRAE 21T W £,

o 24 ENAT= RDATA=REAE R LT 7 AR—DAF x> DB 4R K (20l 3 DRE R
BRIBERAEH L0, vV Fa—HF ol A AE v B R OBKRER 2 H LT X
BENCLET. FEANCODOTE "2 = £ AT — RS A—ZDE " IR DXA— | %
S LT END,

e URLDNFA—=REER LT, v 7aDRATRICT AX—0ME B URLAFE & T& 54 L
9. COFVE T7Vr—y a0 OB ICHFE L. BAGH A>T 7L—y 284
Ak GE 1 7 VN Y—(CIICD) " A 754 > D—HB EL T AF v AT ¢ B35 & (fEF] T
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=19 /XY pR—ZADWeb~v /7oL 2—X

T, FEAH I OW T T"URL /S 54—l " X—22631 4 18 L T2 &0,

s WiEHTET A BLUVET A—WASRT—FD AT A—REMER LT 7 AX—32
FEMIE AU E LT 2N Fr—HF ol AV AF v E3EITTCELLEALET. SF41 o0
TUE T2H L BB AE ] D /8 5 4—RDfE " N—2661 %5 18 L TS0,

RILF UM F ZIX ] § 578 4—55

INTG AL TE R F N F DX S N FDEEEH CBENDHVET .

2—H4 LN A T— NS5 A—ZDff

/A ~raEER LTTANIAR  FLEE SNIE 23T A— R (LB &R 2 22— 4 &
NRAT—=PRDNRIGA—ZEERTEET. ZDB . BAEF IC2—5 4 EXRAT—RDRFA—R%
B X IAMEOVAMAER TEET

AT w7 TD /85 A—RZDVE Bk

22— LR RAT—RD AT A—RE, AV TFA M5 H L TCAT v/ CHBEEKR T&
ES 2P

AT T CNIGA—=REVER T 2121 IROFEHE D FE T,

1. 2R EFLAT V7T RT YT ITART A 22( ) &2 Vv L&T .
AT T ITT AZHE & &7,

2. BI#I=2 V0 2(BBH)LET.

3. MEIR v/ AT £ L. £ 7Yy L&

Arguments
* Walue: M.
Clear: Default (t Cut Text Ctri+X
Copy Text Ctri+C
/pi ral: | Runtime
Typing Interval: T Paste Text —_

Object ]
Create New Paramj%er From Selection...

Transactions
Replace Selection With Parameter 4

4. [Create New Parameter From Selection...(Z R 4> 637 LWy /35 x—K%4E BR)] 2158 41
L£9d.

[NIA=RZ DN ITNEAT Ol Ry I AHM & £7,
5. [/8FA—&4 K v7 AlZusername EN JJ L. [OK]Z 27U vo L &9
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®
Enter Parameter Name
Parameter Name username|
Original Value

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be set to 'username’.

OK Cancel

BE! A5~ 28 CEA LT UN LT K G S N LT Db e 00 B 2D
NE9,

6. NATV—REHELAT V7T AT YT ITART A2 V&7 YL ET .
AT 7' ITT ARHGH & T .
7. Bz (R LET.
[+ 7 AT #3#R L 7YoL ET S
9. [Cre;te New Parameter From Selection...((# R 2 63 Lty/8 54— %4E B )] 232 4R
LEd,
[RFA—RZ DN HEA Tl Ry AHE & & T .
10. [/3FA—RLZ]| A v AiZpassword EN JJ L. [OK] & 27Uy 7L £

2—HHG ENRT—=RFDATA—=RE AR I S 227 7 CTHEER SN TH &,
"ATGA=REA T Ol TIHO YA MEAE T 2" F DRI AR T as ] LTa—¥4 &
INAT— RS A—RDME D VA AR+ 2L BERHVET .

o

RIGA—ZEAL Tl THED YA MAERR T 3

NGA=BEA Tl B LT, 2—H4% &N AT—RD /RS A— K5 E &I 2 2ED VA M
ER LET.

BDOYRNAERR T 2120k IROFIE 54T LET,

1. TruClient A FR—T. [NSA—2D&E] 71 2(B) 2209l &7
REA=REAL T Ol H & AFA— KD — B R R SH &7,
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@ Parameter Dialog - m} x

—+ Add Parameter

N

username

password

®
2. 2—HWLZ RIA—REI Yy L ET,

2—HFLZ DED VA MIFER SN ET. v 7OICELEE SN 270 Ol 1X . ~ 7 of 4 B 1o/
2B 0BEELT—BEE RSN FET,

@ Parameter Dialog - m} *
~+ Add Paramater —+ Add Row
Masked
username g m
New Col 1 &
password
1 username
Policy
Select next row: Sequential -
®

B b A4 28 E T 2 TN VX DERE 7 A a>#27 Uy 7 L T LW 2N
J1L&Ed, fil:Uuser Names.

3. (A7 Y 2NANN LI E~A 0 21003 [RRZ) RN L £

H:Web~v /oL a—X T~ R 273N f{# & . FortifyWeblnspect$ & O
FortifyWeblnspect Enterprise T4 Ffif & AF v 5% i€ T2 L&ICEVYRISN &
£

4. (A7 2N OME #E M 212 (f2 L2 v v F2—HF ol AV AF x> Da—HZ DY
A NEER T 2356 % &),
a. fToEM%E7VyILET,
b. A=Y WEFH LWATCHEEILET,
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Y= A R
% 19: /XY MX—ADWeb~v /oL 0—X

c. vI/ulAERRIEHATAROBEENTILET,
d. BINT 2 T8, AT v7anbecETEEE DR L LT,
5. NAT—PFNIA=RE V7L &T
INAT—ROME D YR MR IR SN ET . vI/OIZRCE STt DfE I« v 7o AR
2ROl LT BER SN LT,
6. (A7 NANS LI E~ZA 0 21003 [RRI) RN L £
E:Web~v /oL a—XT~v A 73N 1248 & . FortifyWeblnspect$ & U

FortifyWeblnspect Enterprise T4 Ffif & AF v 45% i€ T L&ICE VRIS &
ER

7. (A7 2P O 2B I § B (l2 £Z21E vV F2—5 1l 4> A% x> DA ZAT— KD
VA NEVERR T 235 6 % &)
a. fTOBM]Z7Vvy L&Y,
b. #—YWEHF LTI LET.
c. VI/uM AR T2ROEZNTILET.
d. BINd 2l &, A7 v7ambcE TELE VR LT,

8. [OK|%227Vy /LT NFA—=RE~IORAF Ly NTA—RZA Tl 2/ CEd.

9. v/ usWA LT, aZ A NIE LOsREE L &1,

10. ~/7oaRfF L &7,

A r—
INTA=ZEA Tl IR S BR V—i% % I& « FortifyWeblnspectiZiditi | T& & ¥ A .

URL /% 5 x—&Dffi

/A ~7aEER LTTAMLIAR . BU 8% SN /8 T A— R4\ H &1 2 BURL/S S

A—REER TE LT,

AT 7 TD /85 A—ZDVE i,

URLNAFA—RIE, 2> T F A A=a—%FH LTCAT v N CHBEER TEET.

AT YT TCNRIGA—RENERR T B2k IROFIE5E4T L ET,

1. URLZE A7 o7 (B EI T 2]) Ty AFYTTTAXT A2 )& VvoL &7,
AT w7 LT A 2B &7,

2. BlFE2Vv2(ER)L &,

3. BBATIR v /AT 2B L. A 27Uy L ET.
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Arguments
* Location: hitp:/fzero.webappse T ] B...
Cut Text Ctrl+X
Transactions Copy Text Ctrl+C
Paste Text Ctrl+V

4 Signin ]
B 9 Create New Parameter From Selection...
i ® Wait until Settings exists

Replace Selection With Parameter L

4. [Create New Parameter From Selection...(Z2 R 2> 637 LWy /3 5 4A— K &4 )] 2158 4R
LEd,
[N A—=RZ DN NEA T 0l Ry I AH & £7,

x
Enter Parameter Name

Parameter Name starturl
Original Value http:/izero.webappsecurity.cg

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be set to
'http:/izero webappsecurity. com/login_html'.

oK Cancel

BE! NS4 REL TCRRLFENLERXP SN N LFDAEAES UL ERD
NET.

5. [/NFA—RZ] A v/ Ailstarturl s EDL R #N 11 L. [OK] 22 Vy/ L &7

starturl /85 A— &g AT I H SN 2A7T v 7 ICHBER SN TWET., ZITy /85 4—
ZEA 7 s #FH LT, starturl /35 A— DM DO VA MAERR T 2L E A H VE T,

RIGA—ZEA Tl THEDYA MAERR T 3

INGA—=REZAT7ar &4 H LT, starturl /3 5 4 — 258 X 2 2E O VA MERR L £
BOVAMAER T 21 IROFNE#FET LFEFT,

1. TruClient# A FA—T, [/SF4—XO& L7 2(B) 2 2Vy /L 7.
INSA—REA Tl D & RS A=K~ B RKR SN £7.
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@ Parameter Dialog — O «
=+ Add Parameter Add Row
starturl
®

2. URLNFA—RE 7Yy 3. COF| Cldstarturl & > T 9,

URLIE D VA MK IR SN ET . v /DL e SNt DE . v 7of AR i 32
BAYIOE L T—BER RSN &7,

(@ Parameter Dialog — O *
~+ Add Parameter —+ Add Row
Masked
starturl Z oW
New Col 1 &

1 | http/zero.webappsecurity.com/login.html

Policy

®

EY MK ZHREE T BICiE FINVRDERE 7 A a>% 7 )97 LT H LW & 2N
FJ1L&J . fl:URLs Listo

3. (A7 NFIOE 2B T 212 IROFNEZFETLLT.
a. UToEmMEZ7VysLET .
b. #—YEH LOIT B LET.
c. v/ulAER R TAROEENTTLET,
d. BT 2ETEC. AT v7anscEFCELGE DR LET.
4. [OK|% 27 Vy o LTI A—RETITOARTE L NI A—RZA T al 2 L &7,
5. v /uxHAE LT ol A HIE LusEEE LEd.
6. v/oEfRfFL&T.

A Yy—
INFGA=REA T a7 IZRK R S B8 V2 —% € & FortifyWeblnspectiZid i H T& € A
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V=L HA RN
19 {1 XY M—2DWeb~v 7oL 1—X

2F Z PR AEE FH D /3 F x—RDAE ik

oA ~/aEE LTTANIAR . BREE 5 BT A, BLIVEF A—IVDNARAT—
NRSGA—REER CEET. Z2OE . BET LN 6D 54— 2458 & 2 2HD VA I %
fETEFT 2B KRB DNRIA—RE[FH 24, vV Fa—HF ol AV AF ¥ 2EITT
FET,

EY b AXRY MR—Z2DWeb~v /oL 3—K TR A—XEER L& . v~ v Fa—4 o/ A
VAR pvEBRGE LB M fDEa?a‘%ﬁ\ BT AT LA, BEUERE T A RAT—
N#Fortify Weblnspect® R+ v>&% i€ : 5 Ak (Scan Settings: Authentication)] X1 7 o
THRYIAINTI TEET,

a5 8T A— XD R
QERBIE I NV—T AT v Tl VT FA MMz 5 LTEFEE S oA REH
e c&£7.
WRE WG SN TAREE R T B IRD A~y FEFEAT LET,
1. 2BEBIE I/ V—T AT 97Ty RF YT IFARTA 3 Ve o)L &
AT w7 LT 420G &7,
2. BIFE2Vv2(ER)L &,
3. [BREFEBIFAvIATE T 28I L. L4 7)o LETS

aly Py @
— SMS5S Two-factor authentication 1212
Step
Arguments
* Phone Number: 121 ™
o Cut Text Ctrl+x
* lan- +
Regular Expression: | /\d+)Ng Copy Text Ctrl+C
Transactions Paste Text Ctri+Vv

Create Mew Parameter From Selection...

T]#  Two-Factor Authentication stej Replace Selection With Parameter r

4. [Create New Parameter From Selection...((& R 5 687 Liy/8 54— K %4E fR)] i R
LEd,

[STA=RZ DN NEA Tl Ry AHH &,
5. [/\FA—&L A v AiZtwofa_phone EN F7 L. [OK] 22V v /L &9
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x
Enter Parameter Name
Parameter Name twofa_phone |
Original Value

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be setto ' 1212

oK Cancel

BE| RS54 RL TERLF EONLFHXA SN /NLF DA EESOLERD

NE9,

BT A B EOE T A=/ S AT— R85 A—RDAE B

2BRRBRE V=7 AT v Tld, AV T HFAMAZ2— % LTE T AV B SUPE T A—

WDNRAT— KRS A—REHIEER TEET,

BT A—IWBLVE T A—IWVDNRAT— RS A—REER T 22E . IRDa~v>y FEFEITLE

T

1. 2B BB/ NV —T AT w7 T AT YT TTARTA 3( V22U L &7

AT w7 TT AR & £9,
2. BI¥IEIVvo(ER)LET .
3. [BF A W]R v ATE T A—VT7 FLAZER L. A 7V ET,

v P
= Email Two-factor authentication {@email.com
Step
Arguments
* Email: T L
. ) Cut Text Ctrl+x
Server:
. 2000 Copy Text Ctrl+C
Sener Port Paste Text Ctrl+V
TLS: Default {true
* Pagssword: ssssssss | Lreate Mew Para@er From Selection...
* jon: /0
Regular Expression: | f0d+)/g Replace Selection With Parameter 4

4. [Create New Parameter From Selection...(i2 R 5> 68 L1y /35 A—R%&4E )] 212 4R

L&d.
[NIA=RZ DN KA Tl Ry A0 & &7
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V=LA AR

=19 A XY fMR—2DWeb~v /7oL 2—X

5. [/8FA—&LZ| K v/ Alltwofa_email EN F1 L. [OK] 22V v 2L £7 .

6. [NAT— KRR yIATRAT— &R L. A 7VvoLE9

Enter Parameter Name

Parameter Name twofa_email| |
Original Value

If the parameter name you use does not already
exist, it will be added as a type 'File' and the
Original Value will be setto ' {@email.com'.

OK Cancel

BE! RASARELTCERLFUNLERX P SN N L FDAEAES UL ERD

D&Y,

7. [Create New Parameter From Selection...(i& R 2> 587 L1y /85 x— K %&{E B )] £1E IR

L&d.

[NIA=RZ DN KA Tl Ry A0 & &7

8. [/NFA—&L A v AlZtwofa_emailpassword EN 71 L. [OK]Z 27 Vv 2L &9

F7v 27 MBI 4+ B AT v 5] $

TruClientCid . B Bl M S e A7y =2 M E 4 2R O AT w7 B B 41l T %
T,

"A—T AAOEE" K DA

"T IO E " IR D=

"F oy sR s ADE|" R—273
"H AR O F| " X—273
"ER O E|" R—273

"Z AV 7 ADIE E" XN—278
"Flash#4 7Y =7 hD " X—278
"7 A— A RW] fig w1 E" XN—2278
"YR bR w7 AR E| " X—2279
"Multi_listbox D% E|" K—279
"SUX T N—T DHLE|" K—280
"R Z4 XD E" X—3280
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o« "FEZME I ADHE]" A—281
o "7 A O E]" K —v281

F—7F 44 D% E

WORGE AT AAKEN AT 27 bNDY—0T7 02 2 DAT w7 B OWTEH LT &
9,

By b WEBI B 22— A > R7 =205 B L DL AR VR TR SN &d. X
TD5| ¥ 14 JavaScript 2— P8 L UTruClientié it 218 L T 5l T 22 ENTE£T,

5 % A
Ry F—F A OB O B (FP) 25K E £721308 L&,
7 5 D% E|

DR 77O E A7 27 M § 227 975 B HOWTEL LT &1,

B b BHGI B 2 A X7 ADF| H L OLE M OCE TR S &3, X
TD5| # & JavaScript 2— N8 L UTruClienti it 218 &L T i T 32 ENTEET,

777474
DR T I27 47T 73 D AT v7 5 B OWTERB LT &1,
5] #t i B
FH mEreLcER SN ET.
X4 P NFHELTER SN ET,
W A DV ST CHBICE B S B A7 o7 el T
RETEET,
[7 77 4747
WORE [T 2T 47WET T 2y s DAT v7 5 B DL T LTw &,
5 ¥ i B
T TIFA7WN T BT () EIRE LET.
24 v VY ELTER SN ET.
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19 {1 XY M—2DWeb~v 7oL 1—X

5l % B
W A VRSP H B CE R S B AT v LT
RETEES,

[FH L 3]sx7

WKDRIE[FALBETT 0y DAT w75 B OB TR LT £,

5 % B

T P37 feE L&d.

24 by RE LT Z0 T4y RO 7477 77 BB L& . L5

ELTERE SN T,
W 2 MVEER ST CHEBIRCE T sh. RE X7 v7¢L T

RETEEY,

[E n) &7

WORIE[BINETT 72 2D AT w75 FC OO T LT E T,

GIE wt B

% B LB w27 B B DURLEE € L&,

74¥ K T7Vr—y 2207 a—/ V74 RuA7 Y 27 b efg LET
¥E: window.location4 7Y =7 M . Internet Explorer Tl f#
HT&ithi. X 0iZdocument . URLAT Y =2 paffi FH L TK
1230,

¥ &)

WORG BT 72 DAT 75 OO LT Ed.

5 # . B

BAT . % E) ODURLEYR & L &7,
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)

WOFE[JR BT 7y aDAT v7 5 B ODOTEH LT &S,

5| ¥ i B

ATV b RAEXN—UH 2R ELFT,

1 &

WORE [T 2y DAT 7G| B OWTHP LT &7,

51 ¥ B

ATV b HEOR—VH ERE LET,

DA R

WDRIE[VFAR]T 73 2 DAT w7 B OB TEH I LTWL &9,

5l % B

& HLOEZEE LET. COMAETHDEEIT 5L BOY AU
THEINLVLEOLITEIR L NET,

=K Lo SERELLET. COMEFHDEXICT 2, & SO A
RIFAETH SN OB EV IR R ICH VET,

A 7a—)v

WO A2a—T7 oy aDAT 75 FIZOHWTE ] LTw 7.

51 ¥ B

XPE TR HLUOXEEEZR LET. TEHDEFICT 26 XTI >TAZ7u—
WLGWIEEmEK LET.

Y AR HLOYHBIE 2R LET. COMEZTEADE LT 2L, yHlcH -

TAZ7a—)L LW EEER L ET,
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19 {1 XY M—2DWeb~v 7oL 1—X

A 70l - R
MOFRG[KAT70l - MR T 72 2 DAT v7 5 B OO THH LTwET,

5 B i B

0 % [OK] 721 [F v> &V ]ER LET.

XA 7as7a>r7 b
WORE ZKAT70l7arT V772 avDAT 75 B ODWTHH LT &7,
5 % e B

fE AT 2L FHN R LET

HRY [OK] &/2d[F v n]am LET.

A7l -
WOFE.[FA 70l -7 7y 2D AT 975 F OO TEH LTwET,

5 B i B

2—4 AT 22—FZ #EELET.
SRAT—F AT 2B/ RAT7—FERE LET.
P AT BRA 58 ELET,
g 0% [OK] &/2d[F v en]aem LET.

LA 707 - NAT— RO R
RDR G [KAT 0T - RAT—ROWMER] 7 7 s> D AT w75 B DOOTEHH LT &9,

5] ¥ i B
RAT—F AT B 27— E LLT.
g % [OK] &/2d[F v n]aem LET.
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1. [TruClient] 1 KA—T. [RF v DI 74 2/ @ Step )5 29 L £,
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2. [Zo—#EE Vv L&,
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w
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FEATLET AT SO T 20 avid, JR 2. Va— R, &7 %] 0 2 2% EOAR
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o I5—T7AIVD LIV ARA T REFSE) LE T
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el;i & Wait ¥ Choose an object

Step 8: Wait Choose an object failed - Target object was not found. Reason:
Object not sat

~7nDFEATFIH

AT v NA AT w7 A Tl B AT v 7 DB Il A BN—E Ik 3 2720, >— 7> A% 4D
W oL, avra—L LA NSRBI ENTEET,

Y IOaDAT vINART v7 EFEAIT T BIE IROFNE2FEITLET,
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BINLET,

TL— KR A > FOHE A

TL—0RA Y b T B IR OEAE 2T W E T,
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B EoTlk. v /a8 Tl R M EDAT w7 DL RV ATFE OB FH LEWGE S 236
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1. TruClient# 4 FA—T. R7 v/ 42 H ¥ AT w7 TFART A 3 Va2Vl &
AT V7 TT AR & &7,

2. [RAT Y7V RV Ry K7V RENE 7Yy 7L HIIOL NV EEIR L&,

: T}D Gy e S E I
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LA HER AT TEN T,
AT T HEATY AT B IRDOFNE 24T LT,
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<CtrI>+<Alt>+<F4> 521 L A7 =/ MR IR T & £ 7,

T4V RELER SN2 TN —y DA T 27 b T 25 E kL [T4Y R &7 &
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2. [A7C 2o NEZ V(BB LT
3. BHEAEBRIZZVILT. 7T7Vr—y s N DAY =7 MEH I L &5
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r—3 2 OFNAE & oTE s A7Y 27 M OSCE HE GE 248 £ 8 4 200 3
HET,

2. A7 y7EFAE LT B BRIR SOl Em iR L&,

RE 27 7 DfF H

KRB A7 97 Cld. A7 v 7 W CHlRE LG B W R U7 7y 23T T2 50 i 4%
RNRCEET . HJRIBELEIHE LV EHEDODD B~/ 75— AD D, £123 7Ny HW T
AT 7 EE T T&EET .

F2EZUE HAEICESTTFAMB T RVANDATY 325 7)) 2IENTEES., 7
FAMIIEDOTIVIT 28 AT 7R T 256 HHVET. VA M OATY 2 DfF
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NSt A CHERE #EAT LT

2ol b By @ e
#£? Click on Signin button
Step
Arguments
Object

Transactions

RE 277 NER SN FT,

3 & Back

Alternative Steps - Select active step:

#7? Click on Signin button > E
## Select Signin from listbox (1) listbox [ =
£? Select #2 from listbox (1) listbox > E

2. MOWTNMEEITLET,

o 77—y 2 TE AT v ER IR T R NE DL M ICH B[AUTTAZY =2 b
FRPERR|TAIE)E )9 LET

EYMAUTEE . TANMP O 77 Vr—y sk LET,

CHIE AT 27 NOFR R R BT OX—U TELEH LD EfF U A A ME&RE 2
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&
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JavaScript
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HE) AV vRiE. T 740 bTH O, HER SN 3472 =7 M3 51T
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var my_results = document.querySelectorAll('a
[title="SearchResult"]");
random(my_results);
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A=y MR IR SN E 4. U B 125 LT [JavaSeript] 7 ¥ A bR v 2 2040 H B
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Related Objects (0)
+
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Select Add to add & new relation
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Related Objects (1)
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Accept-Language: en-Us

|User-Agent: Mazillafs.0 {compatible; MSIE 9.0; Windows NT 6.1; WO Trident/S.00

Accept-Encoding: gzip, deflate

Hosk: 195,90.21.104

HTTPf1.1 200 O

Date: Mo, 22 Dec 2014 15:533:04 GMT

Server: Apache2. 2,22 (Ubunku)

Cache-Control: no-cache, max-age=0, must-revalidate, no-skore
Conkent-Language: en-US

Wary: Accept-Encoding

Cantent-Type: bextihtml;charset=UTF-5

via: 1.1 SPI

Prozy-Connection: Keep-alive

Search |'n.-'iew v| For - Regex Found: O Find

Proey Server Stopped Showing 14 of 14

7. Ave—VOERRFIER ELEE + 21203 £7( Bx(View)]. BrEI(Split]. f&H
(Info)]. ¥7:1& "5+ (Browser)])Du\ " h m4iER L £ 4.
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BR(View)] 27 & 7=1& Br81(Split)] 27 %18 Fl 3 235 4 & . URLF 2— MURL
Decode)] A 2> #IE R LT, B3R L Z OURLT a— M %) & RN e cE £4,
¥ £A EDFortify Weblnspect L 2 774y 27IJURLT Ty a— RS T 3728, CO%
RE i H] 72 & HTTP X o=V O i 8K B 1o & & 3. @i B Dz, [7] CGET#
RKOWDURLTY a— A= av &7 a— FNN— v 2 L £ 9.

o GET
/notes.asp?noteid=1%20union%20%20select%200%2c1%2c2%20from%20informatio
n_schema.tables%20order%20by%204%20desc%201imit%201 HTTP/1.1

e GET /notes.asp?noteid=1 union select 0,1,2 from information_
schema.tables order by 4 desc limit 1 HTTP/1.1

JGENF vy 7Ty a— NELG LA ShTw 2581k, Fv>2(Chunked)] + x> &
FE 45 (Compressed)] X276 3% D& 4. COMERE 12 & D, Web Proxy 7352 15 L1z

JCDIGE DIE D F o> IR SRR % 1R SN Tb B RN T& &7,

8. ZREHMED VLTI HME L LT)HIEE T2 RRSINTHEE vy 2D VR (>
SER 2R L. HTTP Editor 71 2> % 27 Vv 2L &3 (/i ER #4572V oL, a>7
F A hx=a2—»5 HTTP Editor] 2R L £9).

9. VAInbBYyy avE7U7F 31E. 1200 DX vy 3 %1E R L T<Delete>F— %4 L
F9(£7218. HE(Edit)]> B 22977 3(Clear Selected)] # 7V v 7L £9). X
TOw vy %2073 212k, FREEdIY)]> BRXT2Y7(Clear Al 2V L £7.

¥E: Web ProxyD VR bbbt vy av#7U7 3 %8, 20X vy avid £ 7' F vah iz
F—ZhobHI R SN &9, 12EZ21E VA MI100D & v 3058 £ TH T, 2D 55
98% 7 U7 LIAR T vy av # 7 7 IWIRAF LI & L 7k DD2DD & v 31215 3
EEINET. vy EIIVT TR E L FvIR v AR L TS0,

P71V (File)] A=a—%MH LT IR LIZER & - 774902 vy a7 7 (. tsf)IfR
7L BTt co—r L Ed( Pr4v(File)]> B {Open)] =~> F&EEH). £z, —
T DR #Web~ 7o &L TR L. Fortify Weblnspect 2% x> #5417 ¢ 2 L& Wil 4 3
CELTEET. TRTD P (File)] A=a—av> F&. [ Fzyr~—2fF & 18 K 125
SN 7,

Y vy 2 DIRAF
% THM T 2201200 EDv vy av #7147 § 20l

1. EMH O CF zvr~—205F T RET 2y o5& R L ET,

2. Pr(File)] x=2—%2VvsLT. f#FE(Save)] £/2id B BT &4 1 TR 7F (Save
As)] ZIER L &7,

3. PrMn4&(Filename)] K v7 A&l #NJ1 L. R (Save)l #2VvrL &7,
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VIO AINE

Web ProxyD YA b2 vy a2 7074 28, ZOL vy avlE F¥7 F ¥SLic7 — &6
BB S &4, 7282018 VA M 1000){2‘7“/3‘/75‘3/5".\ FNTHLT, ZDIH598% 7 )7 L1144 T
Yyl ETAIWARAE LIZEG &k D200 v vy 21208 E Fn £,

1O FE DX vy 352074 B2k

1. Loy 25BN L FT. HE Dt vy 2D 4 (£, <Ctrl>F — F /21X <Shift> + — %/ [
LEd,

YE: AE Lyl 3 E2 207358 . Frvrh v/ AEMEA LT E 80,
2. MOWTNhEFETLET.
o <Delete>+—%f L £
o W& (Edit)]> R 2 2Y7(Clear Selected)] # 7 Vv oL £,

FTRCODL vy EIVTTBIE R E2)yrLET (1208 FEEdY]> FRT2YT
(Clear All)] £ 2V v 2L £ 7).

Rt — DR &

Web Proxy 74> RO R &8 cH B3> bo—v e LT, & (View)] 27, B #|
(Split)] X7, &1 15 (Info)] X7 1F 3 SN B Ave—o N O # 4R TE£7.

Ay —Y EM R § I

1. & (Search)] VA b6, BB T 27BN L E7.

2. jjﬁ%?f—-ﬂ(For)] R/ MRE T 27 HANE G THA MR TERER)EA
LE7.

3. AT v72TCIEH KRB AN LI A k. IERRB(Regex)] 7 =/ R vo A% 4L
£,

4. BERFind)] 52Vl %7,

FE: FRROFHEEN LTFE TRR LAVGTHC L, # 2o 2 TR 2R R

TEV—IWEEM T2 TEET. [MRE: MR LB R X—U3251 6 ST

E 7
ST" RX—v326] %5 18 LT 2 au,

TRTOD At —T D&

TRTCODL vy > THREDHFREZR R TEET,
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TRTD Ay —Y MR T BI2UE:

1. V= —0 BRE e2—01] h& %2 (Toggle Search View)] & s 4% 2y 7L £4(&

1zid R (View)] x=2—»5 BZE (Search)] ZE R L £9).

& zY7(Search Area)] VA rfi I LT, X TD L vy 2 ON Bk 2K 4

20\ HFE DL A MR E LTHRER T2 E LT,

3. BREF—AXSearchFor)] Ry A MR T27FA R TIEHREH 2NN L Z
ER

4. P& (Search)] #/7Vy/L &9

H: LR OFEAFH LTFH CHRRE LAVTHEO SN, & o o CHER 2B R

TEL—EIE M T BCELTEXT . [T MR LRI ~—v325) 8 KUTE: 7
77" X—v3261#Z R L T80,

N

F7° 3 DA

Web Proxy 47y s> #4255 ¥ 31214

1. Web Proxy# VA LT 254 5 IROWThh£F4T LET,
o PuFy(Proxy)] x=2—%2YysL. fE1E(Stop)] #iEIR L £,
o« V= A—OB%EZ) v LET .

2. PRE(Edit)]> B E(Settings)] 27 Vy2L. P'oX4—s3(Proxy Servers)] 7%
EIRL &7,
FEANCOWTE TR e 7o o — " X—U3221 #5 H8 L T2 30,

Web Proxy ® &7

FHTTPE vy ax(1DDE K & 24U IR ¥ 2)0 &) 25 Web Proxy®D L XA > ic—&
RARSINET . Lyy a2 28R § 2 & Web ProxyD | #H XA 22D v a2 § 21
WK RSN ET RN SN BEREBIR T 22700 -TRLVET,

AT —RAN—DFT L WCH2a> bo— B2 H LT 6D X7 TR E D a> 7 > Y 28 &R
T&%7.

% 7~ (View)

BaANView)] 272 LT A T 2HTTP A v —V R R LET. K7H FD FryrK
TR MSER T&EB47Y a3 IR D EB DT,

o v a(Session): T4 K&t v (B R LGB O] ) ER R LET
o 7 774 5 5Web Proxy N\ D 3k (Request from browser to Web Proxy): 7" Z 7+ 23Web
Proxy(Zxl LCTIT ofc B R DA #RIN L &T
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» Web Proxy > 54— 3 \DE 3K (Request to server from Web Proxy): #— 3~ DWeb
ProxyZE K O& #F /R L7

o H—/3m5Web Proxy Dt & (Response from server to Web Proxy): Web Proxy (2
T2 L EDAER R LET

o Web Proxy 567 774 D> & (Response to browser from Web Proxy): 7' w4 (k7
3 2Web Proxy}h % DA 4R/~ LET

7 E (Split)

Br&8(Split)] 27 % 27Uy /LT 12D v SAR2ODER V7 2ER L& . o &zlds 7
SUHI & >TE R SN ZHTTPE K Avt—Y(120 V7)) & H— N & >TE K S iz
HTTPILZRQEFEH DTV 4R R T&ET .

1% # (Info)

B (Info)] 27 %L LC. ZR B T 25 4B IR 2R R L& 3. B CiE B ov ol
TA—LOH . ANVRER . BLUR—=2 D7 0 740 g £7

7 Z 74 (Browser)

PS4 (Browser)] X7% 2V v 2 LTy 750 C74—v v SR R O & 85 L &
¥

Web Proxyxt 7% 8 £— K~

Ayt —\Web Proxy (2 Ji W7k S T8 757 ER &5 — G B 2R N T BRI Xt
M E—rEEH LET. BECend)] #2003 34T Avb— IS8 S ia) U THE 2
A EHA INICED, Ave—V 4R S RTICAEE C& T,

B (Deny)] 22Uy LT Ave—V 09— NER SN WEINTBIELTELT,

Web Proxy#% 5 (Web Proxy Settings)] 71> K7D & #% (General)] &7 %1f H L .
Web Proxy %5 i [ 12X O & He—RefF Ik T& &7

o BER DI

o KIHE DB

o BR XIS BHFE DT F AN, DT AR (R Vv—v & )
Web Proxy>t 55 £ £— FO A x—Y

W DA A= 1& %} 55 B £— FOWeb Proxy 47~ LT &7,
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[ a

E_H Interactive hode EI@

Response To Client:  Saved Data |Original

HTTP/1.1 200 QK -
Date: Mon, 22 Dec 2014 193955 GMT

Server: dpachefz.2.22 (Ubuntu)

Cache-Control: no-cache, max-age=0, must-revalidate, no-store
Content-Language: en-LS

Wary: Accept-Encoding

Content-Type: text/hkml;charset=UTF-3

Viar 1.1 5PI

Prosv-Connection; Keep-alive

Conkent-Length: 14677

m

ZIDOCTYPE bkl =
<html lang="en"=
<head=
<meta charset="utf-3"=
<title =Zero - Account Summary < title =
=meka name="viewpart" conkent="width=device-width, initial-scale=1.0,1
<meka http-equiv="%-Ua-Compatible" content="IE=Edge" =

<link type="text/css" rel="stylesheet" href="{resources css/bookstrap . mir
<link type="text/css" rel="stylesheat" href="{resources css/font-awesonm
<link type="text/css" rel="stylesheet" href="fresourcescss/main.css"f =

<scriph sre="{resources)jsfiquery-1.8.2.min.js" = <fscripk >
<sctipt src="resources s boakskrap, min, j5" = =) scripk =

<script sre="{resources)js/placeholders. min. j5" = </ scripk = -
Fl it [

Save Data Cancel Interactive [ Send ] | Deny

x5 M £— FOF gk

PRI Sl N S NN a TN = &

1. Pofy(Proxy)] A=2—%72Yv7L. {Z1k(Stop)] ZiER L 7.

2. WOOBTNHhEEIT LET.
o PoF(Proxy)] A =2—%2VvsL. kt5EE (Interactive)] ZiE R L 7.
* == g ryysL T,

3. Poxy(Proxy)] »=2—%2YysL. BA%(Start)] Zi#R L L7,

¥¥: Web Proxy 35t 55 B £— FDIG & . P'af ¥ (Proxy)] A=2—0 kiag L
(Interactive)] a~> FOREIZF zvr~— 00 f & M FE R 74 3> DRy 4 "3 fT L

JRBE R 00 7Hav &0 Yy ot 2h, v NERIR T 260 k5 R £— PO A
YEXTBY) VB D VET .
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& 7€ (Settings)

D7 a7 42— b LT, Web Proxy®D 1 > &7 x— 2D &« 7' 0¥ >+ —/ Dil il .
BEUER 123 )55 N OF € DE IR IR 7 2720 DIE R OE R 21T &7

HE: Web Proxy DS AT HH 3R 22 H C& &t A. PoF(Proxy)] A=2—»5 &
1 (Stop)] ZEE4R L. 3% € 22 ¥ L C. Web Proxy #H 8 L £9,

Web Proxy® §% & (Settings)] 7 2/8 7 43— MZIE IRD X7 D H N EF .

o 4 (General) (M &= " T 125 1K)

o 7'mF v H—/s3(Proxy Servers) (" ic: 7 o o h—" R OX—v 1 25 1))
o f&Z& LHE ¥ (Search and Replace) (1% i : i 2 LB " XN—2325] 5 1])
o 757 (Flag) (M. 757" X—326] % 1])

o [A] 3 (Evasions) ("% ¢ - [l " ~—3261 2% )

o v 77— 2788 A (Network Authentication) (T3 72 : 4 v b7 —Zi8GE" X—2330) %5
i)

YT A T
B % (General)] 27 (2ld IRDATS av Vv En &4

7'n¥ v YA+ —Di% i€ (Proxy Listener Configuration)

IP7 NLZEF— MES 2N J LET. 7 741 kT Web Proxyld 7 FL 2127.0.0.1 £ —
8080 %1% i L &9 45, W B UCAS T CE &7,

¥E: Web Proxy EWeb 7' 5%+ Ofli 77 T+ [f UIP 7 L R &4 — Nl il 3 206 B 30 0 &
T,

H 7> DA A L DWeb Proxy #jil] D A T 3 2 & JTEE § 212 v—UIP7 FL
ADEEEE T 2L ERNHVET. 7 74V DT FL ATH 3127.0.0.11% . #F 3+ 2 STl
[ TEEtA. COE 27— 2A7—> 2 OREDIPT FL AL E T4, VE— PR
T— 2 CEFDOV— A T—y 57 nx LT TE £,

At #% L% \»(Do Not Record)

COA7y av# ] LT, R € DRA7D 7 74 )L 5Web ProxyiZ & > T & 2D %7 <
EREBR 7V REERLET. I & BB RA71E. TTET 74 bEL TSN S Tw
9. 1220, 20 D KXA 7 (MPEG. PDF 5 £) 64 T& & 3. COH MG, Avbe—Y R
L AEANE T —REHI B L HTTPE K /52 DAT ENvRICHE R 24 TB2ETT.
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%} & T (Interactive)

XFEE T — AT L Cuw 285 4 . Web Proxy 257k OFE %47 45 & 12— R 458 11 256 ]
T&d.

o UIAT U IMHAER EZIET 2

o Y—NDBINE EZIET B

o EM LB V—VE 2T T+ A MR T 2( P57 (Flag)] 47 %14 )

N 047y OWLTN»EEIR LG B (Allow)] R X% 27Y w7 L% » EWeb
Proxyld 1T LE€ A

&2 750 #% (Logging)

0y 77 AOVICELER T RIHH O XA 7 HEIR L, 0l Z7AVERGF T 27 4L 7 M VEFRE L &
ER

LR F12d G & O 8 AR R Lf:i%é“l;t\ Base 64> a—7 47 #fH LTT—R%E%

BLCo/RiRT 5o Eb IR TELT . TR WS G RO/ A V7 =K1 4=
Flash 7 71 V7% E) 2V Fh T 335 LJE%JT@“

o HDER LiE. 254 T ~rAWeb ProxyiZik g S 3HTTP Ayt —Y 498 L &4

o AZTH A% R &L Web Proxy 64— N2k fF SN ZHTTP Ayt —Y %4 L& § .

o L ODIGE LE . H—/3hAWeb ProxyZik 5 S BHTTP A vt —Y 548 L £ 7,

o AETHAB G Lk Web Proxy 7362754 7> M G SN BAHTTP Xy —v %1 L £ 7

= & % HTTPf# #T (Advanced HTTP Parsing)

i EA EDWebR—2 i 330 F £y M7 I7F M 68 2B RO s T g
T COFEIRIE HTML K 2 x> FOHEAD & 73 3> @Content-Typet: & N\ vX( & 21
HTTP-EQUIV/JE 14 2%F DMETAXZ) 2 LTIT b &d. L F 2y b7 7> AL T

OR—UH (CWeb Proxy Cff ] $XELF v b E TE &7,

BRE: 7 oF i H—AN

DT Y7 %F H LT Web Proxyll & >Tv—7 4> 7 S 29 X TOE R 2iE I § 21DL
LFo7axey—n"E2EMLE&T. LB 2EHOH— N ’/\ﬁﬂl?‘éc‘ﬁﬁﬂj ORI D L <%
i Ny A= MR NAREN > AT L& L& DL TE AT RE T D & 277 % 2B L Cu
EQ A

B O7ax o — " %fi ] 4 3154 . Web Proxyld B3k 2T 57> Fobey | CALEE L £9
(D% 0. Web Proxy!d i #] DE K 25 ¥] D4 — NMZiE(E L. 2% H OE R 1E2% H 04—
NEE T 20 ol A&7 af o — "D YR MEERALEE L E4).

TaX YN T T /AT BIP7 L AEIRE T3 TCEET,
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7'a¥ 4 —/3NDIE N
Web Proxy B sk O)v—7 4> 7 Ot &4 27 0% o4 — B 1 ¥ 242

1. P'oF¥> 7 FL A(Proxy Address)] & v27 ZiZ. Web Proxy % >k #)v—7 1> 7 3 ZFF 12
BHTE2H—DIP7 FLAEANTILET.

2. P'mxyR— MProxy Port)] X v/ ATHA—MES 282 LET,
3. Ve O (Proxy Type)] YA bh A7 0% o OFf K (15 4 . SOCKS4. 721k

SOCKS5) #I# R L £ .

4. BIT O LT, B L(None)]. EEj(Auto)]. Kerberos]. NTLM]. 721 &
7 (Basic)] ## R L £ 7.

1 Fl 4 208 58 2R B 235 4 1d . B B (Auto)] #3%4R L £ 9. Web Proxyld NTLMZZ
AE LA 3R AE O U7 23T L &7

5. COH—N\TRRAL DL E 2354 1. B—¥ 4 (Username)] K v/ & PRRAT—F
(Password)] + v 7 22 ﬁ%i‘%f WENSLET,

6. BIMAdd)] 227Vyrd 28 2OH—ARNEI SN, [EHTRE L7 0F 94—
(Available Proxy Servers)] VA MZIP 7 FL ARFK R SN &6

Z'a¥ o —1DAR— |
7 aF Y —DVA N A Vv — T B2

1. Ef‘/rF— Mimport)] 2 7Vv 7L £9 .

RO T ANIBIRKA 70 Ry A% EH LT, 7 axs 34— D VA MF
Delimited Text 7 7{ )L #1# R L £ 7

3. B {Open)]x2VUvsL&7d,

TaF I EREEC 7 AANVEIROER T 2L ERHNET.

o BATWIDDL a—FREF B, ZOBCF YoV VEA—V B LUVKRAIT X F 545 F £7 .
e LI—FHNDE 74—V NigtIaa> XY NET.

» 74—V NI, address;port;proxytype;username;password;authenticationtype DJIH (2 %
N9,

o WG ENAT—REATY TT . RELHERME 2 H Lawg &, 7L —A%
WEELT2DODE aar 25 20 ERHNET.
1l -

128.121.4.5;8080;Standard;magician;abracadabra;NTLM
127.153.0.3;80;socks4; ;None
128.121.6.9;443;socks5;myname;mypassword;None
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7'aF o — D4 B

7'aF S H—ND VR M E T BT

1. [ER 88 %7 2% > +—/3(Available Proxy Servers)] VA h 54— &€ L £
ED

2. pP'eFr 7 L A(Proxy Address)] . P'e¥ > 4A— MProxy Port)]. Pofsy (7
(Proxy Type)]. E—## (Username)]. &7zi& PXA7— K(Password)] ® 2> ho—)v
RSN AERELTE LET.

3. E#(Update)] #2VvrL &7,

7'aF >4 — D

DA b 67 0% 4 — N EH] i $ 211

1. [ER T Bk &7 0% 4— 3(Available Proxy Servers)] YA hh 54— 3518 4R L &
o

2. BiBx(Remove)l #/UyrL &7,
3. BEw(Yes)]#27Uys LT, HIk: #EwE LT,

7'a¥ o —/ND/NA RN R

K E OURL(K B 7 A A b O)NDT 72 A7 BF L H—" 5§ ] § 20 A5 0G4
& PoFs04/52YR NBypass Proxy List)] TU7T1DLL L DK 2 ~afEE T& 4
THFE DY A MNIT 72 AT BT oo — 2/ (/2T 51214

1. BmAdd)] z2Vyr7L &7,
Pro® > @A /3 Z(Bypass Proxy)] X4 70/ K v AR IR SN &7,
2. NAAZF ZHTTPURLDH A M4 #N 1 L £
70k au(http:/ Ze )& B2 DT E &,
F2EZ1E8 . COURLD 7 o v H— 3534 K27 B35 &
http://zero.webappsecurity.com/Page.html
COXLFHENTILET
zero.webappsecurity.com
I COLFH ENTILET
zero.*
HEIIP7RLAEN ] T32E8TEE9 . Web Proxyld & 2 1 %2IP 7 L A fi#E IR
LAEWCEFERE LTS, DEN IPT RL A%HEE L. 2 OHTTPE R (CFE R 12
ZOHAE DIPT FLAHE L4 T 25515 . Web Proxyld 2O A bO7 0 o 4—
NWaENANRALET . L L HTTPE R (CHF Eh T 2048 df8 € LEIP7 KL
AHRIR SN BH A MG TH 254 (KA ML 638 2 L W 9) Web Proxyld 5 &
Gr &7 oo —/NCER #EE LET.

3. OK]z7VvIL &9,
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7 KL ADH B

Pro¥ s dA (38R YR MBypass Proxy List)] 72567 FL Z%H| & 4 212id. 7 FL ZA%IE R
LT BHIBk(Remove)] #2VyoL &7,

AXE R CE B

CORTHEH LT HTTP Ay —Y N DFF A MR E AR BLUOE R T 20—V %1{E

RLET. COMERE L. B DY IaL—y 22 H B AT -0 OIEF IR 2V —L %

R LEFT RSN ZHBRERDEBNTT,

o YR RNAAT— N EDHE T —LDT A

o BHRADZyF—DIE N

o AcceptBE R NvX 74— )L FEETE LT G THR SNBAT AT A7 #BIN £121& Hl
42

o BRURINDEE #/70RY A NAZVT T4V 7B ICEHR T2

7 ¥ X MO R LH
BER FLEIGEDTFAMNERER LTCHE &R 2 3120

BinAdd)] 270y 7L &9,
Web Proxy(Z & o CT7—7WIZT 74V hO T MNUDMERL S £9.
> D R 74— N(Search Field)] %) # 2 Vy 7L £,
3. FawZ R REI &Yy LT MRR T 2 Ave—V T )7 %IER L &,
l/]‘ﬁ;i?7"*-*5Z(Search For)] 4 1o MR + 27 —K(&rd 77— 25K TIEHEH) 2N T
5. B#7—%Replace With)] 5. H.O»-olc7 —%458 & 2 57— 25N 1 LT,
6. MENL—IWEBIMTIER T B AT v71-5%4 DR L &7,

FRNIGZENLV—NVERRF SN TOREF CIEXRER SN &4, &L H2L—uh
HTTPS#SSLICZE B L. 2018 (2%t UV—IVMSSLASECURECZS § 4 285 & & &5 1 1
WHTTPS/ASECUREIZAS B & £,

R EBER DL —ViE . Web Proxy s 65— Nk 5 S BE R Ayt —Y B LU
Web Proxy 767 774 1CIE (G SN BIG 8 Ave— Wkt LTRIT SN Ed. FR
(Info)] #7 #1E R 3 27>, R~ (View)] 27 £7-1& §3#](Split)] K7 ##E IR L. 27D
HRMNZHDZRayZ XTI YR MR DOT IR LT LB S iz Avbe— 21
WMTEET

o 13K :WebProxy ->+4—/3(Request: WebProxy -> Server)

o &% 7 774 <- WebProxy (Response: Browser <- WebProxy)

e L v z3(Session)

—

N

B
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—IL DY 5
IV EHI B 4 2

1. HIBR 20— %EiRIR L ET,
2. HIBR(Remove)] £2Vv/L &4 .

JL—IL D4 &

VIV EHREE T BT

1. & 74— B(Search Field)] 5. & 7—X(Search for)] %l . £1zl&d BE#®7—X
(Replace with)] 5| D> M%7 Uy 7L & .

2. TRERHE L&Y,

L—)L DM % Ak
IV EHI BT R T B

1. BAON)] F=vrF vr 25207 LET,
2. OK]#2YUvsL &+,

RE 757
BR B LR AvE— VDT YTERE LT % L r— M B0 R R C& 4
5.

1. EBmAdd)] zZ7Vy7L £9,
Web Proxy(Z & > C7 =727 74V hO T MUBME RS s £5.
> MO R 74—V N(Search Field)] %] # 27V v/ L 7.
N7 X7 REN 7Yy LTORR T2 Av2—V T YT 1B IR L& T
& (Search) 151 (. MR § 37— X &1ld 7T — KR TIEMREH)EN T L ET.
T MO P5Z(Flag)l ¥l &2y 2L £7.
;::1\7732“'7‘/9% &2V LT, 7T —8&E AR R T 20 (5 Do o &) FEIR L &
7. MENV—VEBINTER T 21& A7 v71-6 %4 DR L &¥,

o0k Wb

S =l 1B i:
[l Sl RANFEH S AT Ly B=K A=T 7 7747 74—, 07 /8=, F1IEHTTPE

RKEZAOVIUEE LT AT LEBE SR i Ld ST 27 /31 %[ 3 272012Web
Proxy2ME ] 4 281 3. BH . S s 7OV REER O 2 L. BEDH 28
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BEIE AT A F 2T 4D 25 2R TTE L IZRRE LET. Ch6DFE L
DR S e BERIETES sh &9,

B R EE 4 272010 Web Proxyld HTTPEE SR 28 B L T 7OV &AM R ¢ 28 4 &7 W
FELETH 20— T A=V B — N >TUH SN 2004 B S 255 L &
1. £H53A. Web ProxysMifi ] 28 #7 3 L L LRI T 38R D&t A . BT E 1X.
B OF S 248 % I £ T A o T M PLFIE 28 A A & £9.

ER! COMREE.RATAN—VELTHER §52%2H ML Tw &7, Fortify
Weblnspect T/ 55 PE ¥ Al AF v> 2R AT T 285G & COY—v e LIvE Rl
2L WT 2 &0,

[0l 36 28 2N B IROFME HE WL E9,

1. [El# %5 %23 3(Enable Evasions)] #E# R L £ 7,
2. MOy av Tl 42 4& 2. 120, L DnlkE 75k 2R L £7

Ay RD— 5]

Web Proxy(d . GET XV v F#HEADIZE &R 2 £9. Chik. GET TR £ 28 & 2 &R
TB7 N REBNICL & HET Bk A T

F2 218 T ITHIEIR D Ayt — #Web Proxy (2% {5 L 7,

GET http://www.microsoft.com/secretfile.txt HTTP/1.1

Web Proxyld . X D Avt— &4 — i fE LET.

HEAD http://www.microsoft.com/secretfile.txt HTTP/1.1

URLZ > a—F 4>/

Web Proxy!d URLPY DL F % 1ISO-8859-13L “F £ v M DL FE I s T 2. [%1 &
ZAzHt QODIGHE L F ] L &7,

F2eZUE . 7 STHIEIR D A vk — #Web Proxy (3615 L £7,

GET http://zero.webappsecurity.com/cgi-bin/filename.cgi HTTP/1.1

Web Proxyid . X D Avt—Y &4 — i E LET.

GET %21%63%67%69%2d%62%69%6e%21%66%69%6C%65%6€%61%6d%65%2e%63%67%69
HTTP/1.1
Host: zero.webappsecurity.com

73 AW 4 &L Tl egi-bing 28R 935 A [ %63%67%69%2d%62%69%6€e | &> 9
LFH E—HLawDT ERGIESR Sh €A

. E DA 3 vy o

Web Proxyld . & 25y 2(N\ 2~ E D ATy a(l)ZWEHR L 7.

feeZUE N 77 IEIR D Avt—Y #Web ProxylZis 5 L 9.

GET http://www.microsoft.com/en/us/secrets.aspx HTTP/1.1
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Web Proxyld X D Ayt — &4 —/NZiEfE LT

GET //en//us//secrets.aspx HTTP/1.1
Host: www.microsoft.com

7 ADVE 4 LT secrets.aspx] #1& 315 & . [l/secrets.aspx] &u> L F Fl] &—
BLALOT, EREIET SN EEA.

U N A 1

CODJ5 % Tld . Te DE R LR S5 O 7 4L 2 PINDS AN § 2 2LT R EDY
VR §RER ERE LS OLLET.

J2 8208 7 5THIEIR D Ayt — 5Web Proxy (2% 5 L £4 .

GET http://www.TargetSite.com/cgi-bin/some.cgi HTTP/1.1

Web Proxyld . X D Ayt — &4 —/NZIEfE LT

GET /d/../cgi-bin/d/../some.cgi HTTP/1.1 [which equates to GET/cgi-

bin/some.cgi]
Host: www.TargetSite.com

HOZ® 7 4L 27bY

Web Proxyld« # 7 4L 2 M U(.J) ALY N AL 2 MU DR FD 208 LT R 24 5
tLEd.

F2 218 7 STHFIEIR D A vk — #Web Proxy (3615 L £7,

GET http://www.TargetSite.com/cgi-bin/phf HTTP/1.1

Web Proxyid . X D Avt—Y &4 — i E LET.

GET /./cgi-bin/./phf HTTP/1.1 [which equates to GET /cgi-bin/phf]

Host: www.TargetSite.com

N F A= ZDIE K 78

FRCIE ZAF IvIR—Carv T o VOE R SN 285 A— K55 H B ENTE
Fd. INBDNRITA—RIEIHE R ER FLLBIRMT b L& i H sn.
WO EWNET,

/anypage.php?attack=paramhiding&evasion=blackhat&success...

COTF A BERIFF ()1 hi <R O IF & N BT A Rk LTH R T . 1272
L NIA=RA P r—REMHH LT, Sl § 27 —REYRAITEET,
feeZE N 77 IEIR D Ay —Y #Web ProxylZis 5 L 7.

GET /index.htm%3fparam=/../cgi -bin/test.cgi

Web Proxyid Ik D Xyt — 49— \IZiEE LET.

GET /index.htm?param=/../cgi -bin/test.cgi

HTTPJE 2\ D&% 9
HTTPZE SRk O i I ICE R SN TWHLW E T,
Method<space>URI<space>HTTP/Version<CR><LF>
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1272 WebH— N2 & 5Tl IR D & A2 AR—ZDR b N2 &7 F 58 QB R 2%
AN B ERDNET .

Method<tab>URI<tab>HTTP/Version<CR><LF>

MET2EL DO ELTAR—RAEBOD avF—3 > bOM )4 AN A THL 2741
AL BERDOIEF R LET .

£ LWURL

SO IR BRI T I SR 2T 70l SLT g &R SO4 7 v M Y] D50
LFBENWDAER T 27 1A A& R LT ET . Web Proxyld 23R O H 102
DXL &N L ZROBERE T 207> 2. 7OV E-TIHlH A S 5
TYV7DIM R LI L &7

F2EZUE N 7 STHIEIR D A vk — #Web Proxy (23615 L £7,

GET http://zero.webappsecurity.com/ HTTP/1.1

Web Proxyld . X D Ayt — &4 —/NZiEfE LT,

GET /YPVIFAHD[hundreds of characters]NIWCIBXZPXMP/../ HTTP/1.1

Host: zero.webappsecurity.com

DOS/Win7 1L 7 kUi 3L

FF € DF 4 (Icgi-bin/some.cgiz &) #4% H L & D& 7 2Windows X— 2D 7 1)L K& . A
Svv 2% 5 B &R 2128 A (/cgi-bin\some.cgiZt &), 72 & S 20 BE b 0 &
7, Windows X—ADWeb+—/3Tld. 7 4L 7 b IE 2 2L &I A5y 25
LT L ET, LI oT, COREFERGA R TT. 2220, HTTPL—Tld. URI
DBV DL FBATyy 2 TH L ERHVET .

NULL #Y v ROAL 3

COFTE Tk AV vy FOHE 1% (CURLT > 32— FONULL S 7 #54F N\ &1 ¥ 9 (GET%00
e E)e SHLER T LT FHEAE A LL &7 27 00 K IR FE S TH 0,
N ASDOLFH FA7IVENULL L F 2 H LT FH O b ER LEd . COKRBE
DTN 2 & NULLSC 2 O Hi 12 & 0, 7734 RUE Ay — DR VO 7y 516 25 C &
BANET.

R 7 &N DX

SO RILF N LF A S 3370 2R T 2701 K&l it 3 2 & i
RErsnTuwEY,

Fz 208 T ITH IR D Avt— #Web ProxyZi& {5 L& 7.

GET http://zero.webappsecurity.com/cgi-bin/some.cgi HTTP/1.1

Web Proxyld . X D Ayt — &4 — N6 LET

GET /CGI-BIN/SOME.CGI HTTP/1.1

Host: zero.webappsecurity.com
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AR E D Ay N7 — TR EE

Za¥ B —"TAHy 77— 7nL.|:xE7\’7“ ‘E@i S WebProxy%ﬁ'%@ ﬁ\“/]‘?"?%ﬁ
(Network Authentication)] %7 T & T& & @“

N /I“7"7nu nﬁ}énﬁﬁj—%

1. By bv—288EE 2K %) 3(Enable Network Authentication)] %% L £

2. REE £17(Authentication Type)] YA b S5 HE XA 7 %18 L &4, fd FI 1] fE % K
A7ERDEBENTT,

« ADFS CBT

H & (Automatic)
# & (Basic)

£4Y A MDigest)
Kerberos

23— MNegotiate)
NT LAN Manager (NTLM)

3. B—¥4(Username)] & v7Ac2—4#ID%#AN f1 L. PSA7—F(Password)] + v7 2
2= DNRAT—REN S LET,

Web~ 7 o DAE K

Web Macro Recorder £ 72(dWeb Proxy #fi HH L T, v—2/7mn—~/nffcidn/fr~/o%
EC& &7,

v—s7a—~vsuld. 77 Vr—y s O E DY Ty B H AR TR b & LT
& 4. g, OpenText A ¥+ BNZD Y7 DB &) (2fF ] + 2URLATEE L £
/A NEREFHBIELTEETH AF v F BT 7T NVr—y avhbnl 77 b 22 8%H <
oY v 2ldE F &€ A. Web Proxy TH v 7' Fva&i ok vy a2 ¢ 52 ¢4, Burp
Proxy 7 7A LDt v h & 12 HTTP 7— 44 7(HAR) 7 7 L &l il T 2 C 4T & 4.

nZA4>y~vrold . Web 74— LR EF I &, AF v 77 Vr—y 2 iZnl/ A > C&5&
NLETe AFAvFER SCT 7 Vr— 2ombnl 77 e 30%f {ay vwiH AN &
YTC&Ed,

Burp Proxy & 72idHAR 7 71 )L D1 A

Burp Proxy 7 7 v Dt v s & 12IdHTTP 7— 44 7(HAR) 7 71 )Wy 67— 2 70—~ 7 a 21E i,
ERCIES
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—

P 71 v(File)]> B {Open)] #7VUvs7L 7.
EHE OWindows D B {J XA 70l R w7 AH & &7 .
2. Fay7’ X7 YA RNC. Burp proxy (*.*)] £/-i& HarZ 71 v(*.har)(Har File (*.har))]
FERLET.
3. Burp Proxy &7z(& Har 7 7AW B L CBH & £ 4.
Web Proxy Tt v av g /R S &7,
4. THRR snf-v vy avn60OWeb~ 7o0DfE K" T JWCHE A £7.

BN Sh 72k v 3 50OWeb < 7 oD J§
Web Proxy T& 7~ &72ld ¥ v7 F va&nfzt vy o % ] L TWeb~ 70 %1E il 4 21214

1. BRI O CF zyr~v—0%f 0T, w70l 02wy 582N LT,

2. P r(File)] x=2—%7Vy2LC. Web~vZ7udfE g (Create Web Macro)] %#i%
LEd,

Web~ 7 oDfE 1 (Create Web Macro)] X4 7 a2 R v/ A%k & &7,

3. (7> =) Web~ 27 oDfE 1l (Create Web Macro)] X4 7 aZ R v/ AT, BZ 77 +D
F zv2 %% %129 3(Enable Check for Logout)] #i# R L. 2—# A/ 77y 2&
& i ol ALz ua— A Ri#E SN ZURLAND 7 7 A2 E K § % £&I2,
;~/<@HTTPFB’§~ TRAETAHEDOTFA MG 7L—X 535 ¢ 2 E R EAN
LEd.

B8 DORAF v s, AF v FlE F—LAR—Y THA FOWeb#E R £ L 5.
A DV —=ZAND V> 75k S 3 & (8 H Id<AHREF> HTML &2 {1 ). %
DURLICFE &) L CEF Al 25517 LET . 07 77 MR—UAD V> 751 8B & (&1
—E DB LI — oA T vEE BRI 0l 77 M LG &),
AT MRl AL TR OWERH TELGIBIND VY —RZAF vFIE T 7L AT
& NET. COTHvhal 77 MFRAE LGS . A v Hid 22— O AE 2
LICHE /A TE2LERHVET. COT7 0L Rk 0l A R B8 Tt % <& of-
CEILAF v R ENER T CEBDEIM A>T ET,

—WOTTVr—y 2Tl 2—F (R R b DIy ho—v %Yy L)y
77 hLIdG A — Nk Have aniceday ] % EDJE A D Ayt—Y 2K R LET.
CDTL—REH—"0al 77 MEZ ELTIRE T84 AF v FRIEE Avk—UH
P 20D T7L—R 5B LET, COTL—AMHE SN 2E. AF v H i 22—
G ENAT— R CHTTPE R 255 LTHE o/ (v 2l A &7,

777 NIzl eERF v M TEBH DRI ELTE NAT— N TR Sz
URLIZAF vF BT 72 A% & 2DWK LT —35F 8 DG & Avbe—v %5
TG ENHVET. I2E21E . y— B A7 —%Z 2— T 302 Object moved | TJis
BESBGENDNET. COILE PSR TRNENE 2 AF v+ BDEMKK R LT
WAGE . OBl SAEal T NIl 5B L. u/ A VIREE 5L C& £
ER

FOB LT, 2= 77U —y avmenl 77 b4 2B T Have a nice day | &
ED Aye—Y M —3m61R Sh 235 A 1k IE#H R I &L CMHave\sa\snice\sday ] A

OpenText™ Fortify Weblnspect (23.2.0) N—>331/360



VIV AA R
% 20: Web Proxy

HLEFT(EBR R CTEAXN—2&48 2 § 27zowcNs) 2ME ] st &9). & Ol gEHE 2
= O 3302 A7 — XA 3— &R L. BT LOURLAZ I 328,64 T9. 2O
% 4+ T[STATUSCODE]302 AND [ALL]http://login.myco.com/config/mail? | %5 —
M HERRBEO7L—R a2 et b 0&+. EHRBHOERICHE §25E> MO
WTIE TE R R B O R" IR DX—,

4. 7oL HET 21 0 TR (Save Macro As)] R v 7 RN AET AV ENTT T 5
. BB (Browse)] # 27V v/ L THERE D 7 7/ WIRIR KA Tl K v A%E & 771
HERELET .

5. OK]z7Vy7L &9,

254 7> NaF B &

Web Proxyzs\Web+—/32s 551 B 3 DEL K %52 (FHL 7235 6« AL B & OFF € 23K » 251
7RI Ry IANR R SN ET IR 707 SATIRRNE 2T — AL | TF vvr 2l &
To LIzthoTy 201 7 E OH—/Nzxt LR OFE B & 2148 4 335 & 1& .« Web Proxy
HEIELThsHEFH L. Frv 28207 T 20 ERHVET.

1AL R B

EM B DSR2 KR A F =7 Y A LUER Sh &9, IROF 2. 2h
SO FD—H &/~ Ly 2O B 2B 25 Lad. R T2 DS &L T
'Regular Expression Library | 3% D &3

] B 245 ik 5 &7 SEE T oL TIE B EZ B ORI oX—v 1 2B L TK
1280,

XF B
\ WO F 5w L F L T~v—2LF T G SCFInjie—s Lid.
=7 AN/l AT L F L&,
A AN &7 OREC—H L ET,

NF AL T2 BEXTF 2R K LET. L2
content7 4L 7 kYN ®/content/en $ & Uf/content/ca #F% <4 X T %%
4h 3 2121« /content/[*(en|ca)].* *#fE H L& 3. \S\D\WLS | LT

&,

$ AN EREITOREBC—HLET,

* Fet7 4+ F D0 LL EORIE &~ L&d. /z0*1kTz) £4Tzoo] &
;L&Y

+ HAT T2 FO1IE L OB & LFT. /zo+dTzoo io—F L
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X F . B
FeA Mz — M LER A,

? AT T3 FO0R £ 1R OHE R &—3 L 4. /a?ve?/L
never]Dlve Jic—F L £,

AT X F 2R EB DI FIC—H L &7,

[xyz] LF Ay b FEYLH OB D13 Fic— 5 L &9, /[abc)/id plain] @
fajiz—#8 L7,
\b AR—R EORGER L ic—3 L £7 . /ea*r\b/id . Tnever early] ®
ferjic—#& L&7.
\B JEHGERE T C— L &9, lea*r\B/id Tnever early ] O Dl ear] &—
HLET,
\d 120 71— LEd.[0-9]&[ LTY.
\D HE LA D1 F e — B L &7, [*0-9] &R LT
\f MAR—=Y LTI L&Y,
\n BAT XL F B LET,
\r FrUyP Y=V FIC—F L&,
\s AR—R, BT\ A=Y EOF HIC—F L FJ . [\An\nt\v] &[F CT
ER
\S FHXTFUADOL F I L E&d. [*WMn\ntw] &F CTds,
\w TYR—=RAAT7 %% CAEE OBREE XL FI1c— 8 L &7, [A-Za-z0-9_] &[F
CT9d,
\W EEOIFERELFIC—HLET. ["A-Za-2z0-9_]&E LT,

IE F 3% B O ok

HH DIE R S ST wext 4 29558 A 0penTextD >y =71 L DB FE 8 U5 an €
WET, ERKRIAHER T2 5. RO GEHE T 2#HTEE7.
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IE R %7

[HEADERS]
[COOKIES]
[STATUSLINE]
[STATUSCODE]
[STATUSDESCRIPTION]
[ALL]

[BODY]
[SETCOOKIES]
[METHOD]
[REQUESTLINE]
[VERSION]
[POSTDATA]
[URI]

MR B A 7

 AND

OR
NOT

[]
()

1

o QAT —RAMTILAT—RAI— 2001 H53F EN TE D, HO(b) Ay —Y KL DEIHIZ
MNogged out] & FREF) 038 FN TH AL L 1 H 77212 IRDIER K H 2 H L %

T

[STATUSCODE]200 AND [BODY]logged\sout

o BR SNV —AN— K FIH OURI (VRA L 7 NIAFAE T 32 E%R LTE D DG
B DEIHZ/ARTLogin.aspl NDZ HE & 1 2)0E 1 H 32121 IRDIEHL R B
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o (@Q)AT—&Aa—F%31200]. »Dllogged out] £7-i4 session expired] &u» & ) HA
L DEIHIE FN TS, 12l (D) AT —XRAI— K302 DI ZF D ETHIZ/AR
[/Login.aspl NDZ B NE 4N THAGEZEDWT N4 21k IROIEH EH %
fERHL&d,

([STATUSCODE]200 AND [BODY]logged\sout OR [BODY]session\sexpired ) OR (
[STATUSCODE]302

AND [ALL]Login.asp )

FBE 145 IR £ 723 TR CIIE I OFT 12 12 AX—Z(ASCII 32) 55 » 2L B R D VET. 79
Lawe IR oCIER KRB O— I &R e s £

o UXAL 7 hLocation\ v&XD & ZH izl login.aspx] HFL 1L 3 VKA L 7 M & #4594 21
E IRDIER R AFHLET,

[STATUSCODE]302 AND [HEADERS]Location:\slogin.aspx

o A7 —A&Z1T MReason-Phraseiil (24 & DO 7 %1 ([ Please Authenticate ] % £)h % &
BPIGE AR T3 IROER B EH LET.

[STATUSDESCRIPTION]Please\sAuthenticate

754 DT B 5% E

Web Proxy V—iL/\—® PS4 DAL 8 (Launch Browser)] = % 7 )y 7 L T tWeb7' 774
FEB) LR WG S E. Web Proxy 22—+ 4 X7 —ADHE T 509 B C& &4, 12
U 777907 ax i 217 W EHLAHVET . AR 2FIHICOWTE, 777D~
a7 WEZR L TS0,
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WebH—E R (2= Tl 2 077 0r—y 2 8BEE L BROER S ZE 4270
7 S5LTY . 1 A EDWebH—E R4 . SOAP (Simple Object Access Protocol) 214 J L
T.WebH—bREMERER 2B UG L2254 7> MWeb 77 V47— 3o EDfH TXMLT —
RaiFfE LET. WebX—Y DFE IR 715 DA i B 97 ZHTML &id 52 4 0. XMLIFE i &
NIT—REH P L. G CkoD7L—L0— 0% LEd. 75147 N\Web7 7 V75— 3
ViELIR SN T —REEE TR L. 2O R AT F2—F IR R CT&ET.

WebH—CRIZT7 72 AT 3277147 N\Web77'Vr— aid . WSDL (Web Services
Definition Language) N = 4> b 52 (FHL O, —ERA LDIEAF ik #8 i T& £ 9. WSDL
N 2 A2 MZIE WebY—EBRIZH gn 370/ 5307 ankz7ay—y v, #h 607 oy —
Ol RS A—R BEVN IS4 T \Web 77 Vr—3 av W52 FEL 8 ME R D x4( 7
IR ST T,

Web Service Test Designer #fi ] L T. WebH—E A A x> DFEAT I IEAE 3 20 B A
b M8 # % CWeby—E A7 A MEEF 7 71 v (filename.wsd) #1E B L £ 7.

X OF IF Tl . Fortify Weblnspect® P/—)v(Tools)] x==—»>5Web Service Test
Designer {2 &) L £ 9 %3, Fortify Weblnspect® [ i X—(Start Page)] »*5 Web#—k
AR F v DB 4 (Start a Web Service Scan)] i L. 70> 7 MR IR SNz 674 A F
Dt By #1%& 7 L C. Fortify Weblnspect 2 ¥ v> 7 14— K674 (7 2B <C&bTEE T

¥E: Web Service Test Designer #Fortify Weblnspect 2 ¥ +> 7 44— Fhs 52 B 3 235
A WSDLA E25% € S Tuha v &, 7 A+ H I CWSDLE A > A — kL. &
RIA=T B BE 1 %F] 025 T, §XCOBAE IO L& 3. Jhid, Fortify
Weblnspect® [P/—i(Tools)] A=a—&7zid ¥ 27 4V —ILF v -6y —L &L #) L
I a EFEELEEA

1. P—(Tools)]> Web Service Test Designer] #iE R L £ 7.
2. BEIKA Tl Ky AT IROOBTN»#IERLET .
o ¥rLuuWebs—EZ7 2 NNew Web Service Test)]-#1 L\ >"WebH—EAT A %

BErL&d.
o« Web#—ERX7 2 2B {Open Web Service Test)]-LL 5 (21F il L7zi% &1 %40
LEd,

ROFM TR EER T 25 G 2B E LTnET,
3. WOWETN»EFEITLET.
« WSDL®DA > #— MImport WSDL)] # v2 2 ¢, WSDL+ 1 FOURL(7z &2
http://www.webservicex.net/stockquote.asmx?WSDL 7 £) &\ 77 7213 4R L.
WSDL®D 1 > #— NIimport WSDL)¥!1 # 7 yv s L 25

* WSDL®D% Hg (Browse for WSDL)] = % 2 )y 2 L. LLRT c o— i 47 L7z
WSDL 7 7/ W &R L £ 7
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DERRE DL E 3G A ol 7 aF o — 8 i TSOAPE K 21T W E b B
5 A1k FEANC DL T, IR 52 (Settings)" X—348 1 25 1B LT {2 &0,

Fre T 74V bTIE B D4 —b Z(Other Services)]| E /8 S a2 & biEm LK
a0, COMERE X . —EARWSDLICEIE T s T Wi & . y—ER2F 8T
BINT 200 H SN 29, B4l o0 "FEjic L 20— 20E IN" A—v
3421 BB L TS0, COTEH O DO F zvo~—2%4 L ET .

EZ N

AR — SN I-WSDLD A A—Y
R DA A—2 1 . Web Service Test DesignertD A > — S 7:WSDL %7~ LT &

ER

&8 Web Service Test Designer
File Edit View Help

) (25) (@) (> ) (a)(&
Web Services

-

= 1 StockQuoteScap
“2 [¥] GerQuote
= -4 [£] stockQuotesoap12
“ [¥] GetQuote
ﬁ Other Services

<

& hitp:/ /www.webservicex-net/stockquote WSDL URL:http://waww.webservicex.net/stockquote. asmx?WSDL
= & [~ stockQuote

Import WSDL: | http://www.webservicex.net/stockquote.asmx?WSDL | 'J @ S

= 0 wsdl v
WSDL Overview

]

<?xml version="1.8" encoding="utf-8"?>
<wsdl:definitions xmlns:soap="http://schemas.xmlscap.org/wsdl/soap/"
*mlns:tm="http://microsoft.com/wsdl/mime/textMatching/"
®¥mlns:sospenc="http://schemas.xmlsocap.org/soap/encoding/"
*mlns:mime="http://schemas.xmlsoap.org/wsdl/mime/" xmlns:tns="http://
wew . webserviceX .NET/™ xmlns:s="http://www.w3.org/20@1/XMLSchema™
¥mlns:soapl2="http://schemas.xmlsoap.org/wsdl/soapl2/" xmlns:http="http://
schemas.xmlsoap.org/uwsdl/http/" targetMamespace="htip://
waw . webserviceX NET/™ xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/"»
<wsdl:types>
<s:schema elementFormDefault="qualified” targetMamespace="http://

EN

ottt

wew . webserviceX NET/">
<s:element name="GetQuote">
<s:complexTypes
<siseguencer
<s:ielement minOccurs="@" maxOccurs="1" name="symbol"
type="s:string” />
</s15equence’
</s:complexType>
</s:element>
<s:element name="GetQuoteResponse">
<s:complexTypes
<siseguencer
<s:ielement minOccurs="@" maxOccurs="1" name="GetQuoteResult"

- —

Test Results

i.;gRun Alll | # Run Selected

d Stop||=5 Clear

Result

Web Service Port Url Service Port Operaticn Error Message

Qutput Test Results

4. K ORA>TH—LA IV AR— bR T 2 & A7 OXA A= MERHVE R &

nNEd. K—hd.

SNAYROT FLAEIERE T BIET il X DTV FRAY MEEHR L &

¥, WSDLODEL IR ICSOAPN—Y 3211 ¢N— 1200 7 3% s 2565 8LV
Wi 7 O IR O AE BFE U A . cnasDA—Y sk — R &, A—2 2110
G—PRAPURHE SN ET. T T ONA— 2B 5 235 51 N—2 21205 1
YEDF 9 oR v A% F LT L&,
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E:SOAPN—Y 32120 [R— l\@i‘%%(Port Overview)] /S 3 uiZid s HTTPA &
WSOAPT 7y s #E BB IN A7 av Vg N TH Ed,

Port URL: hitp://www.webservicex.net/stockquote.asmx

[JInclude SOAP Action in HTTP Header

SOAPE: % TIESOAP NN—2 321 2DSOAP 7 7 v 347y 3 & ST £ 45,
T—XT7 7F ¥ EoTCE NP HEDIGE L. ZRUANL N ZWIGHE 8 HVET. FFE
DT LT SOAP 1.2 34 > 7 4> 7 DSOAP 7 73 3 55 8 2hR A 4 20 %58
IRTEFT.SOAP12E— NDIGE DA F 29/ R I ANK R SN ET . 7 74 FDEK
5E dtrue T1,

HER! RPCYa— FOH—LATIETH OKEILETT, REF—274—IVEF
(Schema Fields)] &7k 7 74V kDSOAP A ¥ —~<%{fi ] LT\ JJ &h £9 . Bl
FeH Frid7oxy F w7 F v oH K DSOAP Ay —Y 2B L. ZTD Avb— %

KML] 270 Hs O 2( &7 R AE LIz Ave—Y & 7oA L6 Y R— 1 3) &
WC&Ed. D% . BfE(Send)] 227V /L CHE2TANCELT,
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HY—BR FFVAR—NHE—MER DA A—

DA A—DIE BN LI bV AE— R NDE—MER ZR LT ET,

Web Service Test Designer

File Edit View Help

|_] ﬁ B b 4 || ® | Import wsDL: Lhttp:.-".-"www.webservicex.ne’t.-'stoc:kquote.asmx?WSDL

| Wessemies R o stockquaeson

Port Overview

‘, =] hlém:,n’,n’www.webser\ficex.net,n’shockquote.asmx?\l‘ Port Name: StockQuotesoap
= @ [ Stockquote Port Soap Version: Soapll

[Ell -& [ StockQuoteSoap
%+ [v] Getquote Port URL: | http://www.webservicex.net/stockguote.asmx |
S

2 .4 [#] stockQuotessapiz
2 [¥] Getquate O ws security
S [#] other sarvices

Service Details:IWEb Service

Lad»

WS-Security |WS Addressing |

a- [ B X

# | Type | Mame

£l i |

Test Results

C—ZRun Alll | J» Run Selected | [j Stop| | Clear

- 0 X

Result Web Service Port Url Service Port Operation Error Message
Output| Test Results]
— N =] .
CF YT AL H Y A

a. WS Security] #1#R L £

b. p—EADF Al (Service Details)] VA b o647y av #IEIR LT
c. LELBMANIILET . £F U7 Rk E DA DWW T "WS 2+ 207

X—o3501 #Z 8 LT 280,

CREEIVy T 28 ERDRAF (LM OXA 2D A7) UG E (T 0) K oR &

nxd.
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FHRIBE AF—vDA( A—
IKDA A—DIE BN LIZERDAF—v 2R LT ET,

B8 web Service Test Designer,

[(=1E9

File Edit View Help
D ___;E ﬂ b 4 || #  Import WsDL: | http://www.webservicex.net/stockguote.asmx?WSDL ] - & _'_
\
Web Services = [l Reguest - Operation: GetQuote d
- QSend 4 Import. # Export 'i) Auto Value
% http:/ fwvow.webservicex. net/stockguota.asma?V| || Soap .ﬂw:tion:| |
= @ StockQuote
S StockQuateSoap |Schema Yalue k=
e - — B
GetQ“'* o Envelope
[ StockQuoteSoapl2 - <
4 GetQuote tJ H:eada' =
& [ Other Services ©oEeny (amay) +
(=) Body
[} GetQuote
il " [_d x
Schema Fields | XML |
Response - Operation: GetQuote =
Schema Yalue
|=HEnvelope
EJ Header
LB ey (array) s
[=HBody
E}- GetQuoteResponse
4|[T) GetQuoteResutt
< | Schema Fields | XML |
Test Results * 0 X
L';—.JRun Alll | J» Run Selected | [ Stop | Clear
Result Web Service Port Url Service Port Operation Error Message
Qutput Test Results

7. BEOEEN I L &S, COB Tld. 22— HMFGP (Micro FocusONYSE > > V) %

ANJILELT

vE: BEE)E(Auto Value)] 27Uy o3 2&. 7H A FIC & >TEAE (E 2% 04 T5
NEd. COBEEFERDHNTNNTT,

« GlobalValuesDefault.xpr 7 71 )L 5 SHLLF SHL B( 2D 7 74 )WAZ /8 T A— KD Hif (2
—H T BT MIBE ENTHBIGE). sF 4l ic DTk "Global Values
Editor" X—>3431 %% 8 L T 2 &0,

o TREATNIEEDTNT, THAF L EI>TER SN 2. COBI Tk THAF WL
T/ Z A—4l symbol 1 (Zf& 'symbol1 1 3N J] st &7

FEATCOOTIE S T EH FE Of " XN—2344 1 25 B LT 23S0,

8. P:f5(Send)]® zsVvsLiT.
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RGP HOILERA IR R ENET WY &7 579/ Ty AF—vba—¢
XMLE2—%Y] 0 2 32EMT&ET .
BER DEE DA A—Y

IKDA A=V B SNTBERDTAMER 2R LTHWET,

B veb Service Test Designer |Z||§|f5__<|
File Edit View Help

\'_1 ,__E; H b 4 || @  Import WsDL: L http://www.webservicex.net/stockquote.asmx?WSDL ]v m _'_
Web Services ~ 0O Request - Operation: GetQuote -

5 hittp:/fwww.webservicex.net/stockguote.asmx?V| | | Soap .ﬂw:tion:| |
= @ [¥] StockQuate
=]

4 [¥] stockQuateSoap

| Schema | Yalue |
> ecripots |=}Envelope
= .4 [¥] stockQuotesoapi2 ; v
s GetQuate .j H:eade.r
&) [ Other Services o By (amay) +
[=) Body
[} GetQuote
(Y| symbol W mrGp %
Schema Fields | HML |
Response - Operation: GetQuote -
Schema Yalue
|[=HEnvelope
d eader
Amy (array) +
[=){Body
.j GetQuoteResponse
(T] GetQuoteResult <5StockQuotes><Stock=> < Symbol=MFGP </Symbol =
< > Schema Fields | XML |
Test Results * 4 X
,'_] Run All |} Run Selected | J Stop =j Clear
Result Web Service Port Url Service Port Operation Error Message
@Val id http:/ feoww.websarvicer. net{stockquote.asmx StockQuats StockQuoteSc  GetQuote

Qutput Test Results

9. HHAF M £F] VY TTTF A MG E (ZOH] TE1DDERAE Lo ST ERAD)
. IRDENTL 7
a. Pr(File)]> RFE(Save)l £ 27Vv/L &7,
b. HED 77 IVIEIR KA 70l Ky A% H LT, Weby—E Ak 5t 7 711 (\wsd) D
ST EG T #IER L LT

YE: WSDLICHE EL O E VS g CL 3 E BB CF v or~—200F I s T B
EDCEIE L BHIEOT — 8RR SN T, Frvr~—2l3 B ICHAE 038 22
fE SN 32EaRm TWBEEE A
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FH#ic L 2H—E2DIE M

WSDL A ff 1 1 Tur/e WWebH—ERBFEIE T 25 & Hd D& d .

}- £71& . Fortify Weblnspect Recommendations € 2—)Lid A% v> 2B 8 L. MUK L7z
AF o> DF P &I T e b wn . BE . ElE 7/~ VERE LEd. Web+s A MDA
F v ICSOAPEL R £ H 2L, ZDH A FOWebHy—EARF v> &4 24 AHfER L

T. Z0HM TWebﬁ-‘thZ Nk BT 7 71 v (filename.wsd) EAE B L 3. WSDL 7 71 11
ME C&25 6 LU C&avwganbnis.

WOBNR T L. H—ECREFF ER TE£T.

1. 7741V bD B D+—E Z(Other Services)] +—tA%4 7Uv/L. Br—EADE
1N (Add Service)] #iR L 7.

fr Luyyr—EZ1(New Service 1)] 23/ ] DX A > OWebH—ERY V—IZFR /N S &
?—

2. BAEPDE B E . WSt’ﬂF:.'}fff(WS Security)] FER L DELEKIERE
AN L&ES.

3. P Luypr—EA1(New Service 1)] 41 7Vv2L. [— +DE N (Add Port)] iR L
9. . BOAP 1.1] £72i& BOAP 1.2 Dt h#iZiR L &7,

WebH—E 2y U—iZ B LLyR— M (New Port 1)] & /R &1L £ 6.
4. [—NURL(Port URL)] £ vZRiz. +—EADIE LOWURLEAN /) L£T.
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5 FrlLuA—r(NewPort )] &4 7)v7L. #4E DiBJ1(Add Operation)] £iE 47 L
9,

&8 Web Service Test Designer |Z”E|rg|
File Edit Wiew Help

0 |y @) & 1mport wspL: L Other Services I 'J & &
Web Senices v [ || Request - Operation: New Operation 1 -
x E 0 Send 4 Import & Export & Auto Value
= g Other Services Soap .ﬁvction:| http://tempuri.org/Mew Operation 1 |

= & [ New Service 1
= -4 [#] New Port 1
v New Operation 1

| Schema |

: Schema Fislds | KML |

Response - Operation: New Operation 1 -

Schema

schema Fields | XML |

|output|Test Results|

F:—ERZ . A— M. B EL ZEE T2 LT 2X7 02y oL &
9o

6. SOAPT>RO—7 % & L 771 > h— T 208 Z 5 Web Proxyy—iv 2 L ¢
E15). B 3¢ 2ol 15 L7zSOAP =>Rp—7"% KML] &7 ae—L Tl 0ffir 32
MTEET,
7'aF X T F bR — T 2545 SOAP T 7 SEHTTPA YR H N E T
(Soapaction=<action_name>).

7. BE G LT, RE—7Z4—V F(Schema Fields)] #7°%7:1& KML] 27" &4 fi LT
A LEd.

8. +—LR&T AT AIE. BEfE(Send)] £/:1&3 BRTEAF(RunAll)] DLFinng s
VoL &7

Global Values Editor

BHE ﬁiﬁ“é*ﬁéﬁﬂﬂ@%FJIJ/TE/\7)<—‘§ZOD7477U%1’EE§Z’C%§$T WSDL 7 71 L %A

A= LR B E O 5 (Set Auto Values)] 8 %4929 5 E. Web Service Test
Designer (&« WSDLEE{E (25 1 2/35 A= RDLHI 27 0—/UE 7 7A VTR L& T,
— T 2L AR OB & B AT U SN IAE BT AV 58T A=K T 4L RICHEA &
nEd,
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Ja—/UE FIB N9 5121

1. R4 (Edit)]> Global Values Editor] # 27 Vv7 L £ .
Global Values Editor#3f &. GlobalValuesDefault.xpr & 5% 85 O 7 7 4)L ~Oxml s <
A—RL A PUXPE) 7 714 VDN K AR R SN T,
2. BinAdd)]&£2Vy2L &7,
N &0, 7 75)L b4 [Name] &7 7 4L M [Value]D = hUZME | s £ 3
3. T NIDMEE DG #2097 T 740 MEEPBE DL T CE TE &R 2 7,
AT v72-3%%E VR LTV IBIM O bUBER L 7,
5. MOWETNhEEITLET.
e OK1%227UysL T, 77/ IWERA LT LET.

o BET 2 U TR (Save As)| £ 2y LT Bl D774 121335 BT %48 ] L.
ZAWVEERR LT L&

A & 5 OfE H

NIA—=RT U E OB AFH CA NI T22E0R B HEELT. BEIMEMRE #FH L&
4. Web Service Test Designerid % /8 5 A—R%&53 1 L. —ERAEAE &3l 2wl gEtE 23b
BIEZFN LET . S & 0. KRB 2 WebH—E R 24 B KR (R 28 &4 T& &
ER

WSDL 7 71 )V %% R L1415 :
1. A= 70V H 728 IEOMOF zv /R v 2% 42 L &7

2. HEE D% E (Set Auto Values)] ® 227Uy L &7,
[7 70V M 22 F % A0D7 o—UE ICE & 2 £ 5?(Would you like the default
values to be replaced with the defined global values?) | £y I Ayt —Y NE IR Sh &
ED
Fuw(Yes)| 22Uy rd 28 FEICAN I LIE G E SN &4, £/ (FEDE/ED
INGA=REG 3T a—/ B 7 7 AV DR T A=K b~ T 28 6 k. TOE1E Tl
WA SN BE D7 74V OB EAT s TAH TH Stz on 7.
PO Z(NO)] #27Vy o3 28 BEREIGER T LET .
3. [Ew(Yes)]=7VvsL &9,

B

4. BFRTOFAMEEFT(RunAll Tests)] © %270y £5.

Web Service Test Designerid . £ #{E (N SHLfAH Lebich—ERE R #1515 L
¥4,

5. A MER(Test Results)] X7 (74> FYDO TR )& 2 )y L £

6. T7—%ik THAE VD oIy & k. ZOEREEXT VIV T E K (Request)] XA >
TH & EEFEITAILET,

ZHHH TS LFan

"Global Values Editor" gif D~X—
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BAEDA v R— e 7 AE— |

BAE LN 60E] Y Ton B D47 V&R LT, fh ODWebH—EZADK T 2% . <
BRI, I eDayR—4 > bl OB FEH 17 A ME Y H EXHR LIZ0T 52enTEL
To K EY 2 B OB CER L2k OFESR D & 52 XML7 71V EL TR AFE S &4

<Envelope >

<Header />

<Body>

<GetQuote >
<symbol>MFGP</symbol>
</GetQuote>

</Body>

</Envelope>

B 2R £ A R — M Bzl

1. OS> CHEFHERLET.

2. EROA>#— MImport Request)] ¥ 7 )v s L CefE #o— L.
3. EXRDxZ2KX— MExport Request)] ¥ %21y L CHIE 25 L& ¥

21 2 —

AX nf D7 A b

fEE D, FE TXNTOEIEDKR E #HDTEHTANTEET,

WSDL% A >F— LB . FRTOF R F4EFT(Run All Tests)] #2727 L £,

Run All Tests

&8 Web Service Test Designer

Import WSDL:

TP A FE R LIS N TORAE O AF £k & L 4 B aR R L&

Bl 7z A M R (Test Results)] XA > &BH A2id . A7 —KXAAN—0D R M R (Test
Results)] # 7y 7L £
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TAMER DA A=Y
K DA A= . Web Service Test DesignertD 7 A Mt R 278 LT &7,

B web Service Test Designer

File Edit View Help

J = H 3 4 | & ImportWsDL: | hitp:ffzero. webappsecurity com/CustomerAccounts/WebService. asmx?wsdl |_"J E [
\
Web Senvices » B wsdl -
= WSDL Overview
-
5, [] http:/ {zero.webappsecurity.com/Custome || ycoy URLihitps/fzeroiweb L counts/WebService.asmxdwsdl
=) Q E webSarvice
.WMUWWSDW <2xml version="1.8" encoding="utf-8-2» :'
+ ] UinkTaTestingDacumentatian <wsdligefinitions xmlns:sosp="http://schemas.unlscop.org/wsdl/soap/ " xalns:tm="http:// ®
*; [& UstTestAccounts microsoft. com/wsdl/mime/textMatching/" xalns:scapenc="nttp://schemas . xalsoap.org/soap/ =
3 [4] 1svalidCustomer 5§ encoding/™ xmlns:mimes"http://schemds . xals00p . or g/widl/aime/ " xalns:tns="http://www.hp.com/ 7
i [¥] GetCustomerAccounts asc/zerows” xmlns:se"http:/ /wee.w3.org/ 2001/ XMLSchema™ xmlns:soapl2="http:// =)
4 ClaseAccount 3§ schemas . xmlsoap.org/wsdl/soapl2/™ xmlns:http="http://schemas . xnlsoep. org/wdl/ htte/" =
> Addaccount 3 targetiamespaces"http:/ /www.hp. com/asc/zerows” onlns:wsdl="http://schesas.xmlsoap.org/wsdls/ ">
7[5 InbemalFundsTrarsfer 3§ Wsdlitypesy
AddCustomerRecord 3§ <s:5chemd elesentFormDefoulte"qualified” targetNamespaces"http://wew. hp.con/ asc/ 2erows™
H CustomerSearch ¢s:element name="LinkToTestingDocumentation™>
= .= [] wabServicescapt2 <s:complexType />
3 [ unkToTestingDocumentation «fsielement>
3 [ ustTesticcounts ¢5ielement name="LinkToTestingDocumentationResponse™>
+ [ 1svalidCustomer <s:complexType>
1+ [] GexCustomeraccounts CgiseguUencel
*3 [ Closerccount <s:element minOccurs="@" maxOccurse==1* names*LinkToTestingDocumentationResult®
7 [ Addaccount type="sistring™ /3
"2 O ntemalFundsTransfer c/sisequence>
3 [ AddCustomerfiecord <5 complexTypes
. [0 customersearch <f5:elements
W [ Other Services ¢sielement name=“ListTestAccounts=>
<s:complexType />
</s:element
A S > »

¢u:alamant AaRss™l fLrTALtAr s AunT LRATAAATA™ S

“]Run alf | b Run Selected| | 1§ Stop| | TR Clear

Result Web Service Port Ud Sarvice Port Operation Error Message -l
valid http://zero.webappsecurity.com/CustomerAcco. WebService  WebSenviceSa  LinkToTasting
valid hittp: [ zero webappsscurity.comfCustomerazes  WabService  WebSeniceSa  ListTesthcoou
Failad hittp: [/ zero.webappsecurity.com/CustomerAcco  WebService WebServiceSo  IsWalidCustorm  Server was unable to read request. -—=3> There is an ermor in the XML docur
valid hittp://zaro.webappsecurity. com{Customeracco  WebService  WebSenviceSo  GetCustomers
Failed hitp:/fzero webappsecurity. com/Customenicco. WebService  WebSenviceSo  CloseAcoount  Server was unable to read request. > Thene is an error in the XML docur
Failed hittp:/fzero.webappsacurity. com/Customerdocn WebService  WebSericeSo  AddAccount  Server was unable to read request. - There is an ermor in the XML docur
Failed hittp: [ zero. webappsecurity. comfCustomeracco  WebSenvice  WebSeniceSa  InternalFunds  Server was unbble to read request. —> There is an effor in the XML docur
Failad hittp: [/ zero.webappsecurity.com/CustomerAcco  WebService WebServiceSc  AddCustomeri  Server was unable to read request. - Thene is an emor in the XML docur
Valid hittp:{/zero.webappsscurity.com/Customerdcco  WebSenice  WebServiceSo  CustomerSear
b NotRun hitp:/fzero mummacmm WebService  WebServiceSo  LinkToTesting
b Kledlaan bt Planes 1eimbanmsss e en b ctamnaet een Wik am dea Minhfamdeate | kTl sea |
1%L 3
Output Test Rasults

- A bt B (Test Results)] XA >izid IRDIE R R R SN &7,

o R (Result)]-7 A ME R, Al EME LD BHEIGIRDEB VT,
o HEH(Valid)]: y—/ 3T 5—£/213SOAPIE E % L CEIE AR I L& LT
o [RFEAT(NotRun)]: #:/E pUR IR SH & 2 ofehN(F 20K w2 ANA Tl % ). R A1E
MIEAE SN BRTIC {5 15 (Stop)] B Koo Szt HBEAE 3515 Sh F ¥ AL

o [RF¥ T (Pending)]: EE47(Run)] & XA Sh £ L7zas, - 4E 2 £ 250645 sh Tw
Ao

o PH(Failed)]: B3R 2SI Ladrofe, — BT I5— Xy —V iR Lz, &1zl
SOAPE E N2 (5 Sh iDL FhnTd.
«  Web#—ERH£— MURL(Web Service Port URL)]-JH H (28 3 {} 1 55 Tur BURL
o fHr—EA(Service)]-JH H B ff I s T2 —ER
o [R—MPort)]-JH H B fF F s T B KR—
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» #:{E(Operation)]-18 H #°% ¥ #:1E
o [E5—Xyt—Y(Error Message)]- 7—Dx)i
b~ 2 bk F (Test Results)] Y —IL A\A—I2E  IRO R XD VES .
B ~TEAT(Run All) -7 1 Fid F o2 SN % 1 0t LTH—ERBR 3545 L
ES I

R E1T(Run Selected)]-7+ 1 F+1d. [ A Mk F (Test Results)] <A > Ci#4R L1
EAE K LT —ERER 25E LT,

& 1E(Stop)]-+—ERAE R DIEE 25 v LET,

P U7(Clear)]- [ A pah R (Test Results)] XA > 469 XTOIHH #H| & L9,

[ 2 M 5 (Test Results)] <1 > CIH H #8700 2 Voo B8, FHAF & >T RE—~
74—V N(Schema Fields)] X+ > TR I 3 24 4F 258 i K 78 S, Z2ITHK N7 A— XD
ENJITEET,

BAESBRALZ R SNIHERE A T5—DA 41—

R DA A=k RF—%74—)L N(Schema Fields)] X »ZFK R SR IF A T5—¢
TORAEER LTV ET,

B vieb Service Test Designer

File Edit View Help

| P a| E | importwsDL: | hitp://zero.webappsecurity.com/CustomerAccounts/ WebService. asmx7wsdl |- i

Wb Senvices ~ B | Request - Operation: IsValidCustomer -
eSend f Import l- Export - Auto Value

= W [ hetp:ffzero.webappsacurity.com/Customera || Soap Action:
= W [E] webservice

= .1 [#] webSarvicaSoap [ Schema value ] -
4 LinkTaTestingDocumentation F Envelepe
¢ [¥] ListTestAccounts s

- [ 1svalidcustomer 55 Ch Header L4

: [#] GetCustomeraccounts - [Bany (aray) -

+ [+] ClossAccount 3§ (=} Body

N Addaccount 3§ =} Isvalid Custamer

InternalFundsTransfer 5§ LT

- i~ name 4 v

¢ [#] addCustomerRacord 5§ L =18

¢ [#] CustomerSearch —\Lpin .
st Resilts - m—

[Z]Run all | B Run Selected| | @ Stop| 5 Clear

Rasult: WSOL Sanvice Port Operation Error Massage Ai
Valid hitp:)  WebSenice WabSanicaSoap LinkToTesting
Valid hitp:] ‘WebSendice WebSandceSoap ListTestiooom
L L Server was unable to read request. --—-> There is an error in the XML document. -— > Inpal

k) Failed hitp:! WebSendce  WebSendceSoap ClosaAccount  Sarver was unable to read request. -—> There is an error in the XML document. -—-> Input string was

b Failed http:]  WebSenace WebSenacesoap Adddccount  Server was unable to read request. —3> Thene i5 an error in the XML document. —> Input String was

£§ Fail=d hittp:!  WabSandice WabSandcaSoap InternalFunds Sarver was unable to read request. > Thena is an error in the XML dooument. ---> Input string was

k) Failad htip:/ ‘WebService  WebServiceSoap AddCustome i  Server was unable to read request. —-> There is an eror in the XML dooument. === Input string was

g Valid http:! WebService  WebSeniceSoap Customersear

b NotRun hittp:/! WebSendce  WebSeniceSoapll  LinkToTesting

I NotRun http:/ WebService  WebSendiceSoapll  ListTesthocou

b MebDiim (R P T I N |

]
OQutput| Test Rasults
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X 7€ (Settings)
Web Services DesigneriZid . IX D20 47 3 VD% & Bd D&,

o "Aybhy—r7OFI" R
o "2y hNT—IRRAE" IR DX—Y

ryhT—r7nFy

Iy hT—07ax T ERTE T B2

1.

P'o¥ 7’0771 )v(Proxy Profile)] VA b67 07 7V 218 L L9,

E# (Direct)]: 7oF o4 —_ % L&t A.

B 8% 1 (Auto Detect)]: WPAD (Web Proxy Autodiscovery)7'o b v 1§ i L
T7ud v HERE 77 AVER L Sh 2l LT7 779 OWeb7 v+ L% & £17
WEd,

P A7 A7 v% v %f# B (Use System Proxy)]: o—/L v vips7 oF o H— 11
WEA v E— I LET,

PAC 7 71 )v %{# i (Use PAC File)]: PAC (Proxy Automatic Configuration) 7 7
Whe7 o i 20— RFLET. I URL] R v 2R TT7 7/ v D5 ft 248 ¢ L &
ER

BRI &7 0% 5% 2 %% F (Use Explicit Proxy Settings)]: o+ O /R )
77X 5 (Explicitly Configure Proxy)] € 73 s> I & LI #16 H L. 7'm¥ >
Y= NEN LAV E—2y MZT 72 AL ET .

Mozilla Firefox % i (Use Mozilla Firefox)]: Firefox#>67 0% » 4 — & # % A
yHR—brL X,

E: 75007 ax iR B A H T 328U TH. 7aF v —EEH OA >
K=y N7 72 AMRGE SN 20U Tld & &t A . Firefox7 774 OF Gt 7% E 03
[ToFs—3H LAV ICERE SN TVRIEES. 7o 3 H S ¥ A.

PAC 7 7 v %% Fi (Use PAC File)] #3% 4% L7-45 4 1&. URL] & v2 ZIZPAC T 71 )L

DLt &N I L&,

BRI %7 ox vk € %18 F (Use Explicit Proxy Settings)] #i# R L7215 & 1d . X

DIFRENTILET S

a.

b.

B—sX(Server)] £ vZ 27 0% v —AOURL /212 IP7 KL ZZA Jj L %50
( R— MPort)] £ vZ7Ri2)F— pE 5 (80804 &) 2N I LET.

A 7 (Type)] VA b5 5. 7' 0% 24— % OTCP F57 192 20 4 270 b
(SOCKS4. SOCKS5. &7-id ) 2R L 27,
FRRE L 25 A 1k . BREE (Authentication)] VA b6 X 7 #IER L L9,
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(¢]

H B/ (Automatic)

H: AEIMHE 25 E 328 AF v O 288 e 0F 5. IR LT 35
DBEE AV R E T 28 AF v DA T7r— > AEKIE A ELET,

F: 7k (Basic)

£4 Y =X MDigest)

Kerberos

2 ¥ x— MNegotiate)

°© NTLM (NT LAN Manager)

4, 7O0F Y —NTRIEPVE LG E L HEIE 22— EXZAT7—FEN T LET,

5. B EDIP7 FL AN 7 A MA M EWT 28 A 2007 mF o H— A& 4 3
VENE WG E G Pudy e/ (/327 394 NBypass Proxy For)] & v 7 A1 7§
LAZREURLEA ST LET . =2 MEX Y 256 & A ~&2FH L&,

6. {R7E(Save)]&2VUvrL &+,

(¢]

[¢]

[¢]

[¢]

Aoy b7 — 7R L

H— \FRRE 2 4 WG AL TFEE(Method)] YA b4 Br L(None)] i 4R L &7,
INLIAN DG G FRAE T L FIRIR L. A v N — B IR AN TSI L ET . fBAE AV v R
EIRDEBNTT .

 ADFS CBT

H # (Automatic)

% & (Basic)

&4 Y =X MDigest)

Kerberos

4 ¥ x— MNegotiate)

NTLM (NT LAN Manager)

754 7 > bk i & Off A

A7V MERAERIE AN T35 2—FE 2—HL L AT7—F 2N 1 T 20T % &
ATV NMEHE AR R T3CENTEET, 0— Ly v oif Bl E 2RI+ 2288,
HED2—E 0 ConiiHEZER T8 TEET, Vv Ea— R Sz
HLiH 7 78 AH— F(CAC) V=K% EDBNANT NA A 6DFE I E 28I § 22T &
T 7747 MEH & 2 H 3 212

1. Poxsy s34 7> NEBH S 25 3127 3(Enable client certificate on proxy)] 7 =v
IR I AEFNILET
2. P54 7> bk B & (Client Certificate)] 27 Vv /L £ 7.
BOAP 754 7> hal B & (Soap Client Certificate)] 7 1> N5 & £ 9.
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3. MOLTHhEETLET.
o AVE2—RZESTHE—AVTY AV E2— R EDTRXTD2—HIZE-TT n— LR
& & 4 312id. E—Av <3 >(Local Machine)] #i%4R L 3.

o IVEa2a—REDZ—FTHTY MNZEoTa—AVaiE lE A T2, RED
z2—4#(Current User)] %% L £ 4.

E: 3B 7 72 24— NCAC) V=X ll s 2a Ml & i 2—¥ 5L & TH Y,
PL1E ® =—4(Current Usen) ] (TR & S & ¥
4, WOWTFNEEITLET.
o TMENIT~A1)AEAF A TSR F IR T 2121 Fay/ Ko IR s [
A(My)] #ER L £7 .

o [ERHENTOV— NE & IR T 21014, Foyr7 &7 YR bC [L— NRoot)] i
WLET.
5. Web# 4 FCIEFCAC Y—XK % H L £3 H
e NIWIDGEHEE IRDFIE#FEAT LET .

i. B #F (Certificate)] VA bh 4. [(SmartCard) | &0 57V 747 AL o 1251 B
FHEERLET,

AR U7-RE B 2B 4 215 3R EPIN 74— A FiE B 2 55 3 (Certificate
Information)] T V7 ICR /N S £ 7,

i. PIN2SLAEL 2354 1k PIN] 74—)v FICCACOPINEAN 1 L7,
VE: PINAVL B 2315 4100 COBE 5 TPINAA J1 Lawb &y A% v 12PIN
DN ] %R & 5 272002 WindowsD e+ 217 4] 74> RZIZPINEA /)
TI2LERHNET,
i. FAMNTest)]z27Uv/L &Y.
ELOPINEZAN S LG & T Ave—Y R IR SN E7.
e Tz 1054 k. HEBIF (Certificate)] VX by ol Bl & #IBIR L & ¥

AR U7ak B & B 3 215 3k A §iE 9 & 1 ¥k (Certificate Information)] = V712
NN ET.

6. OK]z7Vy7L &9,

WSt F2U7r 4

WIR TS84 H— 25 H LT, Weby—ERAX— M DT XRTOEE/EWCHE § 2+«
F2UT AR E BT A ET

o WebH—tX(I"WebH—E 2D E" Ik DA— | 55 1])

» Windows Communication Foundation (WCF)+—EA(["WCF +— & A(CustomBinding)
S N—v3531 %25 1K)
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e WCFH—EA(7x7 L—y ) (I"WCFH—EA(7=7 L—y 22) D% " X\—v354] %%
1)

o WWCF+#—E A(WSHittpBinding) (I"WCF +— & A(WSHttpBinding) D% i " ~X—3354 ]
)d"_z?z‘% Hn)

fr—EeZ5E 4l (Service Details)] VA b 81 1) 49— E AR L. TR SN FR 2N
JiLEd.

Web+#—E ZADE E

h—2Y UIFIEN 2% 2 ')74%1%9 R ASOAPE SR (IZ N\ > T 315 4 . WebH—/3E 20
BIEIEHRHAEIETH B xR L TH 6. Web—ERIZ T U”f“/a/@%ﬁ e TING
&F4.Webyr—bL2DtF 27 4}25&:%&;@:&”:\ SOAP Ayt —SI2IE 7 ¥ RVE 4
AW S 2 T 2081 T3 . SOAP Xyt —U X7 U RIVE L 528240,
BRIE P Ay — VB SN TOR W EETIER T& &7 . SOAP Xyt —Y 215 510 32
& H W O AE B LLAR S Ayt — /@V\]%‘r’éaﬁ{)@ﬁi@%ﬁczﬁ”)\Webb“*‘l:“XODJcﬂfl‘)
FAEMEIR § 2 FE TR L BT

WS-Security] &7

1. X 2V74 b= FBINT 32, B 270970, b—20r A7 %8R LT, R sn
iR ENTILET,

. B—¥4 (UserName)] D b= ¢ 22— &3 A7— FE4E 8 L £9 . nonce
é’/\&)é &@k%ﬁx R nﬁ@t_ =N/ AT — Fé’%{%?%ﬁ/ﬁ( [?;\:X N
(Text)]. [ L(None)]. 7zl [\‘y\‘/ 2(Hash)] ) DR 7€ « B LUV XA L AR T HE ®
BIEIMDIRE #AT ICENTEET .

« K509:L BH & (X509 Certificate)] . 2D b—2>1dX.5095E B F (2 DLW T F 7,
VeriSign, Inc. % EDFRAL R 7> SRE Bl F #EN 3 220 M H ORE B F — R %%
L CEHE 25T $ 3208 T & LT, 1T LA EDOWindowsH—/3 & Al B & #1E
BCEBZARBEAST7IANT7F HPKINK G LT EF . 2018 BRAER W& 4 L
TE6M BB SN TR LREFH 2 C& 3. it F 2R L. S| 247
(BinaryCertificateToken & 7zi& Reference) #45 & L £ 9.

* Kerberos /Kerberos2] . (Windows 2003 & 7z( XP SP1LA [ 0¥ 7). Kerberos”'
O, A—T2 T F 297 8 é‘ﬂ’ﬂ”ﬁf“ﬁ’ v hT7— 7J:0)1—*4ft47“—‘l:7\€’
*HEC:;E FAET 2 S & I AEMEHAFH LT, 2—VERET
S B8LU0EL LET. Kerberosﬁw@a%ﬁJc/ﬂ~(KDC)tn¥c;c°né+f~ M~
Tfﬁ‘{ﬁig’rﬁilii’nunﬁbij_ nunﬂz1§ i*‘*fﬂiz~/l\'7—‘7j:0)1’)uj:0)ﬁ-‘l:7\
T 7RG B —EAFr v bEE R TEET. 77y MIE . 22— O 54k &
m_mm%a&ﬁwur WG En&d. 77y BUAE D2—F D&M 15 #k %18 H
L THU 18 s £ 9. Kerberos b— 7> &Kerberos2 b— 7> D #1& Wik . Kerberos2
Bt F 2UF 4 E— b7 TR K—A v &7 z—R(SSPI) &6 il & 2,5 TF. LA -7,
O34T MO ANIE R 282 T 212D FHME SN E L EHNEIEA. A2,
Kerberos2t 27 4 h—2 14 . Web77—‘L\ THEAIT &N T 2WebH— B RIZIEE
S 2SOAP Ayt —Y R E T 2720 H T&EE T FANEN ALV EFRE L
ERD
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« BAML +—7>/(SAML Token)] . SAML (Security Assertion Markup Language)
AV E—2 v EB L TEY A AN— M —f] T, 7H—y av PN 2 F 297 1
B R 2500 4 210 OXMUERE T4, 74—y i B AT — AV MR
AE S IRTE AT —MAY M BEUMHERAT HIRE AT — AV METHBEEBNTELT,

P71 vh 60— F(Load fromfile)] #27Vy 7L C. SAMLAE H&F 2B L &3, §iL
i & (Certificate)] # 7 Vv /L C RE M E 2/ >R — L ET. B . AL E S &
A 7(X5097 —X &/zIdRSA) #1E R L £ 7.

2. Avb—YEBLZAZEMT2E. RE2V /LT ERSOIBEREN I LET.

« B4 b—2/(Signing token)] . F & M 42 b— 2> (B (X509 X1 7). &
&N XTDOFM—=2>D VA MSIEIR L ET.

o [E#4M 713 YX 4(Canonicalization algorithm)] . [F#R 4L (i ¢ 2703 YR
LADURL, FEyZ RV YA M — I A 7IVT VX LR S &3 [ 52
BEARHLGE . T 74V D EELET,

o BB 73 YX A(Transform algorithm)] . xvt— FE L W 4 28 703y
A LDURL, Fay7 &7y YA MIE . — RN A7V T IR LBR N S &3 HH 3
BENANH LG EE T 700 MO EFCL &Y.

e B A2—54ARX—ZYZR MInclusive namespaces list)] . L& s 24D L TH D
N3, A~TXY el iz7'L 747 ZAD VA NAT Y 3v).

o B4 ¥ 3 (Whattosign)]. & % 3 3SOAPE K (SOAPA XL\ XA L ARYT,
B £ UF'WS-Addressing).

« KPath (47> =/)(XPath (optional))] . & % T2 AvL—Y N O 4 218 € 75
XPath. ZH D £ Ic T 3¢, E4 * 7Y a>(Signature options)] 7 +—)L N TiE R
LI-E & »E 4 S &7 H: //*[local-name(.)="Body']

o [M—2AA7+ 2>)(Token (optional))] . E % § 38— v b—2r . BN S izd
RNCD M—=7>DRay7ZIY YA MpSIER L ET 1 EAEDH—EATIE, O 74—
WRETE DEECT2LELDHVET .

3. Avbt—URE S EEIN T 2. B 22Uy /LT BER S B REAN T L ETS

o [M—2>OE S 4k (Encrypting token)] . 1% 5 46 (A FH 42 ~— 2> (G H (£ X.509

ZA7)e AT WCAE R LIz RTD h—2>D YA Mol TE £7.

B 5 4t 21 7(Encrypting type)] - %0 J¢ B & &k 205 54k 3+ 24 20 a> 7>y
DA&EGE ST 208K LET,

§2 713 YX 4(Key algorithm)] . © v a3 ORE S 4L (2 371 T YR A
RSA15 £ /(X RSAOAEP.

k2 v 3> 7T YX h(Session algorithm)] . SOAP A vt —y D% 54k i fdi Fil 4 3
TIWT VR Lo HEE D VA b SR TEE T

KPath (47" a>)(XPath (optional))] . K5 51k § 3 Ay —Y D4y 27 §
XPath, 25 4 D & £12§ % & SOAPA XL 12U 235 54k s &9,

W

[b—2 /A7 2)(Token (optional))] . t5 51t Stz h—2> D4 i . 1B N S fz

OpenText™ Fortify Weblnspect (23.2.0) N—352/360



Y=V AR
% 21: Web Service Test Designer

TXRTCD =YD YVA M ROy 7 BTV R v I AT IR SN E T, (FEAEDY—EART
. CO74— 1V RETDFEFZT U ERHNET,

4. P FORE T t2EHLT. X 2V7 4B EAEBLEOECKE LET,

WS-Addressing

WS-Addressing] %7 %f# | L T. #—bE X TWS-Addressing £1# [T} § 22:& 9%, B &
HHT25 53—y FES 4B ELET,

WCF +— & Z(CustomBinding) D% &

WCF +—E A(CustomBinding)iZ & 0. & 5 L )LD AR KX~ A X550 B T9 . WCF
customBindingfZ ¥ (23 DWW T B2, T A I B E1F A EOWCFH—E R &3t
WS - <spec_name>tt: % 21 il 4 3JavaX—ADH—ERL E AL DT Sy b 75— 4 D
Y—ERAETANCEET,

[F5> A28 — MTransport)] . HTTP]. HTTPS]. #/zi& AutoSecuredHTTP] #i##R L
7. LRI &SATETCP bV AF— M A — FSN TL ER A

f>a—7 4> 7(Encoding)] . [+ X NText)]. MTOM]. £7:i& WCF/ X1+ YWCF
Binary)] Zi# R L 7.

fe % 2 Y7 «(Security)] . i V] 2 VR s S5RIE E— FE7— PR 97 R U3 —£IBIT L &
T o

B v b ¥ 297 4(Net Security)] - 2 h)—4tF 2U7 4DFf$H: e L(None)]. Windows

A Y=L F 297 4(Windows stream security)] « £72i& SSLA h)—4L £ F 27 4(SSL
stream security)] -

B OF \» Ayk—Y >/ (Reliable Messaging)] - 15 %8 11t O v Xyt — > 7 %{§
¥ 22i& B H(Enabled)] %1 L. ko JEF & Y(Ordered)] /-1 JEFF % L(Not
Ordered)] D\ DI X #IZR L £9.

5 915 R (Identities)] . /N1 > 7 4> 7 Lil Wl & Ok 7 15 3R 232 4t L £
e pB—%4(Username)] & PSR 7— K(Password)]

o M— SiEBHE/ 754 7 Ntk B 2 (Server Certificate/Client certificate)] . +—/ & 72
& 247> bR R IR AE T 2 & . B (Browse)] RV A A LT, §F
B & D% $i (Select Certificate)] X1 70/ R v/ A% & £ ¥

« 3 &h 3DNS(Expected DNS)]. SPN]. 5 £ UPN]. DNS. SPN. &/zizUPN
2 & By H— DT W] Sh 25T . localhost. IP7 L 2. #7213 4— 1% #46 % C&
i,

P 54 7> MWindows:# 7] 15 #R (Client Windows Identity)] . 254 7> MWindows D3 /7
HERENSILET,

o« BiAEDz—4(CurrentUser)]. v >izn/ 4> Lica—4 Ol K .
o WARZL2—4(CustomUser)]. 2—H % NATV— PR, 8LV AL V2R E LET .
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FE4IER 5 (Advanced)] # 2V v LT, FE4H A% 52 (Advanced Settings)] &1 702 K v &
R & & FA I OWTEN" v 207 cDFE4l " XN—U3571 25 18 LTS,

WCFH—EA(7 =7 L —3 2) D& &

WCF#—bA(7=7 L—v 2) &l ] 3 285 & . 251 7> Md Security Token Service
(STS)izxt LTRBAE 24T Wy h—20 A LET. 7947 MNE =20 3 LTT7Y
T 33N LXTT%}nu nE )é:”/f]t WET,

H—

o [FF¥AHR—NTransport)] . FZ7> AH— bRAZHTTP £/2idHTTPS,
e EYa—74>7(Encoding)]. 4— DT> a—7 4> 7RV — 7 F A &2 IEMTOM.

¥ 274
« B3E £— F(Authentication mode)] . FZ ik OF] g 4 €E— KD Fa vy’ X7 YA b
( AnonymousForCertificate] . MutualCertificate] % &)

e P — PR MFy7 R Y —(Bootstrap Policy)] - Secure ConversationiZ it OW] B %4 7— b
A NZy7 RYy—0D Fay7 X7 YR N BspiNegotiated] . [UserNameOverTransport]
5 E).

ank 3] 1 R
INA T 4> 7 LRE B & O3 1 R

» Br—/\5E B F (Server certificate)] - 47“~/\®ﬂa FITHIR #R At v 25 E . BB
(Browse)] & &> % Fl LT, §if B & Di% R (Select Certificate)] 4 7127 A v 7 X %
&¥9d.

. 3 &h 2DNS(Expected DNS)] . DNSI & 3. #— DT 1] S0 23 115 4 .
localhost. IP7 FL R, E/2ld — Y 52458 C& 7.,

STS (Security Token Service) D& 4l

o EYPFRAY 7 FLZX(Endpoint address)] . STSO > N4> 7 FL X, localhost.
IP7 FL R, &feld r— % 216 E C& &7,

e P47 4> 7(Binding)] . STSIH: 48 T 231 7 4> 7 4B B ¥ 22 F Uit

FE AN 3R 2 (Advanced)] # 7Yy 2 LT, FEAN X € (Advanced Settings)] 4 707 & v 2 &
B & E T MOV TET" v 207 4 DFF A % 8" N — Y3571 R L T2 S0,
WCF #—t A2(WSHttpBinding) D&% &

WCF 4 —E A(WSHttpBinding) £{% | 4 2 & sBGE OFE 8 & fx L(None)]. Windows] .
EE B & (Certificate)] . &72ld —% 4% (A vt —Y R # )(Username (message
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prOteCtion))] O)EF‘ 7 51 %ngij— 747 v I‘nu nE 0)*%;’@@0) ﬁ)%j‘jy El\/}g_’i%j:ﬂ L
5o UL 32 & iz, IR U0 218 INTE $E75>H%i0ia“

2L 7 INTG A—R

%z L(None) o B—AEKEIR 22Ty — 17 3(Negotiate server
credentials)] - Webr—EADFE & 24— Nex T x— L E T,
H—/3DDNSIE M 45 € § 6L TEET,

o M—EAIE B & %38 E ¥ 3(Specify service certificate)] . +—t

ADFE E DG . COATY RN LGS . —erAB K
153 # 233 =— b 3(Negotiate service credentials)] # 7' =
EBEBRHVEE A

o {F# &h 24—/ \DNS(Expected server DNS)]. FAf>3—AY
AT L& B — DT i Sh B3 1% ¥k - localhost. IP7 KL X,
Y=Y AR E C&ET. ¥ AL EORIT M &h 2
— MK LT BIELTEET,

e [e¥ 7%ty av%F ¥ T 3(Enable secure session)] . F B
i ﬂ/f7nu nE %{ﬁﬁﬁ L/f;ﬂ;\: 1772{ w3y 3/{’;:4:7 Li?‘

P30 &h 39—33 5 15 3 (Expected server identity)] . +—t 2
7Yy L% (SPN) & 7218 2—4 7' Y+ 214 (UPN). SPN 535 &
4 % &, SPN &, SPNW B # A] (F o 7245 %€ OWindows 7 A7 b &
W EoTH—EARH A S £3. UPNEIG E T2 &, H—L AL &
DODWindows 2—H 7 A7 NCEAT SN B VEST 22— T HY
YMEVIRE I A LT R2—H B 5 ED2—Y T A7 b
THEAIT SN TV R —EBRIZL 3HDOHVTNHTT .

e P54 7> MWindows:H 5l 1% 3k (Client Windows identity)] . 751
7> MWindows D 7l 155 3 .

« BZEODa2—%(CurrentUser)]. v> o/ 4> LThb2—
DEMIEHREMH L £,

o WAZLz2—(Custom User)] . =—# & ¥ 5 ] (= —44 .
AT—R, BEFRAL N BN ST L b B2S CTAEE L)L 2%
RLEFT(F— B2 IAT Y MDAV TF A MCEAT CEBERIEHNC
NTREVET) BRLNWEIRDEB VT,

° [ L(None)]-L XL Sh &8 A

o [ 4 (Anonymous)]-H—\d . 254 7> M Lz 0L i
ALz T328ETEEEAS

o i 7 (Identification)]-+—/3& 254 7> bOi#k A1 i SR bE
FIE TEETN, 7947V M el $32LE T&EE A

o {4 %% (Impersonation)]-4—\& . e—V e AT L L T4
7Y hDEF 2742V T F A MBI TELT .

Windows
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A7

Ak B &
(Certificate)

2—4
(Ave—IfR
%)(User
Name
(Message
Protection))

NI A—R

o [R/T(Delegation)]-4— & VE— b AT AL TISA4 7 b
Dt*2Y7 42> 7 A B TEET.

ke ¥ 27% & v> 2> %% #1127 3(Enable secure session)] .
Windows 2 73RGE &l Lize F 27 % vy av &F Al LE 4.

V54 7> ML B & (Client certificate)] . 751 7> bl Bl & D15
fir. &R (Browse)] A& & H LT, §iF##H D4R (Select
Certificate)] X4 70/ R v/ A% & &7,

Br— & IE ] £ 1 7> — b¥ 3(Negotiate server
credentials)] . Web—EZADGE & #4— /N erTyT— L ET,
H—/SODNSTE R 25 € 2L T&ET,

pr—UER:E B # %38 =& 7 3(Specify service certificate)] . ++—t
ADFEHE DG . COATy av IR LG E . B—EBKE
% # x 73 x— b¥ 3(Negotiate server credentials)] # 7' a1
% CY

7 # &h 24—/ \DNS(Expected server DNS)] . DNSZ & 3.
47“—*/\0)? Wl & 2k 715 #R . localhost. IP7 L A, &/-id #—
HERETEET, I B ORI MEH SN 32— B4 &1 3
ZEHVTEET,

k¥ 277% € v 2 %% ¥ 2 3(Enable secure session)] . il
% ﬂ”f7nu nE ’éﬁﬂﬂ LiceF a7ty EI/%:’nq:T LEd.

B—#'4 . /AX7— N(Username, Password)] . 751 7> rDiZ 5
&1

Br— & IE IR £ 2 T =— b 3(Negotiate server
credentials)] . Webr—EADFEH & 24— Nex T z— L E T,
H—/NDDNSIE M 218 E T 22LLTELT

Br—E AL B & %38 52 3 3(Specify service certificate)] . ++—t
ADHE B # DB T . COATY BRI Lt &L SRR
# %4 7> x— ¥ 3(Negotiate server credentials)] # 7> 214 ik
XTI

¥ &h 24—/ \DNS(Expected server DNS)] . DNSZ & 3.
H—DF Hi Sh 2:8 515 ¥R - localhost. IP7 L A, 7zld H—°
VAR ETCEET N il HEORITIMEH SN 3 — K& £33
ZEHVTEET,

Iflz * 1772 —lz V4 a/?ﬁﬁ] Y 6(Enab|e secure session)
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¥ 27 ADFEA R E
DA Tl R vIATENIRDETTTAMNDLF 2T 4R EENAXTARTEET

> a—7 4> 7 (Encoding)] &7
> a—7 4> 7 (Encoding)] £7 & IRD AT av b VET .

o EYa—74>Z(Encoding)]. Avt— WM H T3 a—F 427 A7 FF AL
(Text)]. MTOM]. £#i& WCF /34 + YWCF Binary)]).

« WS-Addressing/X—¥ a>/(WS-Addressing version)] . i# R L/ic=>a—7 4> 7 D
WS-Addressing® /3 —> 22( & L(None)] . WSA 1.0]. £7/z1& WSA 04/08])-

[ ¥ 7% ¥ (Advanced Standards)] 47
[Fi £ 4 #E ¥ (Advanced Standards)] 272 IROA 7Y av3H V& T,

o [EHEMEODF » AyE£—Y >~/ (Reliable messaging)] - WS-ReliableMessagingft: 1% %
TS 2 —EADE RN OF O XA —Y T ERE L ET . Ave—Y I 43T
Y a—7 127 847 ( & A NText)]. MTOM]. &7l WCF 3 A+ YWCF Binary)]).

o B OFE W AYL—Y Y/ DJEF T 7 (Reliable messaging ordered)] . 548 T& 3
Yoy VAT T T 20 E O ERLET,

o [EEMOE L Ave—Y ¥ 7 D/A—Y z(Reliable messaging version)] . xvt—y 2
1# ] s 33— 3> WSReliableMessagingFebruary2005 & /-1
WSReliableMessaging11.

o [ FLAEZEH T E ¥ 3(Specify via address)] . 4 vt—v #H [ H—ERZEE L.
ZFIMEFEBE O NES SN ET. R, T AT aF i Ave—Y 2k § 285
HFLEH S 255 Nd VL4 . ik, WCF clientViaB {E icxt s LT &3, i
d Avb—UNFEFRIEE SN 7 FL A%, Avb—V DR E L ORI 7 FL A&
X 3l 4 25 & R T .

o [P FL A& H (Via address)] . *vt—Y DS 2 O BL 7 FL Ao g 88—/ 0¥ #
G IR E DL H 216 E C& L. SOAP Ay — IR D & AR IR SN £,
<wsa:Action>http://myLogicalAddress<wsa:Action>

T RL AL, 22— A v R7—AnsllfgF S 3. 7 74V bTIE . WSDLTHE & St
27 RLATY . CO74—IVREFEH LT, COT7 FL A2 EEETELT,
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